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SigmaPlot makes it easier for you to present your findings accurately using
precise, publication-quality graphs, data analysis and presentation tools.
SigmaPlot offers numerous scientific options such as automatic error bars,
regression lines, confidence intervals, axis breaks, technical axis scales,
nonlinear curve fitting, and a data worksheet for powerful data handling.

SigmaPlot is a state-of-the-art technical graphing program designed for
the Windows platform. It is certified for Microsoft Office 2003-2016,
Windows Vista, Windows 7, Windows 8 and 8.1 and Windows 10. SigmaPlot
is specifically designed to aid in documenting and publishing research,
specializing in the graphical presentation of results.

Creating and editing graphs is easy. Just click the Create Graph tab, select a
graph type, pick your data with the Graph Wizard, and you can create a graph
in seconds. You can create a formatted worksheet, or use templates or the
Graph Style Gallery to apply favorite graph styles again and again.

SigmaPlot also includes a powerful nonlinear curve fitter, a huge scientific
data worksheet that accommodates large data sets, summary statistics
including SigmaStat's entire test collection, a mathematical transform
language, and much more.

OLE2 technology is fully supported. You can annotate graphs with the
Microsoft Word Equation Editor, edit your graphs directly inside Word
or PowerPoint, or plot your data with an Excel spreadsheet right inside
SigmaPlot.
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Installing SigmaPlot
Install SigmaPlot on your computer from the CD. The installation program automatically starts up when the CD is
placed in the CD-ROM drive. The dialog boxes that guide you through the installation process are simple and self-
explanatory.

Important:  In order to accomplish your installation, you will need to have your product registration number
available.

System Requirements

Software

• Windows 7, Windows 8.x, Windows 10
• Internet Explorer Version 8 or better
• Office 2003 or higher

Hardware

• 2 GHz 32-bit (x86) or 64-bit (x64) Processor
• 2 GB of System Memory for 32-bit (x86)
• 4 GB of System Memory for 64-bit (x64)
• 200 MB of Available Hard Disk Space

All Operating Systems: 800x600 SVGA/256 color display or better.

Serial Numbers

Your unique serial number is located on the CD cover. Have this number available when you call for product support,
payment, or system upgrade. Copy this number to the registration card and send it in to Systat Software, Inc.

Registration entitles you to:

• Unlimited technical support.
• Product upgrades.

Automatically Updating SigmaPlot
Every time you start SigmaPlot, if there is an update available, the Updates tab of the SigmaPlot License Manager
appears.

New patches appear under Patch Updates.

To install, select the patch name, and then click Install Updates.

Note:  If for whatever reasons you cannot gain access to the server, click Retry.

Deactivating Update Notifications

You can turn off update notifications on the SigmaPlot 14.5 License Utility.

1. In the upper right-hand corner of SigmaPlot, click Sigma Help > License Status
The SigmaPlot 14.5 License Utility appears.

2. Click the Updates tab.
3. Clear Always check updates on application start up.
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Updating SigmaPlot from the Start Menu

1. On your Windows Start menu, click Start > All Programs > SigmaPlot > SigmaPlot 14.5 Update
The Updates tab of the SigmaPlot 14.5 License Utility appears.

2. Select the update under Patch Updates.
3. Click Install Updates.

Updating from SigmaPlot

1. In the upper right-hand corner of SigmaPlot, click Sigma Help > License Status
The SigmaPlot 14.5 License Utility appears.

2. Click the Updates tab.
3. Select the update under Patch Updates.
4. Click Install Updates.

About SigmaPlot's User and Program Files
SigmaPlot is installed for all users that have user accounts on a machine. It installs its program files into a Program
Folder - these are necessary for the program to run - and then creates files in User Folders for each user on a
machine.

This means that two or more separate users can share SigmaPlot using his or her own set of SigmaPlot files and
settings. When someone uses SigmaPlot for the first time, it creates a User Folder just for that person. In this way,
many people can use the same version of SigmaPlot without risking damage to others' files.

SigmaPlot's User Files

When SigmaPlot starts, it checks to see if a user folder exists for the current user. The User Folder is in C:
\Documents and Settings\user\My Documents\SigmaPlot\SPW14_5.

If the User Folder does not exist, SigmaPlot creates the folder and copies user files from the Program Files folder to
the User Folder. The user files for SigmaPlot include:

• Submission Profiles. This directory contains all the available submission profile .ini files.
• Samples. This directory contains samples files of data and graphs that illustrate the capabilities of SigmaPlot’s

graphing, statistical tests, and macros.
• Gallery.jgg. This is the Graph Gallery file including any user-defined graph styles.
• GraphWzd.ini. This file stores all Graph Wizard settings.
• HistogramWzd.ini. This file stores histogram settings.
• DemingWzd.ini. This file stores Deming Regression Wizard settings.
• Layout.jnt. This notebook file is the layout file used when formatting or arranging graphs.
• SigmaPlot Macro Library.jnb. This notebook file contains the Standard Macro Library and user-defined macros.
• SPW.ini. This file stores all SigmaPlot user's settings.
• Standard.jfl. This Standard Equations Library includes all user-defined equations.
• Template.jnt. This notebook file is where all the graph page templates are stored.
• EK.ini. The files stores settings used by the Enzyme Kinetics module.
• Spw32.opt. This file stores the option settings for all statistical tests. It is not installed, but generated after first

running SigmaPlot.

SigmaPlot's Program Files

During installation, SigmaPlot by default installs the following directories and files into C:\Program Files
\SigmaPlot\SPW14_5.

The installed files include spw.exe, all the Help files, .dll files, .pdf manuals, and the following sub-folders:
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• FAQs directory. This directory contains all the .html and graphics files used in the SigmaPlot FAQs.
• Macro Transforms directory. This directory contains the .xfm files used for the macros Frequency Plot, Power

Spectral Density, Rank and Percentile, and Vector Plot. For more information, see The SigmaPlot Toolbox on page
337.

• Samples directory. This directory includes sample graphs , data , and nonlinear curve fit examples .
• Submission Profiles. This directory contains all the available submission profile .ini files. For more information,

see Publishing Graphs on the World Wide Web on page 320.
• Transforms directory. This directory contains sample transforms. For more information, see Transforms,

Regressions, and Graph Analysis.

SigmaPlot Basics
SigmaPlot runs under the Windows operating system and functions within the standard Windows interface. For
information on how Windows works, refer to your Windows documentation.

Using SigmaPlot's Ribbons

SigmaPlot’s Ribbon is very similar to what you've seen in Microsoft Office 2007’s Fluent User Interface.

The SigmaPlot Ribbon groups SigmaPlot’s commands by functionality. Each tab exposes a set of task-specific
controls. To see the controls, just click the tab. So if a worksheet is in view, you’ll see the Worksheet tab. A graph
page exposes the Graph Page tab.

The default setting for the SigmaPlot’s Ribbon is “sticky.” This means that you control which tab is in view. You can,
if you like, set SigmaPlot’s Ribbon to use Context Ribbon Switching.

Customizing the SigmaPlot Ribbon

SigmaPlot comes equipped with four ribbon configurations so that, depending on your use, you can display only the
tabs and groups as you need them. In this way, you can cut back on having to click between tabs; the steps within
your work flow exist within that one tab.

You can switch how your ribbon is configured at any time.

The four configurations are:

• Default. This configuration displays all of SigmaPlot’s tabs and groups. Here you have complete access to all of
SigmaPlot’s graphing and analysis features.

• Compact. This configuration combines the most commonly used features for graph creation and data analysis
onto the Graph tab and Worksheet tab respectively.

• Graphing. This is the original SigmaPlot configuration without the data analysis features.
• Analysis. Select this configuration if you plan on doing a lot of statistics. Its expanded selection of tests and a tab

order that reflects a traditional SigmaStat work flow.

How to Customize Your Ribbon

1. In the upper right-hand corner of SigmaPlot, select Ribbon > Ribbon Configurations.
2. Select your desired ribbon configuration from the drop-down list.

Customizing Your Ribbon

1. In the upper right-hand corner of SigmaPlot, select Ribbon > Ribbon Configurations.
2. Select your desired ribbon configuration from the drop-down list.

http://en.wikipedia.org/wiki/Microsoft_Office_2007
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Minimizing Ribbons

You can't delete Ribbons, but you can minimize them to create more work space on the SigmaPlot desktop.

1. Click Customize Quick Access Toolbar.
2. In the list that appears, click Minimize the Ribbon.

Tip:  You can also double-click any Ribbon title to temporarily minimize the Ribbon; double-click it again
for it to appear.

Minimizing Ribbons for a Short Period of Time

To quickly minimize a Ribbon, double-click the tab. To restore it, double-click the tab again. Alternatively, you can
use the keyboard shortcut CTRL+F1 to minimize and restore the Ribbon.

Turning Off Sticky Ribbons

The SigmaPlot Ribbon by default is set to “sticky,” meaning you control which tab appears. If you want, you
can set this to work more in compliance with Microsoft’s Fluent User Interface, and use what is called Context
Ribbon Switching. This means that whatever is in view, whether it be a graph page, a worksheet, report, and so on,
determines which Ribbon appears.

1. In the upper right-hand corner of SigmaPlot, click Ribbon.

2. Click the downward arrow, and then clear Sticky.

Note:  To restore this setting, follow the steps above and select Sticky.

Keyboard Shortcuts

In addition to the keyboard shortcuts that appear below, you can press the Alt key at any time to display keyboard
shortcuts available on all the ribbons. For example, if you wanted to run the Dot Density macro, you’d press the Alt
key, and then type T for Toolbox and then D for the Dot Density macro.

Table 1: General Keyboard Shortcuts

The following table describes basic keyboard shortcuts available through out SigmaPlot’s worksheets, graph pages,
and reports.

Press this key To do this

Display Help (F1) Display Help

Copy (Ctrl + C)) Copy the selected item

Cut (Ctrl + X) Cut the selected item

Paste (Ctrl + V)) Paste the selected item

Undo (Ctrl + Z) Undo an action

Redo (Ctrl + Y) Redo an action

Delete (or Ctrl + D) Delete the selected item and move it to the Recycle Bin

Bold (Ctrl + B) Make the selected text bold.

Italic (Ctrl + I) Italicize the selected text.

http://en.wikipedia.org/wiki/Microsoft_Office_2007
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Press this key To do this

Underline (Ctrl + U) Underline the selected text.

Table 2: Worksheet Tab Shortcuts

Press this key To do this

Rename (F2) Rename the selected item

Import (Ctrl + L) Import data into the current worksheet.

Insert Switch from inserting to overwriting data in the
worksheet.

Sort (Ctrl + Shift + O) Arrange selected data in ascending or descending order
using a key column.

Insert Graphic Cells (Ctrl + Shift + C) Insert a graph item property into the worksheet.

Column and Row Titles (F9) Enter column and row titles.

View Column Statistics (F6) Display descriptive statistics of all columns containing
numeric values.

Table 3: Create Graph Tab Shortcuts

Press this key To do this

Create Graph (F3) Open the Graph Wizard to create a graph or add a plot to
an existing graph.

Ctrl + = Move selected objects in front of all other objects so that
no parts are hidden behind other objects.

Ctrl + - Move selected objects behind all other objects.

Table 4: Graph Page Shortcuts

Press this key To do this

Align (Ctrl + =) Move selected objects in front of all other objects so that
no parts are hidden behind other objects.

Group (Ctrl + Shift + G) Combine objects so that they are treated as a single
object.

Ctrl + Shift + U Break apart a group.

Select Object (Ctrl + Shift + B) Change to the standard select/move/stretch editing mode.

Text (Ctrl + T) Place text on the graph page.

Draw Line (Ctrl + Shift + L) Draw lines using different line patterns.

Draw Arrow (Ctrl + Shift + A) Draw lines with arrowheads of different sizes and
shapes.

Draw Box (Ctrl + Shift + B) Draw rectangles and squares.

Draw Ellipse (Ctrl + Shift + E) Draw ellipses and circles.
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Table 5: Analysis Tab Shortcuts

Press this key To do this

Quick Transform (Shift + F10) Run a single line transform by selecting functions from a
panel and selecting worksheet functions.

User-Defined Transform (F10) Enter a multi-line transform for complex computations.

Nonlinear Regression (F5) Perform a curve fit of a selected equation to points
selected on a graph or data in the worksheet.

Table 6: Toolbox Tab Shortcuts

Press this key To do this

Macros (Alt + F8) Display macros to run, edit, change options, or delete.

Using Graph Properties

Use Graph Properties to make immediate modifications to graphs.

Figure 1: Use Graph Properties to make any graph modification.

To open Graph Properties, double-click anywhere in the graph. Usually, what you double-click determines which
options appear in Graph Properties. Changes immediately appear in the graph, giving you instant feedback. For more
information, see Modifying Graphs Using Graph Properties on page 68.

Alternatively, you can:

1. Click the Home tab.
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2. In the Navigate group, click Graph Properties.

Figure 2: You can toggle Graph Properties “on” and “off,” much like the Notebook Manager and
the Graph Style Gallery.

Getting Help in Graph Properties

In the right-hand corner of the Graph Properties dialog box, click Help.

Tip:  You can also press F1 at any time.

Turning Off Graph Properties Transparency

Graph Properties is by default set to be transparent so that when you move the pointer away from it, you can see your
graph without having to close the dialog box. You can certainly turn this feature off.

To turn off Graph Properties transparency:

1. Click Options in the upper left-hand corner of Graph Properties.

2. To turn off Graph Properties transparency outright, clear Use dialog transparency.

3. To change Graph Properties transparency to a different percentage, move the Percent Transparent slider or
enter a percentage in its edit box.

Main Button

Whenever you need to save, print, or open a file, click the Main Button.
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Quick Access Toolbar

When you want to quickly print a file, save, or undo, click the Quick Access Toolbar, which contains some of the
most commonly used commands. You can also customize it to include just about any SigmaPlot feature you like,
including commands for creating graphs, running regressions, or statistical tests.

To customize the Quick Access Toolbar:

1. Click the Quick Access Toolbar drop-down button.

2. Click More Commands.
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3. Select from the Commands list.

4. Double-click or click the Add or Remove buttons to move commands to the Quick Access Toolbar.
5. Click OK, and the new command appears in the Quick Access Toolbar.

Setting Program Options

Use SigmaPlot's program options to control application settings, as well as how worksheets and new pages and graphs
appear. To change program options:

1.

Click the Main Button  and then click Options.
2. Choose the appropriate tab and make changes.

• Worksheet. Worksheet options include settings for numbers, statistics, date and time, worksheet display,
default column width, number of decimal places, and use of engineering notation.

• Page. Page options control graph page properties.
• General. The General tab controls application settings.
• Report. Set report options, such as measurement units or to display rulers, on the Reports tab.
• Graph. Graph defaults control attributes that are applied to all new graphs.
• Macro. Select macro options, such as code colors and which macro library to use on the Macro tab.

3. Click OK to apply the changes and close the dialog box.

Graph Types and Styles

SigmaPlot's selectable Graph Type determines the structure of your graph. SigmaPlot provides many different types
of two- and three-dimensional Cartesian (XY and XYZ) graphs, as well as pie charts and polar plots.
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Graph Style determines how data is plotted on a graph. Available styles depend on the selected Graph Type.
SigmaPlot's Graph Wizard conveniently displays all available graph styles associated with each graph type.

Graph Style Gallery and Templates

Use the SigmaPlot Graph Style Gallery to create and store true graph templates using any existing graph style as the
model. Every graph that you add to the Graph Style Gallery is saved as a bitmap image. You can later apply this as a
template for future graphs.

Figure 3: The Graph Style Gallery

Templates. The SigmaPlot template notebook contains a variety of page layouts. Apply these predetermined template
attributes to previously saved pages and graphs, or create a user-defined template. Store your templates in a SigmaPlot
Notebook Template file (.jnt). You may want to create your own template notebook. For more information, see Using
Templates on page 118.

Axis Scales

Create multiple axes for 2D graphs. By default, SigmaPlot automatically calculates axis ranges and enables each plot
to contain separate X and Y axes.

Tick Marks. Use both major and minor axis tick marks and grid lines. Tick intervals, length, direction, thickness,
and color are all adjustable; grid line types are also adjustable. Tick labels can be numeric, time series, or customized,
using labels in a worksheet column.

Axis Breaks. You can specify an axis break with a different post-break tick interval.

For more information, see Modifying Axes, Tick Marks, and Grids on page 275.
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Smoothing Data

Smooth sharp variations in dependent values within 2D and 3D data sets using SigmaPlot smoothing algorithms. For
more information, see #unique_62.

SigmaPlot Worksheet

The SigmaPlot worksheet is capable of containing data up to 32,000,000 rows by 32,000 columns. Enter data in
columns or rows, and perform calculations either row-wise or column-wise.

Worksheet cells within columns are adjustable, and capable of holding up to 16 significant digits. Place labels,
customized fill colors and patterns, and error bar direction codes into these cells in order to specify changes to graphs.
For more information, see Worksheet Basics on page 163.

Statistics

SigmaPlot now provides SigmaStat's fifty frequently used statistical tests to analyze data, including the Advisor
Wizard, to guide you through the process of selecting the appropriate test. Detailed reports are provided in an easy-to-
read format and includes interpretations of many results. Result graphs are also provided. For more information, see
Using SigmaStat Statistics in SigmaPlot.

Descriptive statistics are available for all your worksheet columns. The Statistics Worksheet lists basic statistics for all
worksheet columns.

Display linear regression lines with confidence and prediction intervals, chart error bars for graphs of column means,
and run paired and unpaired t-tests between worksheet columns. Use the Histogram feature to compute and plot
distributions for data sets. For more information, see Transforms, Regressions, and Graph Analysis.

Regression Wizard

The Regression Wizard steps through curve fitting, plotting, and generating a report. For more information on using
the Regression Wizard, refer to Transforms, Regressions, and Graph Analysis.

Transforms

Modify and compute data using SigmaPlot's comprehensive transform language. For more information, see
Transforms, Regressions, and Graph Analysis.

Drawing Tools in the Mini Toolbar

When you select objects on the graph page, you can modify them using an immediately visible yet transparent Mini
toolbar. You can align objects and text, change font, size, and style, and change color, line type, thickness, and fill
pattern of graphs and drawn objects. You can also move object depth from front to back.

Reports

The SigmaPlot Report Editor displays regression results and features complete text editing functionality. For more
information, see Using the Report Editor on page 305.

Enzyme Kinetics

Use SigmaPlot’s Enzyme Kinetics Module to analyze and graph enzyme kinetics data quickly and easily.

To activate the Enzyme Kinetics module:

1. Click the Toolbox tab.
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2. In the Add Ins group, click Enzyme Kinetics.

Figure 4: The Enzyme Kinetics module is located on the Toolbox tab.

Tip:  Click Help to find Enzyme Kinetics documentation.

SigmaPlot Pharmacology Modules

Use SigmaPlot’s Pharmacology modules to perform exploratory enzyme kinetics, shelf life determinations, simple
ligand binding calculations, and standard curve analysis.

To activate the Pharmacology modules:

1. Click the Toolbox tab.
2. Select any one of the four modules available in the Pharmacology group.

Figure 5: Click the Toolbox tab to find the Pharmacology macros.

Tip:  Documentation for each module is available by clicking Help.

Anatomy of SigmaPlot Graphs
A SigmaPlot graph consists of one or more plots of data, and one or more sets of axes. It uses a specific coordinate
system (for example, 2D Cartesian, 3D Cartesian, pie, or polar) and has a specific size and location on the page.

Plots are graphical representations of worksheet data. For example, view data as a vertical bar chart or change the plot
to a horizontal bar chart, even after creating the graph. You can even display more than one plot on most graphs.

Axes are the scales that determine position of the graph's data points. Each axis contains tick marks that indicate the
type of scale used. Scales range from linear to nonlinear within a Cartesian coordinate system. Customize tick mark
labels with worksheet cells or use numeric or time series labels.

The X, Y, and for 3D graphs, Z coordinates, are indicated on each axis by tick marks. An axis can use a linear
numeric scale, nonlinear scales such as log, natural log, and probability, or a date/time scale. 2D graphs can have
multiple sets of X and Y axes. The axes' tick marks and tick labels, can be numeric, time series, or customized with
worksheet column labels.
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2D Cartesian Graph

The following figures show a examples of 2D Cartesian graphs available in SigmaPlot.

This example of a grouped error bar chart includes:

• A post break tick interval set to a new value.
• A Y axis break at 75% along the axis length.
• Error bars using worksheet column data.
• Bar fill colors using a pattern from a worksheet column.
• X axis tick labels using text from a worksheet column.
• A grouped bar chart with specified bar and group widths.
• Legend symbols and text labels.
• Image art cut from a paint program and pasted onto the page using the Windows Clipboard.

Figure 6: An example of a 2D Cartesian graph.

This example of a multiple scatter plot includes:

• Common log scale Y axis with major and minor tick marks.
• Custom sized symbols using an incrementing earthtone color scheme.
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Figure 7: An example of a multiple scatter plot.

This example of a box plot includes:

• Variable box widths expressing another variable dimension.
• Tick mark direction pointing outward.
• X axis tick labels using a category axis scale.
• A Tukey box plot with mean value lines.
• Custom fill colors.

This line and scatter plot with error bars includes:

• A scatter plot of column averaged data points, with Y error bars computed from the standard deviations of the
data.

• A top X axis with tick marks turned off.
• Y axis with a linear axis scale.
• A left Y axis title.
• A left Y axis with major tick marks.
• Numeric major tick labels.
• An X axis with a linear axis scale.
• A bottom X axis title.
• A right Y axis with tick marks turned off.
• An automatically generated legend.
• A reference line.
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Pie Chart Example

Use Pie charts to display a quick comparison of ratios in a data set. The example figure displays:

• Slice fills
• Text labels
• Exploded slices
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Polar Plot Example

Use polar plots to display modular data such as average monthly temperatures, or satellite positioning in the sky over
a period of time.

Contour Plot Example

Use 2D Contour Plots to graph three dimensional data in two dimensions. The following example includes:

• Major and minor contour lines
• Contour labels



 | Introduction | 20

3D Cartesian Graph Example

3D Cartesian Graphs include scatter, 3D trajectory and waterfall plots, mesh plots, and bar charts.

The following figures contain examples of these plots, as well as some additional 3D features.
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3D graph view can be displayed at any horizontal and vertical rotation. This example of a 3D mesh plot includes:

• A Mesh plot with colored fills and lines.
• A Z axis drawn at left side.
• Grid lines at major tick intervals.
• A Y axis drawn at front bottom.
• Axes automatically move to the front view at any rotation.
• X axis drawn at front bottom.
• Light source shading.
• Overlapping and transparent meshes.

Waterfall Plot Example

3D waterfall plots are stacked line plots along the Y axis of a 3D line plot. Because hidden lines are eliminated,
waterfall plots are useful for showing trends of line plots. The following example includes:

• Incremented line fill color
• Eliminated "hidden" lines
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SigmaPlot Help
SigmaPlot's online help uses HTML online Help. View the HTML Help using Microsoft Internet Explorer version 4.0
or higher.

Customer Service

If you have any questions concerning your shipment or account, contact your local office. Please have your serial
number ready for identification when calling.

Tell Us Your Thoughts

Your comments are important. Please send us a letter and let us know about new and interesting applications using
Systat products. Write to Systat Software, Inc. Marketing Department, 1735 Technology Drive, Suite 430, San Jose,
CA 95110 USA.

Getting Technical Support

The services of Systat Technical Support are available to registered customers. Customers may call Technical Support
for assistance in using Systat products or for installation help for one of the supported hardware environments.
To reach Technical Support, see the Systat home page on the World Wide Web at http://sigmaplot.com or http://
www.systat.com:

For more information, see Contacting Systat Software, Inc. on page 22.

Contacting Systat Software, Inc.

If you would like to be on our mailing list, contact one of our offices or distributors below. We will send you a copy of
our newsletter and let you know about Systat Software, Inc. activities in your area.

Global Headquarters

Systat Software Inc.
2635 N 1st St, Ste 131
San Jose CA 95134
Phone: 800-797-7401 or 408-876-4505

http://sigmaplot.com
http://www.systat.com
http://www.systat.com
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Fax: 800-797-7406 or 408-452-9016
Technical Support Phone: 1-408-452-9010
Email: saves.sales@inpixon.com
Support: saves.techsupport@inpixon.com
Website: www.systatsoftware.com

Sales and Regional Offices

Americas
Inpixon
2479 E. Bayshore Rd, Suite 195
Palo Alto, CA 94303
United States
Email: saves.sales@inpixon.com
Support: saves.techsupport@inpixon.com

United Kingdom and Ireland
Inpixon UK Office
268 Bath Road
Slough, SLI 4DX
UK
Email: saves.sales@inpixon.com
Support: saves.techsupport@inpixon.com

Germany and Austria
Inpixon GmbH Office
6th and 7th Floor
Kokkolastrasse 5
Ratingen, 40882
Germany
Email: saveskontakt@inpixon.com
Support: saves.eurotechsupport@inpixon.com

Asia Pacific and India
Inpixon India Office
6 E&F, 6th Floor
Vaishnavi’s Cynosure, Gachibowli
Hyderabad-500032
Telangana
India
Asia Pacific Sales: saves.apac.sales@inpixon.com
APAC Support: saves.apac.support@inpixon.com
India Sales: saves.indiasales@inpixon.com
India Support: saves.techsupport@inpixon.com

Bangalore Branch Office
Inpixon India Limited
Supreme overseas exports building
44/1, 1st & 2nd Floor, 16th cross
Jayanagar 7th block (west),
KR Road,
Bangalore – 560070
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What's New in SigmaPlot

Graph Improvements

The Point and Column Means graph created from the Graph Wizard has been modified to have the x-axis show tick
labels as column titles to indicate the source of each tuple pair that appears in the two plots created for the graph, a
vertical point plot and an error bar plot.

New graph styles and options have been added to the Create Graph Wizard for Statistical Graphs. The Quantile-
Quantile Plot for comparing the empirical distributions of two data sets is new. A graph of the Confidence and
Prediction ellipses for a bivariate data sample is also new. The Point and Column Means graph has been enhanced to
include options for jittering the symbols of the vertical point plot to reduce overlap and improve the identification of
observations.

Bar graphs with a value symbol above the bars. You can add column names, row indicators, and cell values.

Mini toolbars have been improved when drawing arrows.

Now you can delete plots from Graph Properties.

We’ve changed the Default or Add Axis to the Y Axis.

When you select many objects at once, you can right-click and align them.

We’ve improved legends so that you can use only the Y column title for the legend item.

Now you can type in a font name and have available fonts for what you’ve typed.

Worksheet Improvements

Now you can import multiple sheets in Excel files.

Analysis Improvements

The setting for the population value of the mean and median for the One-Sample T-Test and the One-Sample Signed
Rank Test has been moved from the test options dialog to the Test Wizard for your convenience.

A Chi-Square Goodness of Fit Test for category data has been added to our Transform Library (xfms.jnb). This
transform uses a column of data sampled from a finite number of categories that partition the members of a
population. The test determines if your data supports the hypothesis that each category in the population occurs with a
specified probability or that the categories occur with specified ratios that you supply.

The Plotting Polar and Parametric Equations macro in our macro library has been modified to correctly plot polar
equations whose sample values contain negative values of the radial coordinate. The macro dialog box has also been
modified to include options for both radians and degrees for the angular units, which assumed only radians before.

The Pearson Product Moment and Spearman Rank correlation tests have been modified to add bivariate normality
testing for each pair of the selected columns that are tested and measured for correlation. Also, a new table display
format for the report results has been added as an option together with our previous matrix display format. The table
format is especially useful when more than 7 columns are selected in the worksheet for the correlation tests.

The Polynomial Regression feature was also modified to add more options for criteria that are used to select the best
model for your data. More explanations were also added to the report to interpret the criteria and to show you how to
use and complete a polynomial regression analysis.

Options have been added to the Histogram Wizard to include scaling options for histogram counts and options for
left-edge or right-edge binning. The algorithm for automatic binning has been improved.

A Histogram Options dialog box has been added for histogram result graphs that are available for ANOVA and
regression testing. The options include a number of bins that you define, automatic binning, bin count normalization,
and bin type for choosing which edge of the bin to include when partitioning the data. The x-axis scaling has been
changed in terms of the data (usually residuals) being binned rather than just representing the bin number as before.
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Access from a statistics report or a result graph to the SigmaStat panel on the ribbon has been improved to make it
easier to continue with further analysis. From a report or graph page, you can now gain access the Test Options dialog
box, the Advisor, and make a new selection from the Test box. The worksheet automatically appears as needed.

We’ve added four transform language functions for matrix operations:

• trp. Generates the transpose of a matrix
• prod. Computes the product of two matrices using the standard definition of matrix multiplication.
• eigen. Computes the eigenvalues and corresponding eigenvectors of a real symmetric matrix.
• linsys. Solves a system of linear equations and multilinear regression problems. In addition to a solution vector, an

optional distance measure and an estimate of numerical rank are given. The optional values indicate whether the
problem has a solution or not, and whether the solution, if it exists, is unique

The random number generator functions in the Transform Language, gaussian and random, have been improved when
selecting a random seed to use when the user specifies 0/0 for the seed argument. The advantage is to make larger
variations in the seed value so that the random number sequence varies more often and, in particular, won’t repeat
values when you restart the program.

Two new user-defined transforms have also been added to the samples file, Multilinear Orthogonal Regression and
Regression with Linear Equality Constraints. Besides providing solutions to specific problems, the new transforms
also illustrate the use of the new transform functions trp, prod, eigen, and linsys.

The transform samples file has been modified to change its structure by reorganizing the transform sections into
subsections under twelve different sections (categories) which are titled by the general application or the field of study
that the transforms under it apply to. These categories are not rigidly defined but are meant to serve as a guide for
locating transforms.

Passing-Bablok Regression has been added to the Transform Library (xfms.jnb). The transform performs Passing-
Bablok regression for method comparison which is a non-parametric procedure for fitting a straight line to two-
dimensional data where both variables, X and Y, are measured with error.

You can generate an optional report can when using the Smoothers 2D and Smoothers 3D features to save the settings
used to create a smoother’s plot for future reference.

The Chi-Square test for contingency tables has been enhanced to include more options for tables, to improve the
formatting of tables, to add more statistics, and to create a grouped bar chart result graph for the two categorical
variables being tested.





Chapter

2
Creating and Modifying Graphs

Topics:

• Setting Graph Defaults
• SigmaPlot Graph Types
• SigmaPlot Graph Styles
• Arranging Data for Graphs
• Creating Graphs
• Using the Graph Style Gallery
• Modifying Graphs Using Graph

Properties
• Creating and Modifying

Embedded SigmaPlot Graphs
• Changing Symbol Type and

Other Symbol Options
• Changing Line Type and Other

Line Options
• Changing Patterns and Fill

Colors
• Changing Bar and Box Widths

and Spacing
• Adding and Modifying Drop

Lines
• Adding Reference Lines

A graph is a representation of selected worksheet columns on a graph page.
You select the representation, or graph type (for example, 3D scatter plot,
vertical bar chart, and so on), when you create a plot or graph. You can
change it at any time.

Most plot types can graph many worksheet columns, column pairs, or column
triplets. Depending on the plot type, a separate curve or set of bars represents
each column. A graph must have at least one plot, but most graphs can hold
many more plots, each with a different type and style.

This chapter provides an overview of the graph creation process using the
Graph Wizard, including descriptions of the different graph types and styles
available, and common modifications.

Note:

For more information on histograms, plotting equations or regression
lines, see Transforms, Regressions, and Graph Analysis.
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Setting Graph Defaults

Changing graph defaults only affects the new graphs that you create.

1. To change existing graphs:
a) Select the graph.
b) Change its properties using the Graph Wizard, Graph Properties, or other dialog boxes and ribbon items.

The graph default options are intentionally limited and simple. If you want to use more complex graph
defaults, use templates or the Graph Style Gallery to create complex graphs that can be applied to data as a
template, bypassing graph creation entirely.

2. To change graph defaults:
a)

Click the Main Button  and then click the Options button.

b) On the Options dialog box, click the Graph tab.
c) Change the graph defaults options as desired.

SigmaPlot Graph Types
There are more than a dozen graph types available in SigmaPlot. Choose a graph type on the Create Graph tab.

Scatter Plot Plots data as XY points using symbols.

Line Plot Plots data as XY points connected with lines.

Line and Scatter Plot Plots data as XY points using symbols connected with lines.

Area Plot Plots data as XY points with regions below or between curves filled with
a color or pattern.

Polar Plot Plots data using angles and distance from center.

Radar Plot Plots multiple variables using distance from the origin.

Ternary Plot Plots data on a coordinate system based on three different components
which always add up to 100%.

Vertical Bar Chart Plots data as Y points with vertical bars.
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Horizontal Bar Chart Plots data as X points with horizontal bars.

Box Plot Plots data as the median and percentiles.

Pie Chart Plots data as a percent of the total.

Contour Plot Plots data as XYZ values in 2D space. Format data columns as: many Z;
single XY, many Z; or XYZ triplet.

3D Scatter Plot Plots data as XYZ data points in 3D space. Format data columns as:
many Z; single XY, many Z; or XYZ triplet.

3D Line Plot Plots data as XYZ data points connected with lines. Format data columns
as: many Z; single XY, many Z; or XYZ triplet.

3D Mesh Plot Plots data as a 3D surface. Format data columns as: many Z; single XY,
many Z; or XYZ triplet.

3D Bar Chart Plots data as Z values on an XY grid. Format data columns as: many Z;
or single XY, many Z.

Vector Plot Plots an XY column pair for the vector start point and an XY column pair
for the vector end point. Format data columns as: XYXY; or XYAM.

Forest Plot Plots data as a column for the name of the study, then the values,
confidence levels, weights, and overall result data.

Statistical Graphs This graph
type is only
available on
the Create
Graph -
Type panel
of the Graph
Wizard.

Creates statistical graphs directly from worksheet data without having to
run a statistical test.

SigmaPlot Graph Styles
Many graph types have several styles to choose from. When you select a graph type from the Create Graph tab, you
are prompted to choose a graph style.

Scatter Plots

Simple Scatter Plots a single set of XY pairs. Format data columns as:

• XY Pair
• Single X
• Single Y
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Multiple Scatter Plots multiple sets of XY pairs. Format data columns as:

• XY Pairs
• Single Y, Many X
• Single X, Many Y
• Many X
• Many Y
• XY Category
• X Category
• Y Category

Simple Regression Plots a single set of XY pairs with a regression line. Format data
columns as:

• XY Pair
• Single X
• Single Y

Multiple Regressions Plots multiple sets of XY pairs with regression lines. Format data
columns as:

• XY Pairs
• Single Y, Many X
• Single X, Many Y
• Many X
• Many Y
• XY Category
• X Category
• Y Category
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Simple Error Bars Plots a single set of XY pairs with error bars. If using worksheet
columns or asymmetric error bar columns, format data columns as:

• XY Pair; or Single Y

If using columns means, the first column entry, or the last column entry
as symbol values, format data columns as:

• Single X, Many Y
• Many Y

If using Row Means, Row Median, First Row Entry, or Last Row Entry
as symbol values, format data columns as:

• Single X, Single Y Replicate
• Y Replicate

Multiple Error Bars Plots multiple sets of XY pairs with error bars. If using worksheet
columns, asymmetric error bar columns, columns means, the first
column entry, or the last column entry as symbol values, format data
columns as:

• X Many Y
• Many Y

If using row means, row median, first row entry, or last row entry as
symbol values, format data columns as:

• Single X, Many Y Replicates
• Many Y Replicates
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Simple Error Bars &
Regression

Plots a single set of XY pairs with error bars and a regression line. If
using worksheet columns or asymmetric error bar columns, format data
columns as:

• XY Pair
• Single Y

If using columns means, the first column entry, or the last column entry
as symbol values, format data columns as:

• Single X Many Y
• Many Y

If using Row Means, Row Median, First Row Entry, or Last Row Entry
as symbol values, format data columns as:

• Single X, Single Y replicate
• Y replicate

If using By Category, Mean, or By Category, Median, format data
columns as:

• Category, Many Y

Multiple Error Bars
& Regressions

Plots multiple sets of XY pairs with error bars and regression lines.
If using worksheet columns, asymmetric error bar columns, columns
means, the first column entry, or the last column entry as symbol values,
format data columns as:

• Single X Many Y
• Many Y

If using Row Means, Row Median, first Row Entry, or last Row Entry as
symbol values, format data columns as:

• Single X, Many Y Replicates
• Many Y Replicates

If using By Category, Mean, or By Category, Median, format data
columns as:

• Category, Many Y
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Simple Horizontal
Error Bars

Plots XY pairs with horizontal error bars. If using worksheet columns
or asymmetric error bar columns as the as symbol values, format as:

• XY pairs
• Single X, Single Y, Many X
• Many X

If using column means, column median, the first column entry, or the last
column entry as symbol values, format data as:

• Single Y, Many X
• Many X

If using Row Means, Row Median, the First Row Entry, or the Last Row
Entry as symbol values, format data columns as:

• Single X Replicates
• Single Y, single X Replicates
• Many X Replicates
• Single Y, Many X Replicates

If using By Category, Mean, or By Category, Median, format data
columns as:

• Category, Many Y
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Bi-directional Error
Bars

Plots XY pairs with both horizontal and vertical error bars. Format
data columns as XY pairs. If using worksheet columns or asymmetric
error bar columns as the as symbol values, format as:

• XY pairs
• Single X
• Single Y, Many X
• Many X

If using column means, column median, the first column entry, or the last
column entry as symbol values, format data as:

• Single Y, Many X
• Many X

Vertical Asymmetric
Error Bars

Plots one X column and at least one Y column. Format data columns
as:

• X Many Y
• Many Y
• XY Pairs

Horizontal
Asymmetric Error
Bars

Plots one Y column and at least one X column. Format data columns
as:

• Y Many X
• Many X
• YX Pairs

Vertical Point Plot Plots columns of data as Y values. Format data columns as:

• Many Y
• Single X, Many Y
• Many Y Replicates
• Single X, Many Y Replicates
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Horizontal Point Plot Plots columns of data as X values. Format data columns as: Many X

• Single Y, Many X
• Many X Replicates
• Single Y, Many X Replicates

Vertical Dot Plot Plots a column of data as Y values. Format data columns as:

• Many Y
• Single X Many Y
• XY pairs
• X Category

Horizontal Dot Plot Plots a column of data as X values. Format data columns as:

• Many X
• Single Y, Many X
• YX pairs

Line Plots

Simple Straight Line Plots a single set of XY pairs connecting the data points with
straight lines. Format data columns as:

• XY Pairs
• Single X
• Single Y

Multiple Straight Lines Plots multiple sets of XY pairs connecting the data points with
straight lines. Format data columns as:

• XY Pairs
• Many X
• Many Y
• Single X, Many Y
• Many X
• Single Y
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Simple Spline Curve Plots a single set of XY pairs connecting the data points with a
spline curve. Format data columns as:

• XY Pairs
• Single X
• Single Y

Multiple Spline Curves Plots multiple sets of XY pairs connecting the data points with
spline curves. Format data columns as:

• XY Pairs
• Many X
• Many Y
• Single X, Many Y
• Single Y, Many X

Simple Vertical Step Plot Plots a single set of XY pairs connecting the data points with
vertical and horizontal lines, starting with vertical. Format data
columns as:

• XY Pairs
• Single X
• Single Y

Multiple Vertical Step
Plot

Plots multiple sets of XY pairs connecting the data points with
vertical and horizontal lines, starting with vertical. Format data
columns as:

• XY Pairs
• Many X
• Many Y
• Single X, Many Y
• Single Y, Many X
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Simple Horizontal Step
Plot

Plots a single set of XY pairs connecting the data points with
vertical and horizontal lines, starting with horizontal. Format data
columns as:

• XY Pairs
• Single X
• Single Y

Multiple Horizontal Step
Plot

Plots multiple sets of XY pairs connecting the data points with
vertical and horizontal lines, starting with horizontal. Format data
columns as:

• XY Pairs
• Many X
• Many Y
• Single X, Many Y
• Single Y, Many X

Line and Scatter Plots

Simple Straight Line Plots a single set of XY pairs connecting symbols with straight lines.
Format data columns as:

• XY Pairs
• Single X
• Single Y
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Multiple Straight
Lines

Plots multiple sets of XY pairs connecting symbols with straight
lines. Format data columns as:

• XY Pairs
• Many X
• Many Y
• Single X, Many Y
• Single Y, Many X

Simple Spline Curve Plots a single set of XY pairs connecting symbols with a spline curve.
Format data columns as:

• XY Pairs
• Single X
• Single Y

Multiple Spline
Curves

Plots multiple sets of XY pairs connecting symbols with spline
curves. Format data columns as:

• XY Pairs
• Many X
• Many Y
• Single X, Many Y
• Single Y, Many X
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Simple Error Bars Plots a single set of XY pairs as symbols with error bars connected
with straight lines. If using worksheet columns or asymmetric error bar
columns, format data columns as:

• XY Pair
• Single Y

If using columns means, the first column entry, or the last column entry
as symbol values, format data columns as:

• X Many Y
• Many Y

If using row means, row median, first row entry, or last row entry as
symbol values, format data columns as:

• X, Y Replicate
• Y Replicate

Multiple Error Bars Plots multiple sets of XY pairs as symbols with error bars connected
with straight lines. If using worksheet columns, asymmetric error bar
columns, columns means, the first column entry, or the last column entry
as symbol values, format data columns as:

• X Many Y
• Many Y

If using row means, row median, first row entry, or last row entry as
symbol values, format data columns as:

• X, Many Y Replicates
• Many Y Replicates

Simple Vertical Step
Plot

Plots a single set of XY pairs connecting symbols with vertical and
horizontal lines, starting with vertical. Format data columns as:

• XY Pairs
• Single X
• Single Y
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Multiple Vertical
Step Plot

Plots a multiple sets of XY pairs connecting symbols with vertical
and horizontal lines, starting with vertical. Format data columns as:

• XY Pairs
• Many X
• Many Y
• Single Y, Many X
• Single X, Many Y

Simple Horizontal
Step Plot

Plots a single set of XY pairs connecting symbols with vertical and
horizontal lines, starting with horizontal. Format data columns as:

• XY Pairs
• Single X
• Single Y

Multiple Horizontal
Step Plot

Plots a multiple sets of XY pairs connecting symbols with vertical
and horizontal lines, starting with horizontal. Format data columns as:

• XY Pairs
• Many X
• Many Y
• Single Y, Many X
• Single X, Many Y

Area Plots

Simple Area Plots single set of XY pairs as a line plot with a downward fills. Format
data columns as:

• XY Pairs
• Single X
• Single Y
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Multiple Area Plots multiple sets of XY pairs as line plots with downward fills. Format
data columns as:

• XY Pairs
• Many Y
• Single X, Many Y
• Many X
• Single Y, Many X

Vertical Area Plots single set of YX pairs as a line plot with a left direction fill. Format
data columns as:

• Single X
• YX Pair

Multiple Vertical
Area

Plots multiple sets of YX pairs as line plots with left direction fills.
Format data columns as:

• Many X
• Single Y, Many X

Complex Area
Plot

Plots multiple line plots with downward fills and intersections. Format
data columns as:

• XY Pairs
• X Many Y
• Y Many X
• Many X
• Many Y
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Polar Plots

Scatter Plots angle and distance data as symbols. Format data columns as:

• Theta, R Pairs
• XY Pairs
• Many Theta
• Many R
• Single Theta, Many R
• R, Many Theta

Lines Plots angle and distance data points connected with lines. Format data
columns as:

• Theta, R Pairs
• XY Pairs
• Many Theta
• Many R
• Single Theta, Many R
• R, Many Theta

Scatter & Lines Plots angle and distance data as symbols connected with lines. Format
data columns as:

• Theta, R Pairs
• XY Pairs
• Many Theta
• Many R
• Single Theta, Many R
• R, Many Theta
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Radar Plots

Radar Scatter Plot data as distance from the origin using symbols. Format
data columns as:

• Label Many Series
• Many Series

Radar Line Plot data as distance from the origin connected with
straight lines. Format data columns as:

• Label Many Series
• Many Series

Radar Line and Scatter Plot data as distance from the origin using symbols
connected with straight lines. Format data columns as:

• Label Many Series
• Many Series

Radar Vector Arrow Lines Plot data as arrows emanating from the origin. Format data
columns as:

• Label Many Series
• Many Series

Radar Line and Error Band Plot data as a line with an encompassing area band from
line and error value columns. Format data columns as:

• Label Many Series
• Many Series

Radar Area Plot data as distance using connecting lines and area fill
from line to origin. Format data columns as:

• Label Many Series
• Many Series

Ternary Plots

Scatter Plots ternary triplet data as symbols. Format data columns as:

• Ternary Triplets
• Ternary XY Pairs
• Ternary YZ Pairs
• Ternary XZ Pairs
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Lines Plots ternary triplet data as data points connected with lines. Format
data columns as:

• Ternary Triplets
• Ternary XY Pairs
• Ternary YZ Pairs
• Ternary XZ Pairs

Scatter & Lines Plots ternary triplet data as symbols connected with lines. Format data
columns as: X,Y, and Z values; or data.

• Ternary Triplets
• Ternary XY Pairs
• Ternary YZ Pairs
• Ternary XZ Pairs

Vertical Bar Charts

Simple Bar Plots a single column of data as Y values. Format data columns as:

• XY Pair
• Single Y

Grouped Bar Plots multiple columns of data in a series of bars. Format data columns
as:

• Single X, Many Y
• Many Y
• Many Y Replicates
• Single X, Many Y Replicates
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Simple Error Bars Plots data as Y values with error bars. If using worksheet columns or
asymmetric error bar columns as the symbol value source, format data
columns as:

• Single Y
• XY Pair

If using columns means, the first column entry, or the last column entry as
symbol values, format data columns as:

• Single X Many Y
• Many Y

If using row means, row median, the first row entry, or the last row entry,
format data columns as:

• Single Y Replicate
• X, Y Replicate

Grouped Error
Bars

Plots data as multiple sets of Y values in a series of bars with error
bars. If using worksheet columns or asymmetric error bar columns as the
symbol value source, format data columns as:

• Many Y
• Single X, Many Y

If using row means, row median, the first row entry, or the last row entry,
format data columns as:

• Many Y Replicates
• Single X
• Many Y Replicates

Error bar values are from the worksheet.
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Stacked Bars Plots multiple columns of data as a series of stacks in bars. Format data
columns as:

• Single X, Many Y
• Many Y
• Many Y Replicates
• Single X, Many Y Replicates

Horizontal Bar Charts

Simple Bar Plots a single column of data as X values. Format data columns as:

• XY Pairs
• Single X

Grouped Bar Plots multiple columns of data in a series of bars. Format data columns
as:

• Single Y, Many X
• Many X, Many X Replicates
• Single Y, Many X Replicates
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Simple Error
Bars

Plots data as X values with error bars. If using worksheet columns or
asymmetric error bar columns as the symbol value source, format data
columns as:

• Single X
• YX pair

If using columns means, the first column entry, or the last column entry as
symbol values, format data columns as:

• Many X;
• Single Y, Many X

If using row means, row median, the first row entry, or the last row entry,
format data columns as:

• Many X Replicates
• Single Y, Many X Replicates

Error bar values are from the worksheet.

Grouped Error
Bars

Plots data as multiple sets of X values in a series of bars with error
bars. If using worksheet columns or asymmetric error bar columns as the
symbol value source, format data columns as:

• Single Y
• Many X
• Many X

If using row means, row median, the first row entry, or the last row entry,
format data columns as:

• Many X Replicates
• Single Y, Many X Replicates

Error bar values are from the worksheet.
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Stacked Bars Plots multiple columns of data as a series of stacks in bars. Format data
columns as:

• Single Y, Many X
• Many X
• Single Y
• Many X Replicates

Box Plots

Vertical Plots the median, 10th, 25th, 75th, and 90th percentiles as vertical boxes
with error bars. Format data columns as:

• Many Y
• Single X, Many Y

Error bar values are column means.

Horizontal Plots the median, 10th, 25th, 75th, and 90th percentiles as horizontal
boxes with error bars. Format data columns as:

• Many X
• Single Y, Many X

Error bar values are column means.

Contour Plots

Contour Plots data XYZ values in 2D space. Format data columns as:

• XYZ Triplet
• Many Z
• XY, Many Z
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Filled Contour Plots data XYZ values in 2D space filling in the area between
contour levels. Format data columns as:

• XYZ Triplet
• Many Z
• XY, Many Z

3D Line Plots

3D Trajectory Plots data as XYZ data points connected with lines.

3D Waterfall Plots data as XYZ data points, but only displays X or Y gridlines. Format
data as:

• Many Z
• Single XY
• Many Z

Arranging Data for Graphs
For most graph types, unless you are creating a pre-formatted worksheet from the Start Up Screen, the Graph Wizard
prompts you to select a data format. Your selection determines how your worksheet data is associated with points on
the graph. For example, an XY Pair data format means that graph uses two columns; one column corresponds to the
X-axis and the other corresponds to the Y-axis. In the XY, Many Z data format, one column corresponds to the X-axis
data, another column corresponds to the Y-axis, and the remaining columns correspond to Z-axis data.

Arranging Data for 2D Plots

Organize data for 2D graphs by columns. Place data for the X values of a graph in a single column, and place data for
the corresponding Y values in another column.

Arranging Data for a Pie Chart

To organize data for a pie chart, place data in a single worksheet column.
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Figure 8: When creating pie charts, all data is placed into a single column.

Arranging Category Data

Use Category Data formats (indexed data) if your data is organized row wise by categories with corresponding
data, as is often the default data organization for both statistics data tables and databases. Using this format, you can
plot data files from other statistical packages, such as SigmaStat or SYSTAT, without having to divide the data into
groups.

Figure 9: In this worksheet, the data is arranged for an XY Categories data format. The "Animals"
column is what you would select as the "category" column in the Graph Wizard.

The Category Data format is available when creating summary plots. Graph types and styles that can use a category
data format are:

• Scatter Plot. Multiple Scatter; Multiple Regression
• Line Plot. Multiple Straight Lines; Multiple Spline Curves; Multiple Vertical Step Plot; Multiple Horizontal Step

Plot; Multiple Vertical Midpoint Step Plot; Multiple Horizontal Midpoint Step Plot

Arranging Radar Plot Data

To organize data for a radar plot, place the label (if used) in one column, and then each series in a separate column.
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Figure 10: In this worksheet, the data is arranged for the Label Many Series format using three data
sets. The labels appear in Column 1.

Arranging Data for Plots with Error Bars

Arranging Data for Column Averaged Error Bar Plots. Certain graph styles plot data by representing the mean of
an entire column as a single data point. In these cases, place the values you want represented as a single X or Y value
into one column.

Arranging Data for Asymmetric Error Bar Plots. Asymmetric error bar plots use two columns as the error bar
source from which you can independently control the values of error bars. Place the values you want to represent the
error bars to the right of the plotted column.

Arranging Data Using Column Means. Plots the average of an entire worksheet column as a single data point, then
uses the column statistics to compute error bars, as specified by the Error Calculation.

Arranging Data Using the Column Median. Plots the median of an entire worksheet column as a single data point,
then uses the column statistics to compute error bars, as specified by the Error Calculation.

Arranging Data for a Stacked Bar Chart

In a stacked bar chart the bars appear on top of each other. The stack level corresponds to the location of the stack in
the bar. Its stack level value corresponds to the height of the bar at a specific stack value.

X Many Y Data Format.  This consists of one X column and an n number of stack level value (Y) columns. A stack
level value column consists of numbers that correspond to the heights of the bars for the specific stack level. The
following graph has four stacks, each with three stack levels.
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Figure 11: This stacked bar chart has four stacks. Each stack has three levels.

Its corresponding worksheet has three stack level value columns. Each column contains four rows.

The X values are in the first column. The second column, Stack Level 1, contains the bar heights for the first stack
level. This appears as the first bar in each stack, in black. The bar heights for the second and third stacks appear the
third and fourth columns, Stack Level 2 and Stack Level 3. The values in the Y rows are the bar heights for each stack.
In this example, because the values for each row (Stack Level 1 through Stack Level 3) add up to 100, the height of
each stack in the graph will also be 100.

Arranging Data for a Vector Plot

Vector plots always use four columns of data. You can create vector plots using one of two data formats:

• XYXY. This data format uses an XY column pair for the vector start point and an XY column pair for the vector
end point.

• XYAM. This data format uses an XY column pair for the vector start point, and then one data column for the
vector angle, and then another column for the vector magnitude.

Related Topics
Vector Plots on page 242
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Using the Same Column for Multiple Curves (Single X or Y vs. Many Y or X)

SigmaPlot can graph many curves using the same X or Y data column. There is no need to duplicate a column that is
used for more than one curve; for example, enter the X data into only one column, and enter the corresponding Y data
into as many columns as you have curves. Order and length of columns does not matter.

Figure 12: Data for a 2D Graph Arranged and Picked as X Many Y

Using Row Numbers for X or Y Values (Single X; Single Y; Many X; or Many Y)

SigmaPlot can also graph data as only X or Y values, and use the row numbers of the columns as the corresponding Y
or X coordinates. If you want to graph data as only X or Y values, enter the data for each plot into a column, and do
not enter data for corresponding coordinates.

Figure 13: Data for a 2D Graph Arranged and Picked as Many Y Only

Using an XY Pair Format for a Single Curve

If the graph you are creating uses only one set of X and Y values, enter all X data in one column, and all
corresponding Y data in another column. Depending on the setting, these columns do not need to be adjacent or the
same length (missing values are ignored).
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Figure 14: Data for a 2D Graph Arranged and Picked as XY

Using an XY Pair Format for Multiple Curves

If the graph style you are creating plots more than one curve, place as many additional X and Y values in worksheet
columns as you want to plot. Enter X and Y data in the worksheet in consecutive columns, or in any order you want.

Figure 15: Data for a 2D Graph Arranged and Picked as XY Pairs

Arranging Data for Polar Plots

Data for polar plots can be entered in either one of two ways:

• R, Ɵ values
• X,Y coordinates

Data for Radial and Angular Values (R, Theta)

To arrange data using Ɵ (angular) and R (radial) values, enter all Ɵ values in one column, and enter the corresponding
R values in another column. Data is plotted as Ɵ versus R, which is similar to X,Y plots in organization, but differs
from X,Y plots in that R is usually the dependent variable.
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Using X,Y Values for Polar Plots

Polar plot X,Y data is arranged the same as 2D plot X,Y data, with all X values in one column, and all Y values in
another column; however, polar plots are plotted as R,Ɵ pairs defined as:

and

where R is the radius, and Ɵ is the angle of the data point from the origin.

Data for Multiple Curves

Since SigmaPlot can graph more than one curve per plot, place as many additional Ɵ, R values, or X,Y coordinates,
as you want to plot in worksheet columns.

Using Data from One Column for Multiple Curves

SigmaPlot can also graph many curves using the same column as the Ɵ or R data (or, X or Y data). There is no need
to duplicate a column that is used for more than one plot; for example, enter the Ɵ data into only one column, and
enter the corresponding R or dependent data into as many columns as needed.

Arranging Data for a Ternary Graph

Data for ternary plots can be XYZ data in three separate columns or SigmaPlot can extrapolate a third column from
data pairs in two columns. Ternary graphs must have at least one single or multiple curve plot, but can hold many
more plots, each with a different style and data format. If your raw values do not add up to 100% or 1, SigmaPlot
can convert them to normalized ternary data. If you have XY, YZ, or YZ pair data, SigmaPlot can compute the third-
column values shown in the resulting graph.

Data for a Single Curve Plot (Ternary Triplets)

If you are creating a graph with a single curve plot using only one set of XYZ values whose sum is 100% or 1, enter
all X data in one column, all Y data in another column, and the corresponding Z data in another column. The columns
do not have to be adjacent to one another, but they must be the same length. Ternary triplet data should always add up
to 100% or 1. For more information, see #unique_177.

Data for a Multiple Curve Plot (Ternary Triplets)

If you are creating a graph with a multiple-curve plot using multiple sets of XYZ values where the sum of each set
is 100% or 1, enter into worksheet columns as many additional ternary triplet data sets as you want to plot. Each
set of ternary triplet data is a separate plot-curve. All ternary triplet data sets should add up to 100% or 1. For more
information, see #unique_177.

Figure 16: Multiple Columns of Triplet Percentage Data for a Ternary Plot

Data for a Single or Multiple-Curve Plot (Ternary XY, YZ, or XZ Pairs)

If you are creating a graph with a single or multiple curve plot using XY, YZ, or XZ pairs, enter all X, Y, or Z data
in one column, and the corresponding X, Y, or Z pair values in another column. As long as all data pairs use a
percentage or unitary scale, SigmaPlot will compute the third-column data shown in the resulting graph.

SigmaPlot computes third column data for plotting only. Computed third-column data is not displayed in the
worksheet.
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Arranging Data for Bubble Plots

Data for bubble plots can either be X, Y data in two separate columns or single X or single Y data in one column. In
both cases, an additional column is needed to indicate bubble size values. Since the bubble size column corresponds
to symbol diameter, you must convert the data for your third variable to diameters.

Bubble plots must have at least one plot, but can hold many more plots using different data formats if appropriate.
The bubble plot type has available only the default scatter style. You can change the symbol type. However, if you use
something other than a circle you will need a different equation to transform area to diameter.

Figure 17: Example of a Bubble Plot

Using X, Y Values for Bubble Plots

Bubble plot X, Y data is arranged in the same way as other 2D plot X, Y data, with all X values in one column and all
Y values in another.

Related Topics
Bubble Plots on page 241

Data for Bubble Size

SigmaPlot can graph bubble plots using XY pair, Single Y, Single X, and bubble size data. Bubble size values must be
entered in a separate column. Each value corresponds to the diameter of the symbol, in whatever page units are being
used. If you want bubble size to correspond to area data, you must convert your area data to diameters before creating
the bubble plot.

Converting Area Data to Diameters

If you want your bubble plot to display area data, you must run this transform where area is the source column
number and the diameter is the results column number. This transform is derived from the formula for the area of a
circle.

To convert your area data into diameters:

1. Click the Analysis tab, and then in the Transformgroup, click User-Defined.
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2. In the User-Defined Transform dialog box, type the transform function as follows:

pi=3.14159265359 col(diameter)=sqrt(col(area)*factor/pi)

where diameter is the column number for your diameter data, area is the column number for your original data
to be represented by area, and factor is some number to increase or decrease the magnitude of your data to a
reasonable range.

Tip:  Reduce the diameters of your symbols to a reasonable size before plotting them.

Figure 18: Transforming Area Data to Diameters
3. Click Run.

Your new data appears in the worksheet. If you change the symbol shape, you must use a different equation to
transform area data.

Arranging Data for 3D Graphs

Organize data for SigmaPlot graphs by column. Typically, data for contour plots and 3D graphs is composed of X, Y,
and Z value columns, or one or more Z columns and optional X and Y columns. 3D bar charts, scatter plots, and line
plots can use any three columns as XYZ data.

Important:  If multiple Z columns are plotted, they all must be next to each other. The X and Y columns can
be located anywhere.

Data for 3D Bar Charts, 3D Scatter Plots, and 3D Line Plots

Arrange data for 3D bar charts, scatter plots, and line plots either as XYZ triplet data, multiple columns of Z data, or
as a single column for Y values, a single column for X values, and multiple columns for Z values. For each of these
graph types, the data in each row is graphed as a data point.  For bar charts, each column of Z data is plotted as a row
parallel to either the X axis, with Y values as the constants.

If you are formatting XYZ triplet data, you also can use one of the multiple Z column formats designed for 3D mesh
plots.

Data for Contour and Mesh Plots

A regular rectangular mesh plot requires XYZ coordinates for each intersection of a rectangular mesh. The data for
a contour or mesh plot can be in the form of either a regular rectangular mesh or an irregular mesh. If the data is a
regular rectangular mesh it is graphed as-is without any modification. If it is an irregular mesh then it is interpolated
to form a regular rectangular mesh and then graphed.

Y1 Y2 Y3 Y4
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X1 Z1 Z4 Z7 Z10

X2 Z2 Z5 Z8 Z11

X3 Z3 Z6 Z9 Z12

The arrangement of this data for the three possible methods of picking columns to plot are described in the following
sections.

X, Y, and Z Data in Three Columns. To plot three columns as the X, Y, and Z values of a contour or mesh plot, the
data must be in long form mesh format. This format assigns the proper Z value to each X and Y point in the mesh, in
the required order.

For example, for the table of X, Y, and Z values shown above, the three column mesh format must be arranged in the
worksheet as:

X data Y data Z data

X1 Y1 Z1

X2 Y1 Z2

X3 Y1 Z3

X1 Y2 Z4

X2 Y2 Z5

X3 Y2 Z6

X1 Y3 Z7

X2 Y3 Z8

X3 Y3 Z9

X1 Y4 Z10

X2 Y4 Z11

X3 Y4 Z12

This arrangement places the XYZ data point coordinate values in the required order. The XYZ columns must be the
same length.

Figure 19: Data Arranged in Long Form Mesh Format

X and Y Columns vs. Many Z Columns. You can also place the X and Y data in single columns, then place the
corresponding Z data in many continuous columns. This method may work best if you have XYZ data displayed in a
table, or if you have irregularly incremented X or Y values.
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To use this option, you should have as many Z columns as you have Y rows, and the Z columns should be the same
length as the X column.

X data Y data Z data

X1 Y1 Z1 Z4 Z7 Z10

X2 Y2 Z2 Z5 Z8 Z11

X3 Y3 Z3 Z6 Z9 Z12

Y4

The data in the first Z column is assigned to the first Y value, the data in the second Z column to the second Y value,
etc.

The data in each row of the X column is assigned as the X value for the data in the same row in the Z columns.

Figure 20: XYZ Data Arranged as One X Column, One Y Column, and Many Z Columns

You can use columns of uneven length. Extra X, Y, or Z values created by uneven columns are not plotted, as mesh
plots cannot graph missing values.

Z Data vs. Row and Column Numbers: You can also plot columns as Z values versus the cell columns and row
numbers as the X and Y values.

This is the appropriate column assignment option to use: for mesh plots and 3D Bar Charts where X and Y values are
evenly and equally spaced; for example, when graphing pixel intensity data for an image.

All data is assigned as a Z value, and the Z columns must be contiguous. To use this format for a mesh plot, no special
data arrangement is required other than equal column length. The rows and columns of the cells can be used as either
the X or Y values.

Creating Graphs

Once your data is entered into a SigmaPlot worksheet, creating is quick and easy.
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Click the Create Graph tab, and then click any one of the available graph types and styles in the 2D Graphs and 3D
Graphs groups.

The Graph Wizard appears and walks you step-by-step the rest of the way to creating your graph.

Tip:  You can either select the worksheet columns to plot before creating your graph by dragging the pointer
over your data, or you can select data columns later in the Graph Wizard. You can also select data ranges.
For more information, see Entering Data Ranges into the Graph Wizard  on page 63.

You can also create graphs using existing in-house styles that are available both in the easy-to-find Graph Style
Gallery and in SigmaPlot templates. For more information, see Using Templates on page 118.

Creating a Graph from the Quick Start Screen

When you first start SigmaPlot, the Quick Start screen appears with the Welcome to SigmaPlot tab in view. From
here, you can create a new notebook or open an existing file.

Creating Pre-Formatted Worksheets. You can also create pre-formatted worksheets. These are empty worksheets
that contain predefined sections that represent the data formats used for creating SigmaPlot graphs. To do this, click
Create graph. From here, you have most of the control of creating graphs that you have in the standard SigmaPlot
Graph Wizard, but in one dialog box.

Figure 21: The SigmaPlot Quick Start Screen

1. Select a graph type. On the top of the dialog box, you see a row of Graph Style icons. Click one. Its available
graph styles appear on the Graph Style menu on the left hand side of the Start Up screen.
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2. Create another pre-formatted worksheet. Click the Main Button and then click Quick Start.

Creating Graphs Using the Graph Wizard

While it's often times most easy to create a graph using any of the graph styles and types on the Create Graph tab, you
can also create a graph directly from the Graph Wizard.

To create a graph using the Graph Wizard:

1. On the Create Graph tab, in the Wizard group, click Graph Wizard.

2. In the Graph Wizard, under Graph Types, select the type of graph you want to make.

Figure 22: Graph Wizard Graph Types
3. Click Next.
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4. Under Graph Styles, select the desired graph style.

Figure 23: Graph Wizard - Style
5. Click Next. If the graph style you have chosen uses error bars, you are prompted to choose an error bar source

and a value to use for the error bars. For more information, see Creating 2D Scatter Plots with Error Bars on page
216.

6. Click Next.
7. Under Data format, select how your data is formatted, and click Next.

Figure 24: Specifying the Data Format
8. From the Data for drop down list, select the worksheet columns that correspond to the axis or error bar of your

plot.
You can also drag a range of data on the worksheet using the mouse.

Tip:  If you create a graph using Microsoft Excel, you'll have to manually enter the ranges. Or you can
select a range of data by entering the range manually into the Data for box. After entering the range, press
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Enter. The range appears in the Graph Wizard. For more information, see Entering Data Ranges into the
Graph Wizard  on page 63.

If you make a mistake while selecting data, double-click the mistaken column in the Selected Columns list to
clear the selection.

Figure 25: Selecting Columns to Plot
9. Click Finish to create the plot.

Entering Data Ranges into the Graph Wizard

The simplest way to select a region of data is to drag the columns or range using the mouse. You can, however,
manually enter the ranges into the Graph Wizard. This is necessary when creating graphs using Microsoft Excel
where it is not possible to use the mouse to select a range of data.

The Graph Wizard supports the following formats when specifying a region in the worksheet:

rc Notation

Specify a cell using the letter r to denote the row, and the letter c to denote the column. For example, to specify the
cell in the third row and twelfth column, you would enter r3c12.

To specify a rectangular region, follow the upper left cell of the region by the lower right cell, separated by two
periods. For example, if the upper left cell of the region is r2c1 (second row, first column), and the lower right cell of
the region is r4c4 (fourth row, fourth column), you would enter r2c1..r4c4 into the Graph Wizard.

You can also specify the column first. For example, both c2r2...c4r5 and r2c2...r5c4 denote the same region in the
worksheet.

Figure 26: Selecting a Range of Data Using the rc Format
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Excel Notation

You can also use Excel notation in the Graph Wizard. In Excel notation, the columns are alphabetized in lexicographic
order and the rows are numbered. In this case, to specify a rectangular region you would again specify the upper left
and lower right cells. For example, both A3:D9 and $A3:$D9 specify a region with the upper left cell in the first
column, third row and the lower right cell as the fourth column, ninth row. Note that the separator is a colon. The
letters are case insensitive.

Figure 27: Selecting a Range of Data Using the Excel Format

Column Numbers Notation

You can make a selection of a consecutive group of entire columns by specifying the range of column indices. For
example, to specify columns 1 through nine, type 1:9 or 1..9.

Figure 28: Selecting a Range of Data Using the Column Numbers Format

Using the Graph Style Gallery

Use the Graph Style Gallery to create a custom graph from a predefined graph style. You can create this style
yourself, or use one of the many existing templates. When creating a custom graph style, you save all graph, plot, and
axes attributes, including graph size and position. Then you can quickly use these attributes to create future graphs.
All you supply is the data, and the Graph Style Gallery formats the rest.

To open the Graph Style Gallery:

On the Home tab, in the Navigate group, click Gallery and Templates.
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Each graph style appears as a thumbnail preview in the Graph Style Gallery. You can create new graphs by choosing
one of the styles from the window. You can either double-click a graph or click Create Graph to create a graph. The
graph then appears in a location defined by the graph style.
This section discusses:

• Adding styles to the Graph Style Gallery.
• Applying graph styles to pages.
• Editing graphs in the Graph Style Gallery.
• Creating Graph Style Gallery graphs from the Graph Wizard.

Applying Graph Styles to Pages

Use the Graph Style Gallery to quickly apply your own custom graph styles to data.

To apply a graph style:

1. View the Graph Style Gallery.
2. Double-click the graph style you want to use.

The Graph Wizard - Create Graph panel appears.
3. In the Graph Wizard, select the worksheet columns you want to use for the plot.
4. Click Finish to create the plot.

Editing Graphs in the Graph Style Gallery

1. Select the graph to edit in the Graph Style Gallery.
2. Right-click, and from the shortcut menu click Edit.

The graph appears in a graph page.
3. Modify the graph using Graph Properties. For more information, see Modifying Graphs Using Graph Properties

on page 68.
4. Close the graph page.

The new style is saved in the Graph Style Gallery.

Adding Styles to the Graph Style Gallery

After creating and formatting a graph, you can save its style in the Graph Style Gallery, and later apply that style to
future SigmaPlot graphs.
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1. To add a graph style or object to the Graph Style Gallery:
a) Open the graph that you wish to add to the Graph Style Gallery.
b) Select the graph.
c) On the Create Graph tab, in the Graph Gallery group, click Add to Gallery.

d) Right-click and on the shortcut menu click Add Graph. The graph style appears in the Gallery.
e) You can also drag and drop it into the Graph Style Gallery window.

A thumbnail of the graph appears in the Graph Style Gallery. The graph title appears as the graph style's name.
2. To use the right-click shortcut menu:

a) Select the graph on the page, and then click inside the Graph Style Gallery.
b) Right-click and on the shortcut menu click Add Graph.

The graph style appears in the Gallery.

Creating Graph Style Gallery Graphs from the Graph Wizard

You can use the Graph Wizard in conjunction with the Graph Style Gallery to create graphs by selecting Graph
Gallery as a graph type in the Graph Wizard.

To create a Graph Style Gallery graph from the Graph Wizard:

1. On the Create Graph tab, in the Wizard group, click Graph Wizard.

2. Click Finish to create the graph. A graph appears on the page using the applied Gallery graph style.
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3. In the Graph Wizard, under Graph Types, select Graph Gallery, and click Next.

The Create Graph - Gallery panel of the Graph Wizard appears. All graphs that appear in the Gallery graphs
list are also in the Graph Styles Gallery.

4. Under Gallery graphs, select the graph type that you want to apply to your data, and click Next.
The Create Graph - Select Data panel of the Graph Wizard appears.

5. Under Data for, select the worksheet columns to plot. If you make a mistake while selecting data, select the
correct column in the Selected Columns list.

6. Click Finish to create the graph.
A graph appears on the page using the applied Gallery graph style.
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Modifying Graphs Using Graph Properties
For many graph modifications, all you really need to do is click any object on the graph, and the available options
are immediately visible to you in a pop up window. But for the most part, for any type of graph modification, double-
click the object on the graph (the axis, the line, the symbol, area fill, and so on) and the Graph Properties dialog box
appears with the relevant options already in view.

Figure 29: Use Graph Properties to make any graph modification.

Use Graph Properties to make most graph modifications. The choices you make are reflected immediately in Graph
Properties. To undo a change, just press Ctrl + Z.

Modifying Plots and Axes

All you need to do to modify a plot or axis on any graph page is double-click it (the same for modifying any object on
a graph page). The available options immediately appear in Graph Properties.

Modifying Grids and Planes, Titles, and Legends

To modify grids, double-click the graph to open Graph Properties. In the Property list, select: Graphs > Grids.

To hide or show graph titles and automatic legends, to hide or show plots, and to make modifications to
automatic legends, in the Property list of Graph Properties, select: Graph > Legends.
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Selecting a Graph or a Plot

To select a graph or plot:

1. View the page window.
2. On the Graph Page tab, in the Tools group, click the Select Object button.

3. Place the pointer over the desired graph or plot and click.
A selected graph is surrounded by small handles.

Figure 30: Small handles surround selected graphs.

Picking Different Data for the Current Plot

To change data columns for an existing plot:

1. Click the plot to modify.

Square handles appear over the data points for the clicked curve. Do not click the graph, or you will add a plot to
the graph.
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2. On the Create GraphGraph tab, in the Wizard group, click Graph Wizard.

3. In the Graph Wizard, under Data Format, select a data format, and click Next.

Figure 31: The Graph Wizard displays the available Data Formats for the current plot
4. If you don't change the data format for your graph, your previous column choices appear under Selected

Columns. To change column assignments, under Selected Columns, select the desired assignment, then under
Data For, select the appropriate column from the worksheet or from the data list.

Figure 32: You can change the column assignments using the Graph Wizard.

Tip:  To clear a column assignment by double-click it in the Selected Columns list.

5. If you change the data format for your graph, a single data type is highlighted in the Selected Columns list. To
pick data, either click the corresponding column directly in the worksheet, or choose the appropriate column from
the Data for list. Use this method to pick X, Y, or Z data, R and theta data, and error bar data, if applicable.

6. Click Finish to close the Graph Wizard and view the changed graph.

Changing Graph Type and Style

Change plots using the Graph Wizard; however, once you have defined a plot style and type, the styles and types
available for you to apply to the created plot are limited. If the plot you have selected cannot be changed to the plot
type or style that you want, use the Graph Wizard to create another plot using the desired style and type.
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To change graph type and style:

1. Click the plot to modify. Square handles appear over the data points for the clicked curve. Do not click the graph,
or you will add a plot to the graph.

2. On the Create Graph tab, in the Wizard group, click Graph Wizard.

3. To change plot style, in the Graph Wizard , click Back to view the Graph Styles list. Choose from the list of
available styles then click Next.

Figure 33: You can use Graph Wizard to change the type and style of the graph.
4. To change the plot type, click Back twice to view the Graph Types list. Choose from the list of available graph

types, then click Next.
5. If necessary, pick the data columns to plot again. Otherwise, click Finish to complete you plot type or style

change.

Adding New Plots

Graphs can have multiple plots and plot types. Although most 2D graphs with multiple curves do not require more
than one plot, if you want to mix plot types on a single graph you will need to create multiple plots.

Use multiple plots per graph rather than a single plot with many curves only if different plot types or styles are
required (for example, placing a bar chart and a line plot, or a 3D scatter and mesh plot on a graph), if different data
formats are required (such as XY and Y only for a scatter plot), or if a curve requires a different axis (scale, range,
etc.).

2D graphs with multiple plots can also have multiple axes.
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Figure 34: In this example of a graph with two plots, each plot has separate Y-axes.

Creating Additional Plots

Use the Graph Wizard to add a plot to a selected graph.

To add another plot to a graph:

1. Click the graph to modify. Small square handles surround the graph. Do not click a curve, or you will modify that
curve instead.

2. Right-click the graph, and then click Add New Plot.
The Graph Wizard appears displaying all the graph types. The available styles and types for a new plot are
limited depending on the other plot types and styles in the current graph; for example, you cannot add a Polar plot
to a 2D Cartesian plot, or vice versa.

Note:  If the selected graph cannot accommodate the plot type or style that you want to add, the plot
will be created as a new graph. You can move the graph of the new plot over the original graph so that it
appears to be in the same graph.

3. Select a Graph Type and click Next.
4. Select a Graph Style and click Next.
5. Select a Data Format and click Next.
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6. Pick data either by clicking the corresponding column directly in the worksheet, or choosing the appropriate
column from the data list. Use this method to pick X, Y, or Z data, R and theta data, and error bar data.

Tip:  If you make a mistake while picking data, click the wrong entry in the Graph Wizard, then choose
the correct column from the worksheet. You can also clear a column assignment by double-clicking it in
the Selected Columns list.

7. Repeat the process for every data column. When you have chosen the data appropriate for your style of plot, click
Back to re-pick data columns, or if applicable, click Next to pick data for additional plots.

8. Click Finish.

Hiding, Showing, and Deleting Plots

Occasionally, you may want to remove a plot from a graph without deleting it. You can hide plots from view without
deleting them by using the right-click shortcut menu.

1. To hide a plot:
a) Right-click the plot and then click Hide.

The plot is hidden, but not removed.

Figure 35: You can use the right-click shortcut menu to hide graphs.
2. To show a hidden plot:

a) Double-click the graph to open Graph Properties.
b) Clear a check box to hide a plot from view, or select it to show the plot.

3. To delete a plot:
a) Select the plot.
b) Press Delete.
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Sampling Fewer Data Points

If you have a graph with a large number of data points, you can plot only a portion of the column(s) or sample only
a portion of the data from the column. This is useful if you are interested only in graphing part of the data, or if you
want to increase drawing speed while working on the graph.

To plot only a portion of your data:

1. Double-click the graph.
The Graph Properties dialog box appears.

2. In the Properties list select:Plot > Data
3. To plot only a portion of your data, under Data sampling, select Only rows, and then enter the range to plot.
4. To sample the column rows by a specified increment, select by and type a number. Typing a 2 samples every

other row and reduces the number of rows plotted by 50%, typing a 3 samples every third row, and so on. You can
also use the by list to select a number of rows plotted.

Plotting Missing and Out of Axis Range Data Points

You can choose to either plot or ignore bad points. Bad points are either missing values, or data that lie outside the
axis ranges.

Figure 36: Example of Graphs Plotting Bad Data Points

The graph on the left plots both a missing data point and out-of-range data point. The graph on the right ignores both
missing and out of range points.

To ignore missing and out of-range points:

1. Double-click the graph.
The Graph Properties dialog box appears.

2. In the Properties list select:Plot > Data
3. Select the desired plot from the Plot drop-down list.
4. To plot data without missing values, under Ignore, select Missing values. To plot missing values, clear the

option.
5. To plot data without out of range values, under Ignore, select Out of range values. To plot out of range values,

clear the option.

Creating and Modifying Embedded SigmaPlot Graphs
When you insert a graph into a document as a SigmaPlot object, different options are available than when viewing
graphs inside SigmaPlot.

The following describes the behavior of SigmaPlot features while editing a graph.
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Tip:  You can also open embedded graphs inside SigmaPlot functionality.

Creating Embedded Graphs

You can create embedded graphs in any number of ways, including:

• Copying and pasting into an application that accepts embedded objects, like Word, Excel or PowerPoint.
• Using the Insert tab from an application that accepts embedded objects.
• Running any of the SigmaPlot integration routines (for example, Excel integration).
• Using the Paste to PowerPoint Slide or Insert Graphs into Word Toolbox macros.

Using Embedded Graph Options

To activate SigmaPlot options for an embedded graph, click the SigmaPlot Graph tab, which appears with the
following groups:

• Edit. Paste, Cut, Copy, Clear, Select All, Graph Properties.

• Insert. Insert Graphic File, Word Text, Excel Table, Equation, New Object.

• Format.  Arrange Graphs, Bring to Front, Group, Align, Send to Back, Ungroup, Rulers

• Format.  Arrange Graphs, Bring to Front, Group, Align, Send to Back, Ungroup, Show Rulers, Grid Lines, Anti
Aliasing

• Tools. Select Object, Text, Draw Line, Draw Arrow, Draw Box, Draw Ellipse, Line Type, Line Color, Line
Thickness, Fill Color, Symbol Type, Fill Pattern, Axis Scale.

• Text. Font, Font Size, Bold, Italic, Underline, Superscript, Subscript, Normal, Color, Align Left, Align Center,
Align Right, Rotation, Increase Space, Decrease Space, Line Spacing, Greek Characters, Legend Symbol
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Editing Embedded Graphs

You can choose to edit a SigmaPlot graph from inside the current program, or open the embedded graph inside
SigmaPlot.

Editing "in-place". To edit a graph in place, double-click it. You can also right-click it and select Edit the
SigmaPlot Graph Object. To modify the graph at this point, right-click or double-click the graph to access the
different settings.

Opening graphs. To open an embedded graph inside SigmaPlot, you can right-click the inactive graph, and click
Open the SigmaPlot Graph Object. The graph will open as a graph page and worksheet inside SigmaPlot as an
Embedded Page.

Note:  No notebook window or file is associated with this graph.

Viewing Data for an Embedded Graph

If you need to view or edit the data for an embedded graph, you must open that graph inside SigmaPlot.

Resizing Embedded Graphs

The sizing and scaling of the SigmaPlot graph is controlled by the "container" application, that is, the program for the
document where the graph has been embedded; however, you can change the size of the page for the embedded graph
itself. This is particularly useful if for some reason the graph has been clipped, or you need to rescale and resize the
graph or other page objects.

The embedded graph resides on a graph page that has been clipped to just contain the embedded content.

Creating SigmaPlot Graphs Using Microsoft Excel

You can launch the Graph Wizard and subsequently create a SigmaPlot graph using Microsoft Excel. Just as you
would using SigmaPlot, you can select data from the worksheet. You can also select ranges of data. If you change
your data in Excel, the SigmaPlot graph automatically updates.

To create a graph using Microsoft Excel:

1. View a Microsoft Excel worksheet.
2. On the Add-Ins tab, in the Menu Commands group, click SigmaPlot Graph.

3. Create the graph using the Graph Wizard as you would normally.

Changing Symbol Type and Other Symbol Options
You can specify the symbol type used either for the symbols in a single curve, or for all the curves in a plot. The
default is to use the same symbol for a single curve and increment symbols for multiple curves.
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You can only modify symbols. Plots that normally use symbols are scatter plots, line plots, line/scatter plots, bubble
plots, polar plots, box plots, 3D scatter plots, 3D trajectory plots, and ternary plots.

Bubble plots use circles as the default symbol shape. If you choose a different symbol shape, you must change the
transform function used to translate area to diameter.

You cannot increment Symbols for single curves, unless there is only one curve within a plot.

Changing Symbol Type, Size, and Color

To change symbol attributes:

1. Double-click a symbol on the graph page.
The Graph Properties dialog box appears.

2. In the Properties list, select: Plot > Symbols.

3. To change the symbol type for the selected plot, under Symbols, select a symbol type from the Type drop-down
list, or choose to increment symbols using the one of the symbol schemes.

4. To change the size of the symbol, type a new value in the Size box. By default, all symbols in a plot are the same
size. Use symbols of different sizes by entering symbol sizes in a worksheet column, then selecting the column
from the Sizedrop-down list.



 | Creating and Modifying Graphs | 78

5. To make symbols transparent, move the Transparency slider.

6. To change the fill color of symbols for the selected plot, under Fill color, select a color or an incrementing
scheme from the Color drop-down list.

7. To turn off symbol fills, select (None).
8. Select (Custom) to open the Color dialog box to create or choose a custom color. For more information, see

changing_symbol_type__size__and_color.dita#using_custom_increments.

Tip:  Hollow Symbols are symbols that use (None) as the fill color. They are hollow, that is, they are
composed of the edge lines only. Lines, error bars, and graph background colors all show through unfilled
symbols. This is useful if you have many overlapping data points.

9. To change the edge color of symbols, under Edge, select a color from the Color drop-down list. To turn off
symbol edge color, select (none).

10. To control the color of symbol dots and crosshairs, or of text used as symbols, use the Color drop-down list
under Edge. If a symbol is filled with black and has a black edge, then dots and crosshairs automatically default to
white.

11. To change the thickness of the symbol edge, move the Thickness slider, or type a new value.

Automatically Incrementing Symbols

When incrementing symbols automatically, symbol types are assigned to curves (or points, if the plot has only one
curve) in the same order as the column pairs listed in the Graph Wizard. SigmaPlot increments symbols according to
the selected scheme.

Figure 37: Both graphs use the Doubles symbol scheme and the Black and White color scheme.
The first graph has only one curve; the second has four.

Symbol types and colors appear on the curves of the plot in the same order as the symbol types and colors in the right-
click pop-up menus of the incrementing option.

To automatically increment symbols:

1. Double-click a symbol on the graph page.
The Graph Properties dialog box appears.

2. In the Properties list, select: Plot > Symbols.

changing_symbol_type__size__and_color.dita#using_custom_increments
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3. To increment symbol types and fill and edge colors automatically, under Symbols, from the Type, Fill Color,
and Color lists, select a symbol scheme.

Note:  Increment schemes do not include (None) as a symbol type.

Using Characters and Text as Symbols

You can use numbers, characters, and text as symbols by entering them in a worksheet column and specifying the
column in Graph Properties.

Figure 38: Using Text from a Worksheet Column as Plot Symbols

To specify characters as symbols:
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1. Enter the text you want to use as symbols in a worksheet column in the order you want the curve(s) to use them.
To use numeric values as symbols, add a space after each value in the worksheet. You can assign the numbers that
appear aligned to the left as symbols.

Figure 39: Example of Worksheet with Plot Symbol Text Entered in Column 3

You can use all the non-keyboard characters available for the default font. To view and access these characters,
you can use the Windows Character Map utility. The Windows Help and Support also lists these special characters,
along with the keystrokes required to enter them.

2. View the graph page.
3. Double-click the plot on which you want to use text symbols.

The Graph Properties dialog box appears.
4. In the Properties list, select: Plot > Symbols.
5. Under Symbols, select the column that contains the text or numeric values you want to use as symbols from the

Type drop-down list.

Note:  The column option does not appear in the Type list unless text or symbols are entered in a
worksheet column.

6. Right-click that same Type box, and click Symbol Font.
The Text Properties dialog box appears.

7. Click the Font tab.
8. Select another font from the Font drop-down list.

Tip:  This feature is especially useful if you wish to use Wingdings, Zapf Dingbats, or other iconic
or symbolic fonts as a symbol. The Fill Color and Edge Thickness options do not apply to text and
characters.

Using Different Symbol Sizes

By default, all symbols in a plot are the same size. To use symbols of varying sizes, enter symbol size values in a
worksheet column, then set symbol size using Graph Properties.
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Figure 40: Using Symbol Sizes from a Worksheet Column for Plot Symbols

Symbol sizes are assigned to symbols and curves (or points, if the plot has only one curve) in the same order as the
column pairs that form the curves are listed in Graph Wizard.

To use worksheet values for symbol size:

1. Select the first cell of an empty column in the worksheet containing data for the current plot.
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2. Type the size values to use in the order you want to use them. Since the symbol sizes correspond to symbol
diameters or widths, make sure that the symbol sizes you enter are of a reasonable size, that is, small fractions of
inches or only a few millimeters or points.
If desired, you can also include the measurement unit for the value. For example, for inches type in, for
millimeters type mm, or for points type pt.

Figure 41: Example of Worksheet with Symbol Sizes Entered in Column 3

If you omit the measurement unit, the numeric values in the symbol size column are assigned the measurement
unit specified on the Page tab of the Options dialog box.

To view, click the Main Button , click Options, and then the Page tab.
3. View the graph page and double-click the plot.

The Graph Properties dialog box appears.
4. From the Properties list, select: Plot > Symbols.
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5. If necessary, select the plot that contains the symbols to modify from the Plot drop-down list.
6. Select the worksheet column containing the symbol size values from the Size drop-down list.

Note:  When creating a bubble plot, the Graph Wizard automatically prompts you to pick a column to
specify bubble size. For more information, see Bubble Plots on page 241.

Changing Line Type and Other Line Options
You can change the line type, shape, thickness, and color for all lines in a plot. Because plots can also have multiple
curves, you can also increment the line types and colors for any plot with multiple curves.

Lines can only be modified in or added to plots that normally use lines, such as scatter plots, line plots, line/scatter
plots, polar plots, 3D scatter plots, 3D trajectory plots, and ternary scatter, line, and line/scatter plots.

Changing Plot Line Attributes

To change the attributes of lines in a selected plot:

1. Double-click the line.
The Graph Properties dialog box appears.

2. In the Properties list, select: Plot > Lines.

3. To change the thickness of the line, type the new value in the Thickness box or use the arrow buttons.
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4. To change the color of the lines in the selected plot, under Line color, select a color from the Color drop-down
list, or choose to increment line color using the one of the incrementing schemes.

5. To create transparent lines, move the Transparency slider.
6. To change or add a gap color, under Line color, select a color from the Gap Color drop-down list. This option

is only available if you select a line type with actual "gaps" in it, like dotted or dashed, for example.

Automatically Incrementing Lines

Line types and colors appear on the curves of the plot in the same order as the line types and colors in the right-
click popup menus of the incrementing option. There are two line type incrementing schemes: Incrementing and
Monochrome. There are nine different incrementing color schemes to choose from for line colors.

Note:  You can also use incrementing color schemes for fills and lines. See incrementing schemes for more
information.

Figure 42: Each of these graphs uses the Incrementing option, but are assigned different starting
line types.

To use automatically incrementing line types:

1. Double-click the line.
The Graph Properties dialog box appears.
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2. In the Properties list, select: Plot > Lines.

3. From the Type and Color drop-down lists, choose a line scheme.

Note:  Windows is limited in its ability to supply the true colors for lines by the number of system colors
available. For the best representation of true line colors, set your display to either HiColor (16-bit) or
TrueColor (24-bit).

4. Right-click the incrementing option selected in the Type and Color drop-down lists, and select First Line or First
Color.

5. Choose the line type or color to start the incrementing sequence.
6. Use the Line Thickness, Shape, Line Color, and Layering options to modify the lines, if necessary.

Setting Line Widths from Worksheet Column

You can control the width of lines on a graph using an empty worksheet column.

1. Enter the line width in an empty worksheet column cell.

Note:  Take special care to type “in” for inches after the width.
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2. Double-click the line on the graph to open Graph Properties. If necessary, navigate to Plot > Lines  in the
Properties list.

3. Select the column from the Thickness drop-down list.

Changing Patterns and Fill Colors
You can modify and increment the background colors, patterns, and pattern colors used for plots.

You can only modify or add fill colors and patterns to plots that normally use fills, for example area plots, bar charts,
box plots,  pie charts, 3D bar charts, and ternary plots.

Changing Plot Fill Patterns and Colors

Modern laser printing and color slides have removed much of the need for using hatch marks and other line patterns
for bar and pie charts. Instead, use gray shades and colors whenever possible..
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Figure 43: Example of a Bar Chart with a Gray Scale Fill Color Scheme

To change fill attributes:

1. Double-click the fill.
2. In the Properties list of the Graph Properties dialog box, select: Plot > Fills.
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3. To change the background fill color, under Fill Color, select a color from the Color list, or choose to increment
fill colors using the one of the incrementing schemes to change the background fill color.

4. To turn off background fills, select (None).
5. To create a custom color, select (Custom). For more information, see Using Custom Colors and Incrementing

Schemes on page 162.
6. To change the fill pattern for the selected plot, under Pattern and Edge, select a fill pattern from the Pattern

list, or select to increment fill patterns using one of the fill schemes. To turn off fill patterns, select (None).
7. To change the thickness of the pattern lines and edges, move the Thickness slider.

Using Custom Symbol, Fill, Line, and Color Increments

When using a series of incremented symbols, fills, lines, or colors you have defined, the increment scheme is assigned
to curves or points in the same order the columns plotted for the curves are listed in the Graph Wizard.

Note:  This topic discusses using the Insert Graphic Cells dialog box to create an incremented scheme. To
learn how to use Graph Properties for customized color schemes, see incrementing schemes

Figure 44: A Bar Chart Using Custom Incremented Fills

To define and apply a series of incremented symbols, fills, lines, or colors:

1. View the worksheet.
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2. On the Worksheet tab, in the Cells group, click Graphic Cells.

Figure 45: Using the Insert Graphic Cells Dialog Box to Specify a Custom Line Sequence
3. In the Insert Graphic Cells dialog box, click the Colors, Lines, Symbols, or Patterns tab.

Tip:  Using symbol types from a column specifies the symbol shape only. If you want to change the
symbol fills, create another color column and use it as the symbol fill colors. Typically, white is used for
hollow symbols, and black for solid symbols.

4. Select the first cell in an empty column in the worksheet.
5. Double-click the color, line, symbol, or fill pattern in the Insert Graphic Cells dialog box you want to place in the

cell.

Important:  Do not mix graphic cell types within the same column; for example, place colors in one
column, symbols in a different column, fills in yet another column, and lines in a fourth column. You can,
however, use multiple columns to define several different increments of the same graphic cell type. For
example, you can have several columns containing colors of differently ordered increments. The item
appears in the worksheet cell.

6. Continue adding to the column, in the order you want the curves to use the colors, lines, symbols, or patterns.
The order of the curves is the order in which they appear in the Selected Columns drop-down list in the Graph
Wizard.

7. Close the Insert Graphic Cells dialog box.
8. View the graph page and double-click the graph.
9. In the Properties list of the Graph Properties dialog box, select:Fills, Area Fills, Symbols, or Lines

What you select depends on what you have defined in the worksheet.
10. Choose the name of the column which contains the appropriate graphic cells from the Symbols Type, Fills

Foreground Pattern, or Lines Type, or Color drop-down lists.
If you are applying a large number of colors or other property schemes, you may wish to turn off the automatic
legend, which will attempt to display your first 25 different data points. For more information, see Working with
Automatic Legends on page 147.

Incrementing Color Schemes

You can select from a number of existing color schemes for any line or fill on plot, whether it be on a bar chart, an
area plot, the lines surrounding a bar, and so on. You also have control over which color starts the series.

1. Double-click the line or fill to open Graph Properties.
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2. Select (Color Schemes) from any Color drop-down list available in Graph Properties.

3. Click … directly to the right of the Color drop-down list to open the Color Schemes dialog box.

4. Select a scheme from the Select Colors list.

A Preview of the scheme appears directly below.
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5. To set the first color, select from the  First Color drop-down list.

This choice is immediately reflected under Preview.
6. Click OK.

Changing Bar and Box Widths and Spacing

Control the amount of space between bars and boxes, and between grouped 2D and 3D bars by adjusting the percent
of the maximum possible widths of both the individual bars and the bar groups.

Figure 46: From left to right: bar charts with a group spacing of 50% and relative thickness of 100%,
group spacing and relative thickness both set to 66%, and both settings set to 100%.

To control bar and box width and spacing for bar charts and box plots:

1. Double-click the plot to modify.
2. In the Properties list of the Graph Properties dialog box, select: Plot > Widths
3. To change the width and spacing between bars for all bar charts and box plots, move the Bar thickness

slider. The wider the bars or boxes, the less space between them. The narrower the bars or boxes, the more space
between them.

4. To change the width and spacing between groups of 2D and 3D bars, move the Group spacing slider. This
option is only available for grouped and 3D bar charts. SigmaPlot sets grouped bar widths and spacing to as wide
or as narrow and as far or as close as possible given the corresponding spacing or width setting.

5. To set a constant width for all bars or boxes, from the Bar Width style drop-down list, select Uniform. This
is the default setting. If the bars are set to Uniform, the Bar thickness setting has the same effect on all bars. For
more information, see Uniform versus Variable Bar Widths on page 92.

6. To set potentially uneven widths for bars and boxes, select Variable from the Width  drop-down list. If the
constant column values are uneven, the bars will vary in width according to the corresponding axis values. If the
bars are set to Variable, change bar widths according to the percent of their total widths so that wide bars are more
affected than thin bars.

Note:  Bars created with a single plot will not overlap; however, you can create bars using separate plots
and overlap them. For more information, see Spacing Bars from Different Plots on page 225.
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7. To create a needle plot, move the Bar thickness slider to set bar widths to the narrowest possible widths.

Figure 47: To make a histogram needle plot, create a bar chart and set the Bar Thickness to
Needle.

8. To change bar alignment, select either Center, Left, or Right from the Bar Alignment drop-down list.
By default, bar chart bars are centered around the data point. Use Bar Alignment to alternately draw the bars right
or left aligned with the data points.

Figure 48: From Left To Right: Bar Charts with Alignments to the Left of the X Points, to the
Right of the X Points, and Centered over the X Data Points

Uniform versus Variable Bar Widths

Uniform bar widths set all individual bars to the same width, using the width of the narrowest bar. If the values which
the bars are plotted along are unevenly incremented, the bar widths still remain constant.

Variable bar widths set the widths to be as wide as possible, as determined by the Bar Thickness and Group Spacing
settings. If the values which the bars are plotted along are evenly incremented, this option has no effect. However,
if the values which the bars are plotted along are unevenly incremented, the bar widths will vary according to their
corresponding values.
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Adding and Modifying Drop Lines

Use drop lines to produce dot plots on 3D graphs which connect data points to their axis values. You can add drop
lines from plotted data points to either or both axes in a 2D scatter, or line, or line/scatter plot,  or to any or all back
planes in a 3D scatter or trajectory plot. Drop lines are drawn for every curve in a plot.

Figure 49: The graphs on the left are examples of 2D plots with drop lines to the Y and X axes. The
graph on the right is an example of a 3D graph with drop lines to all axes.

Drop lines always fall toward the minimum of a range; for example, if a Y axis range were reversed, a drop line to the
X axis would fall to the top of the graph rather than the bottom.

Use the Drop Lines settings in the Graph Properties to create new drop lines, and to modify existing drop line type,
thickness, and color.

To add or modify drop lines for a selected plot:

1. Double-click the plot to modify.
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2. In the Properties list of the Graph Properties dialog box, select: Plot > Drop Lines.

3. Select the X, Y (or Z) drop-line. Drop lines are added to any and all planes or axes that are selected.

4. To adjust line thickness, move the Thickness slider, type the new value in the Thickness box.

5. To set drop line color, select a color from the Color drop-down lists. Select any of the listed colors, or select
(Custom) to select or define a custom color. For more information, see Using Custom Colors and Incrementing
Schemes on page 162.

Drop Lines for a Single Point

You can use drop lines to indicate the position of a single point. To show a single drop line, create a second plot which
graphs only the desired data point, then add drop lines to the single-point plot. If you do not want the symbol to show
for the point, set the symbol type to (None).
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Adding Reference Lines
You can add horizontal or vertical lines at specific locations using Graph Properties. Use reference lines to draw lines
at specific values, to set quality control limits, and specify other reference values.

Note:  Bar and stacked bar charts automatically place a reference line at the zero value.

You can add up to five reference lines. All lines can be drawn only horizontally or vertically as a set. The Reference
settings display the current calculation, line type, label, and color for each line.

One set of five reference lines, either horizontal or vertical, can be drawn for each plot. If you need more than five
lines or need both horizontal and vertical lines, you must create an additional plot. For more information, see Adding
New Plots on page 71.

Drawing Reference Lines

To draw reference lines:

1. Double-click the plot to open the Graph Properties dialog box.
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2. In the Properties list, select: Plot > Reference Lines.

3. Select a reference line from the Show/edit list. You can add up to five lines for each plot. The default names and
calculations are the names commonly used when employing reference lines for quality control charts.

4. To change the reference line name, select the line from the list, then edit the Label box for that line.

5. To display the label next to the reference line, select Left or Right for horizontal reference lines, or Top or
Bottom for vertical reference lines.
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6. To change the value or statistic used for the line, select an option from the Calc drop-down list.

If you are not using a mean as the calculation, type a value to multiply the statistic by, or a value to use as a
constant, in the box next to the Calc drop-down list. The calculation options apply only to the reference line
highlighted in the Graph Properties dialog box list of reference lines.

To set the reference line value to a specific value, select Constant Calc, and enter the value to the right.

Automatically calculated statistics are derived from the plot data. All data points graphed, including multiple
columns of data, are used for reference line calculations.

7. Use the Appearance options to set a line type, thickness, and color for the highlighted reference line. Each
reference line can have separate line attributes.

8. Use the Direction drop-down list to draw reference lines horizontally or vertically.

9. Use the Layering drop-down list to draw reference lines either Behind or In Front of the selected plot.
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Manager

When you first start SigmaPlot, the Quick Start dialog box appears with the
Open notebook tab in view, with a variety of options to start creating graphs.
The simplest way is to select the first option, Create new blank notebook,
and then click OK.

The Quick Start dialog box closes, and you see the SigmaPlot desktop, with
an empty worksheet in view.

Like all the windows open on the SigmaPlot desktop, the you can either dock
Notebook Manager window or have it be a floating window. Notebook files
contain all of your data and graphs, and are organized within the Notebook
Manager. It is in the Notebook Manager that you can open and work with
many notebook files at once.

The first time you see the Notebook Manager, it appears with one open
notebook file, which contains one section. That section contains one empty
worksheet. Contents of the Notebook Manager appear as a tree structure,
similar to Windows Explorer.

Each open notebook appears as the top level, with one or more sections at the
second level, and one or more items at the third level. Within each section you
can create one worksheet and an unlimited number of graph pages, reports,
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equations and macros. The most recently opened notebook file appears at the
top of the Notebook Manager.

Modified Notebook Names

An asterisk next to an item in the Notebook Manager indicates that the item
has been modified since the last time you saved the notebook.

Notebook Item Names

The default first notebook is named Notebook1. It contains one notebook
section, Section 1, and one worksheet, Data 1. When you save your notebook
file, the name of the file appears at the top of the Notebook Manager
window. Notebook files use a (.jnb) extension. The default names given to
notebook sections and items are, Section (number), Data (number) or Excel
(number) and Report (number). Regression equations are named when they
are created. New items are numbered sequentially.
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Protecting Notebooks
To ensure security of notebook contents, you can lock notebooks using a password. This is particularly useful if two
or more users are using the same version of SigmaPlot. You can also use a password to send confidential data to other
SigmaPlot users.

Creating a Notebook Audit List

Use SigmaPlot Auditing to create a record showing who has modified and saved a Notebook file and what operations
he or she has performed during a given period of time.

Use SigmaStat Auditing to create a record showing who has modified and saved a Notebook file and what operations
he or she has performed during a given period of time.

To create an audit list:

1.

Click the Main Button .
2. Click Protections.

3. Click the Auditing tab on the Protections dialog box.
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4. To create an audit trail, select Enable Audit List.

5. To prevent other users from disabling the audit list, enter and reconfirm a password in the Auditing Password
(optional) and Reconfirm fields.
Creating an Auditing password is optional. Passwords can be any combination of letters, symbols or numbers, up
to 250 characters in length. It is strongly advised that if you create a password, write it down as lost passwords can
not be retrieved.

6. To view the audit list, click View Audit List.
7. Click OK to save passwords and settings and to close the Protections dialog box.

Setting a Password

To set a password:

1. Select the notebook in the Notebook Manager.
2.

Click the Main Button .
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3. Click Protections.

4. In the Set Password tab on the Protections dialog box, type a password in the New Password box.

5. In the Reconfirm box, type the password again.
6. Click OK.

Changing or Removing a Password

To change or remove a password:

1. Select the notebook in the Notebook Manager.
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2.

Click the Main Button , and then click Protections.

3. In the Set Password tab on the Protections dialog box, type the old password in the Old Password box.

4. In the New Password box, type a new password.
5. Click OK.

Creating a Notebook Audit List

Use SigmaPlot Auditing to create a record showing who has modified and saved a Notebook file and what operations
he or she has performed during a given period of time.

Use SigmaStat Auditing to create a record showing who has modified and saved a Notebook file and what operations
he or she has performed during a given period of time.
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To create an audit list:

1.

Click the Main Button .
2. Click Protections.

3. Click the Auditing tab on the Protections dialog box.
4. To create an audit trail, select Enable Audit List.

5. To prevent other users from disabling the audit list, enter and reconfirm a password in the Auditing Password
(optional) and Reconfirm fields.
Creating an Auditing password is optional. Passwords can be any combination of letters, symbols or numbers, up
to 250 characters in length. It is strongly advised that if you create a password, write it down as lost passwords can
not be retrieved.

6. To view the audit list, click View Audit List.
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7. Click OK to save passwords and settings and to close the Protections dialog box.

Working with Sections in the Notebook Manager
Notebook sections are placeholders in the notebook. They contain notebook items, but no data; however, you can
name, open, and close notebook sections.

You can create as many new sections as you want in a notebook. You may also create reports within each section to
document the items in each section.

To expand or collapse a section, double-click the section icon or click the (+) or (-) symbol.

Creating New Items in the Notebook Manager

Using the right-click shortcut menu, you can create new sections and items in the Notebook Manager, such as:

• Worksheets
• Excel Worksheets
• Graph pages
• Reports
• Equations
• Sections
• Transforms
• Macros

To create a new section or item:

1. Right-click anywhere in the Notebook Manager in which you want the new section or item to appear.
2. On the shortcut menu click New, and then the item to create. The new section or item appears in the Notebook

Manager.

Copying and Pasting to Create New Sections

Another way to create a new notebook section is to copy and paste a section in the notebook window. Whenever you
copy and paste a section, its contents appear at the bottom of the notebook window. SigmaPlot names and numbers
the section automatically. For example, if you copy notebook Section 3, the new section is named Copy of Section 3.

Copied sections create copies of all items within that section as well.

Renaming Notebook Files and Items

You can change summary information for all notebook files and items.

To change summary information:

1. If the summary information is hidden on the Notebook Manager, click Summary Info.
2. Select the notebook item and edit as appropriate.

In-place Editing Section and Item Names

You can change the name of a notebook section or item in the notebook itself without opening the Summary
Information dialog box.

To in-place edit:

1. In the Notebook Manager, click the section or item you want to rename.
2. Click it a second time.
3. Type the new name.
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4. Press Enter. The new section or item name appears.

Tip:  To change the name of the notebook, use the Save As dialog box.

Copying a Page to a Section with No Worksheet

If you copy a graph page into an empty section or a section that has no worksheet, you create an independent page.
The independent page retains all its plotted data without the worksheet. You can store the pages from several different
sections that have different data together this way. However, if you ever create or paste a worksheet into a section, all
independent pages will revert to plotting the data from the new worksheet.

Use independent pages as templates, or to draw or store objects. You cannot create graphs for an independent page
until it is associated with a worksheet (and no longer independent).

Dragging and Dropping Items in the Notebook Manager

You can move items within sections and sections within notebooks. Worksheets, however, always stay at the top of
their sections.

To drag and drop notebook items and sections:

1. Select the item.

2. Hold the mouse button and drag the item to its new location.

Opening Files in the Notebook Manager

You can open SigmaPlot files and other types of files as SigmaPlot notebooks.

To open a notebook file that is stored on a disk:

1.

Click the Main Button .
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2. Click Open.

3. In the Open dialog box, choose the appropriate drive and directory of the notebook file to open.
4. Double-click the desired notebook file.
5. If you want to open another type of file, choose the type of file from the Files of type list.
6. Click Open. The opened notebook appears in the Notebook Manager.

Opening Worksheets, Reports, and Pages

You can open a worksheet, report, or page by double-clicking its icon in the Notebook Manager. You can also right-
click the item, and on the shortcut menu, click Open. Open worksheets, pages and report appear in their own window,
and in the notebook as a colored icons.

Double-clicking an item that is already open brings the item's window to the front.

Opening Multiple Items

You can open as many items as your system's memory allows. You can open multiple items from multiple notebooks.
The selected item appears highlighted in the Notebook Manager.

Copying and Pasting Items in the Notebook Manager

You can copy and paste items from one open notebook file to another in the Notebook Manager; however, you cannot
copy a worksheet into a notebook section that already contains a worksheet.

Copying and pasting pages and worksheets between sections results in using graph pages as templates. For more
information, see Using Templates on page 118.

To copy and paste a notebook item:

1. Right-click the item in the Notebook Manager that you want to copy, and on the shortcut menu, click Copy.
2. Right-click the section where you want to paste the item, and on the shortcut menu, click Paste. The selected item

is pasted to the current notebook and section.
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Deleting Items in the Notebook Manager

To delete an item from the Notebook Manager:

Select the item and press Delete. The item is deleted.

Note:  Items removed from a notebook file using the Delete button are removed permanently.
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Use Graph Pages to display and modify graphs that plot data from your
worksheets. You can create as many graph pages as you wish per worksheet.

New graph pages are associated with the current worksheet, and are placed in
the current notebook section.



 | Graph Page Basics | 112

About Graph Pages
Graph pages are true graphical representations of a printed page that contain graphs, text, and other drawn and pasted
objects. You can select objects on graph pages and modify them using Graph Properties and with options available
on the Graph Page tab. You can manipulate all objects graphically using your mouse.

A page can contain an unlimited number of graphs and other objects, and you can create an unlimited number of
pages for each worksheet. You can also paste graphics, OLE (Object Linking and Embedding) objects, and other
objects onto a page.

Graph pages are created in several ways. You can create a graph page as a notebook item, or by using the Graph
Wizard, the Graph Style Gallery or by templates. For more information, see Creating and Modifying Graphs on
page 27.

Setting Page Options

You can control graph page properties on the Page tab of the Options dialog box. To open the Options dialog box:

1. Click the Main Button.

2. Click Options.

3. Click the Page tab.

Exporting Graphs and Pages

You can export SigmaPlot graphs and graph pages to other files formats.

To export a graph or graph page:

1. Select and view the graph page. If you want to export specific graph(s), select the graphs you want to export to a
file.

2. On the Home tab, in the Export group, click the Graph drop-down list.
3. Click Export.
4. In the Export File dialog box, enter the file name, directory and drive for the export file destination.

Restriction:  If you select WMF or EPS file formats, be aware that SigmaPlot does not support anti-
aliasing, gradient fills, and partial color transparency.
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5. Click Save. If you chose one of the graphic file formats, a secondary dialog box appears, asking you to enter some
graphic format information.

6. Enter the desired DPI and Color Resolutions; for EPS files, these setting only affect the resolutions of the TIFF
header, not the actual PostScript resolution. For metafiles, this setting affects only 3D graphs.
The higher the DPI and Color resolutions, the better quality the image, but also the larger the file. Limit the DPI
and Color resolutions to the capability of the intended output device. For example, if you are going to create 600
dpi slide output, set the DPI resolution no larger than 600.

7. If you want to export only the selected graph(s) or objects, select Export selected only.
8. Click OK to create the exported file using the specified file name and graphic resolutions, if applicable.

Printing Graph Pages

You can print any graph in a SigmaPlot notebook.
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1. To print a graph page:
a) Select and view the page window.
b) Click Main Button and then click Print to print the page using all the default settings.

2. To set printing options before you print the graph page:
a) Click Main Button and then click Print.
b) In the Print dialog box, click Properties.

c) Click OK when you are satisfied with the printer properties settings.

Restriction:  The Properties dialog box options vary from printer to printer.

d) Click OK to print the graph.

Saving Graphs as PDF
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To save a graph as a PDF file:

1. On the graph page, select the graph.
2. Click the Home tab, and then in the Export group, click Create PDF.

3. Click the Home tab, and then in the Export group, click Create PDF.

4. In the File Name list, type or select a name for the graph.
5. In the Save as type list, click PDF.
6. Click Save.

Working with Page Objects
Using SigmaPlot ribbon commands, Graph Properties, Object Properties, and wizards you can create and modify
graphs and other page objects.

Graph Wizard

The Graph Wizard guides you through a series of dialog boxes to select the type and style of graph, and to select
worksheet data for plotting. After you create the graph, you can open the Graph Wizard to add or modify plots and
axes.

Graph Properties

Graph Properties customizes the plots, axes, grids planes, titles and legends of your graph. Use it for more advanced
modifications to your graph.

To open the Graph Properties dialog box, double-click anywhere on the graph.

Object Properties

Object Properties modifies many graph attributes including drawn objects. Use Object Properties to make simple
modifications to the objects and graphs. The Line and Fill tabs change fill patterns, lines of your plots and objects.
The Size and Position tab changes position, scaling and size for all selected objects.

To open the Object Properties dialog box, double-click the object.

Text Properties

Most Text Properties appear either in the Text group on the Graph Page tab or you can right-click text on a graph to
open the Text Properties dialog box.

Selecting Page Objects

When you select text, drawn objects, or individual elements on the graph page, and then double-click, you open the
dialog box specific to that element.

To select a graph element, make sure you are in selection mode by clicking Select Object in the Tools group on the
Graph Page tab.
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Selected objects are surrounded with square handles; selected axes and text are surrounded by dotted lines.

Selecting Multiple Objects

To select multiple objects, hold down the Shift key while clicking objects, or drag a window completely around the
objects you want to select. When you select multiple objects, only the last selected object has solid black handles; the
other objects have hollow handles.

You can edit, copy, paste, move, size and scale, delete or hide all selected page objects, including graphs, text, drawn
objects, and pasted objects.

Selecting Objects that Overlay One Another

To select objects that overlay one another, press either the Alt-Click or Alt-Arrow keys.

1. To use Alt-Click:
a) Click the object that you want to select, which may be covered by another object, and then press the Alt key.
b) While holding down the Alt key, repeatedly click the object until it is selected under the position that you

initially clicked.
As you repeatedly click you will cycle through all objects that overlay one another.
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2. To use Alt-Arrow:
a) Click the object that you want to select and then press the Alt key.
b) While holding down the Alt key, repeatedly press one of the arrow keys (up, down, right, or left) to select the

object of interest. Use of different arrow keys will cycle through the objects in a different order.

Tip:  It is important that you click on top of the object that you eventually wish to select. For example,
selecting the intersection of the horizontal and vertical grid lines slightly below the symbol will result
in a different sequence of selectable objects, that is, vertical grid line, right y-axis, horizontal grid line
and plot error bars. It is not possible in this case to select the symbol.

Real Time Mouse-Over Feedback

You can obtain numeric data values from your plots by placing the mouse cursor over the data points. To do this click
on the particular plot to select it. Then move the mouse cursor over the data points. When the cursor is over a data
point the cursor background color is cyan and you can read the numeric value from the cursor window. When the
cursor is not over a data point you can read the position of the cursor using the x and y scales for that plot.

If you would like to disable mouse over feedback:

1. Click the Main Button.

2. Click Options.

3. Click the Page tab.

4. Clear Show data values.

Adding Another Graph to a Page
You can add additional graphs to the current graph page by:

• Creating a new graph onto the current page.
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• Copying a graph to the same page.
• Copying and pasting a graph from another page.

Creating a New Graph on the Current Page

If you want to add a graph to a page by creating a new graph:

1. Add the data for the new graph in the worksheet associated with the current graph page.
2. On the Create Graph tab, click Graph Wizard in the Wizard group.
3. Follow the steps in the Graph Wizard.
4. After clicking Finish to create the graph, you'll need to align the graphs on the graph page, which you can do

manually, or on the Graph Page tab, in the Format group, click Arrange Graphs. For more information, see
Arranging Graphs on page 138.

Copying a Graph on the Same Page

One of the quickest and the easiest ways to add a second graph is to copy the one you have already created, arrange
the graphs so they're both visible on the page, and then modify it. Arranging Graphs on page 138

Copying and Pasting a Graph from One Page to Another

You can copy a graph from a graph page within the current notebook section, or from a different notebook section.

To copy a graph from one page to another:

1. Select the graph you want to copy.
2. Press Ctrl+C.
3. Make the destination page the current page.
4. Press Ctrl+V to paste the graph.

The graph appears on the current page, and the graph data appears in the worksheet associated with the current
page. Another method is dragging and dropping.

Zooming In and Out
Right-click the graph page (not the graph!), and select Zoom or Zoom window. You can view the page at several
different levels of magnification, magnify the page centering on a specified page location, or choose a completely
unobstructed view of the page.

Using Templates
SigmaPlot templates, once you figure out the nuances of the template interface, can simplify graph and graph page
creation and modification.

You can use templates to create pages and graphs with preset properties. For example, if you need to create a set of
slides, you can open pages that are already set to attributes for slides.

Attention:  Never use templates to add a graph to a page.

There are two kinds of templates: template pages and template graphs. You can find examples of these under
Galleries and Templates on the left-hand side of the SigmaPlot desktop. Click Page Templates.
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In this group, you’ll notice some of the template thumbnails are blank and some have graphs in them. The ones
without graphs are called template pages. The ones with graphs are called template graphs.

Template pages are ordinary graph pages. Any graph page can act as a template page. All attributes from the page -
size, color, margins, and orientation - are retained. Any graphs and other objects on the page are also duplicated.

Template graphs automatically plot the worksheet column data that was selected when the graph was created.

Now, you might have right-clicked one of these templates on your own, and then clicked Apply, and noticed you
lost your graph. So don’t do that. What you actually need to do is much more complicated, but in the long run, it will
make your life easier. These next sections outline these complicated steps.

Tip:  Graphs created by templates can be modified like any other graph.

Applying Templates

There are three methods to apply a template to a page, and they are:

• Creating a new but blank graph page. Creates a new page with attributes from the template applied.
• Copying a graph page from one notebook section to another. Creates a new page in a section, using the data in

the existing worksheet for graphs.



 | Graph Page Basics | 120

• Overwriting an existing page. Replaces the existing page.

Creating a New Page with Attributes from a Template
Here you create the graph page first, and then apply the template to it, and then create the graph using your worksheet.

1. Click the Main Button and then click New.

DANGER:  Don’t select a sub menu! Just stick with New.

2. In the New dialog box, select Graph Page from the New drop-down list.

Under Type, you’ll see a list of existing page and graph templates.
3. Select a page template (and not a graph template – see Important! below) and click OK.

Now you have a blank graph page with the template attributes applied.
4. Right-click this graph page, and click Create Graph.

The Graph Wizard appears. Now you can create your graph following the standard procedures.

Important:  To apply a graph template, select one of the graph templates in the Type drop-down list on
the New dialog box. On the graph page, right-click the empty graph (that’s the template) and click Modify
Plot. Follow the prompts of the Graph Wizard.

Copying a Graph Page to use as a Template

The best method of applying a page template to a worksheet is to use an existing graph page as a template. The copied
page acts as a template using the worksheet in the new section. For more information, see Copying and Pasting to
Create New Sections on page 106.

If you plan to copy a page, set up your worksheet so that the data is in the appropriate columns before applying the
template. You can also change the columns to plot after applying a template by selecting the plot, clicking the Create
Graph tab, and clicking Graph Wizard in the Wizard group. For more information, see Picking Different Data for
the Current Plot on page 69.
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Overwriting an Existing Page

When you apply a template to an existing graph page, all features of the existing page are lost.

1. To apply a template to an existing page:
a) Make the graph page the active window.
b) Click the Main Button and then click Templates.

c) In the Templates dialog box, select a template from the Templates list.

d) Click Apply.
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2. To apply a template from a different notebook template file:
a) Click the Main Button and then click Templates.
b) In the Templates dialog box, select the path and file name of the desired SigmaPlot Notebook or template file.
c) Click Open.
d) Select a template from the Templates list in the Templates dialog box.
e) Click Apply.

Templates and Notebooks

Templates are stored on the Gallery tab on the Notebook manager. To quickly find the available templates, click
Gallery and Templates in the Navigate group on the Home tab. Then click Page Templates on the left-hand side of
the SigmaPlot desktop.

Changing the Page Created with the New Page Button

Anytime you click the Main Button and then New and then Graph Page, you’ll see that SigmaPlot automatically
uses by default the Normal template as the source for that specific graph page; however, there are many templates
available under the Type drop-down list. Just be forewarned that selecting a template here only works for the graph
page you are about to create, and not for all subsequent pages.

Changing the Template File Used for New Pages

SigmaPlot automatically uses the template notebook when you open a graph or graph page. You can set this file name
in the General tab of the Options dialog box.

To change the source file template:
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1. Click the Main Button.

2. Click Options.

3. On the Options dialog box, click the General tab.

4. Type the path and file name of the desired template file in the Template File field.
5. Click OK. The notebook becomes the default template source.

Tip:  If a valid default template source file is not specified, a default page is created instead. This page is a
letter-sized, white portrait page by default.

Adding New Pages to Template.jnt

You can add a previously created page to Template.jnt, but first you must open Template.jnt in the Notebook
Manager.
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1. Click the Main Button and then Open.

2. In the Open dialog box, select Template Notebook (*jnt) as the file type to view.
3. Select Select.jnt and click Open.

TEMPLATE.JNT appears in the Notebook Manager.

Now you can copy and paste any page you’ve already created into either the Blank Templates or Graph Templates
section of the Templates notebook.

4.

Cutting, Copying, and Pasting Graphs and other Page Objects
Cut and copy selected page objects to the Clipboard.

Cutting and Copying Graphs

The easiest way to cut or copy a graph or other page object select the graph or object to cut or copy by clicking it. To
cut the item, press Ctrl+X. To copy, press Ctrl+C and to paste, press Ctrl+P.

A copy of the selected graph or object or is placed in the Clipboard. Since copied items remain in the Clipboard until
replaced, you can paste as many copies as you want without having to cut or copy the object each time.

You can also use the buttons available in the Edit group on the Graph Page tab.
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Pasting Objects

You can paste Clipboard contents to any open page, report, or into any other Windows application that supports
Windows Metafiles or OLE (Object Linking and Embedding).

To paste an object to a page, click where you want the object to appear, then press Ctrl+V. Using OLE to Paste, Link
and Embed Objects

Note:  The Clipboard is a Microsoft Windows feature. To learn more about how the Clipboard works, refer to
your Windows User's Guide.

Storing and Retrieving Plot Data and Attributes in Graphs and Pages
All of SigmaPlot’s graph pages, the graphs themselves, and templates store data in one way or another. For example,
graph pages use worksheet data for plots and labeling; templates store graph attributes for a given graph page; some
graphs, like result graphs from statistical procedures, store their own data. Using standard copy and paste keyboard
commands, you can convert one from one form of data storage to another.

Creating a Graph that Stores its Own Data

You can create a graph that is visually the same as the original graph but stores its own data.

1. Copy a worksheet graph.
2. Paste it onto another graph page contained in a section without a worksheet.

Creating a Graph Template that Stores Attributes for Graphs on a Page

You can copy any page template into another section with a worksheet and select data for it using the Modify Plot
Wizard. In other words, you use it to create graphs with customized attributes as with graphs in the file template.jnt,
SigmaPlot’s template interface.

1. Copy a graph page with one or more worksheet graphs from the Notebook Manager.
2. Paste it into a notebook section without a worksheet.

A graph page appears with no data.

Creating a Worksheet from a Graph that Stores its Own Data

You can create a new worksheet graph in which the data for the original graph appears in a new worksheet. This new
worksheet is what stores the data for the new graph, so as to not overwrite the original.

1. Copy a graph that stores its own data, such as a Result Graph.
2. Paste it onto another graph page in a section with a worksheet.

Using OLE to Paste, Link and Embed Objects
There are various ways to paste SigmaPlot objects into other applications, and vice versa. One method is using OLE
(Object Linking and Embedding), which is fully supported by the SigmaPlot page. OLE provides the ability to move
or copy information among supporting applications, and to use the applications interchangeably to modify the data.
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SigmaPlot and OLE

SigmaPlot can place and receive OLE and other types of objects, such as scanned images, clip art, or text from a word
processor. For example, you can place an equation created with the Microsoft Word Equation Editor into a SigmaPlot
report, and edit it with the Word Equation Editor when it changes.

Figure 50: Example of an Microsoft Excel Equation Embedded into a SigmaPlot Report

Methods Of Placing Objects

You can copy, cut, and paste graphs among applications without using OLE. The method of placing objects depends
on each application's implementation. The following list shows how objects can be placed:

• OLE object. Can be placed if application supports OLE.
• Windows Metafile. Can be placed if application doesn't support OLE, but supports pictures.
• Enhanced Metafile. Can be placed in Windows applications only.
• Bitmap. Can be pasted in applications that support bitmaps only (for example, Microsoft Paint).

Note:  SigmaPlot always pastes an OLE object if it is available. The SigmaPlot graph and report pages
support OLE. Graphs (not graph pages) pasted into SigmaPlot reports are always pasted as Windows
metafiles.

Linking or Embedding Objects

Use Paste Special, Insert Object , and Ctrl+Drag to either link or embed the object in the page or report.

Linking appears to place a copy of the object in the destination application, but actually only places a reference to it.
Therefore, the object is modified every time the original file is modified.

You can only link to a file if you create an object using the Paste Special in the Edit group or Insert New Object  in
the Insertgroup, both on the Graph Page tab, or if you drag and drop an object with the Ctrl key held down.

Linking is useful when you need to update an embedded object when the file is updated. The disadvantage of linking
objects is that you cannot open a referenced file if the locations of either the SigmaPlot file and the source file change.

Embedding places a copy of the object in the destination application, and then you can edit it by activating its source
application when you double-click it. Embedding does not use a reference file; the "file" is actually embedded
completely in the SigmaPlot file. For example, if a Microsoft Word embedded object has been placed in a SigmaPlot
report, and you double-click it, Microsoft Word opens. Word temporarily runs under SigmaPlot. When you are
finished editing the item and close Word, SigmaPlot remains open.

Embedding an object has the advantage of keeping all the associated data in one place, but can create large files.

To embed an object:
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1. With a graph page in view, on the Graph Page tab, in the Insert group, click Insert Object.

2. Click Insert Object from the drop-down list.
3. In the New Object dialog box, select the type of object to insert from the Object Type list. A description of the

object type appears below.

4. Click OK to insert the object.

Placing SigmaPlot Objects into Other Applications

You can paste SigmaPlot graphs and reports into other applications, and link or embed them for future editing with
SigmaPlot. For example, you can paste a SigmaPlot graph into a Microsoft Word document (as an OLE object), and
use Graph Properties to edit it by double-clicking the graph.

When you link to SigmaPlot and double-click the graph or report, the notebook file containing the graph or report
opens.

You can change the source of any linked object. For more information, see Dragging and Dropping Graphs on page
131.

View as Icon

With OLE, the View as Icon  allows you to place an icon representing the application that created the file in your
data. For example, if you have a description of a graph written in a Microsoft Word document, you can embed it, and
display it as an icon that shows on the graph page. If you want the object displayed as an icon, select the Display As
Icon option. Click the icon to view and edit the object in its source application.
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Figure 51: Displaying a Microsoft Word Document as an Icon on a Graph Page

To embed the object and view as an icon:

1. With a graph view, on the Graph Page tab, in the Insert Group, click the Insert Object  drop-down list.
2. Click Insert Object
3. In the Insert Object dialog box, select the type of object to insert from the Object drop-down list.

4. Select Display as Icon.
5. Click OK to insert the object as an icon.

Pasting Objects onto a Graph Page or Report

You can paste contents, including OLE objects, into both page and report documents.

To paste artwork, text from a word processing application, or other objects onto a graph or report page:

1. Open the application and file containing the desired artwork or text, and cut or copy the object.
2. Switch to SigmaPlot and view the graph or report page.
3. Click the location where you want the object to appear, then press Ctrl+V. The graphic is pasted to the page. If the

object can be an OLE object, SigmaPlot always defaults to the OLE object.
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4. To paste the object as a specified file type, on the Graph Page tab, in the Edit group, click the Paste drop-down
list.

5. Select the type of object to paste from the As box, then click OK. The object appears at the selected location.
6. Click Paste Special.

Figure 52: Using the Paste Special Dialog Box to Paste an Object from Microsoft Word to
SigmaPlot

Restriction:  The options available in the Paste Special dialog box depend on the type of file being
pasted.

7. Select Paste to paste the object as a specified file type. Select Paste Link to paste the object as a linked file that
can be updated in another application. The options in the As list change depending on your selection of either
Paste or Paste Link, and the explanation in the Result box changes depending on your selection in the As list.

8. Select the type of object to paste from the As box, then click OK. The object appears at the selected location.

Placing Objects without the Clipboard

You can select objects from applications that are installed on your system and to place them into a SigmaPlot graph or
report. The object types available on your system depend on the applications installed.

To insert an object:

1. View the report or graph page, and click where you want the insertion point.
2. On the Graph Page tab, in the Insert group, click the Insert Object drop-down list.



 | Graph Page Basics | 130

3. Click Insert Object.

4. If you want to display the new object as an icon, select Display As Icon in the Insert Object dialog box.

You can also specify a different icon to display the inserted object. Click Change Icon to open the Change Icon
dialog box. Choose a different icon from the available options, or click the Browse button to search for alternative
icons on your system.

5. To create a new object to place on the report or graph page, select Create New, then choose the type of object
from the Object Type list.

6. Click OK to open the application associated with the selected object. Create the desired object, then close the
application and return to SigmaPlot. The created object is displayed on the graph or report page as an embedded
object.
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Dragging and Dropping Graphs

You can drag objects between compatible applications within Windows. Additionally, you can drag and drop graphs
from one graph page to another.

To drag a graph into another application, the other application must support OLE.

1. Make sure the other application is open and visible from the desktop, with the location where you want to drop the
graph also visible.

2. Select the SigmaPlot graph you want placed in the other program, then drag the graph from the SigmaPlot page. If
you want to drop a copy of the graph, press the Ctrl key while dragging.

3. Move the mouse to the location you want the SigmaPlot graph to appear.
4. Release the mouse; the graph appears at the drop location as an enhanced meta file.

Dragging and Dropping Graphs Between Pages

You can drag a graph from one graph page to another. If you drag a graph from a different notebook section, it will
insert its data into the destination section worksheet.

To copy or move a graph from one graph page to another:

1. Open the source and destination pages.
2. Release the mouse where you want the graph to appear. The graph is placed on the new page. If the page is in a

different section, the data plotted by the graph is copied to the current worksheet.

Hiding and Deleting Objects from the Page
You can delete drawn and pasted page objects from the page, and graphs, automatic legends, automatically created
graph titles, plots, and axes can be deleted and/or hidden from view. Modifying Axes, Tick Marks, and Grids on page
275

Hiding and Viewing Graphs on a Page

The quickest way to hide a graph on page is to select the graph page, then right-click the graph you want to hide, and
on the shortcut menu, click Hide.

To control which graphs are displayed on the page:
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1. Click the Main Button, click Print, and then click Page Setup.

2. Click the Page Layout tab. The graphs on the current page are listed in the Shown box.

3. To hide a graph, select it from the list and click Hide. The selected graph is moved to the Hidden list. (To select
multiple graphs, hold down the Shift or Ctrl key while making selections.)
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4. Click OK to apply your selections and close the Page Setup dialog box.

Note:  Hidden graphs do not print.

Hiding Graph Titles and Legends

You can hide automatically generated graph and axis titles and legends from view without being permanently
removed from the graph page.

To hide an automatic legend or automatically created graph title:

Right-click the legend or title and then on the shortcut menu click Hide. The title or legend is not deleted, only
hidden.

Removing Graphs, Plots, Titles, Legends, and Other Page Objects

Anything on the graph page can be removed from the page by selecting the object, then pressing Delete.

Deleting removes curves, plots, and graphs entirely. You can use undo (Ctrl+Z) to retrieve these items. When a graph
or plot is removed, worksheet data remains intact. Delete also completely removes drawn and pasted objects.

Note:  Delete only hides titles and legends, and does not remove them permanently.

Drawing Objects on the Page
Use the tools available on the Tools group of the Graph Page tab to draw rectangles, ellipses, lines, and arrows.

Any drawn object or text is not attached to the graph until they are grouped with the graph.

Graph Page Tools

Use the Tools group on the Graph Page tab to draw objects on the graph page.

The drawing tools on the Tools group are:
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Select Object Use the Select Object button to select objects on the graph page.

Text Click this button to add text, labels, or manually created legends to the
graph page.

Draw Line Click this button to draw a line on the graph page.

Draw Arrow Click this button to draw an arrow on the graph page.

Draw Box Use the Draw Box button to draw a box on the graph page.

Draw Ellipse Click this button to draw an ellipse on the graph page.

Drawing an Object

To draw an object:

1. Click a drawing tool in the Tools group on the Graph Page tab. The pointer has a crosshair appearance when over
the graph page.

2. Release the mouse button to finish drawing the object.

Modifying Object Colors and Lines
Use the tools available below the drawing tools on the Tools group on the  Graph Page tab to modify line type,
thickness, color, line end appearance (arrow heads, etcetera), object fill color, pattern, and pattern color.

Changing Object Fills

Change fill patterns and colors of drawn rectangles and ellipses, and of graph symbols, bars, and boxes using the
Tools group on the  Graph PageGraph  tab

Note:  When you select multiple objects, fill options apply to all selected objects that can be filled, including
lines. Using Custom Colors and Incrementing Schemes on page 162

To change the background color of an object fill:

1. Select the object(s) to modify on the graph page.



 | Graph Page Basics | 135

2. In the Tools group on the Graph Page tab, click Fill Color.

Changing Lines

For drawn lines and graph lines, you can change line type, color, and thickness. Using Custom Colors and
Incrementing Schemes on page 162

To change line color:

1. Select the object(s) to modify on the graph page.
2. In the Tools group on the Graph Page tab, click Line Color.

3. To change line type and thickness, click Line Thickness.

Changing Line Ending Attributes

Edit line ending attributes for existing lines and arrows, or set the default line endings for drawn arrows. Line ending
attributes affect only plain lines and arrows, not graph lines.

To change line ending attributes:

1. Select the line(s) to modify:
2. In the Tools group on the Graph Page tab, click Line End.

Moving and Sizing Graphs and Objects

You can modify graph or object size and position either by using your mouse on the page, or by setting specific
position, size, and scaling options in Object Properties.

1. Double-click the object.
2. In the Object Properties dialog box, click the Size and Position tab.
3. To set the distance of the selected object from the top and the left of the page, under Position, move the Top

and Left sliders or type new values in the Top and Left boxes.
4. To change the size of the selected object, under Size, move the Height and Width sliders to set the size to

specific measurements, or scale the object to a new size by typing a percentage in the Height and Width boxes.

Using Your Mouse to Move Graphs and Objects
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When you use your mouse to move graphs, graph titles, axis labels, and automatic legends are automatically grouped
with a graph and move with it. You can move graphs and objects to other page windows.

Figure 53: Moving a Graph

To move a graph or object with your mouse:

1. Select the desired graph.
2. Release the mouse button. The graph moves to the new position.

Using Your Mouse to Change Graph and Object Size

The easiest way to adjust the size and shape of a graph is to resize the graph using the mouse. You can also specify
proportional scaling of graphs and objects so that the height and width ratios are maintained, and choose to rescale
graph and axis titles and tick marks accordingly.

To adjust graph or object size with the mouse:

1. View the page window.
2. Click the graph or desired objects to select them. Selected page objects are surrounded with small square handles.

Place the pointer over a handle.
3. Press and hold down the left mouse button to drag the handle to a new location. The shape of the pointer changes

when you move it over a handle, indicating the direction you can stretch the graph or object.
Drag a side handle to stretch or shrink an object horizontally, drag a top or bottom handle to stretch or shrink an
object vertically, or drag a corner handle to stretch an object two-dimensionally. A dotted outline of the resized
graph or object follows the pointer position.

Dragging a corner handle preserves the aspect ratio (relative height and width) of objects by default. Also, graph
text, symbols and tick marks are rescaled along with the graph. Graph Page Basics on page 111

4. Release the mouse button when finished. The graph or object resizes to the indicated size.

Remember:  Unlike graphs and drawn objects, you cannot stretch or shrink text labels manually. To resize
text, change the font size. Editing Text on page 144
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Nudging Graphs and Objects

You can use your keyboard arrow keys to move graphs and objects on a graph page. Select the object using your
mouse, and then move the object by using the arrow keys. You can also select objects by pressing the Tab key. Press
Shift+Tab to scroll back. Press Shift+Arrow to select multiple objects.

Pressing an arrow key moves the graph or object one point, or .014in. You can change this default setting in the
spw.ini file. If you have activated Snap-to grids, nudge will not work unless you set the nudge value to be greater
than or equal to the Snap-to value.

You cannot nudge computable objects, such as plots and all parts of plots, tick marks, and regression, reference, and
grid lines.

Moving Objects to the Front or Back

You can move selected objects so that they appear in front of or behind other page objects.

To move an object to the front or back:

1. Select the object to move by clicking it.
2. To move the selected object to the foreground, on the Graph Page tab, in the Format group, click Bring to

Front. The selected object is drawn in front of all other objects.

3. To move the selected object to the background, on the Graph Page tab, in the Format group, click the Bring
to Front drop-down list, and then click Send to Back. The selected object is drawn behind all other objects.

Note:  If you select more than one object, the selected objects remain in their relative front to back
positions. Grouped objects, including titles and legends with graphs, move as a single object.

Grouping and Ungrouping Objects

You can move and modify selected items on the page by grouping multiple objects as one object. To individually
modify grouped objects, you must ungroup them first. Objects and text must be grouped with the graph for them to
stay in place, and move with the graph if you shift the graph's location.

Note:  To learn how to ungroup legend items, see Moving Individual Legend Entries on page 147
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1. To group and ungroup objects:
a) On the Graph Page tab, in the Tools group, click Select Object.

b) On the Graph Page tab, in the Format group, click the Group drop-down list, and then click Ungroup. If you
have grouped a group, you may need to ungroup the objects as many times as they have been grouped.

c) Select the graph, by clicking it, if you wish to attach the graph to the objects or text.
d) Select the objects and text to group by holding down the Shift key while selecting individual objects. Handles

appear around the graph and each selected object.
e) On the Graph Page tab, in the Format group, click the Group drop-down list, and then click Group. The

Group button is available only when more than one object is selected. All selected objects are grouped and can
be selected, moved, sized, aligned, and positioned as a single object.

2. To ungroup objects on a graph page:
a) On the Graph Page tab, in the Format group, click the Group drop-down list, and then click Ungroup. If you

have grouped a group, you may need to ungroup the objects as many times as they have been grouped.
b) Select the group.
c) On the Graph Page tab, in the Format group, click the Group drop-down list, and then click Ungroup. If you

have grouped a group, you may need to ungroup the objects as many times as they have been grouped.

Arranging Graphs
Use the Arrange Graph dialog box to quickly arrange, resize, and set positions of multiple graphs on a page.

Arranging Graphs on a Page

1. Select the graph page.
2. On the Graph Page tab, in the Format Group group, click Arrange Graph.
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3. In the Arrange Graphs dialog box, select a layout for the page from the Layouts list. A preview of the layout
appears in the Preview window.

Figure 54: Arrange Graph Dialog Box

Layouts are stored in a template file called Layouts.jnt.

Note:  You must apply a layout to a page that has the same or fewer number of graphs.

4. Click Apply. The graphs on the page match the layout you selected, and the Layout dialog box remains open.
5. To arrange the graphs again, you can select another layout from the Layouts list, then click Apply, or click Close

to close the dialog box.

Adding New Pages to Layout.jnt

Layouts, like templates, use a .jnt extension and are stored in notebooks. A sample layout notebook, layout.jnt, is
provided with SigmaPlot and is set as the default layout source notebook. You can add a your own graph page to
this file to use the next time you arrange graphs on the page. For more information, see Applying Templates on page
119.

To add a page:

1. Click the Main Button and then click Open.
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2. In the Open dialog box, select Template Notebook (*.jnt) from the Files of type drop-down list.

Figure 55: Open Dialog Box
3. Select Layout.jnt from the SPW14_5 folder. For more information, see About SigmaPlot's User and Program

Files on page 5.
4. Click Open. The Layout.jnt notebook appears in the Notebook Manager.

Creating a Custom Layout Template File

You can create and save your own custom layouts by saving a graph page as a .jnt file.
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To create your own layout template file:

1. Create a graph page and position the graphs as desired.
2. Click Save in the Quick Access toolbar.

3. In the Save As dialog box, type the name of the new layout template notebook in File name box.
4. Click Save. Now you can add future layouts to their own separate layout notebook.

Changing the Default Layout Template File

To change the source template file:

1. Click the Main Button.

2. Click Options.
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3. In the Options dialog box, click the General tab.

4. Type the path and file name of the desired layout file in the Layout file field.
5. Click OK. The notebook becomes the default layout source.

Aligning Page Objects

You can align labels and objects with each other as well as with graphs and axes.

To align page objects:

1. Select the labels, graphs or other object(s) you want to align by holding down the Shift key while selecting
individual objects. (You must select more than one object in order to align them.)

2. On the Graph Page tab, in the Format group, click Align.
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3. Align dialog box, under Horizontal and Vertical, choose the appropriate options to align the selected objects
vertically, horizontally, or both. Graphical feedback for your selections appears in the lower right corner of the
dialog box.

4. To align selected objects relative to each other, select Each Other.
You must have multiple objects selected if you want to align selected objects relative to each other. Each Other
moves aligned objects with respect to the last selected object, which remains in a fixed position. The last selected
object can be distinguished from other selected objects by solid rather than hollow selection handles.

5. To align objects relative to the page margins rather than the page edge, select Page Margins.
6. Click OK.

Working with Grids and Rulers

Use grids and rulers to quickly and easily align graphs and objects on the page. You can show or hide grids and rulers
from the Format  group on the Graph Page  tab.

Using Rulers

Rulers are optionally displayed at the top and left hand side of all graph pages. They display the current units set in
the Options dialog box. You can choose between inches, centimeters, or points.

Using Snap-to

You can use Snap-to if the grids are displayed or hidden. To use grids:

1. On the Graph Page tab, in the Format group, click the Rulers > Grid Lines drop-down list.

2. Click Snap-to.
Graphs and objects snap to the nearest grid.

Using Crosshairs

Use Crosshairs as an object alignment tool. To turn on crosshairs, click the Crosshairs button on the upper left hand
corner of the graph page window. Crosshair lines extend from the pointer tip to the rulers and to the right and bottom
of the window, and follow the pointer.
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To hide crosshairs, click the Crosshairs button again.

Editing Text
Use the mini toolbar to add and edit text labels and legends to the graph page, in addition to editing automatically
created graph and axis titles. SigmaPlot automatically creates legends for every plot. You can format tick or
contourlabels, but you cannot edit their content.

To edit a graph title, right-click it, and then select Edit to open the Edit Text dialog box.

Creating Text Labels

You can add an unlimited number of text labels and legends to any graph page. SigmaPlot supports:

• All TrueType, PostScript, and other fonts installed on your system.
• Multiple lines of text aligned left, right, or centered, with adjustable line heights.
• Mixed fonts and other attributes within a single label.
• Multiple levels of superscripting and subscripting.
• Rotation of text in single degree increments.
• Color using up to 16.7 million different combinations of red, green, and blue

To create text labels or legends on a page:

1. Select and view the page window.
2. Click the Graph Page tab, and then in the Tools group, click Text.

This places you into text mode until another mode or tool is selected.
3. Click the page where you want the label to begin. A text box appears.
4. Select the font, character size, and other starting character attributes in the Text group.

The following table outlines the functions of each button. These buttons act on selected text, or set the format for
following text.

Control Function

Set Font
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Set Size

Normal Format

Bold

Italic

Underlined

Superscript One Level

Subscript One Level

Toggle to Greek (Symbol) Font

Left Align

Center Align

Right Align

Line Spacing (Multiline Paragraph Only)

Rotation

Color
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Legend Symbol

The Rotation, Alignment, and Line Spacing options affect the entire label, not just the selected text, and Line
Spacing is a minimum spacing control, not fixed. If you change the height of characters by changing font sizes or
by adding superscripts or subscripts, the line height adjusts automatically.

Tip:  Using the Default Text Properties you can set default text label attributes by opening the Text
Properties dialog box with no labels selected.

Tip:  In addition to using the Greek Characters button to add a Greek symbol to text, you can also select
existing text and choose Symbol as the font type in the Text Properties dialog box.

5. To add legend symbols to your text, click Symbols. The Symbol palette appears.
6. Type your label.

Editing Text and Individual Characters

To edit existing text on a graph page, you can click the text if you are in text mode, or if you are in select mode,
double-click the text. For more information, see Selecting Page Objects  on page 115.

Formatting Text

If you want only to change the attributes (the formatting) of selected text on a graph page, use the Formatting
toolbar. The Text Properties dialog box sets properties for all selected labels, and applies changes to all characters
within selected labels.

CAUTION:  If you have complex font and character changes within a label, take care not to overwrite these
formats with Text Properties dialog box settings.

Global Text Changes. The Text Properties dialog box is useful for formatting multiple labels as well as all text on a
graph. Select the graph and choose Text Properties, then select the attributes you want applied to all graph labels and
titles.

Default Text Properties. The Text Properties dialog box is used to set the default character and paragraph properties
for new labels. Open the Text Properties dialog box with nothing selected, and set the options you want applied to
new text labels.

To format text using the Text Properties dialog box:

1. Select the text object you want to modify.
If you want to modify several text objects, hold down the Shift key while clicking the objects, or drag a select
window around all objects.

2. To change the font, style, character size, or color of text, or to underline text, click the Font tab.

CAUTION:  If you have multiple text objects with different text properties selected, the attributes that are
not the same appear blank. Do not select an attribute for these options unless you want it to be applied to
all selected objects.
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3. To change paragraph attributes, including line spacing, alignment, or rotation, click the Paragraph tab.

Figure 56: Text Properties Dialog Box Paragraph Tab
4. Click OK to apply the changes and close the dialog box.

Working with Automatic Legends
Legends work as a key for your graph. They label what the different graph symbols, lines, or fills represent.
SigmaPlot automatically creates legends for all graphs, always placing them below the graph on the left side. Legend
entries are labeled using the titles of the columns plotted; if there are no column titles, column numbers are used
instead.

Move and modify legends as you would any other page object. They also have a special set of controls and features.
This section describes how to modify and control these automatic legend features.

You can also add legend symbols to any text label or title.

Editing Automatic Legends using Graph Properties

Direct Labeling of Legend Items

Editing Individual Legend Entries

To edit legend entries:

1. Select the legend on the graph page.
2. Click the Graph Page tab, and then use the properties available in the Text group.

Moving Individual Legend Entries

To move an individual legend entry:
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1. Select the legend entry.

2. Press the Up or Down Arrow keys to move the entry to your desired location.

Important:  Press the left mouse button to regain pointer access to the graph page.

Sizing Legend Symbols

You can individually control legend symbol size using Graph Properties or you can just as easily use the pop-up
menu that appears when you hover the pointer over the legend.

To resize legend symbols:

1. Select the entry in the legend.
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2. On the pop-up menu that appears, click the Legend Symbols button.

The Symbol dialog box appears.

Figure 57: Changing the Symbol Size
3. Under Symbols, select the symbol you would like to modify.
4. Control the symbol size and width using the Symbol Height and Symbol Width sliders.
5. Click OK when finished to close the dialog box.

Editing Automatic Legends using Graph Properties

You can edit a legend as a single object using Graph Properties.

To edit an automatic legend:
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1. Double-click the graph to open Graph Properties.

Figure 58: Legend Properties
2. In the Properties list select: Graph > Legends
3. To show or hide an automatic legend,  under Legend properties, select or clear Show legend.

4. To enclose the legend in a box, under Legend properties, select Framed in box.

5. To hide a legend box, under Legend properties, clear Framed in box.
6. To modify the line thickness and fill of the legend box,  under Legend properties, click Box to open the Object

Properties dialog box.
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7. To halt all automatic updating of the legend text for the whole legend, select Lock legend.

8. To show or hide individual legend entries for a specific plot or curve, under Legend appearance, select or
clear a legend entry from the For legend symbol list.

9. To annotate: Do this for as many legend symbols as you want.
a) Select the symbol from the For legend symbol drop-down list.
b) Under Legend title, click Title.

c) Then type text in the Edit Text dialog box and click OK.
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10. To move the legend symbols either to the right or to the left of text, select a position from the Symbol
placement drop-down list. If you have no legend symbol selected, this operates on all legends. If you select a
specific entry from the For legend symbol list, this option affects only that symbol.

11. To modify the appearance of the symbols for the current legend, select a symbol style from the Style drop-
down list.

The Style drop-down list only affects scatter and line plots. If you have no legend symbol selected, this operates
on all symbols. If you select a specific entry from the For symbol list, this option affects only that symbol.

12. To change the text size or style, click Font under Legend properties. The Text Properties dialog box appears.

Permanently Displaying and Hiding Automatic Legends

You can control the display of automatic legends either for all subsequently created graphs.

To view or hide automatic legends for all subsequently created plots:

1. Click the Main Button.

2. Click Options.
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3. Click the General tab.

4. Select Automatic legends to display the legend, or clear it to hide the legend.

Locking Legend Text

Locking legends halts all automatic updating of the legend text for the whole legend. For example, if you lock
the legend, you can change column titles and column data without resetting the legend label. The legend will
automatically update, however, if you remove or add a curve.

You can also lock a legend by editing it.

If you do not lock the legend, the legend automatically updates itself when you change column titles and data.
Locking the legend affects the entire legend, not just individual entries.

To lock legend text:

1. Double-click the graph to open Graph Properties.
2. In the Properties list, select Graph > Legends.

3. Under Legend properties select Lock legend.

Reordering Legend Entries

1. Double-click the graph to open Graph Properties.
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2. In the Properties list, select Graph > Legends.

3. Select a legend entry under For legend symbol.

4. Click either the Up or Down arrow to move the entry to its desired location.

Setting Legend Columns

To set the number of legend columns:

1. Double-click the graph to open Graph Properties.
2. In the Properties list, select Graph > Legends.
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3. Select your desired number of columns from the Column count drop-down list.

Direct Labeling of Legend Items

You can ungroup the legend move individual legend items to exact locations on the graph. To do so:

1. Double-click the graph to open Graph Properties.
2. In the Properties list, select Graph > Legends.

3. Select Direct Labeling under Legend Properties.

4. Close Graph Properties.



 | Graph Page Basics | 156

5. You can now select the entry in the legend and drag it to where you’d like it to appear on the graph page.

Changing Graph Page Format

Use the Page Setup dialog box to change graph page margins and size. This dialog box also controls which graphs on
a page are displayed or hidden from view, and the color of the page. For more information, see Hiding and Deleting
Objects from the Page  on page 131.

To change graph page margins and size:

1. Make sure a graph page is in view.
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2. Click the Main Button and then click Print and then click Page Setup.

Changing and Displaying Graph Page Margins

To change page margins, and to view or hide margins on the current page:

1. Make sure a graph page is in view.
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2. Click the Main Button and then click Print and then click Page Setup.

3. Click the Margins tab.

4. Use the Top, Bottom, Left, and Right options to specify the width or height of the corresponding page margin.
You can type values in the edit boxes using any of the available units of measurement; the value is converted to
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the current measurement units specified in the Options dialog box. Type in for inches, mm for millimeters, and
pts for points.

Note:  Margins do not affect printing, they are only a guide. The Align dialog box uses margins when
aligning the page.

5. Clear or check the Show Margins option by selecting it. If this option is checked, margins are displayed on the
page. To hide page margins, clear Show Margins.

6. Click OK.

Graph Page Size and Orientation

To change the size or orientation of the graph page:

1. Click the Main Button and then click Print and then click Page Setup.

2. Click the Page Size tab.

3. From the Paper Size drop-down list choose the appropriate size for the page, or select unique page sizes from the
Width and Height drop-down lists.

Restriction:  SigmaPlot does not support heights or widths greater than 32 inches.

4. To switch between portrait (normal) and landscape (sideways) orientation, select either the Portrait or
Landscape option.

5. Click OK to accept your changes and close the dialog box.

Attention:  If you change the page size or orientation, the page changes on the screen, but your graphs
remain in the same relative position. You may have to move the graphs back into position.

Changing Page Units of Measurement

Use the Page Options dialog box to change the units of measurement used on a graph page. Page units of
measurement are important when specifying margins and object size and position. These settings apply to all pages
and graph and object properties dialog boxes.

To change the unit of measurement used:
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1. Click the Main Button.

2. Click Options.

3. Click the Page tab.

4. From the Units box, select the unit of measurement to use on the page. You can choose to use inches, millimeters,
or points.

5. Click OK to accept the changes and close the dialog box.

Changing Page Color
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You can change the color of a page using the Page Setup dialog box. This is especially useful when creating output for
slides or for overhead projectors.

To change the color of a page:

1. Make the page active by selecting it.
2. Click the Main Button, click Print, and then click Page Setup.

3. Click the Page Layout tab.

4. From the Color drop-down list, select the color to use for the page. Select (Custom) to use or create a custom
color. Using Custom Colors and Incrementing Schemes on page 162

5. Click OK.

Tip:  If you want no background color to show up for pasted graphs (for example, pasting a graph into
PowerPoint), set the page color to None.

Page Color Default Setting

You can set the default color for a new page by opening the template file and change the attributes for the Normal
page using the Page Setup dialog box for that page.

If there is no template file or Normal page present, page settings are derived from the settings stored in the spw.ini
file.

For more information, see About SigmaPlot's User and Program Files on page 5.



Templates

You can overwrite the current page entirely by applying a template to it. This is not recommended as a means
of reformatting the page unless you intend to discard all changes made to the page up to this point. For more
information, see Using Templates on page 118.

Enabling Antialiased Lines on a Graph Page

Antialiasing is a technique used by computer graphic software to smooth out jagged, stair step lines. In SigmaPlot,
you control this in the Options dialog box.

1. Click the Main Button.

2. Click Options.

3. In the Options dialog box, click the Page tab.

4. Under AntiAliasing, select Enable AntiAliasing for page objects.

Using Custom Colors and Incrementing Schemes
Color drop-down lists have a (Custom) option that opens the Color dialog box, from which you can select a custom
color from over 16.7 million possible combinations of red, green, and blue (24-bit color).
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5
Worksheet Basics

Topics:

• Opening Worksheets
• Saving Worksheets to

Notebooks
• Setting Worksheet Display

Options
• Freezing Panes
• Moving Around the Worksheet
• Entering Data into a Worksheet
• Importing Files from Other

Applications
• Exporting Worksheet Data
• Descriptive Statistics for

Worksheets
• Displaying Worksheet Data
• Formatting Worksheets
• Cutting and Copying Data
• Entering and Promoting Column

and Row Titles
• Removing Outliers and Other

Data
• Indexing Data
• Using Excel Workbooks in

SigmaPlot
• Printing Worksheets

Worksheets are the containers for the data you analyze and graph. They are
spreadsheet-like in appearance but are limited in function, and are column
rather than cell oriented.

To enter data, you can type in, paste, or import data from other sources. You
can also automatically generate and place data in worksheet columns by data
transforms and statistical procedures.
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Opening Worksheets
You can open as many worksheets as you like in a single notebook file. Each worksheet you open is assigned to its
own notebook section.

To open a worksheet:

1. Right-click the notebook file in which you would like the new worksheet to appear.
2. In the shortcut menu click New and then click Worksheet.

Saving Worksheets to Notebooks
Worksheets are saved along with the other contents of notebook files, including graph pages, reports, and so on.

1. To save data for the current worksheet to a notebook file:
a) Right-click the worksheet in the Notebook Manager, and then click Save.

If you are saving the notebook for the first time, the Save As dialog box appears prompting you for a file name
and path for the notebook file. If you are saving the worksheet to an existing notebook file, the notebook is
updated to include the new worksheet or the changes to the existing worksheet.

2. To export a worksheet as a different file type (non-notebook file):
a) With the worksheet in view, click the Home tab.
b) In the Export group, click Worksheet.

Setting Worksheet Display Options
Use the Options dialog box to set the default display settings for worksheets.

Tip:  You can also change individual cells or blocks of cells using the Format Cells dialog box. These
custom formats remain even after editing options in the Options dialog box.

To set worksheet display options:

1. Click the Main Button.

2. Click Options.
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3. In the Options dialog box, click the Worksheet tab. For more information, see Displaying Worksheet Data on
page 178.

Figure 59: The Options Dialog Box Worksheet Tab Data and Time Options

Options on the Worksheet tab include:

• General. Select to turn Worksheet undo on or off, or to set SigmaPlot to display an error message if duplicate
column titles appear when running transforms. Turn Worksheet undo off if you are using a large data set and
have a small amount of memory.

• Numeric. Select to control how many decimal places you want to appear in the worksheet, or if you want to
use E notation. For more information, see Displaying Worksheet Data on page 178.

• Date and Time. Select to set the display for the specified columns. For more information, see Displaying
Worksheet Data on page 178.

• Statistics. Use the Show and Hide buttons to move the statistics between the Shown and Not Shown lists.
These buttons are available only if a Statistics worksheet is in focus. For more information, see Descriptive
Statistics for Worksheets  on page 175.

• Appearance. Set column widths, row heights, color and thickness of the worksheet grid lines, adjust data
feedback colors, and select a font style and size. For more information, see Displaying Worksheet Data on
page 178.

Freezing Panes
You can freeze panes to keep rows and columns visible as you scroll through the worksheet.

To freeze panes:

1. Select a cell below and to the right of where you want the split to appear.
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2. On the Worksheet tab, in the View group, click Freeze Panes.

Moving Around the Worksheet
You can move around the worksheet using scroll bars or, move the highlighted worksheet cursor with the keyboard.

• # or #. Move one column right/left
• # or #. Move one row up/down
• Page Up or Page Down. Move one window view up/down
• End. Move to end of column
• End+End or Ctrl+End. Move to end of worksheet
• Home. Move to top of column
• Home+Home or Ctrl+Home. Move to column one, row one
• Ctrl + →. Move to last column of next data block
• Ctrl + ←. Move to first column of previous data block
• Ctrl + ↑. Move to top row of previous data block
• Ctrl + ↓. Move to last row of last data block
• F2. Put cells into Edit mode

Going to a Cell

You can move the worksheet cursor to any cell in the worksheet by specifying the column and row number in the Go
to Cell dialog box.

To go to a cell:

1. Press Ctrl + G.
2. In the Go to Cell dialog box, enter the desired column and row number.

3. To select the block of cells between the current highlight location and the new cell, click Extend Selection to
Cell.

4. Click OK to move to the new cell.

Using the Worksheet Shortcut Menu

In addition to the commands available in SigmaPlot ribbons, right-clicking the worksheet displays a shortcut menu.
The commands on the right-click shortcut menu include the Cut, Copy, Paste, Transpose Paste, Insert Cells and
Delete Cells commands.
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Figure 60: Right-click Edit Worksheet Menu

Entering Data into a Worksheet
This section describes entering data into worksheet columns, and formatting the columns for numeric, label, or date
and time display.

To enter data into a SigmaPlot worksheet:

1. Place the cursor in a cell.
2. Type a number, label, or date and time value.
3. Press Enter to move down one row, or use the arrow keys to move around the worksheet.
4. If you make a mistake entering data, press Ctrl + Z.

Entering Dates and Times

Enter dates and times using delimiters. The delimiters used are determined by the Windows Regional Settings. For
more information, see Regional Settings on page 187

Date Delimiters

The default date delimiter for most systems is a forward slash. An entry that displays only two fields of a date value
is assumed to be day and month. If the second field's value is greater than 31, months and years are assumed. Entries
with two delimiters assume month/day/year. If you enter only two digits for the year, the century defined in your
Regional Settings is implied.

Time Delimiters
The default time delimiter is usually a colon (:). Entries displaying two fields of a time value are assumed to be hours
and minutes. If PM is not specified, hours less than 12 are assumed to be morning hours. An entry with two colons
assumes hours:minutes:seconds.

Insertion and Overwrite Modes

Press Insert on your keyboard to switch between overwrite and insert data entry modes.

If in Insertion Mode, Ins appears in the status bar.
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If in Insertion Mode, new data entered in a cell does not erase the previous contents. Any existing data in the column
is moved down one row. Pasting a block of cells pushes existing data down to make room for the pasted cells. If you
cut or clear data, data below the deleted block moves up.

If not in Insertion Mode, the worksheet is in overwrite mode. Data entered into a cell replaces any existing data. If
you paste a block of data, the block overwrites existing data.

Importing Files from Other Applications
You can import data from other applications into an existing worksheet for graphing, worksheet display, or running
regressions. When you import data, it appears at the position of the worksheet cursor.

• Excel 2007 files (.xlsx)
• SAS Data Set (V6) (*.sd2)
• SAS Data Set (V8 and V9) (*.sas7bdat)
• SAS Export File (*.xpt)
• Minitab (v8 to v12) (*.mtw, *mpj)

You can import the following file types into SigmaPlot worksheets:

• SPSS (.sav).
• SigmaPlot 1.0 and 2.0 files (.spw).
• SigmaPlot Macintosh 4 Worksheet.
• SigmaPlot Macintosh 5 Worksheet.
• SigmaStat 1.0 files (.spw).
• SigmaPlot and SigmaStat DOS files (.spg, .sp5).
• TableCurve 2D and 3D files.
• Microsoft Excel files (.xls).
• Lotus 1-2-3 files (.wks, .wk*).
• Quattro/DOS files (.wk*).
• Plain Text files (.txt, .prn, .dat, .asc).
• Comma Delimited files (.csv)
• SigmaScan.
• SigmaScanPro Worksheets.
• SigmaScan Image
• Mocha Worksheets.
• Axon Text and Binary formats.
• Paradox (.db)
• Symphony (.wkl, .wri, .wrk, .wks)
• SYSTAT (.sys, .syd)
• Microsoft Access (.mdb)

When you import data from another application that is left-justified, SigmaPlot assumes it is text.

To import data:
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1. Place the cursor to the worksheet cell where you want the imported data to start.
2. On the Worksheet tab, in the Import group, click Import File.

3. In the Import File dialog box, select the type of file you want to import from the Files of Type drop-down list.
4. Change the drive and directory as desired, select the file you want to read, then click Import, or double-click the

file name. Depending on the type of file, the data is either imported immediately, or another dialog box appears.

Copying and Pasting Data from Other Applications

Perhaps the easiest way to import data from another application is to simply copy and paste it from that application's
spreadsheet into SigmaPlot. This is perhaps the simplest method, especially if you cannot directly import the data into
SigmaPlot. For more information, see Moving Data on page 194.

Once you have copied and pasted the data, you can promote the top row of data - the variable names - to become the
column titles.

Importing ODBC Databases

You can import ODBC compliant databases into SigmaPlot. To import a database, first define an ODBC Data Source.
After defining the data source, you can then either import tables or import using SQL (structured query language).

Note:  For more information on SQL, see the many sources and tutorials available on the Internet.

To define the ODBC data source:

1. On the Worksheet tab, in the Import group, click Import Database.

2. In the ODBC Options dialog box, click the Select ODBC Data Source tab. The User and System Data Sources
list contains all defined the ODBC data sources.

3. To add a data source that is not on the list, click Add.
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4. In the ODBC Data Source Administrator dialog box, click the User DSN tab.

5. Select a name from the User Data Sources list.
6. Click Add.
7. In the Create New Data Source dialog box, select a driver for which you want to set up a data source from the

Name list.

8. Click Finish.
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9. In ODBC Setup dialog box (this is specific to the driver you selected for the data source), enter a name to identify
the new data source in the Data Source Name box.

10. Under Database, click Select.
11. In the Select Database dialog box, select the database, and click OK.
12. Click OK again to close the ODBC Setup dialog box.
13. Click OK in the ODBC Data Source Administrator dialog box.
14. Click OK in the ODBC Options dialog box.
15. If the data source already appears in the User and System Sources drop down-list, select it. The Import

Table dialog box appears.
16. In the Import Table dialog box, select a table from the Select Table/Query drop-down list.
17. Select fields in the table by moving fields from Unselected fields to Selected fields by double-clicking a selection

in the list. You can also click << and >> to move all the selections, or < and > to move them individually.
18. Click Import to import the fields into the worksheet. Field names in the database become column headings in the

worksheet. All records in the table are imported.
19. To import using SQL, on the ODBC Options dialog box click the SQL Query tab.

20. Under Recently Used SQL, type the name of the path where the SQL is stored, or select a recently used SQL
(Structured Query) from the drop-down list.

21. Click Open to open an .spq file.
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22. Click Import to run the query and import the data.

• If the SQL is valid, SigmaPlot imports that data into the worksheet based on the SQL statement. Field names
in the database become column headings in the worksheet. Only the records defined by the SQL (rows) are
imported.

• If the SQL is invalid, you are prompted to correct the SQL.

Importing Excel as ODBC

When importing Excel spreadsheets using the ODBC Options dialog box, you must first assign a name to each data
set (or a range of data) which is then imported as a table; otherwise, the Excel file will not import.

SigmaPlot, SigmaStat, SigmaScan, and Mocha Worksheets

If you are importing a SigmaPlot, SigmaStat, SigmaScan, or Mocha file, a dialog box appears prompting you to select
a range of data to import.

1. Select the range of data by specifying the start and end of the range; the default is the entire range.
2. Click Import to place the data in the worksheet.

MicroSoft Excel, Lotus 1-2-3 and Quattro Files

To import a spreadsheet:

1. On the Worksheet tab, in the Import group, click Import File.

2. In the Import File dialog box, select an .xls or .wks file to import, and click OK.
3. In the Import Spreadsheet dialog box, select either the entire spreadsheet or a specified range of cells. Specify

cells using the standard Lotus 1-2-3 notation (for example, A1:C50 for a range from cell a1 to cell c50).

4. When you have finished specifying the range to import, click Import. The selected data is imported.

Note:  The dialog box indicates whether or not the worksheet is in overwrite or insert mode, and where the
imported data will begin.

5. To import spreadsheet data from non-compatible programs, save the spreadsheet as either an Excel or text
file, then import that file.
If you want to use an Excel workbook as an actual Excel workbook within SigmaPlot, you must open the
workbook instead of importing it. Importing places the Excel data into a SigmaPlot worksheet, and does not open
the workbook as an actual Excel workbook.
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Importing Text Files

If you are importing a text file, the Import Text dialog box appears. Use this dialog box to view the text file and to
specify other delimiter types, or to build a model of the data file according to custom column widths.

Figure 61: Import Text Dialog Box

Fastpath:  A quicker method of importing text is copying the data in your source application, then opening
SigmaPlot and pasting the data.

1. To specify a different column separator, select Delimiter to activate the delimiter options; then select the
appropriate type. You can select commas, hyphens, or any other characters. For example, many databases use
semicolons (;) as delimiters.

2. When you are finished specifying the file parameters, click Import. The specified data from the file is imported.

Importing Axon Files

SigmaPlot can import data files produced by Axon Instruments, Inc. laboratory equipment and data acquisition
programs. SigmaPlot imports both text and binary data files; if you select one of these options, the Import Axon
dialog box appears prompting you to select a range of data to import. The File selected is indicated in the dialog box
title.

Select the range of data by specifying the Row and Column ranges; the default is the entire range. Click Import to
place the data in the SigmaPlot worksheet.

SPSS (.SAV)

If you are importing SPSS (.sav) files, the Import Worksheet dialog box appears prompting you to select variables to
import.

To select variables to import:

1. In the Unselected Variables list, select a variable you want to import.
2. Click the single > arrow to move that variable to the Selected Variables list.
3. Click the double >> arrow to move the entire contents of the Unselected Variables list to the Selected Variables

list.
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4. Click Import to place the data in the SigmaPlot worksheet.

Note:  SPSS data files use category data as the default data format.

Exporting Worksheet Data
Saving worksheets as non-notebook files is useful if you want edit your data in other spreadsheet applications.
Exporting worksheets does not export associated graphs.

You can only export the entire worksheet. If you want to export a portion of the worksheet, delete the portion you do
not want to export, then export the remainder of the worksheet.

You can export worksheets as the following file types:

• MS Excel (*.xls)
• SigmaStat 3.1 Notebook
• SigmaStat 3.0 Notebook
• SigmaStat 2.0 Notebook (*.snb)
• Comma Delimited (*.csv)
• Tab Delimited (*.tab)
• Plain text (*.txt)
• SigmaPlot 2.0 (*.spw)
• SigmaPlot 1.0 (*.spw)
• SigmaPlot Macintosh 5 Worksheet (*.spw)
• SigmaScan, SigmaScan Pro (*.spw)
• Mocha, SigmaScan Image (*.moc)
• Lotus® 1-2-3 v1.0 (*.wks)
• DBase III (*.dbf)
• Quattro Pro v1.0 (*.wq1)
• Paradox v3.0 (*.db)
• Symphony v1.0 (*.wrk)
• SYSTAT (*.syd)
• SAS Data Set (V6) (*.sd2)
• Minitab (V11) (*.mtw)
• Minitab (V11) (*.mpj)

Exporting a Worksheet

1. Select the worksheet you want to export by opening and viewing it, or selecting it in the notebook window.
2. On the Home tab, in the Export group, click Worksheet.

3. In the Export File dialog box, select a file format from the Files of type drop-down list, and then enter the file
name, directory, and drive for the exported file.

4. Click Export to create the file.
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Exporting Worksheets as Text Files

When you export a worksheet as a text file, tabs or commas are used to separate data columns and data is saved at full
precision. If you want to save a text file with data as it appears in the worksheet rather than at full precision, copy the
selected data to the Clipboard, paste it into a text editor, and save it as a text file.

Exporting to SYSTAT

When exporting data to SYSTAT, make sure that there are no text cells or indefinites in data columns you export, or
they will be converted by SYSTAT into text instead of numbers.

Descriptive Statistics for Worksheets
SigmaPlot automatically calculates a number of basic statistical values for all the data in your worksheet columns. For
more information, see Printing the Current Worksheet on page 205.

To view the statistics for the currently selected worksheet, on the Worksheet tab, in the View tab, click View
Column Statistics.

The running calculations performed for each column appear in a Column Statistics window for that worksheet.

Figure 62: Column Statistics Worksheet

Available Statistics

To determine the statistics shown in the Statistics windows, use the Statistics Options dialog box. Most calculations
ignore empty cells, missing values, and text. The following statistics appear in the Column Statistics window.

Mean.The arithmetic mean, or average, of all the cells in the column, excluding the missing values. This is defined by

Std Dev. The sample standard deviation is defined as the square root of the mean of the square of the differences from
their mean of the data samples xi in the column. Missing values are ignored.
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Std Err. The standard error is the standard deviation of the mean. It is the sample standard deviation divided by the
square root of the number of samples. For sample standard deviations

95% Conf. The value for a 95% confidence interval. The end points of the interval are given by:

where x is the mean, s is the sample standard deviation, and t(v,z) is the t statistic for v= n-1 degrees of freedom and z
= 1.96 standard normal percentile equivalent.

99% Conf. The value for a 99% confidence interval. The end points for this interval are computed from the equation
for the 95% confidence interval using z = 2.576.

Size. The number of occupied cells in the column, whether they are occupied by data, text, or missing values.

Sum. The arithmetic sum of the data values in the column.

Min. The value of the numerically smallest data value in the column, ignoring missing values.

Max. The value of the numerically largest data value in the column.

Min Pos. The smallest positive value.

Missing. The number of cells in the column occupied by missing values, denoted with a double dash symbol (--).

Other. Either text or an empty cell.

Statistics Options

To display only a portion of the available statistics, use the Worksheet Options dialog box, then select the column
statistics to show or hide. For more information, see Displaying Worksheet Data on page 178.

To specify which statistics are shown or hidden:

1. On the Worksheet tab, in the View tab, click View Column Statistics.

2. Click the Main Button.
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3. Click Options.

4. In the Options dialog box, click the Worksheet tab.

5. Select the statistic(s) you want shown or hidden.
6. Select the appropriate options to change the column widths and data display.

Engineering and E Notation

In SigmaPlot, E Notation is synonymous with scientific notation. The E expresses the power of 10.

For example, 1.23 e+03 is 1230, or, equivalently, 1.23 e+03. Select E Notation When Needed or E Notation Always
on the Worksheet tab of the Options dialog box if you want to use Scientific Notation.

Engineering Notation, which you can select as an option on the Worksheet tab of the Options dialog box, uses
integral powers of 3 (with 10 as the base).

Number Scientific Notation Engineering Notation Engineering Notation (SigmaPlot)

1230 1.23 e+03 1.23 e+03 1.23 x 10^3

12300 1.23 e+04 12.3 e+03 12.3 x 10^3

123000 1.23 e+05 123 e+03 or 0.123 e+06 123 x 10^3 or 0.123 x 10^6
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Displaying Worksheet Data
You can display data in your worksheet columns as:

• Text
• Numbers
• Date and Time values
• Graphic information

Figure 63: Numbers are displayed in Column 1, dates are displayed in Column 2, and text is shown
in Column 3

You can enter numbers, labels, and dates and times directly into the worksheet. You can also convert numbers to dates
and times and vice versa. You can change column widths, number decimal places, or date and time format, and you
can also change the color and thickness of the worksheet gridlines, and adjust data feedback colors.

Tip:  You can format columns to override the defaults set using the Options dialog box.

Sizing Columns and Rows

If the contents of your column exceed the column width, cell contents display as pound symbols (####). Label entries
are truncated.

1. To change a column width, drag the boundary on the right side of the column heading until the column is the size
you want.

2. To change a row height, drag the boundary below the row heading until the row is the size you want.
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3. To adjust column width and row height using the Options dialog box:
a) Click the Main Button.

b) Click Options.

c) On the Options dialog box, click the Worksheet tab.
d) In the Settings For list, click Appearance.
e) Set column width and row height in the Column Width and Row Height drop-down lists.

f) Click OK to apply the changes and close the dialog box. SigmaPlot's worksheet can display up to fourteen
digits of precision regardless of how many decimal places you specify.

Changing the Appearance of the Worksheet Grid

You can change the color and thickness of worksheet grid lines.

To change the grid appearance:
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1. Click the Main Button.

2. Click Options.

3. On the Options dialog box, click the Worksheet tab.
4. In the Settings For list, click Appearance.
5. Set color and thickness in the Color and Thickness drop-down lists.

6. Click OK to apply the changes and close the dialog box.

Setting Data Feedback Colors

Data Feedback highlights the cells and columns on the worksheet that correspond to the X and Y values of the
selected curve or data point. You can change these colors on the Options dialog box.

To change the data feedback colors:
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1. Click the Main Button.

2. Click Options.

3. On the Options dialog box, click the Worksheet tab.
4. In the Settings For list, click Appearance.
5. Set data feedback colors and thickness in the X and Y drop-down lists.

6. Click OK to apply the changes and close the dialog box.

Setting Decimal Places

To set the number of decimal places used for worksheet values:
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1. Click the Main Button.

2. Click Options.

3. In the Options dialog box, click the Worksheet tab.
4. In the Settings For list, click Numeric.
5. Select the number of decimal places from the Decimal Places drop-down list.

6. Click OK to accept the changes and close the dialog box. If the number of decimal places exceeds the column
width they appear as # symbols.

Changing Numbers Display

You can display numbers in the worksheet in four ways:
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Numeric Display Description Example

E Notation When Needed Displays worksheet data as
scientific notation only when
the length of the value exceeds
the width of the cell. The default
column width is twelve.

12.00

E Notation Always Always displays data as scientific
notation. The number of decimal
places is set in the Decimal Places
edit box.

12.00e+1

Fixed Decimal Displays data with a fixed number
of decimal places. Set the number
of decimal places in the Decimal
Places edit box. The number
of decimal places allowed is
limited by the column width –
the maximum number of decimal
places cannot exceed the column
width or it appears as a series of
# symbols. The default setting for
decimal places is two.

12.00

General Displays data exactly as you enter
it in the worksheet.

12

To set the numeric display for your worksheet:

1. View the worksheet.
2. Click the Main Button.

3. Click Options.

4. In the Options dialog box, click the Worksheet tab.
5. In the Settings For list, click Numeric.
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6. Select a Numeric format setting from the Display As drop-down list.

Figure 64: Selecting Numbers Display Format
7. To use engineering scientific notation for worksheet values, select Engineering Notation. For more

information, see Engineering and E Notation on page 177.
8. Click OK to accept the settings and close the dialog box.

Changing Date and Time Display

SigmaPlot has a variety of date/time displays. When you enter a value into a date/time formatted cell, SigmaPlot
assumes internal date/time information about that value from the year to the millisecond. For example, if you enter a
day and month, you can display the month and year.

To view and modify the current settings:

1. Click the Main Button.

2. Click Options.



 | Worksheet Basics | 185

3. In the Options dialog box, click the Worksheet tab.
4. Click the Worksheet tab.
5. Select the Date and Time from the Settings for list.

6. Type one of the following examples into the Date box, or select a format from the drop-down list:

• M/d/yyyy. 10/8/2005
• M/d/yy. 10/8/05
• MM/dd/yy. 10/08/05
• MM/dd/yyyy. 10/08/2005
• yy/MM/dd. 05/10/08
• yyyy-MM-dd. 2005-10-08
• MMMM. Complete month
• dd-MMM-yy. 08-Oct-05
• dddd, MMMM dd, yyyy. Tuesday, October 08, 2005
• MMMM dd, yyyy. October 08, 2005
• dddd, dd MMMM, yyyy. Tuesday, 08 October, 2005
• dd-MMMM-yy. 08-October-05
• dd MMMM, yyyy. 08 October, 2005
• gg. Era (AD or BC)
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7. To change the display Time format, type one of the following examples into the Time box, or select a format
from the drop-down list:

• hh or h. 12 hour clock
• HH or H. Military hours
• mm or m. Minutes
• ss or s. Seconds
• uu or u. Milliseconds
• H: h: m: s: or u. No leading zeroes for single digits
• HH: hh: mm: ss: uu. Leading zero for single digits
• tt. Double letter AM or PM
• t. Single letter AM or PM

8. Click OK to accept the settings and close the dialog box.

Setting Day Zero

SigmaPlot provides three date systems:

• 1900
• 1904
• -4713

Note:  SigmaPlot by default uses the system zero date of 4713 BC.

Setting a Start Date is only necessary if you are importing numbers to be converted to dates, or converting dates to
numbers for export. The starting date must match the date used by the other application.

Note that SigmaPlot recognizes day zero as starting at 0. Some spreadsheet software products begin day zero at 1.
This means that you may have to set your starting date in SigmaPlot to one day prior.

Also, unlike Microsoft Excel, SigmaPlot correctly treats the year 1900 as a normal year and not a leap year (a century
year, to be a leap year, must be divisible by 400). If you're importing from Microsoft Excel, dates from January 1st
1900 to the day before March 1st 1900 will differ by one day.

To set the start date:

1. Click the Main Button.

2. Click Options.

3. In the Options dialog box, click the Worksheet tab.
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4. Select a date from the Day Zero drop-down list, or type your own start date. The default start date is 1/1/1900.

Figure 65: The Day Zero Drop-down List

Day Zero becomes the number 01.00 when you change from Date and Time to Numbers format. The basic unit
of conversion is the day; that is, whole integers correspond to days. Fractions of numbers convert to times. Zero
becomes Day Zero, and negative numbers entered into the worksheet convert to days previous to the Day Zero
start date.

Conversion between date/time values and numbers can occur for the calendar range of 4713 BC to beyond the
year 4,000 AD. The internal calendar calculates dates using the Julian calendar until September, 1752. After that,
dates are calculated using the Gregorian calendar.

Note:  If you convert numbers to dates, a start date is applied. If you convert the dates back to numbers, be
sure you use the same start date as when you converted them, or they will have a different value.

Regional Settings

Drop-down lists in the Options dialog box worksheet tab use the current date/time settings in your operating system.
The Windows Regional Settings control date/time delimiters, 12 or 24 hour clock, and AM/PM display.

Date and time display formats may be affected by your operating system's Regional Settings. For example, if your
Time Zones are specified as British (English), your date values appear as dd/mm/yy. If the setting is US (English),
your date values appear as mm/dd/yy. If you want to view or modify the current settings, or view alternative settings
available on your system, click the Regional Settings button, or modify them directly from the Windows Control
tab.

Note:  Date and time values appear on the worksheet using the date and time delimiters, generally a forward
slash (/) or colon (:). For more information, see Entering Dates and Times on page 167.

Using Date/Time Format with Other Programs

You can copy date/time values from a SigmaPlot worksheet and paste them into other programs, such as an Excel
workbook, or, you can copy date/time values from another program and paste them into a SigmaPlot worksheet. If
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the date/time format you are pasting is larger than the worksheet column width, you may need to change the column
width.

If you are copying date/time values from another program to SigmaPlot, make sure that the program is displaying
dates/times in a format that SigmaPlot accepts as valid data entry. For example, if you are pasting dates from Excel,
make sure the dates are displayed as numbers separated by slashes (/), or whatever date delimiter Windows is set to.

To change Excel formats, see your Excel reference.
Keep the following in mind when copying or importing date and time formatted data:

• Pasted or imported numeric data does not automatically convert to Date and Time format. You must convert it
using the same start date (Day Zero) that is used by the other program.

• When copying worksheet values, values are copied as numeric strings, not date/time.
• SigmaPlot recognizes Date and Time formats imported from Excel, but you will need to convert most other non-

text dates and times from numbers to dates and time.

Formatting Worksheets
You can format entire columns even if they contain no data. If a populated cell in a column is already specifically
formatted, as you enter data the entire column continues to use the same format, provided the data is appropriate to
that format.

When importing data, the import format takes precedence over the column format.

Remember:  Formatting worksheets is not the same as setting worksheet display options. Setting worksheet
display options sets the default for the entire worksheet. You can override these defaults by formatting
worksheet columns using the Format Cells dialog box.

To format worksheet columns:

1. Select an entire column.
2. On the Worksheet tab, in the Cells group, click Format.

3. In the Format Cells dialog box, click the Data tab.
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4. Select a Type. The Type you select determines which Settings are available. Available Types are:

• Numeric. Select Numeric to control how many decimal places you want to appear or if you want to use E
notation in a selected worksheet column.

• Text. Select text to wrap text using the existing column width.
• Date and Time. Select Date and Time to set the display for the specified columns.

Tip:  If you select the Date and Time format, not only can you select a format from the Date and Time
drop-down lists, you can also manually type a format into the same field.

Setting Row and Column Size

To set row and column size for a selected block of data:

1. Select a block of data on the worksheet.
2. On the Worksheet tab, in the Cells group, click Format.

3. In the Format Cells dialog box, click the Rows and Columns tab. The selected box reflects the selected block of
rows and columns.

Figure 66: The Format Cells Dialog Box
4. Set column width and row height from the Column width and Row height drop-down lists.
5. To apply the row and column formats to the whole worksheet, select Apply to entire data region.
6. Click OK to apply the changes and close the dialog box. The worksheet appears with new column and row sizes

for the selected cells.

Note:  Setting row height and column width from the Format Cells dialog box only changes the selected
block of data.

Switching Between Date and Time and Numeric Display

You can convert between date/time and numeric display when:

• Importing data.
• Switching numbers to dates.
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• Modifying the display between date, time and date/time.

To display worksheet cells in Date and Time format:

1. View the worksheet.
2. Select the data you wish to display in date/time format.
3. On the Worksheet tab, in the Cells group, click Format.

4. In the Format Cells dialog box, click the Data tab.

5. In the Type list, click Date and Time.
6. Click OK. The data is displayed showing the date, time, or date and time as specified. The dates and times that are

entered as dates and times are automatically displayed as such.

Customizing Date and Time Formats

SigmaPlot comes with a long list of data formats far beyond what you see in its drop-down list in the Format Cells
dialog box. All you need to do is type one into the field itself. A complete listing of all the available date and time
formats appears below.

To change the date and time format:

1. View the worksheet.
2. Select the data you wish to display in date/time format.
3. On the Worksheet tab, in the Cells group, click Format.
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4. In the Format Cells dialog box, click the Data tab.

5. To change the date format, type any format from the following table, using any additional characters as
delimiters (for example, slashes, commas, spaces, and so on. As you enter a different format, the Sample fields
shows an example of the labels.
Option Description

Typing: Displays:

M/d/yy No leading 0 for single digit month, day or year

MM/dd/yy Leading 0 for single digit month, day or year

MMMM Complete month

dddd Complete day of week

yyy or yyyy Complete year

MMM Three-letter month

ddd Three-letter day of week

gg Era (AD or BC)

6. To change the time format, use any format from this table.
Option Description

Typing: Displays:

hh or h 12 hour clock

HH or H 24 hour clock

mm or m Minutes

ss or s Seconds

uu or u Milliseconds

H:h:m:s:or u No leading zeroes for single digits

HH:hh:mm:ss:uu Leading zero for single digits

tt Double letter AM or PM

t Single letter AM or PM
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Sorting Data

You can use SigmaPlot's built-in Sort Selection transform to move selected blocks of data in ascending or descending
order according to the order in a key column. You can sort both numerically and alphabetically.

Tip:  Because the sort command sorts data in place, if you want the original data to remain intact, copy the
data to a new location and sort the copied data.

To sort selected data:

1. Use the mouse or keyboard to select the data you want to sort. Only the selected columns and rows are sorted;
unselected values within a column are ignored.

2. On the Worksheet tab, in the Edit group, click Sort Selection.

The Sort Selection dialog box appears.

This example shows a range of data to be sorted, in descending numerical order, using the Salary column as the

key column.

Figure 67: The Sort Selection Dialog Box
3. To set the key column, select its column title or column number from the Set Key Columns drop-down list.
4. Under Sort Order, select either Ascending or Descending.
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5. Click OK to sort the data in place and close the Sort Selection dialog box.
Here you can see that only the selected data is sorted, in descending numerical order, using the Salary column as
the key column.

Figure 68: Results of Sorting a Selection

Cutting, Copying, and Pasting Graphs and other Page Objects

Cut and copy selected page objects to the Clipboard.

Stacking Columns

You can merge the contents of two or more columns by stacking the column contents on top of each other.

1. Click a worksheet in view, click the Analysis tab.
2. In the Transforms group, select Statistical > Stack.

The Pick Columns for Stacked Columns dialog box appears.
3. Select the output column to place the stacked data by clicking the worksheet column.
4. Select the columns to stack, either by clicking the worksheet columns, or selecting the column from the Data for

Input drop-down list.
5. Click Finish to stack the contents of the selected input columns in the selected output column.

Restriction:  You cannot stack blocks of data, only entire columns.

Selecting a Block of Data

There are several ways to select a block of worksheet cells. You can:

• Drag the mouse over the desired worksheet cells while pressing and holding down the left mouse button.
• Hold down the Shift key and press the arrow, PgUp, PgDn, Home, or End keys.
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• Click Go To in the Edit group on the Worksheet tab.

Figure 69: Selecting a Block of Data in the Worksheet

1. To select an entire column, move the pointer to the column title row and click.
2. To select entire rows, move the pointer to the row title column and click.

Cutting and Copying Data
Cut removes a selected cell or block from the worksheet and copies it to the Clipboard. Copy copies data to the
Clipboard without deleting it from the worksheet.

Pasting Data

To paste data:

1. Click or move the worksheet cursor to the cell where you want to paste the data, or to the upper-left corner of the
block.

2. Press Ctrl+V. Any data in the Clipboard is placed in the worksheet.

Moving Data

Move a block of data by cutting it, selecting the upper-left cell of the new location, then pasting the block. For more
information, see Deleting Data on page 194.

Deleting Data

Press Delete. This operation does not copy data to the Clipboard, and is faster than cutting.

Inserting Blocks of Cells, Columns, and Rows of Data

You can insert blank blocks cells, rows, and columns into the worksheet, and fill them with data. If you're moving and
copying cells, you can insert them between the existing cells to avoid pasting over data.

To insert a column, row, or blocks of cells into the worksheet:

1. Drag the mouse over the region where you want the empty block of cells, column, or row to appear. The selected
region of cells indicates exactly which cells will be inserted.
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2. Right-click, and then on the shortcut menu, click Insert Cells.

The Insert Cells dialog box appears.

Figure 70: Inserting an Empty Block of Data in the Worksheet
3. Select the direction you want the existing data to shift when the cells are inserted, or to insert an entire column or

row, select Insert Columns or Insert Rows.
4. Click OK. The column, row, or block of cells appears on the worksheet.

Deleting Blocks of Cells, Columns, and Rows of Data

When you delete blocks of cells, columns, and rows, you are also permanently erasing the data. It will not be
available on the Clipboard.

To delete columns, rows, and blocks of cells from the worksheet:

1. Drag the mouse over the block of cells, column, or row you wish to delete.
2. Click OK.

Switching Rows to Columns

You can rearrange data from a row-oriented format to a column orientation, or vice versa. When you swap data,
SigmaPlot pastes contents with the row and column coordinates transposed.

To swap data column and row positions:

1. Select the block of data to transpose.
2. Cut or copy the selected data.
3. Select the cell where you want to begin pasting the data.
4. Right-click, and on the shortcut menu, select Transpose Paste.

The data is pasted to the worksheet with the column and row coordinates reversed.

Entering and Promoting Column and Row Titles
Column and row titles label and identify columns and rows of data. Column titles appear in the Graph and Regression
Wizards when you pick columns, identify columns for legends, and can be used instead of column numbers in
transforms.

To enter or edit a worksheet column or row title:

1. Double-click the title, and enter or edit the title.
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2. Press Enter to accept the new title. The new column or row title appears along with the original column or row
number.
You must use at least one text character in every column title. If you need to use a number as column title, type a
space character (by pressing the space bar) before the number.

Using the Column and Row Titles Dialog Box

Enter and edit column and row titles using the Column and Row Titles dialog box.

1. To enter or edit a column title:
a) On the Worksheet tab, in the Cells dialog box, click Titles.

b) In the Column and Row Titles dialog box, click the Column tab.
c) Enter the column title in the Title box.

d) To edit an existing title, move to that column by clicking Next or Prev, then edit the title.
e) Click OK to close the Column Titles dialog box when you are finished editing column titles.
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2. To enter or edit a row title:
a) On the Worksheet tab, in the Cells dialog box, click Titles.

b) In the Column and Row Titles dialog box, click the Row  tab.
c) Enter the row title in the Title box.

d) To edit an existing title, move to that row by clicking Next or Prev, then edit the title.
e) Click OK to close the Column and Row Titles dialog box when you are finished editing row titles.

Using a Worksheet Row for Column Titles

Enter labels into a row, then use that row for worksheet column titles. This is useful for data imported or copied from
spreadsheets.

All the cells of the selected row are promoted, not just those cells which contain column titles. This may effect other
data sets in the worksheet.

To use a row for column titles:

1. If necessary, enter the column titles you want to use in a single worksheet row.
2. Select the cells in the row you want to use as column titles.
3. On the Worksheet tab, in the Cells dialog box, click Titles.
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4. In the Column and Row Titles dialog box, click the Column tab. The number of the row you wish to promote
appears in the Promote row to titles box.

Figure 71: Using a Column for Row Titles
5. To delete the original row once it has been promoted, select Delete Promoted Row.
6. Click Promote. The selected row contents appear as column titles and the Column and Row Titles dialog box

closes.

Using a Worksheet Column for Row Titles

Enter labels into a column, then use that column for worksheet row titles. This is particularly useful for data imported
or copied from spreadsheets.

All the cells of the selected row are promoted, not just those cells which contain column titles. This may effect other
data sets in the worksheet.

To use a column for row titles:

1. If necessary, enter the row titles you want to use in a single worksheet column.
2. Select the cells in the row you want to use as row titles.
3. On the Worksheet tab, in the Cells dialog box, click Titles.
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4. In the Column and Row Titles dialog box, click the Row tab. The column you wish to promote appears in the
Promote column to titles box.

5. Select Delete Promoted Column to delete the original column once it has been promoted.
6. Click Promote. The selected column contents appear as row titles and the Column and Row Titles dialog box

closes.

Using a Cell as a Column or Row Title

Use the Column and Row Titles dialog box to promote individual cells to column and row titles.

To promote individual cells:

1. Click the cell on the worksheet that you want to promote to a column or row title.
2. On the Worksheet tab, in the Cells dialog box, click Titles.

3. In the Column and Row Titles dialog box, click the Column tab to promote a row cell to title; click the Row tab
to promote a column cell to a title.

4. Click Next or Prev to move to the next desired column or row, then follow steps above.

Removing Outliers and Other Data
You can manually omit or ignore an outlying point or group of points by converting the number to a text cell which
removes the data point from both graphing and computation.

To remove or ignore an outlier:

1. Find the outlier on the graph, then click it to select the curve, pause, and then click again (do not double-click).
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2. View the worksheet. The data for the selected symbol is indicated with colored highlighting.

Tip:  It is possible to highlight data points only if you create graphs using symbols.

Figure 72: When you find the outlier on the graph, click it once to select it, and click it again, but
make sure not to double-click.

3. Select the highlighted worksheet cell(s).
4. On the Worksheet tab, in the Cells group, click Format.

5. In the Format Cells dialog box, click the Data tab.

Figure 73: Format Cells Dialog Box
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6. Select Text from the Type list, then click OK. This converts the number to text characters; you can tell this if the
alignment of the cell changes to be left aligned.

Figure 74: Graph with Removed Outlier

The data point is no longer plotted, and if you perform additional statistics on the graph, the data point will also be
ignored.

Highlighting Outliers

Another way to remove an outlier is to cut the data and move it to another part of the worksheet. This is useful if
you still want to plot the data but ignore the outlier. Then you can plot the moved outlier data with a second plot to
continue displaying the outlying data.

To plot outlier data as a separate plot:

1. Identify the worksheet cell(s) corresponding to the outlier(s).
2. Select (highlight) the cells, and press Ctrl+X to cut them.
3. Move to another location in the worksheet and paste the data.
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4. Plot the outlier data by adding it as a second plot to your graph. Change the symbol color or other attributes to
distinguish the data.

Figure 75: A Highlighted Outlier

Indexing Data
You can convert raw data to indexed data and vice versa, using the Index and Unindex transforms available from the
Statistical drop-down list in the Transform group on the Analysis tab. You can index and unindex data with one and
two factors.

Creating Indexed Data

Before indexing data, add titles to the columns. The column title strings are used as the index codes.

Tip:  If you are indexing two ways, use columns titles consisting of the levels of the two factors for that table
cell, separated by a hyphen (-), forward slash (/) or colon (:). These levels names will be used for the index
codes.

To index data by one factor:

1. On the Analysis tab, in the Transform group, click Statistical > Index > One Way.
2. To index data by two factors, click Two Way.
3. Click the worksheet column to select the output column for the indexed data. This should be an empty column

with at least one empty column to the right for a One Way ANOVA, or two empty columns for Two Way ANOVA.
4. Select the columns to index, either by clicking the worksheet columns, or selecting the column from the Data for

Input drop-down list.
5. Click Finish to index the contents of the selected input columns in the selected output column.

The indexed data is tabulated, with the indexes appearing in the left column(s), and the data in the right column.

Unindexing Data

Indexed data can be unindexed for graphing purposes using the Unindex command.

1. On the Analysis tab, in the Transform group, click Statistical > Unindex > One Way.
2. To unindex data by two factors, click Two Way
3. Select the columns to unindex as prompted.
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4. If you unindexed two ways, each column contains the data for one cell in the Two Way ANOVA table, and the two
factor levels appear as the column title, separated by a hyphen (-).

Using Excel Workbooks in SigmaPlot
SigmaPlot supports Microsoft Excel workbooks which you can use to create graphs, run transforms, and perform
regressions and other statistics on your data.

Most Excel ribbons are available when Excel workbooks are viewed, as are all of SigmaPlot's functionality. When an
Excel worksheet is in focus, all keyboard shortcuts are assigned to Excel's hotkeys, not SigmaPlot's.

Excel workbooks created by SigmaPlot are initially limited to a single worksheet. Excel workbooks with multiple
worksheets that are opened by SigmaPlot as notebooks retain all sheets, but only the first sheet can be used for graphs
and statistics.

To open a new Excel worksheet:

Click Main Button > New > Excel Worksheet.

Using Excel as Default Workbooks

You can use Excel workbooks as the default SigmaPlot worksheet.

To set Excel as the default worksheet:

1. Close all open Excel workbooks.
2. Click the Main Button.

3. Click Options.
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4. Click the General tab.

5. Select New notebooks use Excel workbook.

6. Click OK to apply the changes and close the dialog box. All new notebooks will use Excel workbooks as the
default worksheet.

SigmaPlot Functionality within Excel Workbooks

To understand how Excel works with other applications, please see your Excel documentation. The following
functions are unavailable when working with data in an in-place active Excel workbook:

• You cannot insert graphic cells into an Excel workbook for customized sequences of colors, lines, symbols, and
patterns.

• An Excel workbook does not have an associated Statistics worksheet. To view statistics for data in an Excel
workbook, use Excel's own statistics, or copy and paste the data into a SigmaPlot worksheet. To display the
statistics worksheet for the active SigmaPlot worksheet, on the Worksheet tab, in the View group, click View
Column Statistics.

Creating SigmaPlot Graphs With Excel Workbooks

An Excel worksheet works the same as a SigmaPlot worksheet when creating graphs. You can select data before
beginning a graph, or click or highlight columns from the Graph Wizard.

Using Transforms on Data in Excel Workbooks

You can perform SigmaPlot and user-defined transforms on data in Excel worksheets. The transform language uses
syntax which refers to columns numerically, or by the column titles currently assigned. When prompted to pick
columns, you can select columns as you would on a SigmaPlot worksheet.

To perform user-defined transforms on an Excel worksheet, use the corresponding column number in place of the
column letter that appears in the gray heading area at the top of the column. For example, the transform function:

col(1)=data(1,100)

corresponds to inserting data values from 1 to 100 into column A of an Excel workbook.

Using Statistics with Excel

You can use SigmaPlot's statistical tests, including the Regression Wizard, with Excel worksheets.
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When prompted to pick columns, select the columns from the Excel worksheet just as you would from a SigmaPlot
worksheet. Results for statistics can be placed in Excel worksheets as well.

Printing Worksheets
You can print active worksheets by clicking the Main button and then clicking Print. You can print any worksheet in
a notebook. This section explains:

• Printing the current worksheet.
• Previewing worksheets before printing.
• Printing column statistics.
• Setting printing options.
• Configuring printer settings.

Printing the Current Worksheet

1. Select and view the worksheet. If you want to print only a portion of the columns in the active worksheet, select a
block from the worksheet.

2. Click the Main Button .

3. Click Print.
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Previewing Worksheets

1. With a worksheet in view, click the Main Button.

2. Click Print.

3. Click Print Preview.

Printing Column Statistics

1. On the Worksheet tab, in the View group, click Column Statistics.
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2. With the column statistics worksheet in view, click the Main Button.

3. Click Print.

4. From the Name drop-down list in the Print dialog box, select the printer you wish to use.
5. Click OK.

The Print Data Worksheet dialog box appears.

Figure 76: The Print Data Worksheet Dialog Box for Columns Statistics
6. To print the names of the statistics that appear in the row region of the worksheet, under Headers select

Row Headings.
7. Click OK to print.
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Setting Printing Options

1. Click the Main Button and then click Print.

2. In the Print Data Worksheet dialog box, specify whether you want to print the entire worksheet, only the
selected cells in the worksheet, or a specified range of columns by selecting one of the options under Area to
Print.

3. Click OK to print the worksheet.
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Configuring Printer Settings

1. With a worksheet in view, click the Main Button and then click Print.

2. In the Print Data Worksheet dialog box, click Setup.

3. In the Print dialog box, click OK when you are satisfied with the Printer settings, or click Properties to edit the
printer properties.

Note:  The Properties dialog box options vary from printer to printer.
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6
Working with 2D Plots

Topics:

• Scatter, Line, and Line and
Scatter Plots

• Area Plots
• Bar Charts
• Box Plots
• Creating 2D Plots
• Creating 2D Scatter Plots with

Error Bars
• Creating 2D Plots with

Asymmetric Error Bars
• Modifying Error Bars
• Grouped Bar Charts
• Creating Box Plots
• Creating Area Plots
• Bubble Plots
• Vector Plots
• Forest Plots
• Radar Graphs
• About Axes and Plots

You can create 2D Cartesian (XY) plots from many worksheet columns or
column pairs. Each column is represented as a separate curve, set of bars, or
box, depending on the plot type. 2D graphs must have at least one plot, but
you also can display many more plots, each with a different type and style.
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Scatter, Line, and Line and Scatter Plots
Scatter, line, and line/scatter plots graph data as symbols, as lines only with no symbols, or as symbols and lines. Line
shapes can be straight segments, splines, or steps. You can add drop lines to either axis to any of these plot types,
and add error bars to plots with symbols, and you can draw linear or polynomial regressions with confidence and
prediction intervals for each curve.

Figure 77: Examples of a Stepped Line Plot, a Scatter Plot, and a Line Scatter Plot

Area Plots
Using area plots, you can fill an area under a curve with a color making the curve easier to see. You can orient the fill
up, down, left, or right. If your curve is a closed polygon, you can also fill the polygon. You can have multiple curves
(plots) on a page, so you can stack Area Plots. For more information, see Creating Area Plots on page 231.

Figure 78: Examples of Area Plots

Bar Charts
Bar charts plot data either as vertical or horizontal bars. They originate from zero in either a positive or negative
direction. Simple bar charts plot each row of data as a separate bar, and grouped bar charts plot multiple columns of
data by grouping data in the same rows. Stacked bar charts plot data as segments of a bar; each data point is drawn as
a bar segment starting where the previous data point ended.

Use Graph Properties to modify bar width, bar fill colors, and bar fill patterns and to add error bars to simple and
grouped bar charts. For more information, see Grouped Bar Charts on page 223.



 | Working with 2D Plots | 213

Figure 79: Examples of a Simple Bar Chart, a Grouped Bar Chart, and a Stacked Bar Chart

Box Plots
Box plots graph data as a box representing statistical values. The boundary of the box closest to zero indicates the
25th percentile, a line within the box marks the median, and the boundary of the box farthest from zero indicates the
75th percentile. Whiskers (error bars) above and below the box indicate the 90th and 10th percentiles. In addition, you
can graph the mean and outlying points.

You need a minimum number of data points to compute each set of percentiles. At least three points are required
to compute the 25th and 75th percentiles, and at least nine points are required for the 5th, 10th, 90th and 95th
percentiles. If SigmaPlot is unable to compute a percentile point, the related graph element is not drawn.

Figure 80: Example of a Box Plot

Creating 2D Plots
To create a 2D plot:

1. Select the worksheet columns to plot before creating your graph by dragging the pointer over your data.
2. Select the desired graph type and style from the Create Graph tab. The Graph Wizard appears.
3. From the Data Format list, choose the appropriate data format, and click Next.
4. Specify which worksheet columns correspond to the data for your plot. Since you selected columns prior to

opening the Graph Wizard, your choices automatically appear in the dialog box and you can click Finish to
create the graph.

Note:  If you have not already picked columns, note that a single data type is highlighted in the Selected
Columns list. This shows the data type you are picking a column for. Begin picking data either by clicking
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the corresponding column directly in the worksheet, or choosing the appropriate column from the Data
Columns list. Repeat this process for every column you are using to create your graph.

5. If you make a mistake while picking data, select the wrong entry in the Graph Wizard, then choose the correct
column from the worksheet. You can also clear a column assignment by double-clicking it in the list.

6. When you have finished picking data, click Finish to create the plot and close the Graph Wizard. Use Graph
Properties to modify the plot, or reopen the Graph Wizard to pick different data columns for your plot, or to add
another plot to your graph. For more information, see Creating and Modifying Graphs on page 27.

Creating 2D Plots with Multiple Curves

You do not have to create multiple plots to obtain multiple curves. To plot more than one curve, choose any of the plot
styles described as Multiple and add additional columns, or column pairs to the list of curves in the Graph Wizard.
Both the Graph Wizard and the graph styles available on the Create Graph tab list all types of multiple plot graph
styles.

The order of the curves is determined by the order of the column pairs in the Graph Wizard. To change the curve
order, select columns again in the Graph Wizard or select the column in the worksheet.

Figure 81: Plot Styles that Include Multiple Curves

Plotting Category and Grouped Data

Use the Category Data formats (indexed data) if your data is organized row-wise by categories with corresponding
data. For more information, see Arranging Category Data on page 50.

Figure 82: The data in this worksheet is arranged as category (or indexed) data. The data is
organized row-wise by categories.

To plot category (grouped) data:
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1. Select any multiple graph style for any one of these following graph types on the Create Graph tab:

• Scatter Plot
• Line Plot
• Line/Scatter Plot

Figure 83: Selecting a Category data format from the Graph Wizard.
2. In the Data Format panel of the Graph Wizard, select one of the following category data formats:

• XY Category. Uses one worksheet column to graph the categories, and a pair of XY columns.
• X Category. Uses one X column, and a column for categories, indexes, or levels to group the data in

corresponding rows.
• Y Category. Uses one Y column, and a column for categories, indexes, or levels to group the data in

corresponding rows.
3. Click Next. The Select Data panel of the Graph Wizard appears.
4. Select which data columns will correspond to which axis or category. For example, if you are using an XY

Category Data format, first select the column to use for the X data from the Data for drop-down list. This
selection appears in the Selected columns list. Then select the column to use for the Y data from the drop-down
list. Lastly, select the column to use as the Categories from the drop-down list.

5. If you make a mistake while picking data, select another entry in the Graph Wizard, then choose the correct
column from the worksheet. You can also clear a column assignment by double-clicking it in the list.

6. When you have finished picking data, click Finish to create the plot and close the Graph Wizard.
Use Graph Properties to modify the plot, or reopen the Graph Wizard to pick different data columns for your
plot, or to add another plot to your graph. For more information, see Creating and Modifying Graphs on page 27.
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Creating 2D Scatter Plots with Error Bars
In a Line and Scatter Plot with Error Bars, plot the means of each column as the Y value, and represent the standard
deviations with error bars.

Use the Graph Wizard to create 2D plots with error bars. Scatter plots, line/scatter plots, or simple bar charts can be
created with error bars. For more information, see SigmaPlot Graph Styles on page 29

Figure 84: 2D Plots with Error Bars

To add error bars to an existing plot, first change the plot type. For more information, see Creating and Modifying
Graphs on page 27 .

To create a scatter plot with error bars:

1. Select the worksheet columns to plot before creating your graph by dragging the pointer over your data.
2. On the Create Graph tab, click the Scatter group, and then click Simple Scatter - Error Bars.
3. In the Graph Wizard, select the error bar source from the Symbol Value drop-down list.

• Symbol Value. Choose either Column Means to use the column means as the error bar source, Replicate
Row Means to use the row means as the error bar source, Worksheet Columns to use values you’ve entered



 | Working with 2D Plots | 217

in the worksheet, or 2 Worksheet Columns to read error bar end values from sets of two adjacent columns.
You are prompted during data picking to specify the column to use as error bar source data.

• Error Calculation. If you choose any option besides Worksheet Columns  as the symbol value, specify the
error calculation method to use for upper and lower error bars.

4. Specify the error calculation for the error bars from the Error Calculation - Upper and Error Calculation
- Lower drop-down lists. Error Calculations are not applicable if you select Worksheet Columns or
Asymmetrical Error Bars from the Symbol Value list.

5. Click Next.

6. Select the appropriate data format from the Data Format list. X column averaged plots require a constant Y
column value, and Y column averaged plots require a constant X column value.
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7. Click Next.

Figure 85: Specifying the Data Columns for the Error Bars
8. Specify which worksheet columns correspond to the data for your plot. Since you selected columns prior to

opening the Graph Wizard, your choices automatically appear in the dialog box, and you can click Finish to create
the graph.

9. To create a single plot graph, choose data for every column you are using to make the graph. To create a graph of
multiple plots, choose data for the first plot, then click Next to pick data for the next plot. Repeat this process for
as many plots as necessary.

10. To make a graph with simple error bars or a graph with multiple error bars using worksheet columns as
the Symbol Value for error bar data, you are prompted to choose columns for error bar data. Repeat the data
picking process for every column you are using to create your plot.

11. To make a graph using any of the other sources for error bar data (i.e. Column Means, Column Median,
Standard Error, etc.) with multiple error bars, you can create a graph using a single plot, or a graph with
multiple plots. Use multiple plots if you want to use different symbols to distinguish between data sets.

Tip:  If you make a mistake while picking data, click the wrong entry in the Graph Wizard, then choose
the correct column from the worksheet. You can also clear a column assignment by double-clicking it in
the Selected Columns list. Click Back to access previous Graph Wizard panels.

12. Click Finish when you have finished picking the data to create the plot.

Creating a Range Plot

A range plot is an error plot that plots the highest and lowest values in a column or row of data as the range of the
error bar, using the mean or median value as the data point.

To create a range plot from columns of data:

1. Select the worksheet columns to plot before creating your graph by dragging the pointer over your data.
2. On the 2D Graph toolbar click Scatter Plot and then Simple Scatter - Error Bars.

The Graph Wizard - Create Graph dialog box appears.
3. Select Column Means or Column Median from the Symbol Value drop-down list.
4. Select Maximum from the Error Calculation - Upper drop-down list.
5. Select Minimum from the Error Calculation - Lower drop-down list.
6. Click Next. The Graph Wizard prompts you to select a data format.
7. Select X Many Y from the Data Format list, and click Next.

Since you've already selected the data columns to plot, the appropriate column titles appear in the Selected
Columns list.

8. Click Finish. A range plot appears.
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Creating 2D Plots with Asymmetric Error Bars
Create 2D scatter plots with error bars using two adjacent worksheet columns as the error bar source to independently
control the error bar values. SigmaPlot computes the asymmetrical error bars by using the column value as the
absolute value.

The column to the right of the plotted data is the source for the bottom or left error bar; the next column is the source
for the top or right error bar.

Figure 86: 2D Plots with Asymmetrical Error Bars

To create a plot with asymmetric error bars:

1. Drag the pointer over your worksheet data to select the data.
2. On the Create Graph tab, click Scatter Plot, and then click either Simple Scatter - Vertical Asymmetrical

Error Bars or Simple Scatter - Horizontal Asymmetrical Error Bars.
The Graph Wizard appears.

3. From the Data Format list, select a data format, and click Next.
4. Specify which worksheet columns correspond to the data for your plot. For more information, see Modifying

Graphs Using Graph Properties on page 68.
Since you selected columns prior to opening the Graph Wizard, your choices automatically appear in the Selected
Columns list.

5. Click Finish to create the graph. Modifying Error Bars on page 221

Creating Quartile Plots

A quartile plot is an asymmetrical error bar plot that divides the total sample of a frequency distribution into four
quarters. The median of the data is the data point, while the 75th and 25th percentiles of the data represent the upper
and lower error bars.

By default, SigmaPlot uses the Standard method to calculate percentile values for box and quartile plots. You can
change this setting to the Cleveland method on the General tab of the Options dialog box.
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Figure 87: Example of a Quartile Plot

To create a quartile plot:

1. Select the worksheet columns to plot before creating your graph by dragging the pointer over your data.
2. On the 2D Graph toolbar click Scatter Plot and then Multiple Scatter - Error Bars. The Graph Wizard -

Create Graph dialog box appears.
3. Select Column Median from the Symbol Value drop-down list.
4. Select 75th Percentile from the Error Calculation - Upper drop-down list.
5. Select 25th Percentile from the Error Calculation - Lower drop-down list.
6. Click Next. The Graph Wizard prompts you to select a data format.
7. Select X Many Y from the Data Format list, and click Next.
8. Since you've already selected the data columns to plot, the appropriate column titles appear in the Selected

Columns list.
9. Click Finish.

Creating Error Bar Plots Using Category Data

You can create SigmaPlot error bar plots using category data entered into a SigmaPlot worksheet. For more
information, see Plotting Category and Grouped Data on page 214.

To create a SigmaPlot error bar plot using category data:

1. Open or import a worksheet using a category data format. For more information, see Worksheet Basics on page
163.

2. On the 2D Graph toolbar click Scatter Plot and then Multiple Scatter - Error Bars.
The Graph Wizard - Create Graph dialog box appears.
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3. Select a graph style that uses error bars from the Graph styles list, and click Next.
The Create Graph - Error Bars Graph Wizard dialog box appears.

4. Select either Category Mean or Category Median from the drop-down list.
5. Select error calculations from the Error calculation - upper and Error calculation - lower drop-down lists, and

click Next.
The Graph Wizard - Create Graph - Data Format dialog box appears.

6. From the Data for Categories drop-down list, select a column that corresponds to the categorical data you wish to
plot.

7. From the Data for Y drop-down list, select the column that corresponds to the Y data you wish to plot.
8. Click Finish.

An error bar plot appears.

Modifying Error Bars
You can compute error bars for scatter, line/scatter, and bar charts. You select error bar values when you pick the data
for a plot and compute using values in a worksheet column or using column means.

Note:  You cannot add error bars to existing plots. However, you can select the desired plot on the page and
change its plot type and style so that it includes error bars. For more information, see Modifying Graphs
Using Graph Properties on page 68.

Figure 88: Examples of Graphs with Error Bars

Changing Error Bar Appearance

Use Graph Properties to change error bar color, cap width, line thickness, mean computation method, and direction.

Note that you cannot select error bar values from the Graph Properties, as it only affects the appearance of error
bars. Determine error bar values when you pick data to plot.

To change error bar appearance:

1. Double-click the plot to open Graph Properties.
2. In the Properties list select Plot > Error bars.
3. To change the color of the error bars, from the Line Color list, select a line color.
4. To change line thickness and error bar cap width, move the Thickness and Cap Width sliders.

Changing Error Bar Directions

You can specify error bar direction using two different methods: absolute and relative. Specify absolute error bars to
point in either a positive or negative direction; specify relative error bars to point either towards or away from zero.

To change error bar direction
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1. Double-click the error bar to open Graph Properties.
2. From the Properties list, select Plot > Error Bars.
3. Under Error Bars, from the Direction drop-down list, select the direction of Y.

Note:  An X positive absolute direction always points right; a Y positive direction always point up. An X
negative absolute direction always points left; a Y negative absolute direction always points down.

Figure 89: The bar chart on the left uses Y error bars with an absolute positive direction. The bar
chart on the right uses a relative direction away from zero.

A relative to zero direction always points toward or away from zero. This option is useful for bar charts that have
negative values.

Figure 90: The bar chart on the left uses X error bars with an absolute negative direction. The
bar chart on the right uses a relative direction towards zero.

Customizing Error Bar Directions

You can customize the error bar direction used for each data point by entering error bar directions into a worksheet
column.

To use custom error bar directions:

1. Select the first cell in an empty worksheet column.
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2. Enter the codes for the error bar directions. The codes for the directions are:

Direction Code

Absolute Positive Positive or P

Absolute Negative Negative or N

Relative From Zero From Zero or F

Relative To Zero To Zero or T

Absolute or Relative, Both Directions Both, PN or FT

Tip:  Codes you type in the worksheet can be either upper or lower case.

3. Double-click the error bar in the plot to open Graph Properties.
4. If necessary, select Plot > Error Bars from the Properties list.
5. Under Error bars, from the Direction list, choose the name of the first column which contains the error bar

direction codes.

Note:  SigmaPlot assumes that it is the next column that contains the second column of error bar codes.

Changing the Mean Computation Method

If your graph uses a log axis scale, you can choose between calculating the column means arithmetically (the default)
or geometrically on a log scale. This option is only available for log axis scales.

To change the mean computation method:

1. Double-click the plot with a log axis scale to open Graph Properties.
2. If necessary, select Plot > Error Bars from the Properties list.
3. Select Arithmetic or Geometric from the Mean Computation drop-down list.

Changing Error Bar Source

Use this method to change the error bar source after you have created a graph. You can:

• Plot the means of worksheet columns as single data points and compute the error bars values from column
statistics (column averaging).

• Use data in worksheet rows and columns as error bar values.
• Use data in two adjacent worksheet columns as the absolute error bar values.

To change the error bar source after you have created the graph:

1. Click the Graph Page tab.
2. Click Modify Plot in the Graph Additions group.
3. Assuming you want to continue to use worksheet columns as the error bar source, continue to click Next until you

reach the Modify Plot - Select Data panel of the Graph Wizard.
4. Select a new column in the worksheet for the error bars source so that it appears in the Selected columns list.
5. Click Finish.

Grouped Bar Charts
You can create grouped bars charts by picking multiple columns for a single plot. Data points within the same row
appear within the same group, and each additional column adds another bar to each group. There are as many groups
as there are rows of data.
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The order of the column pairs in the list determines the order of the bars for each group. To change the bar orders
within groups, change the order the column pairs appear in the list by using the Graph Wizard to re-pick column data.
For more information, see Modifying Graphs Using Graph Properties on page 68.

Use the Graph Wizard to create grouped bar charts with or without error bars. If creating a grouped bar chart
with error bars, error bar values must be from worksheet column values entered prior to creating the plot. You are
prompted during graph creation for error bar worksheet columns.

Figure 91: Examples of Grouped Bar Charts with and without Error Bars

Creating Grouped Bar Charts

To create a grouped bar chart:

1. Select the worksheet columns to plot before creating your graph by dragging the pointer over your data. For more
information, see Modifying Graphs Using Graph Properties on page 68.

2. Click the Create Graph tab.
3. In the 2D Graphs group, click Horizontal or Vertical Bar Chart, and then click either Grouped Bar Chart, or

Grouped Error Bars.
The Graph Wizard appears.

Figure 92: Using the Graph Wizard to Specify the Data Format
4. From the Data Format list, choose the appropriate data format to specify how your data is formatted. The data

formats available depend on the graph type and style.
5. Click Next.

Since you selected columns prior to opening the Graph Wizard, your choices automatically appear in the in the
Selected Columns list. To change the selected data, select the wrong entry in the Graph Wizard, then choose the
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correct column from the worksheet. You can also clear a column assignment by double-clicking it in the Selected
Columns list.

Note:  Notice that this dialog box also prompts you for the columns with the data to use as the error bar
values.

.
6. Click Finish. For more information, see Modifying Error Bars on page 221.

Spacing Bars from Different Plots

If you need to create a bar chart with two or more different axes scales, or a chart with overlapping bars, use multiple
plots.

SigmaPlot does not automatically space bars from different plots. However, you can manually space bars by grouping
your data column(s) with column(s) containing missing or empty data. This creates bar groups with null values and
leaves room for other bars. When picking columns to plot, pick the missing columns in a different order for each plot,
so that the bars do not overlap.

To overlap bars, plot your bar values versus a column of evenly incremented values rather than by row numbers.
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Figure 93: Bars graphed with different plots that both overlap and are spaced differently by using
different x increments.

Grouping Column Averaged Bars

You cannot create a grouped bar chart with error bars using column averaging; the bars do not group or space
correctly. However, you can copy the worksheet means and standard deviations from the statistics window, then plot
this data as a grouped bar chart with error bars.

To create a bar chart with grouped column averaged bars:

1. Click the Worksheet tab.
2. In the View group, click View Column Statistics.

The statistics window for the worksheet appears.

Figure 94: Column Statistics Worksheet
3. Select the block of data in the statistics window that consists of the means and standard deviations of the first set

of bars.
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4. Right-click, and on the shortcut menu click Copy.
5. Select the first row of an empty column in the worksheet.
6. Right-click, and on the shortcut menu click Transpose Paste

The first pasted column of data is the mean, and the next column is the standard deviations. For more information,
see Moving Data on page 194.

Figure 95: The data in columns 8 and 9 of the worksheet are transposed from the selected data
in rows 1 and 2 of the Column Statistics window. Column 8 contains the means of the column
data and column 9 contains the standard deviations of the data.

7. Repeat the copy and transpose paste procedure for the remaining sets of bars. Each pair of mean and standard
deviation columns you create adds an additional bar to each group.

8. Click Finish when done.

Creating Box Plots
A box plot is a summary plot that plots graph data as a box representing statistical values. The boundary of the box
closest to zero indicates the 25th percentile, a line within the box marks the median, and the boundary of the box
farthest from zero indicates the 75th percentile. Whiskers (error bars) above and below the box indicate the 90th and
10th percentiles. In addition, you can graph the mean and outlying points.
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By default, SigmaPlot uses the Standard method to calculate percentile values for box and quartile plots. You can
change this setting to the Cleveland method on the General tab of the Options dialog box.

To create a box plot:

1. Select the worksheet columns to plot by dragging the pointer over your data.
2. On the Create Graph tab, in the 2DGraph group, click Box Plot.

3. Click Horizontal Box or Vertical Box.
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4. From the Data Format list, choose the data format that you want to use, and click Next. Since you already
selected columns prior to opening the Graph Wizard, your choices automatically appear in the Selected Columns
list.

Important:  You need a minimum number of data points to compute each set of percentiles. At least three
points are required to compute the 25th and 75th percentiles, and at least nine points are required for the
5th, 10th, 90th and 95th percentiles. If SigmaPlot is unable to compute a percentile point, that set of points
is not drawn.

5. Click Finish to create the graph.
Use Graph Properties to modify the plot, or reopen the Graph Wizard to pick different data columns for your
plot, or to add another plot to your graph.

Changing Other Box Plot Attributes

To add a mean line, change which outliers are displayed, and change the 10th and 90th percentile whisker cap widths:

1. Double-click the box plot to open Graph Properties.
2. If necessary, select Plot > Box Options from the Properties list.
3. To display a mean line in addition to the median line, under Box Plot Mean Line, select Display Mean Line.

If the check box is clear, the mean line is not displayed.
4. To modify the mean line, under Box Plot Mean line, from the Line Type drop-down list, select a mean line type.
5. Select a line thickness and color using the Thickness and Color options.

Selecting (none) from the Line Type or Color lists creates a transparent mean line. Selecting (Custom) from the
color list enables you to use a custom mean line color, or to create a new color.

6. To change how outliers are handled, from the Handling Outliers drop-down list, select either Show Each
Outlier (to plot outside the 10th and 90th percentiles), or Show 5th/10th Percentiles (to plot only the 5th and
95th percentiles as symbols).

Remember:  You need at least nine data points to compute the 5th, 10th, 90th and 95th percentiles. Also,
there may be no data points beyond the 10th and 90th percentiles.

7. To modify whisker cap width, under Whisker Caps, move the Width slider, or type a new value in the Width
box.

Modifying Box Plots

The fill, width, and symbol settings for the boxes can be modified using the appropriate Graph Properties settings.

You can change:

• Symbols used to display extreme data points. For more information, see Changing Symbol Type and Other
Symbol Options on page 76.

• Box fill color and patterns (including edge and whisker color). For more information, see Changing Object Fills
on page 134
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• Box widths.

Computing Percentile Methods

When graphing error bars and creating box plots, you can select the method of computing percentiles.

To compute the percentile method:

1. Click the Main Button.

2. Click Options.

3. On the Options dialog box, click the General tab.

4. From the Percentile Method drop-down list, select either:

• Cleveland
• Standard

Both the Cleveland method and the Standard method use linear interpolation to determine the percentile value, but
each uses a different method of rounding when determining the smallest data index used for the interpolation. The
two methods give the same result when computing the 50th percentile (median).
If the data in increasing order is x1, x2, ..., xN and the percentile is p, then the two methods compute the data
percentile value v using the following formulas:

• Cleveland: Let k be the nearest integer to N*p/100, and let f = N*p/100 + .5 - k.
• Standard: Let k be the largest integer less than or equal to (N+1)*p/100, and let f = (N+1)*p/100 - k.

5. To compute the percentile value, each of the above methods uses the formula: v=f*xk+1+(1-f)*xk.
6. Click OK.
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Creating Area Plots
Area plots are 2D line plots with regions below or between curves filled with a color or pattern. Most commonly, an
area plot is a line plot with shading that descends to the axis. You can add shade below a curve and shade in different
directions, and you can uniquely fill and identify intersecting regions.

Figure 96: This example is actually four plots: a simple straight line, simple scatter, vertical area,
and multiple area. You can find this example in Samples.jnb.

Creating Simple and Vertical Area Plots

Simple Area Plots plot a single line plot with a downward fill. Vertical Plots plot single YX line plots with a left
direction fill.
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Figure 97: In this example, there are see two vertical area plots, a simple area plot, and a simple
scatter plot.

To create a simple straight line area plot:

1. Select the worksheet columns to plot by dragging the pointer over your data.
2. On the Create Graph tab, click Area in the 2DGraphs group, and then click Simple Area Plot.
3. From the Data Format list in the Graph Wizard, choose the appropriate data format, and click Next.

Since you already selected columns prior to opening the Graph Wizard, your choices automatically appear in the
Selected Columns list.

Restriction:  You can plot no more than 2500 data points per curve.
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4. Click Finish to create the graph.

Figure 98: Example of a Vertical Area Plot

Use Graph Properties to modify the plot, or reopen the Graph Wizard to pick different data columns for your plot,
or to add another plot to your graph.

Creating Multiple Area and Multiple Vertical Area Plots

Multiple Area Plots plot multiple line plots with downward fills. Multiple Vertical Area Plots plot single YX line plots
with left downward fills.

To create a multiple area plot:

1. Select the worksheet columns to plot by dragging the pointer over your data.
2. On the Create Graph tab, click Area in the 2DGraphs group, and then click Multiple Area plot.
3. From the Data Format list in the Graph Wizard, choose the appropriate data format, and click Next.

Since you already selected columns prior to opening the Graph Wizard, your choices automatically appear in the
Selected Columns list. To change the selected data, select the wrong entry in the Graph Wizard, then choose the
correct column from the worksheet. You can also clear a column assignment by double-clicking it in the Selected
Columns list.

Restriction:  You can plot no more than 2500 data points per curve.
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4. Click Finish to create the graph.

Figure 99: Example of a Multiple Area Plot using a Y Many X data format.

Use Graph Properties to modify the plot, or reopen the Graph Wizard to pick different data columns for your plot,
or to add another plot to your graph.
You can identify intersections either by using Graph Properties or by creating a complex area plot.

Creating Complex Area Plots

Complex Area Plots plot multiple line plots with downward fills and intersections.

To create a complex area plot:

1. Select the worksheet columns to plot by dragging the pointer over your data.
2. On the Create Graph tab, click Area in the 2DGraphs group, and then click Complex Area Plot. The Graph

Wizard appears.
3. From the Data Format list, choose the appropriate data format, and click Next.

Since you already selected columns prior to opening the Graph Wizard, your choices automatically appear in the
Selected Columns list. To change the selected data, select the wrong entry in the Graph Wizard, then choose the
correct column from the worksheet. You can also clear a column assignment by double-clicking it in the Selected
Columns list.

Restriction:  You can plot no more than 2500 data points per curve, and you cannot plot more than four
curves.
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4. Click Finish to create the graph.

Figure 100: Intersections only appear for two or more curves, and a legend appears for each
intersection.

Converting a Multiple Area Plot to a Complex Area Plot

You can uniquely identify intersecting areas of all curves of a multiple area plot with a separate fill by using the
Graph Properties. Each possible intersection appears on the area plot, and each identifiable set of intersections uses
the next color or pattern in the selected scheme.

You can display intersections for a minimum of two curves and a maximum of four. Plots with two curves will have
up to three different regions, one region for each tuple, and one region for the intersection. Three curves yield up to
seven regions, and four curves up to fifteen.

To change a multiple area plot to a complex area plot:

1. Double-click the graph to open Graph Properties.
2. If necessary, select Plot > Area Fills from the Properties list.
3. Select Identify Intersections.

Shading in Different Directions

Use Graph Properties to change the direction of fill colors in an area plot.

To change the area fill direction:

1. Create an area plot.
2. Double-click the graph to open Graph Properties.
3. Select Plot > Area Fills from the Properties list.
4. From the Direction drop-down list, select Up, Down, Left, or Right.

Changing Area Plot Fill Colors

Use Graph Properties to change area plot fill colors.

Restriction:  SigmaPlot only supports system patterns. If you enter patterns into the worksheet, you should
only use system patterns.

To change the area plot fill color:
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1. Create an area plot.
2. Double-click the graph to open Graph Properties.
3. If necessary, select Plot > Area Fills from the Properties list.
4. From the Color drop-down list, select (none) to create a transparent fill color, (Custom) to create a custom color,

or an incremental color scheme to use a color array, or any one of many available colors.
5. Select a pattern from the Pattern drop-down list. For more information, see Changing Patterns and Fill Colors on

page 86.

Shading Between Two Curves

You can emphasize the difference between two curves by filling in the area. This is useful when creating a
climograph, for example, where two lines could show high and low temperatures throughout the year. Shading
between the curves aids in visualizing the range in temperatures which would otherwise be lost in a sea of data points.

Figure 101: An example of two plots, a bar chart and an area plot. In the area plot, the area between
the two curves is shaded.

You can shade the area between two curves by:

• Using Object Properties to change the background color of the graph to match the lower shade.
• Using the Insert Graphic Cells dialog box to insert colors in to the worksheet, and then applying those to the

plot.
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1. To shade the area using Object Properties:
a) Create an area plot that uses either X Many Y or XY Pairs data formats. Make sure, when in the Graph

Wizard, that you first select to plot the column with the largest Y values for the upper curve. Then use the
column with the smallest Y values for the lower curve.

Figure 102: To shade between the curves, first create an area plot that uses the larger values
for the upper curve.

b) Once you've created the graph, select the fill. A shortcut menu automatically appears.
c) Click the Paint button, and then select the fill color that matches the color of the lower curve.

The graph appears with the area between the two curves shaded.
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Figure 103: The area between the two curves appears shaded, while the area under the lower
curve matches the background.

For more flexibility you can define the area colors by inserting colors into a column in the worksheet and then
use the front area color as the graph background color.
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2. To insert graphic cells to shade between two curves:
a) As above, create an area plot.
b) View the worksheet, and select a cell in the first row of an empty column.
c) On the Worksheet tab, in the Cells group click Graphic Cells.

d) In the Insert Graphic Cells dialog box, click the Colors tab.
e) Double-click to select two colors. In the first cell (row 1), select the color that you want the area to be and in

the second cell (row 2), select the color you want the background to be.

f) Click Close to close the dialog box.
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3. To assign the area plot colors to those in the worksheet:
a) Double-click the graph.
b) Select Plot > Area Fills from the Properties list.
c) Under Fill Color, scroll to the bottom of the Color drop-down list and select the column that contains the

colors you selected in the Insert Graphic Cells dialog box.
The graph now appears with the two shaded areas filled with the colors you inserted in worksheet; however,
the background of the graph is still white.

Figure 104: Once you've selected the color for the lower curve, you still must match a color
for the background.

d) Now select the background fill of the graph, and in the shortcut menu, click the Paint button.
e) Select the color that matches the lower shaded area on the graph.

The graph appears with one shaded area between the two curves.
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Figure 105: As in the example above, the graph appears with the background color matching
the color of the lower shaded region.

Bubble Plots
Bubble plots are XY scatter plots that use symbols to represent not only XY locations, but also a third dimension
represented by the size of the symbol. Use bubble plots to plot population density, epidemiological data, or other
similar data sets where a third variable can be clearly illustrated by the size of the symbols.

Related Topics
Arranging Data for Bubble Plots on page 56

Creating a Bubble Plot

To create a bubble plot:

1. Select the worksheet columns to plot before creating your graph by dragging the pointer over your data.
2. On the Create Graph tab, click Bubble in the 2D Graphs group.

3. When you have selected all the columns to plot, including the Bubble Size column, click Finish.
4. In the Graph Wizard, select the appropriate format from the Data Format list, and click Next.
5. When you have selected all the columns to plot, including the Bubble Size column, click Finish.
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Vector Plots
A vector plot is a line plot where the line represents the magnitude, and an arrow head represents the direction.

Related Topics
Arranging Data for a Vector Plot on page 52

Creating a Vector Plot

To create a vector plot:

1. Select the worksheet columns to plot before creating your graph by dragging the pointer over your data.
2. On the Create Graphs tab, in the 2D Graphs group, click Vector.
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3. In the Create Graph - Data Format panel of the Graph Wizard, select one of the two available formats:

• XYXY. Select XYXY when you want both Start and End points of the graph appear as XY coordinates.
• XYAM. Select XYAM if you want the end points to be represented in terms of angle and magnitude. The XY

point is the midpoint of the vector.

Figure 106: Selecting a Vector Plot Data Format

If you select XYAM, when you click Next, the Create Graph - Angle Units panel appears.

Figure 107: Selecting Vector Plot Angle Units for the XYAM Data Format

Tip:  You may need to scale the magnitude data if you are using the XYAM format and your vector
magnitudes are either much larger or smaller than the X,Y coordinates. The vectors should be large
enough to be clearly visible, but also small enough to be spaced within the X,Y coordinates so that they do
not overlap.

If, for example, the magnitudes are too large, use a Quick Transform to divide the magnitude column by a constant
that is roughly the ratio of the largest magnitude to the smallest X and Y coordinate increment. Then you can
easily adjust this constant to obtain a pleasing graph. For more information, see Performing Quick Transforms.
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4. Click Next. The Create Graph - Select Data dialog box appears.

Figure 108: Selecting Data for a Vector Plot
5. When you have selected all the columns to plot, click Finish.

Modifying Vector Plot Arrowheads

You can edit the degrees and length of vector plot arrowheads using the Graph Properties.

To edit the vector plot:

1. Double-click a vector on a vector plot to open Graph Properties.
2. Select Plot > Vectors from the Properties list.
3. Use the Line Type options to modify how vector plot lines appear in the graph.

a) To change the type of line, such as a dotted line or dashed, select an option from the Type drop-down list.
b) To change the line color, select a color from the Color drop-down list.
c) To change or add a gap color, select a color from the Gap Color drop-down list. This option is only available

if you select a line type with actual "gaps" in it, like dotted or dashed, for example.
d) To change the thickness of the line, enter a value in the Thickness box.
e) To make the lines transparent, move the Transparency slider.

4. Use the Arrowhead options to set arrowhead line type (lines or filled), angles in degrees, and the arrowhead
lengths.
a) To set the arrowhead line type, select Lines or Filled from the Type drop-down list.
b) To set the angle of the arrowhead, move the Angle in degrees slider.
c) To set the length of the arrowhead, you can select either:

• Percentage of vector length. Enter a percentage into the field or move the slider.
• Constant. Enter a value into the field or move the slider.

Forest Plots
A forest plot is a type meta-analysis, and is used as a comparison of different experiments within a single graph. You
can enter data as differences or ratios, using eight columns of data.

Meta-analysis statistically combines the samples of each contributing study to create an overall summary statistic that
is more precise than the effect size in the individual studies.

Most forest plots appear with two basic parts:

• The overall effect value (diamond symbols) and its 95% confidence interval (the width of diamond).
• The individual study values (square symbols) and their 95% confidence intervals (the horizontal bars).
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Figure 109: Forest plots use square symbols to show the individual study values and diamond
symbols to show the overall effect value. The widths of the symbols are determined by their 95%
confidence intervals.

Arranging Forest Plot Data

Forest plot data entry requires eight columns. The two forest plot data formats are:

• Differences data

Figure 110: An Example of Forest Plot Differences Data
• Ratios data

Figure 111: An Example of Forest Plot Ratios Data
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Creating a Forest Plot

To create forest plot:

1. On the Create Graphs tab, in the 2D Graphs group, click Forest Plots.

The Create Graph - Data Format dialog box appears.

2. Select Differences Data or Ratios Data, depending on how you’ve entered your data. For information on entering
forest plot data, see Arranging Forest Plot Data on page 245.

3. If you’ve correctly entered the data, then all you need to do is select all the columns. The following table shows
how each column title corresponds to its proper Selected column name in the Create Graph - Select Data dialog
box.
Selected Column Name Column Title

Studies Names Study

Studies Values Mean Difference

Studies LCL Lower 95% CI

Studies UCL Upper 95% CI

Studies Weights Weight

Overall Value Overall Mean

Overall LCL Lower 95% CI

Overall UCL Upper 95% CI
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4. Click Finish.

A forest plot appears.

The above example of a forest plot uses the Townscape color scheme for the symbols. For more information about
using incremental color schemes, see Incrementing Color Schemes on page 89.

Radar Graphs
A radar graph is a two dimensional graph on which you can simultaneously display many variables. Each variable is
plotted along a different radial line, called a spoke, emanating from the origin of the plot. If you have ten variables
then there will be ten radial lines thirty six degrees apart. In SigmaPlot, the radar plot has one axis superimposed
on a spoke. The axis range defines the maximum and minimum for all variables. Small values are near the center
of the radar plot and large values near the outer circumference. For example, an experiment might result in multiple
measured variables and you want to compare the results of this experiment, but repeated under different conditions.
If you connect the variable values on each radial axis with a straight line, you create a distorted star-like pattern. You
can then visually compare the patterns created by the lines representing the different conditions for the experiment.
The radar graph name comes from the multiple radial axes resembling a radar antenna. A radar graph is also called a
spider plot, a polar plot or a spiral space diagram.

An excellent example of the use of a radar graph is to demonstrate the relationship between gene expression
signatures and the type of childhood brain cancer. The results shown below are a radar line graph of three data sets.
The results were generated using a data mining technique that determined which genes and their expression levels
predicted different brain cancers. Eight genes were found to be predictive. One way to display the gene expression
signature is with a radar graph. The variables for the radar graph are the gene expression levels of the eight different
genes. These are shown as the eight radial axes of the following radar plot.
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Figure 112: Example of a Radar Plot

Creating a Radar Graph

To create a radar graph:

1. Select the worksheet columns to plot before creating your graph by dragging the pointer over your data. For more
information, see Radar Plots on page 43.

2. On the Create Graphs tab, in the 2DGraphs group, click Radar.

3. Click the style of radar graph you want to create.
4. In the Create Graph - Data Format panel of the Graph Wizard, select one of the two available formats:

• Label Many Series. Select Label Many Series if you want a column of data to represent labels.
• Many Series. Select Many Series want to use at least one column as a data source.

5. Click Next. The Create Graph - Select Data dialog box appears.
6. When you have selected all the columns to plot, click Finish.

About Axes and Plots
You can only create new pairs of X or Y axes if you have more than one plot on a graph and you want to scale these
plots differently. For more information, see Modifying Axes, Tick Marks, and Grids on page 275.

Creating Additional Axes for Multiple Plots
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If you have more than one plot on a graph and want to use multiple axes, use the following steps to add additional
axes.

To create an additional axis:

1. Right-click the plot, and on the shortcut menu, click Add New Axis. The Graph Wizard appears.
2. Select to create either a new X axis or Y axis for the specified plot.
3. Click Next.
4. Select which side of the graph to add the new axis. You can add the new axis to the left, right, top, or bottom of the

graph. Selecting an Offset location moves the new axis slightly to the side, top, or bottom of the original axis.
5. Click Finish to add the new axis according to the specified settings. The New axis appears on the graph, and the

plot re-scales to reflect the new axis

Figure 113: Example of a Second Y Axis Added to the Graph for a Line Plot

Creating Multiple Axes for a Single Plot

If you want to use two or more X or Y axes for a single plot (for example, to show two different units of
measurement), first create a plot which graphs empty columns, then add an axis to the empty plot.

To add an axis to the second plot:

1. Right-click the graph, and on the shortcut menu, click Add New Plot.
The plot type does not matter, so long as it is a 2D Cartesian plot.

2. Pick any data format.
3. Pick empty columns when prompted to select the data to plot.
4. Create an axis for this "dummy" plot at the desired location



5. Select the new axis, then use manual scaling to set the appropriate range and tick interval for the new axis. This
scale is often a linear transformation of the opposite axis scale, for example, a Celsius scale to a Fahrenheit scale.

Figure 114: The second temperature axis for the single plot was created by first creating a
“dummy plot,” creating a Y axis for the dummy plot, then manually scaling the axis range.



Chapter

7
Working with 3D and Contour Graphs

Topics:

• 3D Scatter and Line Plots
• Mesh Plots
• 3D Bar Charts
• Waterfall Plots
• Creating 3D Scatter Plots and

3D Bar Charts
• Creating Trajectory Plots
• Creating Waterfall Plots
• Creating Mesh Plots
• 3D Graph Axis Placement
• Creating Contour Plots
• Modifying Contour Plots
• Displaying and Modifying

Contour Labels

Create 3D (XYZ) plots from many worksheet columns or column triplets.
XYZ plots must have at least one plot, but can display many more plots, each
with a different type and style. Graphs can be rotated and shaded added to
enhance the height and depth of mesh and bar charts.
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3D Scatter and Line Plots
3D scatter and Line  plots graph data as symbols, as lines only with no symbols, or as symbols and lines. Use Graph
Properties to add symbols to a 3D line plot, or the Lines settings to add lines to a scatter plot.

You can add drop lines to any back plane of either of these plot types.

Figure 115: Examples of a 3D Scatter Plot and a 3D Line Plot

Mesh Plots
Mesh plots graph 3D data as a continuous surface with a mesh. Use Graph Properties to modify mesh lines, color,
transparency, and to enable the light source for shading.

Figure 116: Mesh Plot with No Fill Color and with a Gradient of Colors

3D Bar Charts
Create bar charts in 3D space using 3D data. Modify 3D bar charts by changing fill color and pattern. For more
information, see Changing Patterns and Fill Colors on page 86. You can also adjust bar width and spacing.
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Figure 117: 3D Bar Charts

Waterfall Plots
Waterfall plots graph 3D data as stacked line plots along the Y axis. Use Graph Properties to modify plot lines,
color, and transparency.

Figure 118: Waterfall Plots

Creating 3D Scatter Plots and 3D Bar Charts
3D scatter plots can use any data format; however, 3D bar charts are limited to XY Many Z or Many Z only.

Creating a 3D Scatter Plot or 3D Bar Chart

1. Select the worksheet columns to plot by dragging the pointer over your data.
2. On the Create Graph tab, in the 3DGraphs group, click 3D Scatter Plot or 3D Bar Chart.
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3. In the Data Format list in the Graph Wizard, specify how your data is formatted. The data formats available
depend on the graph type you are making.

Figure 119: Specifying the Data Format
4. Click Next.

Figure 120: Selecting Columns to Plot

Since you already selected columns prior to opening the Graph Wizard, your choices automatically appear in the
dialog box.

5. Click Finish.
Use Graph Properties to modify the plot, or reopen the Graph Wizard to pick different data columns for your
plot, or to add another plot to your graph. For more information, see Modifying Graphs Using Graph Properties on
page 68.

Creating Trajectory Plots
Trajectory plots use an XYZ coordinate system to create a 3D line plot.

Creating a Trajectory Plot

1. Select the worksheet columns to plot by dragging the pointer over your data.
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2. On the Create Graph tab, in the 3DGraphs group, click 3D Line Plot .

3. Click 3D Trajectory. If you already selected columns prior to opening the Graph Wizard, your choices
automatically appear in the Selected Columns list.

4. Click Finish.
Use the Graph Properties to modify the plot, or reopen the Graph Wizard to pick different data columns for
your plot, or to add another plot to your graph. For more information, see Creating and Modifying Graphs on page
27.

Creating Waterfall Plots
3D waterfall plots are stacked line plots along the Y axis. Because hidden lines are eliminated, waterfall plots are
useful for showing trends of line plots.

3D waterfall plots are limited to Many Z and XY Many Z data formats.
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Creating a Waterfall Plot

1. Select the worksheet columns to plot by dragging the pointer over your data.
2. On Create Graph tab, in the 3DGraphs group, click 3D Line Plot.

3. Click 3D Waterfall.
4. From the Data Format list, choose the appropriate data format.
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5. Click Next. Since you've already selected columns prior to opening the Graph Wizard, your choices automatically
appear in the Selected Columns list.

6. Click Finish.
Use the Graph Properties to modify plot lines, color, and transparency.

Changing the Color of Drop Planes in Waterfall Plots

You can change color scheme within the drop planes of waterfall plots, as well as add a drop plane to 3D scatter and
3D line plots, using Graph Properties.

1. In the waterfall plot (or 3D scatter or line plot), double-click a plane to open Graph Properties.
2. Select Plot > 3D Lines from the Properties list.
3. To set the color of the graph plane, under Fill color, select a color from the Color drop-down list.
4. To set a color scheme for the planes, select Scheme from the Color Schemes drop-down list and then a

particular color scheme to color the waterfall plot planes.
5. To create a transparent fill, select Transparent. When a fill is transparent, it becomes translucent; that is, other

plots are visible even if when they appear "behind” the plot.

Creating Mesh Plots
When you create a mesh plot you can choose between solid and transparent mesh with discrete or gradient shading.
Use a transparent mesh to highlight the relationship of one mesh plot to another on the same graph.

3D mesh plots use an XYZ coordinate system; the data points are graphed as intersections of a mesh grid. If you
select Many Z as the data format, SigmaPlot uses column numbers as the X values, and row numbers as the Y values.

Creating a 3D Mesh Plot

1. On the Create Graph tab, in the 3DGraphs group, click 3D Mesh Plot.
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2. Choose the appropriate data format from the Data Format list in the Graph Wizard.

3. Click Next. If you've already selected columns prior to opening the Graph Wizard, your choices automatically
appear in the dialog box.

4. Click Finish.
Use Graph Properties to modify the plot, or reopen the Graph Wizard to pick different data columns for your
plot, or to add another plot to your graph.

Modifying Mesh Lines and Fill Color

To modify mesh lines and fill color:

1. Double-click the mesh plot to open Graph Properties.
2. Select Plot > Mesh from the Properties list.
3. To change the color of the mesh, under Fill Colors, select a color from the Color drop-down list. Select (none)

to create a transparent mesh, select (Custom) to create a custom color, and select one of .the color schemes or
color columns to increment the mesh from bottom to top using a color array. For more information, see Modifying
Mesh Lines and Fill Color on page 258.

4. To make your mesh translucent, select Transparent. Objects behind it will be visible. Use this option to more
clearly show the intersections between two or more 3D meshes.

5. To specify how the colors flow across the grid, from the Transitions drop-down list, select either Discrete to
use an increment with a clear shift between colors, or select Gradient to use an increment with a gradual shift
between colors.

6. To change line thickness, move the Thickness slider, or type a new value in the Thickness box.
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Changing Graph Perspective, Rotation, and Shading

Modify the view of the 3D graph by changing perspective and rotation of the graph, and by enabling a light source to
add shading.

1. Double-click the graph to open Graph Properties.
2. Select Graph > Rotation from the Properties list.
3. To rotate the graph, move the Horizontal and Vertical View sliders, or type horizontal or vertical values into the

boxes.

Note:  Horizontal and vertical values are in degrees. Rotate the graph horizontally from 0° to 360°, or
vertically from -90° to +90°. The recommended Horizontal View is 205°, and the Vertical View is 25°.
The rotation is displayed in the axes degrees from 0°. The origin used to determine the degree from the
horizontal or vertical is the intersection of the three axes.

When both rotation angles are set to 0°, the origin as you see the graph, is the left bottom rear corner.

Tip:  The origin axes are not related to the axes marked with ticks and tick labels, but act as the zero point
for tick labels and data.

Figure 121: A 3D graph with a horizontal rotation of 0°, a vertical rotation of 0°, and a perspective
of 20
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4. To change the perspective of the graph, move the Perspective slider, or type a new value into Perspective box.

Figure 122: A 3D graph with a horizontal rotation of 0°, a vertical rotation of 45°, and a
perspective of 20

Figure 123: A 3D graph with a horizontal rotation of 45°, a vertical rotation of 45°, and a
perspective of 20

Figure 124: A 3D graph with a perspective of 0
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Note:  The Perspective value is based on the depth of the graph. A perspective of 0% means that the graph
has no depth; 100% means that the graph has maximum depth. The recommended perspective is 20%.

Figure 125: A 3D graph with a perspective of 50

Figure 126: A 3D graph with a perspective of 100
5. To turn on the light source and create shading on your graph, select Enable Light Source. If this option is

cleared, the light source is not applied to the graph.

Attention:  Set your display to High Color (16 bit) or True Color (24 bit) for this feature to work
properly. You may check your system’s color capabilities under the Windows Display Properties Settings.

Figure 127: The graph on the right has the light source option selected.

3D line and scatter plots are not affected by the light source option.
6. To return to the 3D View settings you had before applying any changes, click Reset to last applied.
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3D Graph Axis Placement
3D axes are always at the following positions (unless you rotate the graph horizontally):

• X: bottom right front
• Y: bottom left front
• Z: left front

Axis Placement During Graph Rotation

When you rotate the view of a 3D graph, SigmaPlot automatically repositions the visible axes to the front of the graph
so that the axes do not become positioned behind the graph.

Drawing, Modifying, and Hiding Frame Lines

Drawing a 3D graph frame completes the cube surrounding the plotted data. Normally, these lines are hidden. You can
use a frame to mark the origin axes, or to mark the 3D extent of the graph.

Frame lines are unrelated to the lines used to draw axes and planes, and are controlled independently of those lines.
Frame lines are drawn over the axes.

To add frame lines, modify frame lines, or hide frame lines from view:

1. Double-click the plot to open Graph Properties.
2. Select Graph > Frame Lines from the Properties list.
3. From the Frame Lines drop-down list, select either:

• Relative to Viewer: If the frame is oriented from your perspective, one set of lines is composed of the three
cube edges closest to you, and the other lines are the remaining sides of the cube. The position of these lines is
independent of the graph's rotation. This is the default position.

• Relative to Graph Origin: If the frame is drawn according to the origin, one set of the lines is drawn over the
origin axes, and the other lines draw the remainder of the cube. The position of these lines is dependent on the
graph's rotation.

4. Hide frame lines, or add frame lines to your graph by selecting or clearing the appropriate Show check box.
Selected frame lines are drawn.
A graph cannot display frame lines for both the Relative To Viewer and Relative To Graph Origin perspectives.
If Relative To Graph Origin is selected from the Frame Lines drop-down list, the Show check boxes for
Relative To Viewer are cleared automatically, and vice versa.

5. To change the frame line type, under Front lines, from the Line Type drop-down list, select a line type.
6. To change a frame line color, under Front Lines, from the Color drop-down list, select a frame line color.
7. To create transparent frame lines, select (none) from either list. Choose (Custom) from the Color drop-down

list to use or create a custom color.
8. To the modify frame line thickness, move the Thickness slider, or type a new thickness value into the thickness

field.

Creating Contour Plots
Contour graphs and filled contour graphs plot 3D data on an XYZ coordinate system with the Z data (vertical)
indicated with lines at specified Z intervals. If you select Many Z as the data format, SigmaPlot uses column numbers
as the X values, and row numbers as the Y values. If you are using XYZ triplet data, it needs to be reformatted as
mesh data. For more information, see Smoothing 3D Data.
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Figure 128: Contour Plots

Creating a Contour Plot

1. Select the worksheet columns to plot by dragging the pointer over your data.
2. On the Create Graph tab, in the 3D Graphs group, click Contour Plot.

3. Click Contour.
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4. In the Graph Wizard, from the Data Format list, select the appropriate data format, and click Next. The Graph
Wizard prompts you to specify which worksheet columns correspond to the data for your plot. Since you selected
columns prior to opening the Graph Wizard, your choices automatically appear in the Selected Columns list.

Tip:  If you made a mistake picking data, click the wrong entry in the Selected Columns list, then select
the correct column from the worksheet. You can also clear a column assignment by double-clicking it in
the Selected Columns list.

5. Click Finish.

Creating a Filled Contour Plot

1. Select the worksheet columns to plot by dragging the pointer over your data.
2. On the Create Graph  tab, in the 3DGraphs group, click Contour Plot.

3. Click Filled Contour.
4. In the Graph Wizard, from the Data Format list, select the appropriate data format and click Next. The Graph

Wizard prompts you to specify which worksheet columns correspond to the data for your plot. Since you selected
columns prior to opening the Graph Wizard, your choices automatically appear in the Selected Columns list.

5. Click Finish.

Modifying Contour Plots
Use Graph Properties to modify a contour plot. You can:

• Pick new data for the plot.
• Change contour line attributes, and hide or display lines.
• Modify back plane color and grid lines.
• Change the vertical (Z data) range and scale.
• Change X and Y axis and tick attributes.
• Add colors to contour fills.
• Turn on or off interpolated fills.
• Change and display contour labels.

Displaying and Changing Contour Lines

To modify contour lines:
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1. Double-click the contour plot to open Graph Properties.
2. Select Plot > Contour Fills from the Properties list.
3. To modify contour lines, from the Contours drop-down list, select Major or Minor. The Line Styles reflect the

contour you select in the Contour drop-down list. Select Major to change the Line Styles for major contours.
Select Minor to change the Line Styles for minor contours.

4. To specify the line type of major and minor contour lines,  select a line type from the Line Type drop-down
list. Select one of the incrementing schemes to increment contour line types, or select (none) to create transparent
lines.

5. To select the color of the contour lines, from the Line Style Color drop-down list, select a color. You can choose
from several predefined color schemes, or select (none) to create transparent lines. Select (Custom) to create a
custom color.

6. To set the thickness of the contour lines,  select the value in the Thickness box and type a new value.

Adding Fills to Contour Plots

To fill intervals between contour lines with colors:

1. Double-click the contour plot to open Graph Properties.
2. Select Plot > Contour Fills from the Properties list.
3. Select Major from the Contours drop-down list.
4. In the Color drop-down list, under Fill, select from several predefined color schemes.
5. Set the direction of the contour fills from the Start drop-down list. The default direction is bottom. That is, the fill

starts from the lowest z value.

Modifying Interpolated Filled Contours

When you create a filled contour plot from the toolbar, its fill colors are automatically interpolated and stretched to fit
the number of z-intervals.

To turn off interpolated fills:

1. Double-click the contour plot to open Graph Properties.
2. Select Minor from the Contours drop-down list.
3. Under Fill, select (none) from the Color drop-down list.

Changing Contour Vertical (Z Data) Range and Scale

Use Graph Properties to select the scale type and set the vertical range used by the contour lines.

To set the scale and range used by contour lines:

1. Double-click the contour plot to open Graph Properties.
2. Select Plot > Contour Scale from the Properties list.
3. From the Scale Type list, select Linear or Log (Common) scale. The linear scale uses a standard base 10 numeric

scale, and the log scale uses a base 10 logarithmic scale.
4. To manually set the Z axis range, enter beginning and ending range values in the Start and End boxes.
5. To automatically set the Z axis range, select Data Range from the Calculation drop-down lists. SigmaPlot

automatically determines the vertical range based on the Z data plotted.
6. To add padding to both ends of the axis, select Pad 5%.
7. To extend the range to the nearest major tick mark, select Nearest Tick.

Changing Contour Line Intervals

Use the Graph Properties Line Interval settings to select line intervals for Major and Minor contours.

To set line intervals for major contour lines:
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1. Double-click the contour plot to open Graph Properties.
2. Select Plot > Contour Scale from the Properties list.
3. Select the Major or Minor lines to modify from the Apply to drop-down list.
4. Under Line intervals, select one of the following intervals from the Lines drop-down list:

• Automatic: SigmaPlot automatically determines the interval at which contour lines are drawn.
• Manually: Manually set the number of contour lines are drawn. Enter the z interval in the Every box, and the

value at which the first interval is drawn in the From box.
• Columns: Select the column used to determine major contour line z values.

Note:  When major contour lines are plotted from a column, no minor lines are drawn.

Displaying and Modifying Contour Labels
Use the Graph Properties Label settings to switch contour line labels on and off, add prefixes or suffixes to labels, and
rotate labels relative to the contour line.

To add, hide or modify contour line labels:

1. Double-click the contour plot to open Graph Properties.
2. If not already visible, select Plot > Labels from the Properties list.
3. To display or hide contour labels, under Contour Labels, select or clear Major Contour Labels and Minor

Contour Labels.
Selected options display labels, and cleared options hide labels.

4. To align contour labels parallel to the contour line, under Label Appearance, select Align With Contour
Line.
Clear the option to align the contour labels parallel to the X axis.

5. To control how many labels appear for the contour lines, move the Label Frequency slider.
Move the slider toward Fewer to reduce the number of contour labels, or move the slider toward More to increase
the number of contour labels.

6. To add to the contour labels, under Add to Major Labels and Add to Minor Labels, in the Prefix and Suffix
boxes, type the prefix or suffix.

7. To separate a suffix or prefix from the tick label, type a space before a suffix or after a prefix.

Changing Contour Label Settings

Using the Graph Properties you can:

• Use a numeric type of contour label.
• Use a series type of contour label.
• Use values or text from a worksheet column for contour labels.
• Change the font size, style or color of contour text labels.

Setting a Numeric Type of Contour Label

1. Double-click a tick label on the contour plot to open Graph Properties.
2. If not already selected in the Properties list, select Plot > Contour Details.
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3. From the use drop-down list, specify which type of numeric display to use.
The Scientific Notation and Engineering Notation options always use scientific notation or engineering notation to
display numbers.

• For large numbers options, use scientific or engineering notation only when numbers exceed a specified
range. Use the Above and Below lists to specify the range beyond which scientific notation or engineering
notation is used.

• For linear scale, you can always use scientific notation, or only when needed. If you use scientific notation
only when needed, set the range to by typing values in the Lower and Upper ranges in the edit boxes. These
values are expressed in log units.

4. Use the Precision options to specify the number of places used to display numeric tick labels. Select Automatic
to let SigmaPlot automatically determine precision, or select Manual, then select the number of decimal places to
use from the Places drop-down list.

Setting a Series Type of Contour Label

1. Double-click a tick label on the contour plot to open Graph Properties.
2. Select Plot > Contour Details
3. From the Type drop-down list, select Series.
4. From the Series list, select one of the following series:

• Months
• Days of the week
• Years
• Alpha Series
• Numeric

5. From the Length drop-down list, select the number of characters to use for the labels.
6. From the Start At drop-down list, select the series item to begin labeling tick marks with, then from the Step By

drop-down list, select the frequency or increment for the series.
7. To restart tick labeling from a specified point, use the After and Repeat From drop-down lists.

Using Values or Text from a Worksheet Column for Contour Labels

1. Enter the values or text in a worksheet column.
2. Double-click a tick label on the contour plot to open Graph Properties.
3. Select Plot > Contour Labels from the Properties list.
4. From the Type drop-down list, select the column containing tick labels.

Changing the Font Size, Style or Color of Contour Text Labels

Changing the text attributes for both major and minor contour labels involves changing the font, style, size and color
of the text.

1. Double-click a tick label on the contour plot to open Graph Properties.
2. Select Plot > Contour Details from the Properties list.
3. Click Contour label font to open Text Properties.





Chapter

8
Working with Pie , Polar, and Ternary Plots

Topics:

• Pie Charts
• Polar Plots
• Ternary Graphs

This chapter describes basic procedures specific to pie charts, polar plots, and
ternary plots.
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Pie Charts
Pie charts plot a single worksheet column by representing each data point in the column as a pie slice. Each data point
in the column is graphed as a slice size equivalent to the data point's percent of the sum of all the data.

Figure 129: Example of a Pie Chart

The first pie slice starts at 0 degrees (3 o'clock) by default. Additional slices are added counterclockwise, in the order
the data points occur in the column.

Creating a Pie Chart

1. Select worksheet data before creating the graph.
2. On the Create Graph tab, in the 2DGraphs group, click Pie.
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3. Specify which worksheet column corresponds to data for your plot. Since you selected a column prior to opening
the Graph Wizard, your choice automatically appears in the dialog box and you can click Finish to create the pie
chart.

4. If you selected the incorrect columns to plot, select a column either by clicking the corresponding column directly
in the worksheet, or selecting the appropriate column from the Data for Pie list.

Tip:  If you make a mistake while picking data, click the wrong entry in the Graph Wizard, then select the
correct column from the worksheet.

5. Click OK.
6. Use Graph Properties to modify the pie chart, or reopen the Graph Wizard to pick a different data column for

your plot.

Restriction:  You cannot add plots or axes to pie charts.

Modifying Pie Charts

Modifying pie charts includes:

• Changing fill color and patterns of pie chart slices.
• Rotating the pie chart.
• Adding exploded pie slices to the pie chart.
• Picking new data for the graph.

To modify a pie chart, select the graph and modify it using Graph Properties. For more information, see Creating
and Modifying Graphs on page 27.

Rotating the Pie

Use Graph Properties to rotate pie charts or add single or multiple exploding slices.

To rotate the pie:

1. Double-click select the pie chart to open Graph Properties.
2. Select Plot > Pie Slices from the Properties list.
3. Under First slice starts, move the Counterclockwise at slider to change the starting angle.

Increasing the starting angle for the first slice moves the starting slice counterclockwise. The default is 0° (3
o’clock).

Adding Exploding Slices

Use Graph Properties to add single or multiple exploding slices.

To explode one slice:

1. Double-click select the pie chart to open Graph Properties.
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2. Select Plot > Pie Slices from the Properties list.
3. Select Single Slice from the Explode drop-down list.
4. Select the number of the slice to explode from the Exploded slice drop-down list.

By default, the first slice begins at 0° and proceeds counterclockwise. If you have not rotated the pie chart, the
slice number corresponds to the worksheet row number.

Tip:  Choosing No exploded slices from the Explode drop-down lists replaces any exploded pie slices.

Polar Plots
Polar plots display data in the coordinate system format where r is the distance from the origin of the graph, and theta
(θ) is the angle between the positive horizontal axis and the radius vector extending from the origin to the plotted data
point.

Use polar plots to show data where one value (θ) is periodic in nature, like a clock. An example of this is a graph that
shows average temperatures of differing geographical regions during the days of a month, or months of a year.

Figure 130: Polar Plots

Creating a Polar Plot

1. Select the worksheet columns to plot by dragging the pointer over your data.
2. On the Create Graph tab, in the 2DGraphs group, click Polar Plot.

3. Click the style of polar plot you want to create.
4. In the Graph Wizard, choose a unit type from the Angular units drop-down list. The Range Lower Bound and

Range Upper Bound boxes change depending on your selection from the list.

Tip:  If you don't see the axis units you want to use for your polar plot listed in the list, you can type the
desired values in the Range Lower Bound and Range Upper Bound fields.

5. If you want to create a polar plot with its angles increased in a clockwise direction, select Clockwise. This creates
a plot where the Range Lower Bound starts at the top of the graph. On a counter clockwise polar plot, the Range
Lower Bound starts at the 3 o'clock position.

6. Click Next.
7. Select the appropriate data format from the Data format list.
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8. Click Finish.
Use Graph Properties to modify the plot, or reopen the Graph Wizard to pick different data columns for your
plot. For more information, see Creating and Modifying Graphs on page 27.

Modifying a Polar Plot

Modifying polar plots involves:

• Modifying angular and radial axes. For more information, see Modifying Polar Axes on page 293.
• Picking new data for the plot. For more information, see Picking Different Data for the Current Plot on page 69.
• Changing symbol type, size, and color. For more information, see Changing Symbol Type and Other Symbol

Options on page 76.
• Changing line type, size, and color. For more information, see Changing Line Type and Other Line Options on

page 83.
• Modifying back plane color and grid lines. For more information, see Displaying Grid Lines and Backplanes on

page 291.

To modify a polar plot, select the graph and modify it using Graph Properties. For more information, see Modifying
Graphs Using Graph Properties on page 68.

Ternary Graphs
Ternary graphs plot data on an XYZ coordinate system in the form of three variables that add up to 100% or 1. These
variables are typically the normalized proportions of three substances and are plotted on three axes generally arranged
as an equilateral triangle, known as a composition triangle. These graphs are also commonly referred to as triangle
plots.

Figure 131: Examples of a Ternary Line Plot, Scatter Plot and Scatter and Line Plot

Ternary Plot Styles

You can create ternary scatter, line, and scatter and line plots. These graph data as symbols, as lines only with no
symbols, or as symbols and lines, respectively. Line shapes can be straight segments or spline.

Creating a Ternary Plot

Ternary plot data set (triplet or pair) must be based on a percentage or unitary scale with the sum of all values being
100% or 1. If your data does not add up to 100% or 1, you must first normalize the data. For more information, see
#unique_177.

1. Drag the pointer over your data to select the worksheet columns to plot.
2. On the Create Graph tab, in the 2DGraphs group, click Ternary Plot.

3. Click the style of ternary plot you want to create.



4. In the Graph Wizard, select the appropriate format.

5. Click Next. Since you selected columns prior to opening the Graph Wizard, your choices automatically appear in
the dialog box.

Figure 132: Selecting Columns to Plot Using the Graph Wizard

Tip:  If you made a mistake picking columns, highlight the wrong entry in the Graph Wizard, then choose
the correct column either in the worksheet or from the column list.

6. Click Finish.
Use Graph Properties to modify the plot or to open the Graph Wizard to pick different data columns to plot or to
add another plot to your graph. For more information, see Modifying Ternary Axes on page 297.

Modifying Ternary Graphs

Modifying ternary graphs involves:

• Changing axis properties.
• Picking new data for the plot.
• Changing line and symbol type, size, and color.
• Modifying backplane color and grid lines.

To modify a ternary graph, select the graph and modify it using Graph Properties. For more information, see
Modifying Graphs Using Graph Properties on page 68.



Chapter

9
Modifying Axes, Tick Marks, and Grids

Topics:

• Axis Scale Types
• Changing Axis Scales and

Range
• Changing Scale Type
• Hiding, Displaying, and Deleting

Axes
• Setting Axis Breaks
• Working with Axis Titles and

Tick Labels
• Changing Tick Mark Intervals
• Changing Tick Mark

Appearance
• Changing Tick Labels
• Displaying Grid Lines and

Backplanes
• Modifying Polar Axes
• Modifying Ternary Axes

Axes are the scales or rulers along which data is plotted. 2D Cartesian graphs
have an X (horizontal) axis, and a Y (vertical) axis. For 3D graphs, the X and
Y axes form the base of the graph, and the Z axis is the vertical axis. Polar
plots use an angular axis to draw the circumference of the plot and the radial
axes to draw the radius of the plot. An axis is always associated with at least
one plot on a graph, and determines the scaling of the plot.

Each axis consists of pairs of lines that you can move and modify
independently. Tick marks are short lines along the axis that represent scale
intervals. You can display and modify tick marks for each axis. Grid lines are
attached to the graph planes, and can be drawn at tick intervals for all axes.
Make most axis modifications using Graph Properties.
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Axis Scale Types
Scale types appear under Axis in the Properties list in Graph Properties.

1. Double-click an axis on a graph to open Graph Properties.
2. Select Axis > Scaling from the Properties list.

The available scale types appear in the Type list. They include:

• Linear
• Common Log
• Natural Log
• Probability
• Probit
• Logit
• Category
• Date/time
• Reciprocal
• Weibull

Linear

A linear scale is a standard base 10 numeric scale. (This scale is recommended for a date axis when an exact
representation of spacing depicted by dates is not required. Otherwise, use the date/time scale.)

Common Log

A common log scale is a base 10 logarithmic scale.

Natural Log

A base e logarithmic scale.

Figure 133: Graphs of the Same Data Using Linear, Common Log, and Natural Log Scales

Probability

A probability scale is the inverse of the Gaussian cumulative distribution function. The graph of the sigmoidally
shaped Gaussian cumulative distribution function on a probability scale is a straight line. Probabilities are expressed
as percentages with the minimum range value set at 0.001 and the maximum range value set at 99.999. The default
range depends on the range of the actual data.
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Probit

A probit scale is similar to the probability scale; the Gaussian cumulative distribution function plots as a straight line
on a probit scale. The scale is linear, however, with major tick marks at each Normal Equivalent Deviation (N.E.D. =
X - μ)/σ) plus 5.0. At the mean (X = μ) the probit = 5.0; at the mean plus one standard deviation (X = μ + σ) the probit
= 6.0, etc. The default range is from 3 to 7. The range limit for a probit axis scale is 1 to 9.

Figure 134: Graphs of the Same Data Using Linear, Probability, and Probit Scales

Logit

A logit scale uses the transformation

where a = 100 and 0 ≤ y ≤ 100.

Category

A category scale uses numerical values or text from a worksheet column used to generate a plot. Each distinct entry
in the column is a separate category against which the corresponding data values are plotted. This scale is commonly
used for bar charts or other plots used to graph different categories of data.
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Figure 135: A Graph Showing the Category Scale

Any plot generated by plotting a column containing any text versus a column containing data will use a category axis
automatically.

You can select a category scale for numeric data, and each unique value will be treated as its own category.

Note:  If a column contains more than one instance of the same category, the category appears only once, and
all corresponding data is plotted within that category.

Date and Time

Date and time formatted data are automatically plotted using a Date/Time axis scale. This scale is specifically
designed to handle true calendar date and time units, labeling and spacing. You can:

• Entering Dates and Times on page 167
• Change date and time labels.
• Change data and time intervals.

Reciprocal

A reciprocal axis scale uses the multiplicative inverse of a number, where x is the number which, when multiplied by
x, yields 1. Its equation is 1/x or x-1
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Figure 136: An Arrhenius Plot with a Reciprocal Axis Scale

Researchers often use a reciprocal scale when creating graphs for reliability studies. For example, there is a theory
that aging accelerates as temperature rises. The plot in this case would use a reciprocal temperature (1/T (1/mK)) x-
axis and a log (ln k) y-axis. The slope of the line fitted through the plot is the activation rate of the studied chemical
reaction, that is, the reaction causing the failure.

Weibull

The Weibull axis displays the Cumulative Percent Failure (CPF) using the Weibull distribution using the formula:

This scale is frequently used for life data analysis. The Failure Time, typically a log scale on the x-axis, is plotted
against the Cumulative Percent Failure, typically on the y-axis.

Changing Axis Scales and Range
You can control the axis units and increments used in representing your data. Axis scale and range are modified
within the Axis Scaling Properties found in Graph Properties.

You can also use transforms and tick labels and intervals from worksheet columns to create your own custom axis
scales.

Changing Axis Range

Axis range includes the values of the starting and ending points of an axis. You can choose to set axis range
automatically or manually.
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To change the axis range:

1. Double-click the axis to modify to open Graph Properties.
2. Select Axis > Scaling from the Properties list.
3. To automatically set the axis range, select Data Range from the Calculation list. SigmaPlot automatically

determines the axis range based on the data plotted.
For log axes, or axes that forbid zero or negative numbers, the minimum is set to the nearest major tick mark
beyond the smallest value.

4. To manually set the axis range, select Constant from the Calculation drop-down list, then type beginning and
ending axis range values in the Start and End edit boxes.

Note:  Date/time axes display the ranges in date and time units.

5. Select Pad 5% to add padding to both ends of the axis.
6. Select Nearest Tick to extend the range to the nearest major tick mark.

Changing Scale Type
To change an axis scale type:

1. Double-click the axis to modify to open Graph Properties.
2. Select Plot > Scaling from the Properties list.
3. Select the desired axis scale type from the Scale type drop-down list.

The default axis scales are Linear for all numeric data, Category for text data, and Date/Time for date and time
data.

Using a Category Scale

Use the category scale type by plotting a column containing categories against other columns of data values, or
modify an already existing plot to use a category scale by changing the axis scale type to Category, then using the
Graph Wizard to re-pick the data and assign your category column as the X or Y coordinate values.

Figure 137: Plotting Category Data Using a Category Scale
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1. To plot a column of text as a category scale:
a) Enter your category data (text) into a worksheet column, and corresponding data into adjacent worksheet

columns.
b) On the Create Graph tab, click the graph type and style you want to create.
c) In the Graph Wizard , select the data format, and click Next.
d) Since you have not already selected your data from the worksheet, click the worksheet columns to assign

them under Selected Columns. Plot your category column as the category axis data type, and pick your other
column(s) as the corresponding data type.

e) Click Finish to create the graph.
2. To modify a plot to use a category scale:

a) Double-click the axis you want to modify to open Graph Properties.
b) Select Axis > Scaling from the Properties list.
c) Select Category from the Scale type drop-down list.
d) Click the Create Graph tab, and then in the Wizard group, click Graph Wizard.

The Graph Wizard - Modify Plot dialog box appears.
e) Under Data Format, select the data format you want to use, and click Next.
f) Click the columns in the worksheet to choose the worksheet columns to assign to plotted data under Selected

Columns. Plot your category column as the data type you want to use as the category axis, and pick you other
columns(s) as the corresponding data type.

g) Click Finish to create the graph with the newly assigned worksheet data and modified data.

Using a Date and Time Scale

SigmaPlot graphs date and time data from worksheet columns as specific calendar dates and times against which
corresponding data values in other columns are plotted.

To create a plot using a date/time scale:

1. Enter dates or times into a column of a worksheet. For example, enter 1/1, 2/1, 3/1, etc., indicating months and
days.

2. Enter corresponding data into a separate worksheet column or columns.
3. Drag the pointer over both the date and data columns.
4. Create the graph using the Graph  toolbar or the Graph Wizard.
5. Plot your date and time column as the date/time axis.
6. Pick your other column(s) as the corresponding axis.
7. Click Finish in the Graph Wizard to create the graph.

Using a Custom Axis Scale

Hiding, Displaying, and Deleting Axes
The easiest way to hide an axis is to select it, then press Delete. The axis is hidden rather than deleted. You can also
hide an axis by right-clicking the axis, then choosing Hide.

Control the display of axes using the Axis Lines settings in Graph Propertiesr.

To view, hide or modify the display of an axis:

1. Double-click the axis to open Graph Properties.

Tip:  You can also double-click hidden axes.

2. Select Axis > Lines from the Properties list.
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3. Under Show/place axes, select an axis to display that axis, or clear an axis to hide it. Hidden axes hide all ticks
and labels associated with that axis.

Note:  You can hide 3D axes, but if frame lines are active, a line will remain present. Also, if the graph has
grid lines, a line will remain present. For more information, see Displaying Grid Lines and Backplanes on
page 291.

Changing Axis Line, Color, and Thickness

Use Graph Properties to change axis color and thickness.

To change the color and thickness of an axis:

1. Double-click the axis to open Graph Properties.
2. Select Axis > Lines from the Properties list.
3. To change the color of the axis, under Line properties, select a color from the Color drop-down list. Choose

(None) to make the axis transparent, and choose (Custom) to open the Custom Color dialog box.
4. To change the thickness of the axis, move the Thickness slider or type a thickness in the Thickness box.

Note:  3D graph frame lines are drawn over axes lines and may obscure 3D axes modifications.

Moving Axes

To move a 2D axes, select it and then move it with your mouse. You cannot move 3D axes, but you can hide them
from view.

Moving 2D Axes Manually

To move a 2D axis with the mouse, select the axis and drag it to a new position. Y axes move only horizontally and X
axes only vertically. Moving ternary graph axes changes the axis range and scale, along with the size and shape of the
graph. Axis titles move with the axis.

Figure 138: Moving an Axis by Dragging

Moving Axes to a Precise Location

Use the Axis Lines settings in Graph Properties to position axes a precise distance from the graph origin. For more
information, see Modifying Ternary Axes on page 297.

To move an axis:

1. Double-click the axis you want to move to open Graph Properties.
2. Select Axis > Lines from the Properties list.
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3. Under Show/place axes, move the sliders to change the percentage in the Top and Bottom boxes for X axes or Y
axes, or type the value in the fields. .
Locations are described as the percentage of the graph dimension the axes lie from the original position. To move
an axis up or right, enter a percent greater than 0% (positive). To move an axis down or left, enter a percent less
than 0% (negative). The defaults are 0.0%, and Normal.

Setting Axis Breaks
You can set axis breaks for 2D Cartesian graphs over specific ranges, at a specific location along the axis and you can
change the major tick intervals that occur after the break. You can also use several different break symbols.

Restriction:  You can't create axis breaks on a graph that uses a date and time axis scale.

Figure 139: A Graph Before and After the Addition of a Y Axis Break

Creating an Axis Break

To create an axis break:

1. Double-click the axis where you want to add the break to open Graph Properties.
2. Select Axis > Breaks from the Properties list.
3. Under Break range, select Show break.
4. In the Omit boxes, enter the Break to omit.
5. To specify the break position, move the Position slider or enter a specific value.

The location of the break is determined as a percent of the total axis length, from the origin.
6. To set the width of the space between break lines, move the Gap Width slider or enter a specific value.
7. To set a post break interval, type a value in the Post Break Interval box.

The default value is the interval specified for the axis range.

Note:  Tick values from a column are not applied to the post break interval.

8. To set axis break properties, under Break properties from the Symbol drop-down list, select a break symbol
type then use the Length, Color, and Thickness options.
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Working with Axis Titles and Tick Labels
SigmaPlot automatically labels graph axes with titles and tick labels. Axis titles can be modified like any other text
label.

Editing an Axis Title

To edit an axis title:

1. On the graph page, select axis title. The title appears highlighted.
2. Make your changes to the title.

Rotating Axis Titles

To rotate an axis title:

1. Right-click the axis title, and then click Edit. Edit Text dialog box appears.

2. Select a degree of rotation for the selected label from the Rotation drop-down list.

Viewing and Hiding Axis Titles and Tick Labels

The easiest way to hide a graph axis title or tick label is to click it and press delete. You can also right-click, and select
Delete.

Moving an Axis Title

To move an axis title, drag it with the mouse, just like any other text label.

Note:  Axis title position, relative to the axis, remains constant when the axis or graph is moved.

Changing Tick Mark Intervals
Use Graph Properties to modify tick intervals. You can also change tick marks for ternary graphs. For more
information, see Changing Tick Labels on page 288.

Important:  Tick Intervals options vary depending upon the axis scale used. For example, there are no tick
interval options for category axes.

Changing Probit Scale Tick Mark Intervals

To change the tick intervals for linear and probit axis scales:

1. Double-click the tick marks you want to change to open Graph Properties.
2. Select Axis > Scaling from the Properties list.
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3. To change major tick intervals:
a) Select Axis > Major Ticks from the Properties list.
b) Under Tick intervals, select either Manual, Automatic, or a column that contains the tick intervals.
c) If you select Manual, enter interval values by typing into the Every and From boxes.

The value in the Every field specifies how often major tick marks appear, and the From value specifies and
origin point on the axes from which major tick marks start appearing. For example, if you type 0 into the From
field and the 2 into the Every field, the major tick marks appear at even numbers on the axis. If you type 1 into
the From field , the major tick marks appear at odd numbers on the axis.

4. To set custom tick intervals, choose the major tick interval values from the worksheet column available in the
Major ticks drop-down list. Custom tick intervals are not available for minor ticks.

Tick Intervals for Log Axes

You can only specify log axis major tick marks automatically or from a column. However, you can select specific
intervals for log scale minor ticks.

Figure 140: A View of a Graph with Log Y Axis Minor Ticks

To change log scale minor tick intervals:

1. Change the axis scale to a log axis. For more information, see Changing Axis Scales and Range on page 279.
2. Double-click the tick marks to open Graph Properties.
3. Select Axis > Minor Ticks from the Properties list.
4. Under Tick intervals, select an interval from the Minor tick intervals drop-down list.

Natural Log and Logit Scales

Natural log and logit scales have only Automatic and from column Tick Intervals.

Natural log intervals occur at every factor of e. Logit ticks occur at 7, 10, then every ten until 90, then 95 and 97.
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Figure 141: Tick Intervals for Natural Log and Logit Scales

Tick Intervals for Probability Scales

Probability scale axes have no minor ticks, but have three different settings for major tick intervals, coarse, medium,
and fine, as well as the option to set tick intervals from a worksheet column.

Figure 142: Coarse, Medium and Fine Tick Intervals for Probability Scales

To specify the tick mark density for probability scales:

1. Double-click the tick marks to open Graph Properties.
2. Select Axis > Major Ticks from the Properties list.
3. Under Tick intervals, select a density from the Major ticks drop-down list.

Tick Intervals for Date and Time Axes

SigmaPlot automatically sets both major and minor tick intervals that are computed from the data range. You can also
manually set Major Ticks and Minor Ticks.

To set tick intervals for a date/time axis:

1. Double-click the tick marks to open Graph Properties.
2. Select Axis > Major Ticks  or Axis > Minor Ticks from the Properties list.
3. Under Tick intervals, from the Major ticks or Minor ticks drop-down list, select a tick interval type, Tick

intervals are defined by the unit Type used and the selected Count. Dates fall at 12:00 AM of the first day for that
period. The major tick interval options available are limited by the data range. You are prevented from selecting
time units that would create too many tick marks.

CAUTION:  Do not select a minor interval that creates hundreds or even many thousands of minor tick
marks.
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4. To increase the period between tick occurrences, change the Count. For example, set ticks to occur every other
Type date by changing the Count to 2, or every fifth by changing the count to 5. Counts must be positive integers.

Customizing Tick Intervals

You can specify major tick locations by entering major tick values into a worksheet column, then selecting that
column in Graph Properties.

Restriction:  Custom tick intervals are not available for minor ticks.

To use worksheet columns to customize tick intervals:

1. Enter the desired tick marks into an empty worksheet column.
2. Double-click the tick marks to open Graph Properties.
3. Select Axis > Major Ticks from the Properties list.
4. Under Tick intervals, from the Major ticks drop-down list, select the column number or title of the column you

want to use for major tick marks. The numeric values of the intervals are automatically used for tick labels, that
you can modify them like any other tick labels.

Changing Tick Mark Appearance
Use Graph Properties to modify tick appearance including tick length and color. You can also specify tick mark
direction, or hide tick marks altogether.

You can change:

• Tick marks for polar plots.
• Tick marks for ternary graphs.

Tick Mark Direction

To turn tick drawing on and off and to select tick directions for both sides of an axis:

1. Double-click tick mark to open Graph Properties.
2. Select Axis > Major Ticks or Axis > Minor Ticks from the Properties list.
3. From the Direction drop-down list for either axis:

• Select Outward, to point tick marks away from the graph.
• Select Inward to point tick marks toward the inside of the graph.
• Select Both to point tick marks in both directions.
• Select (none) to hide tick marks.

Note:  The options that appear under Direction are dependent upon what type of graph you are modifying.
If you are modifying a 3D plot, then the options are Front and Rear. If you are modifying a polar plot
with a radial axis, then the options are Outer and Inner. In a polar plot with a radial axis, you change the
direction of the spokes.

Directions for tick marks are independent for either side of the axis.

Hiding Tick Marks

To hide tick marks:

1. Click the tick marks on the page.
2. Press Delete, or right-click and from the shortcut menu, click Hide.
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Changing Tick Mark Line Attributes

To change tick mark length, color, and thickness:

1. Double-click the tick mark to open Graph Properties.
2. Select Axis > Major Ticks or Axis > Minor Ticks from the Properties list.
3. To change tick length, under Tick lines, select a length from the Tick length drop-down list. You can either

manually type in a value or move the slider.
4. To change tick color, select a tick on the graph.

5. In the pop up menu that appears, click the Color button, and then select a color from the palette that appears.
Select (none) to create transparent tick marks. For more information, see Using Custom Colors and Incrementing
Schemes on page 162 .

6. To change tick thickness, select a tick on the graph.

7. In the pop up menu that appears, click the Thickness button, and then select a thickness from the palette that
appears.

Changing Tick Labels
SigmaPlot can display tick labels for:

• Both major and minor tick marks.
• Tick marks.
• Standard numeric labels.
• Time and series labels.

You can also add a suffix or prefix to all major or minor tick labels on a selected axis, and modify the calculation and
precision of numeric labels, view different dates and times, select among many different series labels, and change the
font and other text attributes.

Changing Tick Label Font and Other Text Attributes

To change the font size, style, or color of tick labels:

1. Select a tick label.
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2. Edit the font size, style, and color properties from the pop up menu which appears.

3. To rotate tick labels, select a tick label, and on the pop up menu that appears, select form the Rotation drop-
down list. For more information, see Editing Text on page 144.

Changing Tick Label Type

You can change the type of tick label used for all axis types except for category axes.

1. Double-click a tick label to open Graph Properties.
2. Select Axis > Tick Labels or from the Properties list.
3. To use a numeric type of tick label, from the Type drop-down list, select Numeric, then use the Label

appearance options.
4. To use a series type of tick label, from the Type drop-down list, select Series.

Important:  If you want to plot data versus true calendar dates, you should have entered date and time
data in the worksheet, and use a date/time axis scale.

Formatting Numeric Tick Labels

To format numeric tick labels:

1. Double-click the tick labels of the axis you want to change to open Graph Properties.
2. Select Axis > Major Ticks or Axis > Minor ticks from the Properties list.
3. Under Label appearance, from the use drop-down list, select the type of label notation to use.

• Select Scientific Notation or Engineering Notation for large numbers only when numbers exceed a specified
range. Use the When below and or above drop-down lists to specify the range beyond which scientific
notation or engineering notation is used. Once a label exceeds the range, then all the labels will use the
specified notation.

• For log axes, you can select to display the number, only the Exponent, or both the Base and exponent.
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• For linear axes, you can select Scientific notation or Engineering notation to use always, or you can select
Scientific notation, for large numbers or Engineering notation, for large numbers to use only when
needed for large numbers. To specify when scientific notation is needed, enter the lower and upper ranges in
the When below and or above.

Figure 143: Log Scale Y Axes Using Numbers, Exponent Only, and Base and Exponent
4. To specify the number of places used to display numeric tick labels, under Precision, select Automatic to let

SigmaPlot automatically determine precision, or select Manual, then select the number of decimal places to use
from the Number of places drop-down list.

5. To divide numeric tick label values by a specific number, enter a divisor in the Factor Out drop-down list. A
value of 2 divides label values in half, a factor of 0.5 doubles the tick label values, etcetera.

Formatting Series Tick Labels

To format series tick labels:

1. Double-click the tick labels of the axis you want to change to open Graph Properties.
2. Select Axis > Major Ticks or Axis > Minor Ticks from the Properties list.
3. Select Series from the Type drop-down list.
4. From the Series drop-down list, select a series.
5. From the Length drop-down list, set the number of characters to use for the tick label.
6. From the Start at drop-down list, specify which series item to begin labeling tick marks with.
7. From the Step by list, set the frequency, or increment, of series items to use.

For example, if you are using a Days of the Week series, you might choose to start with Monday, and to step
labeling by 2 days at a time. Tick labels appear as Monday, Wednesday, Friday, Sunday, Tuesday, etc.

8. To re-start tick labeling from a specified point, use the After and Repeat From drop-down lists.
For example, if you were using a Days of the Week series, and were stepping by 2 days at a time, you might use
the After and Repeat From lists to specify that after Friday, repeat the series from Monday. Tick labels appear as
Monday, Wednesday, Friday, Monday, Wednesday, Friday, etc.

Adding a Prefix or Suffix to Tick Labels

To add a suffix or prefix to the major or minor tick labels on a selected axis:

1. Double-click the axis you want to change to open Graph Properties.
2. Select Axis > Major Labels  or Axis > Minor Labels from the Properties list.
3. To add a prefix or suffix to the major or minor tick labels, under Add to major tick labels, type the prefix or

suffix into the appropriate Prefix or Suffix boxes. All labels on the selected axis appear with the specified suffix
or prefix.

Tip:  You can use any keyboard or extended characters. Use the Windows Character map accessory
program, or Alt+Numeric keypad combinations to enter extended characters like degrees symbols (Alt
+0176).
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Using Custom Tick Labels

You can enter text and numbers into worksheet columns and use them as major tick labels.

To customize tick labels using worksheet columns:

1. Enter the labels you want to use in a worksheet column in the order you want them to appear. Enter minor labels in
the right adjacent column.

Tip:  To skip specific labels, leave an empty cell for that tick mark when entering the labels into the
worksheet column.

2. Double-click the axis tick labels you want to modify to open Graph Properties.
3. Select Axis > Tick Labels from the Properties list.
4. Select the column in which you entered the tick labels from the Type drop-down list. Labels for minor ticks are

automatically taken from the column to the right of the major tick labels.
5. To change the font used for the tick labels, select the tick label to view the shortcut menu, and then select a font

from the Font drop-down list.

Displaying Grid Lines and Backplanes
Display and modify grids for each graph plane using Graph Properties. Grid lines are associated with both a
backplane and one of the two axes which form the plane. If a graph has multiple axes, the axes used are the original
pair.

You can choose to turn on and modify grid lines for both major and minor tick intervals.

Modifying Graph Planes

To change graph planes:

1. Double-click the graph to open Graph Properties.
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2. Select Graph > Graph Planes from the Properties list.

3. If your graph is a 3D graph, select the plane to modify from the Plane list.

Note:  When modifying a 2D graph, only one plane is available.

4. To select a background color for the selected plane, under Background, select a color from the Color drop-
down list.
Select any of the listed colors, or select (Custom) to use or create a custom color.

5. To create a transparent plane, select (none) . Transparent planes are especially useful when superimposing
graphs over one another. The grid lines available for Cartesian plots are X, Y, and Z for 3D plots. The grid lines
for polar plots are for the Angular and Radial axes. Ternary plots have X, Y and Z direction grid lines.

Modifying Grid Lines

To change major or minor grid lines:

1. Double-click the graph to open Graph Properties.
2. Select Graph > Grids from the Properties list.
3. To change grid line thickness, under Grid lines, move the Thickness slider or type a thickness value in the

Thickness box.
4. To change grid line style, under Line properties, select a type from the Line Type  drop-down list.
5. To change grid line color, under Line properties, select a color from the Color drop-down list. Choose any of

the listed colors, or choose (Custom) to use or create a custom color. Choose (none) to turn off grid lines.
6. To change or add a gap color, select a color from the Gap Color drop-down list. This option is only available if

you select a line type with actual "gaps" in it, like dotted or dashed, for example.
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7. To move the grid behind or in front of the plot, from the Layering drop-down list, select to move either the plot
or grid to the front. This feature is especially useful for bar charts, and is not available for 3D plots.

Figure 144: A Bar Chart with a White Backplane and White Grid Lines Placed in Front of the Plot

Hiding and Viewing Grid Lines

To view hidden grid lines, or hide visible grid lines:

1. Double-click the graph to open Graph Properties.
2. Select Graph > Grids from the Properties list.
3. To hide grid lines, under Style, select (none) from the Line Type drop-down list.
4. To display grid lines,  select any style other than (none) from the Line Type drop-down list.

Modifying Polar Axes
Polar plots have a radial axis and an angular axis. The angular axis describes a circle and can use radians, degrees, or
other units as the scale. There are both outer and inner angular axes.

The radial axes are spokes of the circle and scale the distance from the center of the circle (the radius, or R). There are
four radial axes, referred to as spokes 1-4.
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Figure 145: A Diagram of the Axes of a Polar Plot

Restriction:  Axis breaks cannot be created for either radial or angular axes.

Angular Axes

You can draw angular axes along the inner and outer circumferences of the graph. By default, the inner axis is not
displayed. You can modify angular axes by:

• Changing axis titles.
• Displaying or hiding either axis.
• Changing axis lines.
• Changing axis scaling, range, and rotation.
• Changing tick marks.
• Changing axis tick labels.

Changing Angular Axis Scaling and Position

Polar plot angular axis scale and range settings control the axis units and increments used to plot data. You can
modify axis scale, range, units, and rotation using the Scale settings on in Graph Properties.

To change an axis scale, range, units, and rotation:

1. Double-click the plot to open Graph Properties.
2. Under Current, select Angular Data from the Axis drop-down list.
3. Select Axis > Theta Scaling from the Properties list.
4. To change the axis scale used,  select the desired axis scale type from the Type drop-down list.



 | Modifying Axes, Tick Marks, and Grids | 295

5. To change the measurement units of the angular axis, select measurement units from the Axis Units  drop-
down list. If you don't see the axis units you want to use for your polar plot listed in the list, select Other, then
type new axis range values in the From and To boxes under Range. If using a predefined measurement unit, the
From and To box values are entered automatically. For more information, see Using a Custom Axis Scale on page
281.

Note:  The only effect of changing units is to change the predefined axis range. This range can be
manually changed regardless of the current units.

6. To change the size of the displayed arc of the polar plot, move the Arc slider. A setting of 360 degrees displays
the entire circle, 270 degrees displays three-quarters of the circle, and 90 degrees displays half of the circle.

Tip:  If you change the arc of the angular axis, the axis range remains the same. The current axis range
appears along the new distance of the arc.

7. To change the start angle for the displayed arc, move the Start angle slider. The default is 0 degrees (3
o’clock). Rotation is counterclockwise.

Figure 146: Polar plots with: Starting angle of 315° and arc of 270°; start angle of 0° and arc of
180°; and start angle of 135° and arc of 22.5°

Moving Angular Axis Positions

You can drag both inner and outer angular axes closer or further from the center of the graph. Select the axis, and
move it using the mouse.

To set exact locations for angular axes:

1. Double-click an angular axis to open Graph Properties.
2. Under Current, select Angular Data from the Axis drop-down list.
3. Select Axis > Lines from the Properties list.
4. To change the percentage in the Outer and Inner axes,  under Show/place axes, move the Outer  and Inner 

sliders or enter values.
Locations are described as the percentage of the distance the axes lie from the center of the graph. To move an axis
out, increase the percent. To move an axis in, decrease the percent.

Radial Axes

The radial axes are drawn along the radius of the graph, and by default are displayed as four axes extending from the
center of the graph to the outer of edge the graph. Each of the radial axes is a representation of the same data, so the
range and scale must be the same for each radial axis; however, you can modify the color, tick marks, labels, location,
and display of each radial axis independently.

Modify radial axes by:

• Displaying or hiding any axis.
• Changing display of axis and tick label titles.
• Changing axis lines.
• Changing axis scaling.
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• Changing tick marks.
• Changing axis tick label type.

Modifying Radial Axes Lines and Position

To control polar plot radial axes line settings:

1. Double-click the graph to open Graph Properties.
2. Under Current, select Radial Data from the Axis drop-down list.
3. Select Axis > Radius Lines from the Properties list.

Moving a Radial Axis

To move a radial axis:

1. Select the axis on the page.
2. Use the mouse to drag it to a new location. Radial axes rotate about the center of the graph like the spokes of a

wheel.

Setting Radial Axis Positions to Exact Degree Positions

To set radial axis positions to exact degree positions

1. Double-click a radial axis to open Graph Properties.
2. Under Current, select Radial Data from the Axis drop-down list.
3. Select Axis > Radial Lines from the Properties list.
4. To move a radial axis, under Show/Place Axes, move the sliders to set a new location. The axis location is in

degrees from 0 degrees (3 o'clock). The defaults are 0 degrees, 90 degrees, 180 degrees, and 270 degrees.
5. To offset an axis from the center of the graph, move the Axes start slider to change the length of the radial

axes.
Setting the slider to 0% draws the axis from the center of the graph outward, 25% draws the axis beginning a
quarter of the distance from the center, 50% draws it half the distance from the center, and so on.

Figure 147: Radial Axes in the Default Positions, and Offset by 45 degrees with an Axes Start of
30%

Displaying and Modifying Radial Axes Lines

To display and modify radial axes lines:

1. Double-click a radial axis to open Graph Properties.
2. Under Current, select Radial Data from the Axis drop-down list.
3. Select Axis > Radial Lines from the Properties list.
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4. To view or hide a radial axis, select Spoke 1, 2, 3, or 4.
5. To change line color and thickness, under Line Properties, select a color and thickness from the Color and

Thickness drop-down lists.

Displaying and Changing Radial Axis Ticks and Labels

Use Graph Properties Tick Label settings to display polar radial axis labels, and modify tick labels. Angular axes
labels are analogous to standard Cartesian graph titles and labels; however, radial tick marks and labels have
additional positioning options.

Other than display and position, polar plot tick marks and labels have the same options as Cartesian graph tick marks
and labels.

Specifying the Direction for Radial Axis Tick Marks for Each Pair of Radial Axes

To specify the direction for radial axis tick marks for each pair of radial axes:

1. Double-click a radial axis to open Graph Properties.
2. Under Current, select Radial Data from the Axis drop-down list.
3. Select either Axis > Major Ticks or Axis > Minor Minor from the Properties list.
4. Use Direction options to change the tick directions on the radial axes. You can only change the directions for

Spokes 1 and 3 together, and for 2 and 4 together.

Remember:  Selecting Inward orients the ticks clockwise, and Outward points the ticks
counterclockwise.

Figure 148: A Polar Plot with Ticks for Spokes 1, 3 Pointing Inward and 2,4 Outward
5. Selecting Both directions draws ticks both clockwise and counterclockwise, and selecting (none) hides the tick

marks.

Modifying Ternary Axes
Ternary axes are drawn to represent increases in data value in a counterclockwise direction by default. You can
reverse the axis direction, which is indicated by a reversal of tick labels. The tick direction changes accordingly.
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Because ternary axes are interdependent, any modification in the scale type or range of one of the axes is reflected in
the other axes, and may alter the shape and size of the graph. You can modify the color and thickness of axis lines,
the appearance of tick marks and tick labels, location and rotation of axis titles, and display of each ternary axis
independently.

Ternary axes can be modified similarly to other graph axes.

Restriction:  You cannot create axis breaks for ternary axes.

Modifying Ternary Axis Title Location

You can position axis titles of ternary graphs either at the apex or along the length of the axis. You can also rotate
them to a position parallel to the axis.

To reposition a ternary graph axis title:

1. Select the axis.
2. In the pop up menu that appears, select a degree of rotation from the Rotation drop-down list.

Figure 149: The titles along the axes are also rotated with the axes.

Changing Ternary Axis Range, Scale, and Direction

Ternary axis scale type and range settings control the units and increments used to plot the data. Axis scale, range, and
direction are modified using the Scaling settings displayed in Graph Properties. Axis range can also be modified by
dragging a selected axis. Modifying a ternary axis range can alter the size and even the shape of the graph.

Modifying Axis Range by Dragging

You can modify axis range by dragging a selected axis or apex. Because ternary axes are interdependent, dragging an
axis to modify its range can change the ranges of the other axes.

Dragging an apex modifies the ranges of the two axes which form the apex; reducing the maximum of an axis range
introduces a fourth axis, creating a trapezoid graph. Dragging a selected axis toward or away from the center of the
graph modifies all three axis ranges by the same increment, maintaining the original shape of the graph.

To modify ternary axis ranges:

1. View the ternary graph.
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2. Select either an apex or an axis to modify. A selected apex displays a black, square selection handle and is
surrounded by a dotted line; a selected axis displays a selection handle at the center point of its range and is
surrounded by a dotted line.

Figure 150: Dragging an Axis to Rescale a Ternary Plot Range
3. Drag either the apex or the axis toward or away from the center of the graph. The axis ranges adjust accordingly.

Note:  Modifying axis ranges of ternary graphs often introduces additional axes. These axes are the
second axes of each "pair' of axis lines. An axis which appears as a result of moving an apex is paired with
the axis opposite the apex which moved.

Figure 151: The left graph Y axis was dragged to 50%. The right graph Y apex was dragged to
50%.

Modifying Ternary Axis Range

Use Graph Properties to modify ternary graph ranges.

1. Double-click the axis to open Graph Properties.
2. Select Axis > Ternary Scaling from the Properties list.
3. To change individual axis ranges, under X Range, Y Range, and Z Range move the Start and End sliders.

Tip:  Increasing an axis range minimum reduces the size of the ternary graph because it is always reduces
the other axis range maximums. Reducing the maximum of a ternary axis range changes the graph shape.

Ternary Scale Type

All ternary axes on a single graph use either the default Percentage (0-100) scale or the Unitary (0.0-1.0) scale. Data
used by each scale should be within the required ranges for each scale.

The type of graph you create determines the graph scale. There should be no need to change the scale unless a mistake
was made while creating the graph. Changing the scaling from Percentage to Unitary can also hide out-of-range
data.
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Figure 152: The data range used for Percentage is 0-100; the data range for Unitary data is 0-1.

To change ternary axis scale type:

1. Double-click the ternary axis to open Graph Properties.
2. Select Axis > Ternary Scaling from the Properties list.
3. Select the new axis scale type from the Scale type drop-down list.

When you change the axis scale type for one axis, it is changed for all axes.

Changing Ternary Axis Direction

Ternary graph axes show data increasing in either a clockwise or counterclockwise direction. Each axis line can
represent either or both of two values in the graph. Changing the direction changes which values are shown on the
axis by default. Modifying axis direction changes all three axes; ternary axes are interdependent.

Ternary graph axes have interdependent axis ranges from 0 to 100, where 0 to 100 is the default setting or 0-1.0 where
0-1.0 is the default setting.

The axis range and scale control the axis units and increments used to plot data.

To modify the axis direction:

1. Double-click the ternary axis to open Graph Properties.
2. Select Axis > Ternary Scaling from the Properties list.
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3. Select the axis direction from the Direction drop-down list.

The tick directions change on all three axes and the axis ranges reverse.

Changing the axis directions inverts the 0-100 direction of the labels and changes the direction of the tick marks.
However, axis titles only move if they are positioned along an axis, not at an apex. Apex position for each variable
remain constant regardless of axis direction.

Figure 153: Ternary Graphs Displaying Counterclockwise (Left) and Clockwise (Right) Axis
Directions

Changing Ternary Axis Tick Marks and Tick Labels

Ternary axes tick marks indicate the precise location of each value at specific intervals determined by the axis range.
Tick marks and tick labels along ternary axes have both direction and origin. Every tick location can have tick
marks and labels pointing in clockwise, counterclockwise, both clockwise and counterclockwise, and perpendicular
directions, independent of the actual direction of the data.

Tick and Tick Label Directions and Ownership

Tick marks and labels indicate which values correspond to the plotted data points by the direction they lean in. The
direction also indicates which axis the tick is actually controlled by. This can be a different axis than the tick mark is
actually drawn on.

For example, the default ticks for the X axis are drawn leaning in a clockwise direction on the bottom axis. These tick
marks also correspond to the counterclockwise tick marks on the Y axis. If you change the tick mark attributes for X
axis ticks, you can affect tick marks that are actually drawn on a different axis.

The following figure best illustrates tick mark and label ownership.
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Figure 154: The X Axis ticks and labels are drawn in light gray, the Y Axis ticks and labels are
drawn in black, and the Z Axis ticks and labels are drawn in dark gray.

Modifying Ternary Tick Marks Direction and Intervals

Use Graph Properties to modify tick appearance including tick length and color. You can also specify to view or hide
tick marks, which side of the axis they extend from, and the tick interval.

To modify tick marks:

1. Double-click the ternary axis to open Graph Properties.
2. Select either Axis > Major Ternary Ticks or Axis > Minor Ternary Ticks from the Properties list.
3. To turn tick drawing on and off and to select tick directions for both sides of an axis line, use the Direction

lists. The second list is only available if a ternary plot range change has created a secondary axis.
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4. Select Out, In, or In and Out to display tick marks on the selected axis out from the center of the graph, in
toward the center of the graph, or both outward and inward. Select a clockwise, counterclockwise, both, or 90
Degree option to select the tick mark direction along the axis. Select (none) to hide tick marks.

Figure 155: Graph Examples of Tick Marks Pointing, counterclockwise, Clockwise, Both, and 90
Degrees



5. To change tick intervals,  under Tick intervals, move the Major ticks every or Minor ticks every slider.

Figure 156: Ternary Graphs with Tick Intervals of 15 and 30

Modifying Ternary Tick Mark Line Appearance

To change tick mark display, length, color, and interval:

1. Double-click the ternary axis to open Graph Properties.
2. Select either Axis > Major Ternary Ticks or Axis > Minor Ternary Ticks from the Properties list.
3. To change tick thickness, under Tick lines, move the Length and Thickness sliders. Drag the slider control with

the mouse or set the tick length and thickness to specific values by typing directly in the Length and Thickness
boxes.

4. To change tick color, under Tick lines, select a color from the Color drop-down list. Choose from any of the
listed colors, or select (Custom) to use a pre-defined custom color or create your own color. Select (none) to
create transparent tick marks.

Modifying Ternary Tick Label Display

Tick labels are drawn using directions clockwise, counterclockwise, and both clockwise and counterclockwise. Tick
label direction is controlled independently of the data direction. Tick labels can also be turned off, have a prefix or
suffix added, and be rotated along the angle of the axis line.

You can also modify the tick label.

To modify tick label display along an axis:

1. Double-click the axis you want to change to open Graph Properties.
2. Select either Axis > Major Ternary Labels or Axis > Minor Ternary Labels from the Properties list.
3. To change the direction of the axis tick labels, under Major (or Minor) tick labels, select Clockwise and

Counterclockwise (CCW). You can draw in both directions at once.
4. To draw tick labels at the 90 degrees tick position, clear both direction options.
5. To add a suffix or prefix to the major or minor tick labels on ternary axes, under Add to major (or minor)

tick labels type a prefix or suffix..
6. To rotate major or minor tick labels parallel to their axis, under Rotate with axis, select Axis title or Tick

labels.
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10
Using the Report Editor

Topics:

• Creating Reports
• Setting Report Options
• Setting Report Page Size and

Margins
• Exporting Reports
• Printing Reports
• Inserting the Current Date and

Time into a Report
• Formatting Text and

Paragraphs
• Using the Report Editor Ruler
• Adding Tables to Reports

Use the Report Editor to annotate and document your graphs and data. The
Report Editor features a complete text editor and OLE2 insertion and editing.
It is also used by the Regression Wizard to report regression results and by the
Statistics Wizard to report statistics test results.
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Creating Reports
To create a new report:

1. Right-click the section in the notebook where you want to create the report, and on the shortcut menu click New.

2. Click Report. A report window opens and a new report is added to the selected section.

Setting Report Options
Use the Reports tab on the Options dialog box to:

• Set the number of decimals displayed in the report.
• Enable or disable scientific notation.
• Enable or disable explanatory text for report results.
• Set whether or not you want to report only flagged values.
• Hide or display the report ruler.
• Set measurement units.

To set report options:
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1. Click the Main Button.

2. Click Options.

3. Click the Report tab.

4. To set the number of significant digits used for the values in the report, select Number of Significant Digits.
The default is three digits. The maximum number of digits is sixteen.

5. To use scientific notation for the appropriate values in the report tables, select Always Use Scientific
Notation. If this option is disabled, scientific notation is only used when the value is too long to fit in the table
cell. This option is disabled by default.
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6. To explain explanatory text for test results in the report, select Explain Test Results. This option is enabled by
default. Clear this option to keep explanatory text out of the report.

7. To specify a significant P value, select P Value for Significance. This option determines whether there is
a statistically significant difference in the mean values of the groups being tested. The value you specify is
compared to the P values computed by all tests.

Note:  This P value does not affect the actual test results. It only affects the text that explains if the
difference in the mean values of the groups is due to chance or due to random sampling variation.

If the P computed by the test is smaller than the P set here, the text reads, "The difference in the mean values of
the two groups is greater than would be expected by chance; there is a statistically significant difference between
the input groups."
If the P value computed by the test is greater than the P set here, the text reads, "The difference in the mean
values of the two groups is not great enough to reject the possibility that the difference is due to random sampling
variability. There is not a statistically significant difference between the input groups."
One of the above explanation text strings appears for each P value computed by the test. ANOVAs and some
regressions produce multiple P values.

Remember:  If the Explain Test Results option is cleared, the results of this P value do not appear in the
report.

8. To display the ruler at the top margin of the report page, select Show Ruler. This option is enabled by default.
Clear this option to hide the report ruler.

Setting Report Page Size and Margins
Use the report Page Setup dialog box to set report margins, paper orientation, paper size, and paper source.

Important:  These settings apply to the current report, but not to other open reports. To have these settings
apply to subsequently opened or created reports, make your changes, then close the page. Newly opened or
created reports will use all of these settings.

To open the Page Setup dialog box:

1. Select the report window.
2. Click the Main Button.
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3. Click Print, and then Page Setup.

4. In the Page Setup dialog box, select the paper size and source from the Size and Source drop-down lists. The
page sample at the top of the dialog box reflects changes.

5. To select the printer, click Printer. The Page Setup dialog box appears on which you can select and setup any
printer configured for your system.

6. To change the margins, under Margins (inches), type the desired values into the four boxes. The current ruler
units appear in the Margins title.

Exporting Reports
You can only export the entire report. If you want to export a portion of the report, delete the portion you don't want to
export, then export the remainder as the file.

To export a report:
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1. Select and view the report window you want to export.
2. On the Home tab, in the Export group, click Report.

3. In the Export File dialog box, from the Files of type drop-down list, select a file format.
4. Click Export to create the file.

Printing Reports
You can print any report in a SigmaPlot notebook.

1. To display a report as it will look when printed:
a) Click the Main Button.

b) Click Print, and then Print Preview.

c) Click OK to print the report.
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2. To set printing options before printing the report:
a) Click Main Button > Print > Page Setup.

b) In the Page Setup dialog box, click Printer.

c) In the next Page Setup dialog box, click Properties.
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d) Click OK when you are satisfied with the printer properties settings.

Restriction:  The Properties dialog box options vary from printer to printer.

e) Click OK to print the report.

Inserting the Current Date and Time into a Report
To insert the current date and time into reports:

1. Select the report and click where you want to insert the Date or Time.
2. On the Report tab, in the Insert group, click the Insert drop-down list.

3. Click Date and Time.
4. In the Date and Time dialog box, select the date and time format from the Available formats list.

5. Click OK. The current date and time appear as text at the specified location.

Important:  The list of available date and time formats depends on your Regional Settings. You can view
or modify the Regional Settings directly from your Windows Control Panel.
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Formatting Text and Paragraphs
Use the Format, Ruler, and Text groups on the Reports tab to change report text attributes such as font, font size,
color, and style of selected text.

To modify text:

1. Select the text you want to modify. You can select individual characters, words, paragraphs, or the entire report.
2. To format character font, size, weight, underlining, or color, use the Text group. For more information, see

Editing Text on page 144.
3. To set paragraph alignment, use Align Left, Align Center, and Align Right and Justify in the Text group.

4. To add bullets or numbers a to selected paragraph, select the Bullet Style or Number Style in the Format
group.

5. To remove bullets, click the Bullet Style or Number Style again. You can also right-click the report page and on
the shortcut menu click Bullet or Number.

Using the Report Editor Ruler
Use the Report Editor ruler to view margins and to both view and modify report page tabs and paragraph indents.

Figure 157: The Report Editor Ruler

The ruler indicates:

• Usable page column width
• Default tabs
• User-defined tabs
• Left and right paragraph indents
• First line indent
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Showing and Hiding Report Rulers

To show or hide horizontal and vertical rulers:

1. On the Report tab, in the Ruler group, click the Show Ruler drop-down list.

2. Click Show Vertical Ruler and Show Horizontal Ruler. A check mark means the ruler is visible. Clear it to
make the ruler invisible.

Setting Report Ruler Units

You can set the horizontal and vertical ruler units in SigmaPlot reports to either Inches or Centimeters.

1. On the Report tab, in the Ruler group, click the Show Ruler drop-down list.

2. Click Units and then either Inches or Centimeters.

Setting Tabs

All tab stops appear on the report ruler. The default tab stop is 0.25" regardless of the current units. Tab stops are
made for individual and selected paragraphs, and are saved with reports.

To set a tab:

1. Select the paragraph(s) to change the tab stops.
2. Click the ruler where you want to place a tab. A tab marker appears at the clicked location.
3. To move a tab, drag the tab marker to another location on the ruler. To delete a tab, drag the tab marker off the

ruler.
You can also set tabs from the Tabs dialog box.

4. On the Report tab, in the Format group, click Tabs.
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5. In the Tabs dialog box, select tab stops from the Tab position in inches drop-down list.

6. Enter Tab locations using the current ruler units.
7. Click OK to add the tab setting to the list.

Setting Paragraph Indents

You can set left, right, and first line indents for individual paragraphs. These settings are saved with the report.

To set paragraph indents:

1. Select the paragraph(s) to change the indents.

2. To change the first line indent, drag the marker at the top left of the ruler.
3. To change the left indent, drag the marker on the bottom left of the ruler.
4. To move both the left and first line indents, drag each marker separately.
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5. To change the right indent, drag the marker on the bottom right side of the ruler.

Tip:  To create an indented line, drag the top left marker to the right of the left indent. To create a hanging
indent, drag top left marker to the left of the bottom left indent marker.

Adding Tables to Reports
1. In the report, click where you want the report to appear.
2. On the Report tab, in the Tables group, click Tables, and then click Insert Table.
3. In the New Table Parameters dialog box, select the number of rows and columns you'd like to appear in the table.

Changing Table Border Color

1. On the Report tab, in the Tables group, click Tables, and then click Table border color.
2. Select a color in the Color dialog box.
3. Click OK.

Deleting Cells, Columns, and Rows from Tables

1. Select the block of cells in the table that you'd like to delete.
2. Right-click, and on the shortcut menu, select Delete Table.

You can also select the entire table and press Delete.

Adding Rows to Report Tables

1. Click on a cell in a table above or below where you'd like the new row to appear.
2. On the Report tab, in the Tables group, click the Rows drop-down list.
3. To add a row above the cell, click Insert rows above.
4. To add a row below the cell, click Insert rows below.

Adding Columns to Report Tables

1. Click on a cell in a table to the left or to the right of where you'd like the new column to appear.
2. On the Report tab, in the Tables group, click Columns drop-down list.
3. To add a column to the right of the cell, click Insert columns to the right.
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4. To add a column to the left of the cell, click Insert columns to the left.
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11
Publishing Graphs

Topics:

• Publishing Graphs on the World
Wide Web

• Submitting Graphs for
Publication

• The Submission Assistant

You can use SigmaPlot to publish graphs on the World Wide Web, and to
create publication quality graphs for submission to journals and other printed
forms.
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Publishing Graphs on the World Wide Web
You can save your graphs in high resolution and then later publish them on the Internet using the SigmaPlot
WebViewer. For more information, see About the SigmaPlot WebViewer on page 320.

Saving your graphs as a web page creates HTML code that you can later import into any HTML editor.

About the SigmaPlot WebViewer

The SigmaPlot WebViewer is an ActiveX control freely distributed from the Systat Web site. If this control is not
installed the first time a SigmaPlot graph is viewed on a web page, the WebViewer is automatically installed. Then
you can view the graphs in high resolution on the Intranet or Internet.

Using the SigmaPlot WebViewer, you can:

• View the graphs in high resolution.
• Pan and zoom the graph without losing resolution.
• Print in high resolution (printer resolution) as opposed to typical Web graphics (GIFs, JPEGs, etc.) that are printed

in low resolution.
• View the data used to create the graph.

Exporting Graphs into HTML Format

When you export a graph to the Web, SigmaPlot automatically creates three files:

• A notebook .JNB file which contains the SigmaPlot graph and data worksheet.
• A .JPG of the graph, viewable by those who do not have the SigmaPlot WebViewer.
• An .HTM file which references a .JPG of the graph and the .JNB file.

You can export an entire graph page or other pasted objects.

To export a SigmaPlot graph into HTML format:

1. Open a graph page.
2. Select the page objects you want to publish.
3. On the Home tab, in the Export group, click the Graph drop-down list.

4. Click Save as Web Page.
5. In the Export File dialog box, enter a name of the file in the File name box.
6. Click Export.
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7. To set the size of the figure, in the Export Web Graph dialog box, select desired measurements from the Height
and Width drop-down lists.

Tip:  One inch is 96 pixels, and the aspect ratio Export Web Graph dialog box uses is fixed.

8. To export the currently selected graph or objects, select Export Selected Only.
9. To export the entire graph page, clear Export Selected Only.
10. To password protect the file, click Set Password.
11. Click OK.

Three files are created: an .HTM file which references a saved .JPG file, and a .JNB file. You can later insert
this .HTM file into any HTML editor.

Password Protecting Data on the World Wide Web

You can secure your data for a graph you export to an HTML file by setting a password for viewers to enter when
viewing this graph on the Internet. Setting a password also prevents the opening and downloading of this file.

To set a password:

On the Export Web Graph dialog box, click Set Password. The Set Password dialog box appears.

Exporting Data Associated with the Graph

When you export a graph to a web page, you not only export the data for the graph but the entire worksheet as well.
This can be useful if you want to associate or display additional data for the graph, but it can also increase the size of
the .JNB file, which can slow viewing.

To export just the data associated with the graph:

1. Select the graph on the page, and copy it.
2. Click the Main Button.

3. Click New > Graph Page.

4. Click No on the Graph Page dialog box.
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5. Paste the graph to the new page.
Now when you export this graph, you will also only export the data associated with the graph.

Submitting Graphs for Publication
The following are some guidelines for preparing graphs for submission to journals or other printed form. This process
is not necessarily simple, and requires understanding both the figure requirements of the publication as well as
graphic file formats and terminology.

Figure Submission Requirements

The ultimate destination for most SigmaPlot graphs is a publication, and most publishers are now equipped for digital
pre-press. This requires graphic files with specific formats and properties. Keep in mind the requirements of the
different journals and other publications. These tend to vary, but are usually available at the web site for the journal
submission requirements.

Some URLs (as of the writing of this document) for requirements for some major publications are:

• Nature: http://www.nature.com/nature/submit/gta/index.html
• Science: http://www.submit2science.org/ws/menu.asp
• The Proceedings of the National Academy of Sciences: http://www.pnas.org/misc/iforc.shtml#Submitting

%20Manuscripts
• Journal of the American Chemical Society: http://pubs.acs.org/instruct/illus.html and http://pubs.acs.org/

page/4authors/index.html

Many journals also use the Cadmus electronic prepress service. Their requirements can be found at: http://
cjs.cadmus.com/da/guidelines.asp.

Creating Files for Figure Submission

The steps to producing a file for publication can vary from publisher to publisher. For more information, see Figure
Submission Requirements on page 322.

When preparing a figure for file export, first determine:

• The final size of the figure, including the size of text (usually inches or millimeters).
• The required line weights.
• Acceptable typefaces (especially important for EPS (Encapsulated Postscript) files).
• The desired final dpi (the dots-per-inch resolution), if necessary.

To produce a file for publication:

1. Determine the final size of the figure, the heights of text and thicknesses of lines and whether the figure will be
color, grayscale, or black and white.

2. Determine what file formats are acceptable, and choose the best one. The ranking in which you should choose
your format is:

• SigmaPlot
• EPS
• TIFF

3. Printed hardcopy (not really a file, but some publications actually still prefer this).
These formats are regardless of whether the graph is color or not.
Some publishers will directly accept SigmaPlot files. Most others accept EPS, TIFF, or both.

4. Determine how much the figure is going to be scaled using the size of your current figure. For example, if your
graph is 5 inches wide, but the figures are printed at 3.25 inches wide, then scale your graph by a factor of 3.25/5,
or .65.
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5. Increase text labels and line widths accordingly on your SigmaPlot graph.
For example, if you reduce your graph to .65 of the original size, and text must be 10pt in height, increase your
labels to at least 15.5pt.
Alternately, you can reduce the graph itself to the final publication size.

6. Make any other changes to your graph to meet the publisher's requirements, such as typeface, labeling, and so on.
7. Once you have your graph formatted, produce the selected file. Make sure that you select the figure (click it)

before choosing export-this will automatically crop your figure for you.
If you are producing an EPS file, you don't need to pay attention to dpi at all.
If you must use TIFF format, make sure you use the CMYK-compressed TIFF format. Uncompressed TIFF files
are too big to easily handle. Also, you will now have to do some dpi calculations.
For example, if you are producing a file that requires a final printed dpi of 600, and the graph is being reduced
by a .65 ratio, do not set the file dpi to 600. Instead, use a dpi of 390 (600*.65). When this file shrinks to the final
printed size, the final dpi will also be 600.

Why Use EPS?

Most publishers request either EPS or TIFF formats. When given a choice, choose EPS. Why? Because EPS is known
as a vector format. This means that the image is not made up of pixels, but instead graphic descriptions of lines, fills,
text, and so on. A vector format has no "size." It is dimensionless. This means you can shrink it as small as you want,
or grow it as big as you want, with no change in resolution. dpi has no meaning for a vector file.

This format is ideal for a graph figure since there is no degradation of the quality of the figure as it re-scales. It is also
means that when you place a vector format file in a document, it often first appears at an arbitrary size, and then you
can scale it to the final desired size. This can often startle, annoy or confuse someone not familiar with the behavior of
vector files.

The other vector format supported by SigmaPlot is the Windows Enhanced Metafile format.

Restriction:  Be aware SigmaPlot does not support certain graphic features in the EPS format, such as anti-
aliasing, gradient fills, and partial color transparency; however, the Enhanced Metafile format does support
these features.

About dpi

dpi (dots per inch) is a printer term, and is often misleading. dpi determines how many pixels are used to create the
figure. A more accurate term would be resolution. You can increase the final dpi of a raster figure by shrinking it. This
creates more pixels within a smaller space, increasing the dpi.

Most printed figures do not require a dpi higher than 600 for grayscale figures, and 300 dpi for color figures. The
1200 dpi number is for black and white figures only that have no half toning. If you must produce a 1200 dpi figure,
you will have to do some post-processing on your file in order make it palatable to the printer. This can be beneficial
if you must use TIFF file and have Photoshop.

The Submission Assistant
The Submission Assistant walks you through the sometimes arduous process of creating graphs suitable for
publication. Choose from a list of journal profiles that correspond to specific journal submission requirements,
or create and edit your own profiles. If you run into any problems along the way, the Submission Assistant offers
suggestions to get your graph publication-ready.

This section explains how to:

• Submit a graph using the Submission Assistant.
• Editing a submission profile.



Using the Submission Assistant

To start the Submission Assistant:

1. On the Home tab, in the Export group, click Graph.
2. Click Submission Assistant.

3. Once the graph has met the Submission Criteria, click Export.

4. In the Submission Assistant dialog box, pick a journal profile from the Submission Profile drop-down list.

Note:  Profile data is stored by default in individual profile files in your User’s Folder. For more
information, see About SigmaPlot's User and Program Files on page 5

.
5. Enter the final figure size into the Height and Width fields. This is either set by default or you enter this

information manually.
6. Once the graph has met the Submission Criteria, click Export.

Editing a Submission Profile

Use the Submission Assistant - Pick profile dialog box to modify the file type, figure size and minimum sizes for
fonts and lines.

To edit a profile:

1. On the Submission Assistant - Edit profile dialog box, click Edit.
2. After you've edited the profile, click OK to save it.



Chapter

12
Automating Routine Tasks

Topics:

• Before you Record a Macro
• Recording Macros
• Creating Macros Using the

Macro Language
• Editing Macros
• About User-Defined Functions
• Using the Debug Window
• Streamlining Procedures with

Macros

SigmaPlot uses a VBA®-like macro language to access automation internally;
however, whether you have never programmed, or are an expert programmer,
you can take advantage of this technology by using the Macro Recorder.
This chapter describes how to use SigmaPlot's Macro Recorder and
integrated development environment (IDE). It also contains descriptions of
related features accessible in the Macro window, including the Sax Basic
programming language, debugging tool, dialog box editor, and user-defined
functions.

Record a macro any time that you find yourself regularly typing the same
keystrokes, choosing the same commands, or going through the same
sequence of operations.
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Before you Record a Macro
Before you record the macro:

• Analyze the task you want to automate. If the macro has more than a few steps, write down an outline of the steps.
• Rehearse the sequence to make sure you have included every single action.
• Decide what to call the macro, where to assign it, and where to save it.

Recording Macros
To record a macro:

1. On the Toolbox tab, in the Macros group, click Record New Macro.

REC appears in the status area of SigmaPlot's main window, indicating that the macro is recording your tab
selections and keystrokes.

2. Complete the activity you want to include in this macro.

Note:  The Macro Recorder does not record cursor movements.

3. When you are finished recording the macro, on the Toolbox tab, in the Macros group, click Stop Recording.
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4. In the Macro Options dialog box, type a name for the macro in the Name text box.
Give the macro a descriptive name. You can use a combination of upper- and lowercase letters, numbers, and
underscores. For example a macro that formats all of your graph legends to match a certain report might be called
"Report1AddFormatToLegend".

5. Enter a more detailed description in the Description text box.
6. After you have finished recording the macro, save it globally (for use in all of SigmaPlot) or locally (for use in a

particular notebook file). Your macro appears in the Notebook Manager.

Creating Macros Using the Macro Language
You can record a macro using the Macro Recorder, or you can create a macro manually using a VBA®-like macro
language in the Macro Window.

To create a macro using the Macro Window:

1.

Click the Main Button , and then click New, and then click Macro.
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2. The Macro Window appears.

Figure 158: A new Macro Window. You can create SigmaPlot macros from scratch using
SigmaPlot's VBA-like macro language.

Editing Macros

When you edit the macro, SigmaPlot generates a series of program statements that are equivalent to the actions
that you perform. These statements are in a form of SigmaPlot language that has custom extensions specifically for
SigmaPlot automation and appear in the Macro Window. You can edit these statements to modify the actions of the
macro. You can also add comments to describe code.

To edit a macro:

1. On the Toolbox tab, in the Macros group, click Macros.
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2. In the Macros dialog box, select a macro from the Macro list.

3. Click Edit. The Macro Window appears.

Getting Help for Sax Basic in SigmaPlot

To get help for Sax Basic, in the Macro Window, click on an item you want to learn more about, and press F1.

Tip:  If you are using Windows 7 you are prompted to download a Help conversion program. Do that to see
Sax Basic Help items.

Using the Macro Window Toolbar

The Macro Window toolbar appears at the top of the Macro Window. It contains buttons grouped by function.

Figure 159: The Macro Toolbar

The following describes the functions of the toolbar buttons in the Macro Window.

Button Button Name Function

New Procedure Opens the Add Procedure dialog box that lets you name the
procedure and paste procedure code into your macro file

Start Runs the active macro and opens the Debug Window.

Pause/Continue Pauses and restarts a running macro. This button also pauses
and restarts recording of SigmaPlot commands while using
the Macro Recorder.

Stop Terminates recording of SigmaPlot commands in the Macro
Recorder. Also, stops a running macro.
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Find Opens the Find dialog where you can define a search for text
strings in the Macro Window.

Step in Executes the current line. If the current line is a subroutine
or function call, execution will stop on the first line of that
subroutine or call.

Step Over Executes to the next line. If the current line is a subroutine
or a function call, execution of that subroutine or function
call will complete.

Step Out Steps execution out of the current line the cursor is on.

Run to Cursor Steps execution out to the current subroutine or function
call.

Toggle Breakpoint Toggles the breakpoint on the current line. The breakpoint
stops program execution.

Quick Watch Shows the value of the expression under the cursor in the
Immediate Window.

Macros Opens the Macros dialog box.

User Dialog Opens the Dialog Box Editor.

Object Browser The Object Browser provides lists of the methods and
properties that can be called in macros for automating tasks
in SigmaPlot.

Reference Editing Macros Opens the Reference dialog box which
contains a list of all programs that are extensions of the
SigmaPlot Basic language.

Color-Coded Display

The color-coding of text in the Macro Window indicates what type of code you are viewing. The following describes
the default text colors used in the script text:

• Blue. Identifies reserved words in Visual Basic (for example, Sub, End Sub, and Dim).
• Magenta. Identifies SigmaPlot macro commands and functions.
• Green. Identifies comments in your macro code. Separates program documentation from the code as you read

through your macros.

Object and Procedure Lists

The Object and Procedure lists show SigmaPlot objects and procedures for the current macro. These lists are useful
when your macros become longer and more complex.

• The object identified as (General) groups all of the procedures that are not part of any specific object.
• The Procedure list shows all of the procedures for the currently selected object.
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Setting Macro Window Options

You can set appearance options for the Macro window in the Macros tab of the Options dialog box.

To set the options of the Macro Window:

1. With a Macro window open, click the Main Button.

2. Click Options.

3. In the Options dialog box, click the Macro tab.

4. Set text colors for different types of macro code and Debug Window output.
5. Set the location for the macro library.

Parts of the Macro Programming Language

The following topics list the parts of the macro programming language:
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• Statements are instructions to SigmaPlot to perform an action(s). Statements can consist of keywords, operators,
variables, and procedure calls.

• Keywords are terms that have special meaning in SigmaPlot. For example, the Sub and End Sub keywords mark
the beginning and end of a macro. By default, keywords appears as blue text on color monitors. To find out more
about a specific keyword in a macro, select the keyword and press F1. When you do this, a topic in the SigmaPlot
on-line reference appears and presents information about the term.

• You can add optional comments to describe a macro command or function, and how it interacts in the script. When
the macro is running, comment lines are ignored. Indicate a comment by beginning a line with an apostrophe.
Comments always must end the line they're on. The next program line must go on a new line. By default,
comment lines appear as green text.

Scrolling and Moving the Insertion Point

When you use the scroll bars the insertion point does not change. To edit the macro code that you are viewing in the
macro window, you must move the insertion point manually.

To edit macro code manually:

1. In the Macro Window, click where you want to edit.
2. You can also use arrows and key combinations to move the insertion point; when you do this the window scrolls

automatically.

Editing Macro Code

You can edit macro code in the same way you edit text in most word-processing and text editing programs. You add
select and delete text, type over code, or insert text by moving the insertion point and then typing in new text. As with
other programming languages, you can also add comments to code.

To edit macro code:

Open the macro code window and select the text to edit.

• Adding Comments to Code. Add comments to code to identify the purpose of the various parts of a macro and to
map locations as you edit a complex macro. Insert comments to fully document how to use and how to understand
the macro code.

• Deleting Unnecessary Code. The Macro Recorder creates code corresponding exactly to the actions that you
make in SigmaPlot while the recorder was turned on. You may need to edit out unwanted steps.

• Moving and Copying Code. You can cut, copy, and paste selected text.
• Finding and Replacing Code. When you need to find and change text in a macro that you have written, use

the Find commands. For example, if you change the name of a file that is referenced in your macro, you need
to change every instance of the file name in your macro. Use Find to locate the instances of the filename in the
macro and replace using cut and paste edit commands.

Adding Existing Macros to a Macro

If you have another macro that already does what you want, you can just paste it into your new macro. Copy and paste
the macro into your new macro, test it in the new code and run it.

Creating Custom Dialog Boxes

Design and customize your own dialog boxes using the UserDialog Editor. When you are designing and creating
SigmaPlot macros, you can automatically create the necessary dialog box code and dialog monitor function code.
Like the other automated coding features in SigmaPlot, the code may require further customizing.

To create a custom dialog box:

1. In the Macro Window, place the insertion point where you want to put the code for the dialog box.
2. On the Macro Window toolbar click the User Dialog button. The blank grid in the User Dialog Editor appears.
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3. On the left hand side of the User Dialog Editor there is a Toolbox. You can select a tool, such as a button or
check boxes, from the Toolbox. The cursor changes to a cross when you move it over the grid.

4. To place a tool on the dialog box, click a position on the grid. A default tool will be added to the dialog grid.
5. Resize the dialog box by dragging the handles on the sides and the corners.
6. Right-click any of the controls that you have placed on the dialog surface (after selecting the control) and enter a

name for the control.
7. Right-click the dialog form (with no control selected) and enter a name for the dialog monitor function in the

DialogFunc field.
8. To finish, click OK. The code for the dialog box with controls will be written to the Macro Window.

Finally, and in most cases, you must edit the code for dialog box monitor function to define the specific behavior
of the elements in your dialog box. For more information, see SigmaPlot Automation Reference on page 369.

Using the Object Browser

The Object Browser displays all SigmaPlot object classes. The methods and properties associated with each
SigmaPlot macro object class are listed. A short description of each object appears in the dialog box as you select
them from the list.

To view the Object Browser, the Macro Window must first be in view.

To open the Object Browser:

1. On the Macro Window toolbar, click the Object Browser button.
2. Use Paste to insert generic code based on your selection into a macro.

Tip:  Press F1 at any time for full details on using the Object Browser.

Using the Add Procedure Dialog Box

Organizing your code in procedures makes it easier to manage and reuse. SigmaPlot macros, like Visual Basic
programs, must have at least one procedure (the main subroutine) and often they have several. The main procedure
may contain only a few statements, aside from calling subroutines that do the work. You add procedures using the
Add Procedure dialog box.

To add a procedure:

1. On the Macro Window toolbar, click the New Procedure button.
2. In the Add Procedure dialog box, define a sub, function, or property using the Name, Type, and Scope boxes.
3. Click OK to paste the code for a new procedure. The new procedure appears at the bottom of the macro.

Tip:  For full details on using the Add Procedure dialog box, press F1 from anywhere in the Macro
Window.

About User-Defined Functions
A user-defined function is a combination of math expressions and Basic code. The function always requires input data
values and always returns a value. You supply the function with a value; it performs calculations on the values and
returns a new value as the answer. Functions can work with text, dates, and codes, not just numbers. A user-defined
function is similar to a macro but there are differences. Some of the differences are listed in the following table.

Recorded Macro User-Defined Functions

Performs a SigmaPlot action, such as creating a new
chart. Macros change the state of the program.

Returns a value; cannot perform actions. Functions return
answers based on input values.

Can be recorded. Must be created in Macro code.
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Are enclosed in the Sub and End Sub keywords. Are enclosed in the keywords Function and End
Function.

For more information, press F1 from anywhere in the Macro window to view user-defined function on-line Help.

Creating User-Defined Functions

A user-defined function is like any of the built-in SigmaPlot functions. Because you create the user-defined function,
however, you have control over exactly what it does.

A single user-defined function can replace database and spreadsheet data manipulation with a single program that you
call from inside SigmaPlot. It is a lot easier to remember a single program than it is to remember several spreadsheet
macros. For more information, see SigmaPlot Automation Reference on page 369.

Using the Debug Window
The Debug Window contains a group of features that are helpful when you are trying to locate and resolve errors
in your macro code. The debugging tools in SigmaPlot will be familiar if you have used one of the modern visual
programming languages or Microsoft Visual Basic for Applications.

Essentially, the Debug Window gives you incremental control over the execution of your program so that you can
sleuth errors in your programs. The Debug Window also gives you a precise way to determine the contents of your
variables. Again, a series of buttons is used to select the operation mode of the Debug Window.

Debug Toolbar Buttons

The debugging features of the Debug Window are controlled by buttons on the Macro Window toolbar. To review:

• The four Step buttons provide methods for controlling the execution of commands. They offer various ways of
responding to subroutines and functions.

• The Breakpoint button lets you set a point and execute the program until it reaches that point.
• The Quick View button displays the value of the expression in the immediate window. The inclusion of these

features for controlling program execution are a standard but powerful combination of tools for writing and
editing macros.

Debug Window Tabs

The output from the Debug Window is organized in four tabs that allow you to type in statements, observe program
execution responses, and iteratively modify your code using this feedback.

If you have never used a debugging tool and are new to programming, it would be a good idea to supplement the
following description with further study.

Immediate Tab

The Immediate Tab lets you evaluate an expression, assign a specific value to a variable or call a subroutine and
evaluate the results. Trace mode prints the code in the tab when the macro is running.

• Type "?expr" and press Enter to show the value of "expr".
• Type "var = expr" and press Enter to change the value of "var".
• Type "set var = expr" and press Enter to change the reference of "var" for object vars.
• Type "subname args" and press Enter to call a subroutine or built-in expression "subname" with

arguments "args".
• Type "trace" and press Enter to toggle trace mode. Trace mode prints each statement in the Immediate Tab

when a macro is running.
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Watch Tab

The Watch Tab lists variables, functions, and expressions that are calculated during execution of the program.

• Each time program execution pauses, the value of each line in the window is updated.
• The expression to the left of the "->"  may be edited.
• Pressing Enter updates all the values immediately.
• Pressing Ctrl+Y deletes the line.

Stack Tab

The output from the Stack Tab lists the program lines that called the current statement. This is a macro command
audit and is helpful to determine the order of statements in you program.

• The first line is the current statement. The second line is the one that called the first, and so on.
• Clicking a line brings that macro into a sheet and highlights the line in the edit window.

Streamlining Procedures with Macros
Use SigmaPlot macros to help streamline your workflow. For example, you can create macros in Microsoft Word or
Excel that allow you to open SigmaPlot from within either application. You can place macros that you create yourself
on the main Toolbox tab. You can even run a SigmaPlot macro by specifying its path in your command prompt
without ever having to open SigmaPlot. Examples of these macro applications appear in the following topics.

Opening SigmaPlot from Microsoft Word or Excel

You can create a macro in either Microsoft Word or Microsoft Excel that can open SigmaPlot directly from either
application.

To create this macro:

1. In either Microsoft Word or Excel, click the Microsoft Office Button, and then click Excel Options.
2. In the Popular category, under Top options for working with Excel, select the Show Developer tab in the

Ribboncheck box, and then click OK.
3. Click the Developer tab, and then in the Codegroup, click Visual Basic.
4. Type (or copy and paste):

Sub SigmaPlot()
'
SigmaPlot Objects and Collections
'
SigmaPlot Macro
'

'
Dim SPApp as Object
Set SPApp = CreateObject("SigmaPlot.Application.1")
SPApp.Visible = True
SPApp.Application.Notebooks.Add 
End Sub 4.

5. To run the macro, in Excel, on the Developer tab, in the Code group, click Macros.
6. Click Run.

SigmaPlot appears with an empty worksheet and notebook window.



Running SigmaPlot Macros from the Command Prompt

You can run SigmaPlot macros directly from your command prompt, saving you valuable time. Suppose you need
to produce the same graph report of a data set week after week. Rather than going through the trouble of starting up
SigmaPlot, opening a file, and then running a macro, you can run the entire macro from a run command on the Start
menu instead.

In your command prompt type: c:\spw "filename" /runmacro:"macroname".
For example, suppose you want to run a macro that you created called "ErrorBars", and it is stored in a file
called "MyNotebook.jnb" in your user profile folder. You would type: C:\program files\sigmaplot
\spw14_5>spw MyNotebook.jnb /runmacro:ErrorBar .
To run a macro located in SigmaPlot's application folder, you would type: C:\program files\sigmaplot
\spw14_5>spw “C:\program files\sigmaplot\spw14_5\MyNotebook.jnb” /runmacro:
ErrorBar

Tip:  You can also create a batch file or script that runs SigmaPlot from the DOS command prompt as part of
the batch file's set of operations.

Creating Macros as Buttons

You can place your macro as a button in either the Pharmacology or Tools group on the Toolbox tab.

To create a new button:

1. On the Toolbox  tab, in the Macros group, click Macros.
2. Enter a new macro name in the Macro name field.
3. Click Create.
4. Under Assign to, select Button, and then enter the new name in the Button name field.
5. Select the group in which you'd like the macro to appear, Tools or Pharmacology, from the Group drop-down

list.
6. Click OK.



Chapter

13
The SigmaPlot Toolbox

Topics:

• Running Macros from the
Toolbox

• Area Below Curves
• Batch Process Excel Files
• Bland-Altman Analysis
• Border Plots
• By Group Data Split
• Color Transition Values
• Compute 1st Derivative
• Dot Density Plot
• Frequency Plot
• F Test Comparison of Curves
• Gaussian Cumulative

Distribution
• Insert Graphs into Microsoft

Word
• Label Symbols
• Merge Columns
• Paste to PowerPoint Slide
• Piper Plots
• Plotting Polar and Parametric

Equations
• Power Spectral Density
• Quick Re-Plot
• Rank and Percentile
• ROC Curve Analysis
• Standard Curve
• Survival Curve
• Vector Plot

SigmaPlot comes with an extensive library of Macros, and many of
these appear in the Toolbox. The macros, along with their corresponding
sample data, can be found in: ProgramFiles\SigmaPlot
\SPW14_5\SigmaPlot Macro Library.jnb.

You can double-click the macro in the Notebook Manager to run it. If the
macro does not have any errors or run into difficulties with your data, it will
run to completion.

Tip:  You can also run a macro from the Macro script window. This
is useful for debugging the macro script.
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Running Macros from the Toolbox
Click the Toolbox tab. You can run a macro from one of four groups.

• The Macros group. From here, you can select a macro from SigmaPlot's complete collection or create a macro of
your own.

For more information, see Automating Routine Tasks on page 325.
• The Tools group. This group presents SigmaPlot's most common task patterns.

• The Pharmacology group.

• The Add Ins group. This is were all of SigmaPlot's modules are located, of which currently Enzyme Kinetics is
the only one.

For more information on using the Enzyme Kinetics module, select Enzyme Kinetics Help from the Help menu.

Area Below Curves
This macro integrates under curves using the trapezoidal rule. This can be used for equal or unequally spaced x
values. The algorithm is:

Specify the column number for the results. Click Compute to calculate the area under the curve. The results are in the
Results Column.

Restriction:

• This macro only works using a SigmaPlot worksheet.
• This macro only works with plots with both X and Y data.
• A graph window containing a scatter or line plot must be open and in focus when running the macro.

Batch Process Excel Files
Use this macro to import data from multiple Excel Files into individual SigmaPlot worksheets, then plot and curve fit
the imported data automatically. The macro plots the first two columns of data for each file as a Simple Scatter Plot,
curve fits the data using a Logistic, 4 parameter equation, and generates a statistical report. You are then prompted to
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save the results in a "BatchFile.jnb" SigmaPlot notebook. This macro is intended as a non-trivial example for you to
emulate in you own macros.

The following options are available:

• Single-step mode. Displays a dialog box after each step within the macro. For instance, after the Excel data is
imported a dialog box appears that states, "The data is imported from the Excel Worksheet..." You must click OK
to continue running the macro. By default, this mode is disabled so that the macro runs without stopping at each
step.

• Add File button. Opens the Select Excel File dialog box. Double-click the Excel file to add it to the Excel files
list.

• Excel Files. Select the Excel file in the Excel files list to activate this button. Click to delete the file from the
Excel files list.

• Import Range. Enter the starting and ending ranges to import from the first worksheet in the Excel files. Only the
first two columns of imported data are plotted and/or fit.

• Process. Plot data as a Simple Scatter Plot or a Simple Bar Chart. Curve fit data using an equation from the drop-
down list.

• Save notebook to. Shows the path where the BatchFile.jnb notebook is saved.
• Browse. Select to save the BatchFile.jnb notebook file to a folder other than the default.

You may edit the macro to change:

• To a different fit library.
• The default location of the source data block.
• Whether the data are plotted or fit.
• The file extension to import different file types.

Restriction:

• Only data from the first Excel worksheet from each file is imported.
• You cannot specify a different Excel worksheet.
• You must select an Excel file.
• You must select a curve in order to plot curve fit.
• You may change the default equation Only simple scatter and bar charts are available.

Bland-Altman Analysis
The Bland-Altman analysis compares two methods to see if they agree. It consists of two, graphs a method
comparison graph and the Bland-Altman graph, and some statistics associated with the latter.

Data

Double-click a column or click >> in the Available Columns list to move it into the appropriate Method field under
Selected Columns.

Plots

Select which type of plot you'd like to appear when you run the macro.

• Plot Method 1 versus Method 2.  This is a method comparison graph in which an XY scatter plot of the two
methods shows the results values. Select Add Linear Regression Line to add a linear regression line, and Add
Line of Equality to add a confidence lines and the line of identity.

• Plot Bland -Altman Graph. Select this option to produce a Bland-Altman graph, which is an XY scatter plot in
which the difference of the two methods is on the Y axis and the average of the two methods is on the X axis. The
mean of the differences is displayed together with the Limits of Agreement for the difference data.

Bland-Altman Difference Statistics
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The Bland-Altman graph appears with the following Difference Statistics:

Bias. The mean of the differences.

Std Dev. The standard deviation of the differences.

Limits of Agreement. The mean of the differences (bias) +- 1.96 (or 2) times the standard deviation of the
differences.

Confidence Intervals (CI). These are the 95% or 99% CIs for the:

• Bias
• Lower limit of agreement
• Upper limit of agreement

Options

Click Options to view and edit the Bland-Altman settings.

Bland-Altman Settings

Statistics

Number of SDs (Standard Deviations). This option is used in the Limits of Agreement computation. Select either
1.96 or 2.

No. of decimal places. This option sets the number of decimal places in the difference statistics.

CIs (Confidence Intervals) to be used for B-A plot. Used in difference statistic Confidence Interval computation.
Select either 95% or 99%.

Add confidence lines. Select 95%, 99% or None for the Method Comparison Graph regression confidence lines.

GoTo Column Position. Allows viewing the extents of your data while the Bland-Altman graph Dialog is displayed.

Graph Options. Select to place both graphs on either one or two pages.

Border Plots
This macro draws a histogram or box plot along the top and right axes of a scatter plot. The border plots are located .5
inches from each axis. When using histogram border plots, specify the number of bins displayed.

Restriction:

• A graph window containing a scatter plot must be open and in focus when running the macro. If the
current plot is not a scatter plot, the macro can convert the plot to the required form.

• If the plot is an X only or Y only plot, the macro creates one border plot corresponding to the X or Y axis.

By Group Data Split
This macro splits data contained in one column into groups of data sorted into multiple data columns within one
SigmaPlot worksheet.

The following options are available:

• Data Column. Define the column to begin the data grouping, and to use as column headings.
• Group Column. Define the column data to group. This column should not have empty cells.
• Output Column. Define the column to begin placing the group results. The default is the First Empty column

found in the worksheet. Change the output column location by entering the number of the worksheet column. The
Output column must be greater than the last data column.

• Sort Data. within the Group Arranges the data within each group into ascending order.
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Restriction:

• To run the macro, a worksheet must be open and in focus.
• The worksheet must have at least two columns of data.
• Can accept empty cells. Puts "--" into grouped cell to indicate an empty cell or missing data.
• Group Column should not have empty cells.
• Grouped Data Column Heading Titles correspond to the Group Column contents.
• Output column entry must be numeric and greater than the last data column.

Color Transition Values
This macro creates a column of colors changing smoothly in colors as the data changes from its minimum value to
its maximum value and employs this gradient to color the symbols in a scatter plot. Define X and Y columns, as well
as the column for displaying the color gradient. The Y column generates the gradient. The scatter plot plots the Y
column against the X column with the color column determining the symbol color.

Restriction:  To run the macro, a worksheet must be open and in focus.

Compute 1st Derivative
This macro computes a numerical first derivative of a pair of data columns. It computes the running average of
specified adjacent first order derivatives. Both the original data and resulting derivative values can be plotted
automatically.

The SigmaPlot transform language 'diff' function is used to compute the first order differences in x and y required for
the numerical derivative. The data need not be sorted by x. Replicate x values and the associated y values are row-
wise deleted to eliminate zero divides.

To run the macro, choose the first data column and results column. You can also change the length used to determine
the running average. Use even values for the length of the running average to place each derivative at the midpoint of
the derivatives used in the average. Use odd values to place it at the first point to the left of midpoint.

For even running average length values, there will be len/2 empty cells at the beginning and end of the derivative
values.

Finally, you can also automatically generate graphs of the original data and the derivatives.

Dot Density Plot

Data Selection

Select multiple data columns using the First Column (left most) and Last Column (right most) of data. The data
column range need not start in column 1 and may contain empty columns. The number of data columns is limited to
30 except with percentiles lines which are then limited to 5.

Graph Attributes

Symbol Size. Select Auto to obtain a reasonable symbol size. Enter a symbol size to obtain exactly that size.

% Overlap. A positive value overlaps the symbols to obtain a grape cluster effect. A negative value creates space
between the symbols.

% Width.  The percent of total horizontal space taken up by the widest portions of multiple dot densities. Adjustment
may be required in some cases to allow space for percentile or box plot display.

Symmetry. The dot density can be symmetric or one-sided.
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Orientation.

• Vertical. The X axis is the variable, the Y axis is categorical.
• Horizontal. The Y axis is the variable, the X axis is categorical.

Graph Dimensions

Select the height and width of the graph. This allows the symbols to touch for different sized graphs.

Axis Scale

Select Linear or Logarithmic.

Axis Range

• Automatic. Select Automatic if you'd like the axis minimum, maximum and tick interval to be determined
automatically.

If you leave Automatic clear, enter Minimum and Maximum values. These must exceed the minimum and
maximum for all data. The data minimum and maximum are displayed when the Axis Range is set to Automatic.

Other Lines

Line Type.

• None.
• Mean.  Displays a mean line across the dot density.
• Median. Displays a median line across the dot density.
• Percentiles. Shows "internal" percentile values next to each dot density.
• Box Plot. Draws a box plot next to each dot density.
• MeanStdError. Shows the mean plus or minus the standard error for each dot density.

Line Length (Percentiles only).

• Short. Draws a short indicator line for each percentile.
• Long. Draws a line across the dot density for each percentile.

Frequency Plot
Creates frequency plots with mean bars for multiple data columns. The following options are available:

• Column Selection. Specify the number of data columns. The analysis includes all columns between the first and
the specified column, inclusive. Each column corresponds to a group. In addition, define the column in which to
begin placing the macro results.

• Graph Dimensions. Set the height and width of the frequency plot in inches.
• Bins. The Vertical Interval indicates the range into which data points will be grouped. The Start Value defines the

smallest vertical interval value. A value of 0 corresponds to a vertical range from 0 to 100.
• Mean/Median Lines. Add a line (of the specified width) corresponding to the mean or median for each group.

Symbols Size defines the diameter of the plotting symbols. Gap represents the horizontal distance between
symbols as a percentage of the symbol diameter.

Restriction:

• To run the macro, a worksheet must be open and in focus.
• Data must begin in column 1.
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F Test Comparison of Curves
You can use the F Test Comparison of Curves macro to compare the fits of two equations to determine if the more
complicated equation provides a significantly better fit. For the test to be valid the two equations must be nested; for
example, the simpler equation must be a subset of the more complicated one.

The F test is a hypothesis test with the null hypothesis being that the simpler equation is correct. An F ratio is
computed which compares the relative difference in the sum of squares of the two fits to the relative increase in the
number of degrees of freedom. If this value is significantly greater than 1.0 then the null hypothesis is rejected and
the more complicated equation is chosen as the best fit. A P value is used to determine if the F value is significantly
greater than 1.0. If P < 0.05 then the null hypothesis is rejected and the more complex model is considered the best.

An example is to determine whether the double exponential rise to maximum equation provides a better fit to the data
than a single exponential rise to maximum.

Single Exponential Rise to Maximum

Double Exponential Rise to Maximum

Fitting these two equations to the data in the graph below gives the relative increase in the sum of squares

and the relative increase in the degrees of freedom

The F ratio is the ratio of these two which is

The P value is computed from the F distribution and is P = 0.65.
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If you fit the simpler equation first and then the more complex equation the macro will select for you all the options in
F-test Comparison of Curves dialog box.

Otherwise you can enter by hand the number of parameters in each equation (simpler equation first) and the columns
containing the fit residuals for each equation.

The results are given in the report.

Gaussian Cumulative Distribution
This macro returns the results of a Gaussian Cumulative Distribution function (CDF) for a single column of data,
and optionally plots the results with a probability Y axis scale. The error function is approximated with a polynomial
approximation.
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Insert Graphs into Microsoft Word
Use this macro to insert a SigmaPlot graph into an open Microsoft Word document.

1. In your Word Document, place your cursor at the position where you want to insert the graph.
2. The macro lists all graph pages in your currently active notebook. Select the page containing the graph(s) you

want to insert.
3. Adjust the size and positioning of the figure as desired, then click Insert. All graphs on the selected page are

placed into the specified frame. The next version of this macro will also allow selection of a specific graph on a
page.

4. To insert additional graphs from this notebook, move to where you want to place the graph in Word, then switch
back to SigmaPlot, click the desired page, and click Insert.

Restriction:  You must have both a Word Document and a SigmaPlot notebook open in order to use this
macro.

Label Symbols
This macro labels a scatter or simple bar plot with text from a specified column. Select an offset percentage and one
of eight locations for the labels. The offset percentage is a percent of each axis range - 3 to 5 percent is a good starting
value. If you have more than one plot in your graph then select the plot you want to label by clicking on a symbol or
bar of the particular plot.

Rerun the macro to obtain the best position for the labels and then use Graph, Delete Plot to remove the unwanted
label plots.

You can label the plot with numbers by placing the numbers in a column and using Format, Cells to change the
numbers to text. Then format each text-number for a pleasing appearance by removing places to the right of the
decimal point, and so on.

If the label column contains fewer entries than the plot contains symbols or bars, labeling continues by returning to
the first case of the label column. For example, in a scatterplot containing six points, if the label column contains three
entries (A,B,C), the points are labeled (A,B,C,A,B,C).

Restriction:

• A graph window must be open and in focus when running the macro.
• The macro is restricted to scatter and simple bar charts and is not applicable to stacked or grouped bar

charts.

Merge Columns
This macro merges two separate worksheet columns into one single text column. This is useful if you have two text
fields that need to be combined into one, or if you have imported data that contains dates in one column and time in
another.

To run the macro, simply select the first and second columns to merge, then click OK.

Restriction:  At least two columns of data must present on your worksheet. The results are automatically
placed into the first empty column after the last data column.

Paste to PowerPoint Slide
This macro creates PowerPoint slides from selected SigmaPlot graphs.
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1. To create a PowerPoint slide:
a) Open PowerPoint and create a new presentation or open an existing one.
b) Select the slide where you want to place the SigmaPlot graph.
c) Select a slide background if so desired.
d) In SigmaPlot select the graph or multiple graphs that you want to paste into PowerPoint.
e) On the Toolbox tab, in the Tools group, click Paste to PowerPoint Slide.
f) Select Bold text and Change the text color to to contrast with the PowerPoint background color. Note that

Transparent Graph Background is selected. This allows the PowerPoint background color to show through
the graph.

g) Thicken the lines and change their color if so desired.
h) Click OK.

PowerPoint opens, and the graph object appears centered in a new PowerPoint slide.
2. To edit the graph object in PowerPoint:

a) Open the PowerPoint presentation with the inserted SigmaPlot graph.
b) Use Graph Properties to edit.

Piper Plots
To create a Piper plot:

1. Make sure the values of your four cations and three anions are entered into seven columns.
2. Pick the units the data use. If the units used do not match any of the options (percentages, mg/l, or mmol/l) then

you will need to transform your data to one of these units.
3. Assign the column for each cation/anion as desired by selecting a worksheet column from the Worksheet columns

list, the cation/anion from the Assign to list, and clicking the Assign button. You column assignments are listed
under Assigned columns.

4. When finished, click OK.

About the Piper Diagram

The PIPER diagram (Piper, 1944) is a plot commonly used by hydrogeologists and hydrologists to display water
chemistry data. It has the advantage that many different water samples can be plotted on one graph. The major
dissolved ionic species in most natural waters are Ca2+, Mg2+, Na+, K+, Cl-, HCO3- and SO42-. The PIPER
diagram displays the relative proportions of the major cations (positively charged ions) and anions (negatively
charged ions) on two adjacent triangular plots (Figure 1). For plotting purposes, Na and K are grouped together. Each
apex of the triangle represents 100% of that component and mixtures of components plot either along the axes (for 2
components) or within the triangle (for 3 components).
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Figure 160: PIPER Diagram Showing how the Relative Proportions of Cations and Anions are
Plotted

The PIPER diagram above shows how the relative proportions of cations and anions are plotted. The diamond
shaped graph is used to represent the composition of water with respect to both cations and anions. This graph
has the advantage that mixing between two waters plots as a straight line. The cation and anion points for each
sample are projected onto the diamond shaped field along a line parallel to the outer axes of each triangular plot as
shown in the figure below and the intersection of these points is plotted. The PIPER diagram can be used to classify
"hydrochemical facies" or "water-types" based on the dominant ions.

The proportions of different elements provide information on the chemical history of groundwaters and indicate the
dominant chemical reactions that occur between groundwater and the rocks through which it passes. Some data from
a sandstone aquifer in Yorkshire are shown in the figure below where it can be seen that the groundwaters generally
vary from a Ca-HCO3 type to a Ca SO4 type due to the dissolution of the minerals calcite (CaCO3) and gypsum
(CaSO4). Some samples also trend towards the Na and Cl apex of the plots due to mixing with an old seawater
component (dominated by Na and Cl). Piper, A.M. 1944 A graphic procedure in the geochemical interpretation of
water analysis. Transactions, American Geophysical Union, 25, 914-923.
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Figure 161: The Distribution of Water Types from a Sandstone Aquifer in the Vale of York Displayed
on a PIPER Diagram

The PIPER diagram above displays the distribution of water types from a sandstone aquifer in the Vale of York.

Plotting Polar and Parametric Equations
This macro creates curves in either Cartesian or polar coordinate systems.

1. Select Rectangular or Polar as the Coordinate System.
2. Select Single Equation or Parametric as the Curve Description.

A curve description can be:

• A single equation relating the two coordinate variables (such as y=x^2 or r = cos(2*theta)).
• A pair of equations that define the coordinate values of points on the curve in terms of a third parameter

variable (such as x = cos(t), y=sin(t), or r= t*sin(2*t), theta = t^2).
3. Set the range of the Independent variable and the number of sampled intervals within that range.
4. Set the Angular Units to either Radians or Degrees.
5. Click Close to close the dialog box.
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Power Spectral Density
Computes the power spectral density (psd) for a data column. Specify two columns: the data column and the results
column. In addition, define the sampling frequency and whether the macro should employ a Hanning window.

The macro creates two plots:

• Amplitude versus Time
• PSD versus Frequency

Restriction:  To run the macro, a worksheet must be open and in focus.

Quick Re-Plot
This macro quickly reassigns the columns that are plotted for the current curve in the current two- or three-
dimensional plot. Click Next Curve to change the plotted columns for several curves simultaneously.

Restriction:  To run the macro, a graph must be open and in focus.

Rank and Percentile
Computes ranks and cumulative percentages for a specified data column. Specify the following:

• Data Column. The data to be ranked. SigmaPlot also computes cumulative percentages for this column.
• Percentile Column. A column containing percentiles. SigmaPlot returns the raw value corresponding to these

percentiles.
• Results Column. The worksheet column at which the results should begin.
• Percentile Type. One of two methods of computing percentiles must be selected.
• Numeric. No adjustment made to the values.
• Graphing. The Cleveland definition of percentiles described in The Elements of Graphing Data by William S.

Cleveland (1985), in which .5 is subtracted from the positions before computing percentages.

The macro returns the sorted data, an index of the original positions, the ranks, and the cumulative percentages.
Specifying a column of percentiles yields the values corresponding to those percentiles.

Restriction:  To run the macro, a worksheet must be open and in focus.

ROC Curve Analysis
Receiver operating characteristic (ROC) curves are used in medicine to determine a cutoff value for a clinical test
(its origin, and the origin of its name, is from radar signal detection). For example, the cutoff value of 4.0 ng/ml
was determined for the prostate specific antigen (PSA) test for prostate cancer. A test value below 4.0 is considered
to be normal and above 4.0 to be abnormal. Clearly there will be patients with PSA values below 4.0 that are
abnormal (false negative) and those above 4.0 that are normal (false positive). The goal of an ROC curve analysis is
to determine the cutoff value.

Assume that there are two groups of men. By using a "gold standard" technique, one group is known to be
normal (negative), not to have prostate cancer, and the other is known to have prostate cancer (positive). A blood
measurement of prostate-specific antigen is made in all men and used to test for the disease. The test will find
some, but not all, abnormals to have the disease. The ratio of the abnormals found by the test to the total number of
abnormals known to have the disease is the true positive rate (also known as sensitivity). The test will find some,
but not all, normals to not have the disease. The ratio of the normals found by the test to the total number of normals
(known from the ‘gold standard’ technique) is the true negative rate (also known as specificity). The hope is that
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the ROC curve analysis of the PSA test will find a cutoff value that will, in some way, minimize the number of
false positives and false negatives. Minimizing the false positives and false negatives is the same as maximizing the
sensitivity and specificity.

For the PSA test abnormal values are large (> 4) and normal values are small (<4). This is not always the case,
however, so the present macro allows for both conditions of abnormal being larger and abnormal being smaller.

The ROC curve is a graph of sensitivity (y-axis) versus 1 – specificity (x-axis). An example is shown below.
Maximizing sensitivity corresponds to some large y value on the ROC curve. Maximizing specificity corresponds
to a small x value on the ROC curve. Thus a good first choice for a test cutoff value is that value which corresponds
to a point on the ROC curve nearest to the upper left corner of the ROC graph. This is not always true however.
For example, in some screening applications it is important not to miss detecting an abnormal therefore it is more
important to maximize sensitivity (minimize false negatives) than to maximize specificity. In this case the optimal
cutoff point on the ROC curve will move from the vicinity of the upper left corner over toward the upper right corner.
In prostate cancer screening, however, because benign enlargement of the prostate can lead to abnormal (high) PSA
values, false positives are common and undesirable (expensive biopsy, emotional impact). In this case maximizing
specificity is important (moving toward the lower left corner of the ROC curve).

An important measure of the accuracy of the clinical test is the area under the ROC curve. If this area is equal to 1.0
then the ROC curve consists of two straight lines, one vertical from 0,0 to 0,1 and the next horizontal from 0,1 to 1,1.
This test is 100% accurate because both the sensitivity and specificity are 1.0 so there are no false positives and no
false negatives. On the other hand a test that cannot discriminate between normal and abnormal corresponds to an
ROC curve that is the diagonal line from 0,0 to 1,1. The ROC area for this line is 0.5. ROC curve areas are typically
between 0.5 and 1.0 like shown in above.
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Two or more tests can be compared by statistically comparing the ROC areas for each test. The tests may be
correlated because they occurred from multiple measurements on the same individual. Or they may not be correlated
because they resulted from measurements on different individuals. The ROC Curves Analysis Module refers to this as
"Paired" and "Unpaired", respectively, and can analyze either situation.

The test measurements may contain missing values and two methods are provided to handle missing values when
comparing ROC areas- pair-wise deletion and case-wise deletion. This is described in detail later.

Given a value for the probability that the patient has the disease (pre-test probability) the probability that the patient
has the disease, given the value of the test measurement, can be computed. Also, given a value for the false-positive/
false-negative cost ratio (for the screening example above, the false-negative cost would be greater than the false-
positive cost), an optimal test value cutoff can be computed. The present macro allows entry of the pre-test probability
and the false-positive/false-negative cost ratio.

Entering Data for the ROC Curves Macro

The ROC Curves macro accepts both indexed and grouped data formats. In most cases SigmaPlot identifies the data
format from the information in the data worksheet.

Indexed Data

Indexed data is the format found in statistics programs such as Systat and SigmaStat (the statistics in SigmaPlot).
"Indexed" is the terminology used in SigmaStat. It has one column that indexes another column (or other columns).
It is also the format of the output of logistic regression where ROC curves are used to determine the ability of
different logistic models to discriminate negative from positive test results (normals from abnormals). Each data set
consists of a pair of columns – a classification variable and a test variable. The classification variable has a binary
state that is either negative (normal) or positive (abnormal). Many programs use a value of 1 for positive and 0 for
negative. The classification variable is required to be located in column 1 of the worksheet. The test variable is a
continuous numeric variable and contains the test results. A single test variable will be located in column 2. Multiple
test variables will be located in multiple columns starting in column 2. There is no built-in limit for the number of test
variables. There is only one classification variable for multiple test variables and it is located in column 1. The test
variable columns must be left justified and contiguous. Therefore, no empty columns to the left of or within the data
are allowed.

The following example shows a few rows of data for two data sets. The first column is the classification variable.
It contains a column title "Thyroid Function", which is the classification variable name. It also contains the two
classification states "Hypothyroid" and "Euthyroid" (normal thyroid function). Hypothyroid and Euthyroid are the
abnormal and normal classification states, respectively. T4 and T5 are the names of different blood tests that will be
used in the ROC analysis to discriminate between normal and abnormal and then compared to determine which is the
better test. The classification variable must be in column 1 and the two test variables in the two columns adjacent to it.

The classification variable name will be obtained from the column 1 column title if it exists. The test names will
be obtained from the column titles of the test variable columns if they exist. The classification state names will be
obtained from the entries in the cells of column 1. If no column titles have been entered for the test variables then
default names for the tests, "Test 1", "Test 2", etc., will be used and displayed in the graphs and reports. The test
variable names should be unique but the program will subscript any identical names that are not.

The test names are T4 and T5, the classification states are Euthyroid and Hypothyroid and the Classification variable
name is Thyroid Function. The index column is always column 1 and data columns must be left adjusted.
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Figure 162: Indexed Data Format for Two Tests

There must be two or more non-missing data points for each test for each classification state. Missing values are
handled automatically by the analysis. For data columns, missing values are everything but numeric values (blank
cells, the SigmaPlot double-dash missing value symbol, "+inf", "-inf", "NaN", etc.). Missing values are ignored for
all computations except the Paired area comparison (see the Missing Value Method section) where they are handled
using one of two possible algorithms.

Grouped Data

The grouped data format consists of pairs of data columns - one pair for each test. One column in a data pair consists
of the negative (normal) data values and the other column for positive (abnormal) values. So, for example, if two tests
are to be compared, the worksheet will contain four columns of data - the first two columns for the first test and the
third and fourth column for the second test.

A specific column title format is used to identify the test associated with the data column pair and the classification
states within each pair. The user is encouraged to use this format since it clearly identifies the data in the data
worksheet and will annotate all the graphs and reports generated. It is not necessary to use column titles as the
program will identify column pairs starting in column 1 with the generated test names "Test 1", "Test 2", etc., and
will arbitrarily assign "1" and "0" classification state names to the first and second columns, respectively, but this
is clearly not the best way to organize the data. Since the test names and classification states are numerical it is also
more difficult to interpret the results.

Column Title Convention for Grouped Data

This column title convention is a simple way to identify worksheet data for the Grouped data format. The following
example shows a few rows for two data sets. The first two columns contain the data for the T4 test. The first column
“T4 - Euthyroid” is the column with the normal data for test T4. The column title consists of the test name followed
by a minus sign followed by the classification state. Spaces on either side of the minus sign are ignored. The second
column “T4 - Hypothyroid” is the column with the abnormal data for test T4. The third and fourth column titles are
the same as the first two except the second test name T5 is used.

This is the same data as in the figure above. There are two tests T4 and T5. Each test consists of a pair of data
columns. In this case T4 is in columns 1 and 2 and T5 in columns 3 and 4. The “Test-State” column title format is
used to identify the two tests and the normal (Euthyroid) and abnormal (Hypothyroid) states.
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Figure 163: Grouped Data Format for Two Tests

The test names in both columns of a column pair must be the same. Also there must be exactly two classification
states in the column titles.

Like Indexed format, missing values in the worksheet cells are ignored except for special handling when comparing
ROC areas (see the Missing Value Method section).

Setting ROC Curve Analysis Options

You immediately set ROC Curve Analysis options upon running the macro.

Data Selection

For more information about entering macro data, see Entering Data for the ROC Curves Macro on page 351.

Data Format. In most cases the ROC Curve Analysis macro identifies the data format from the information in the
data worksheet. You may select from the two formats: Indexed and Grouped.

Data Type. If two or more data sets are selected then the Data Type option for correlated tests is available. The data is
correlated when two or more tests are obtained on the same individual.

You may select either Paired, for correlated tests, or Unpaired. If Paired is selected the ROC areas and area
comparisons are determined using the DeLong, Delong and Clarke-Pearson method. If Unpaired is selected the areas
are computed using the Hanley and McNeil method and the areas are compared using a Z test.

Missing Value Method. If missing values exist then two options are available for the pairwise comparison of ROC
areas - Pairwise Deletion and Casewise Deletion. This option is not available if no missing values exist.

Pairwise deletion only deletes rows containing missing values for the particular pair being analyzed – not for an entire
row of data. Fewer data values are deleted using this method. There are situations when pairwise deletion will fail but
this is the option to use when it is possible. Casewise deletion deletes all cells in any row of data containing a missing
value. Much more data may be deleted using this option. To better understand the difference, consider a simple
example of two data columns of equal length one of which has no missing values and the other has one missing value.
When ROC areas are being compared, certain computations on these two columns will be done pairwise - the first
column with itself, the first column with the second column and the second column with itself. When the column
without a missing value is being compared with itself no row deletions occur for pairwise deletion. For casewise
deletion, however, the row that contains the missing value will be deleted from both data sets. So, for casewise
deletion, the computation involving the column without a missing value with itself will be done with one row deleted
(the row corresponding to the missing value in the other data set). The macro determines when pairwise deletion is
not valid and informs the user when this is the case.



 | The SigmaPlot Toolbox | 354

Positive State Options

The two classification states are referred to as “Negative” (normal) or “Positive” (abnormal). You must specify which
state is Positive and whether the test measurement values for the positive state are High, meaning higher than those of
the negative state, or Low, meaning lower than those of the negative state.

Accepted normal values for the PSA (prostate specific antigen) test are less than 4 ng/ml and abnormal values are
higher than this; thus if the two classification states names are "positive" and “negative” then the Positive State is
"positive" and the Positive Direction is "High". In this case you would select Positive and High.

On the other hand, for the T4 (thyroxine) test for hypothyroidism the T4 values are lower in the abnormal state than
for the normal state. In this case the abnormal Positive State is "Hypothyroid" and the Positive Direction is "Low". So
you would select Hypothyroid and Low.

What happens if you select the incorrect option? Sensitivity (specificity) is defined in terms of the positive (negative)
state. So if the positive state is incorrectly selected then sensitivity and specificity will be incorrectly defined
(switched) and the ROC curve will have the X and Y axes switched. This will result in an ROC curve that appears
below the diagonal unity line. It will have an area less than 0.5. The ROC Curve Analysis macro will detect this and
give you the following options.

It is possible that there is something wrong with the data so you can abort the analysis and correct the problem. More
likely you have selected the incorrect positive state or direction so you can Retry the analysis with correct selections.
In rare occasions for multiple tests some tests will have areas greater than 0.5 and one or more will have areas less
than 0.5. In this case you can Ignore this warning and continue with the analysis.

Available Data Sets - Selected Data Sets
Select one or more of the available data sets by clicking on them in the Available Data Sets window and then clicking
on the Add button. If desired, you may then select a test name in the Selected Data Sets window and click Remove to
deselect the test.

Reports

Confidence level. Confidence levels are computed for statistics in both the Sensitivity and Specificity and Area
Comparison reports. You can generate 90, 95 and 99% confidence intervals.

Create sensitivity and specificity. Cutoff values are created between each test data value in the (sorted) data set. If
there are a large number of data points and several tests then there will be a large number of cutoff values and the
Sensitivity and Specificity Report can be very long. If you clear this option then all report options in the dialog box
below this are not required and are disabled.

Results in. You may display sensitivities, specificities and probabilities in either fraction or percent format. Selecting
Percents also requires the pre-test probability to be entered as a percent.

Create post-test results. Selecting this option allows entry of the pre-test probability. It also enables the possible
entry of the false-positive/false-negative cost ratio. Given a pre-test probability the program will create post-test
probabilities, both the positive predictive value (PV + = probability of disease given a positive test result) and the
negative predictive value (PV - = probability of no disease given a negative test result), for each cutoff value. If the
cost ratio option is selected then the optimal cutoff value will be computed. All of these results are displayed for each
test in the Sensitivity & Specificity report.

ROC Graph

All of the graph options in the dialog box apply to the ROC graph. They allow you to add a diagonal line to the graph,
add grid lines, add symbols for sensitivity and specificity at each cutoff point and change the ROC plot lines from
solid to different line styles.

Analyzing ROC Analysis Results

Typical results of the ROC analysis are shown in the following example from the Notebook Manager.
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ROC Curves Graph

The ROC curves graph for three data sets is shown below. These graphs are derived from numerical results in the
worksheet entitled Graph Data. The graph title is obtained from the section name containing the raw data. The legend
shows the test names and the ROC areas for each curve. The diagonal line and grids options were selected for this
graph.

Figure 164: The ROC curves graph for three tests.

Of course, you can edit this graph in any way you wish. You might want to change the starting color of the color
scheme used for the line colors.

Dot Histogram Graph

Dot histograms for the data associated with the ROC curves are shown below.

The horizontal lines and the tables below the graph show the optimal cutoff values determined from the pre-test
probability and cost ratio.
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Figure 165: Dot Histogram Pairs for Each Test

The graph title is obtained from the title of the section containing the raw data. The x-axis tick labels are obtained
from the test names and the classification state names. The tick labels will rotate if they are too long to fit
horizontally. The symbol layout design allows for symbols to touch horizontally and nest vertically.

If values for pre-test probability and false-positive/false-negative cost ratio are entered then the optimal cutoff values
for each test are computed and represented as a horizontal line across the two dot histograms for each test. The
numeric values for the optimal cutoff parameters are shown as tables below the x-axis.

Sensitivity and Specificity Report

The sensitivity and specificity report contains results for all tests with additional tests results placed in report rows
below those of prior tests. The results for each test can be separated into three parts:

• Optimal cutoff value.
• Sensitivity and specificity versus cutoff values.
• Likelihood ratios and post-test probabilities.

If values for both pre-test probability and cost ratio have been entered then the optimal cutoff is calculated. A slope of
the tangent to the ROC curve m is defined in terms of the two entered values (P = pre-test probability).

The optimal cutoff value is computed from sensitivity and specificity using the slope m by finding the cutoff that
maximizes the function

The results of this computation in the Sensitivity and Specificity Report are shown below.
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Figure 166: Optimal Cutoff Results in the Sensitivity and Specificity Report

For this data set, the optimal cutoff is 7.125 for a pre-test probability of 0.5 and cost ratio of 1.0.

Sensitivities, specificities and their confidence intervals are listed as a function of cutoff value in the second part
of the report. A portion of these results is shown in the table below. These results can be expressed as fractions or
percents by using the Fractions/Percents option.

Figure 167: Sensitivity and specificity results in the Sensitivity and Specificity report.

The third part of the Sensitivity and Specificity report contains the likelihood ratios and post-test probabilities.

The positive and negative likelihood ratios are defined respectively as

The post-test probabilities are the probability of disease given a positive test (PV+) and the probability of no disease
given a negative test (PV-). These will be computed when a pre-test probability has been entered. Using P = pre-test
probability, the equations used for these probabilities are:

A portion of the report showing the likelihood and post-test probabilities results is shown below.

Figure 168: Positive and Negative Likelihood Ratios, LR+ and LR-, and Post-test Probabilities, PV+
and PV-, in the Sensitivity and Specificity Report

The positive likelihood ratio is not defined for some cutoff values since specificity = 1.

ROC Areas Report

The ROC Area report consists of two parts:

• ROC areas and their associated statistics.
• Pairwise comparison of ROC areas.

An example of a report is shown in below.
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From top to bottom it shows the type of analysis used together with the missing value method, the ROC areas and
associated statistics and a pairwise comparison of ROC areas.

Figure 169: An Example ROC Areas Report

In this case there are three correlated tests. Row two of the report shows that a Paired Analysis was performed and,
since there were missing values in the data, Pairwise Deletion of missing values was selected to compare the areas.

The first section of the report shows the ROC curve areas for the three tests. This is followed by the standard error of
the area estimate, the 95% confidence interval (90% and 99% are also available) and the P value that determines if the
area value is significantly different from 0.5. The sample size and the number of missing values for each classification
state are given. The number of missing values reflects only what is seen in the data and does not give the number used
for each computation-pair in the pairwise-deleted comparison of areas.

The second section shows the results of the pairwise comparison of areas. The method of DeLong, DeLong and
Clarke-Pearson(2) is used to compare areas when the Paired data type option is selected. When the Unpaired data type
is selected, areas are compared using a Z test. The report shows results for all pairs of data sets. The difference of each
area pair and its standard error and 95% confidence interval are computed. This is followed by the chi-square statistic
for the area comparison (or Z statistic if Unpaired is selected) and its associated P value.

Formatted Full Precision Display
This report presents the numeric results in a four significant digit format with full precision available. Double click on
any cell (except the confidence intervals) to display the number at full precision.

Additional Graphs
Results data in both reports can be used to create additional graphs. Some examples seen in the literature are shown
here.
Sensitivity and Specificity versus Cutoff
The data for the graph in the graph below is from the Sensitivity & Specificity report in columns 1, 2 and 4. Use the
Data Sampling option in Graph Properties, Plots, Data to specify the row range for the graph (you can also drag select
the rows in the worksheet to do this).
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Figure 170: Graph of Sensitivity and Specificity versus Cutoff for One Test Using Data from
Columns 1,2 and 4 of the Sensitivity and Specificity Report

Likelihood Ratios

The positive and negative likelihood ratios for three different imaging modalities are shown in below (the data is
artificial). The data is in columns 1, 6 and 7 of the Sensitivity & Specificity report. The values associated with the
optimal cutoff are shown as solid symbols. The largest positive likelihood and smallest negative likelihood at the
optimal cutoff is associated with magnetic resonance imaging (MR).

Figure 171: Positive and negative likelihood ratios graphed from data in the Sensitivity and
Specificity report from columns 1, 6 and 7. The results for three tests are shown together with
values associated with the optimal cutoff (solid symbols).

Optimal Cutoff versus Cost Ratio

Frequently it can be difficult to determine a value for the false-positive/false-negative cost ratio. So it is worth
performing a sensitivity analysis (sensitivity here means how much one variable changes with changes in a second
variable) to see whether the cutoff value changes significantly in the range of cost-ratio values of interest. The ROC
Curves Module was run multiple times for different cost ratios and a graph of optimal cutoff vs. cost ratio for the three
imaging modality tests is shown below.
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Figure 172: Optimal cutoff values obtained from multiple runs of the macro. Regions of
insensitivity, or strong sensitivity, to cost ratio can be identified.

If the relative cost of a false-positive is much greater than that of a false-negative then the cost ratio is greater than
1. But let's assume that we don't know exactly how much greater it is but have some idea that it should be in the
range of 2 to 5, say. Looking at the optimal cutoff for the best imaging modality (MR, green line) we find that it
doesn’t change for cost ratios from 2 to 20. So the optimal cutoff is insensitive to cost ratio and, in this case, it is not
important to know a precise value for cost-ratio.

Post-Test Probability Versus Pre-Test Probability

Given values of sensitivity and specificity associated with the optimal cutoff a graph of post-test probabilities as a
function of pre-test probability can be created using the equations below. The post-test probability of disease when
the test is positive, blue lines in the graph below, was obtained from equation and the post-test probability of disease
when the test was negative, red lines, was obtained from 1.0 minus equations PV+ and PV- above. A transform was
written in SigmaPlot implementing these two equations that generated the post-test probabilities for a range of pre-test
probabilities. The results for the best test, MR, and worst test, US, are shown. The MR test is clearly better since the
post-test probability range, from negative test to positive test, is larger. Thus given a positive test the patient is more
likely to have the disease using the MR test rather than the US test. Similarly, given a negative test it is less likely that
the patient has the disease using the MR test.
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Figure 173: Post-test probabilities of disease given positive and negative test results. The MR test
is based on sensitivity = 0.94 and specificity = 0.97 whereas the US test used sensitivity = 0.78 and
specificity = 0.85.
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Standard Curve
A standard curve is used to calibrate an instrument or assay. The Standard Curves macro provides five equations that
may be fit to your data. These range from a straight line equation to two different five parameter logistic equations.

The X data may or may not be logarithmic and, if not, may still be graphed logarithmically. Multiple Y replicate
columns may be used.

Predicted values may be obtained after the curve fit is performed: Y values from Xs, X values from Ys, and ECxx
values from xx percentages. These predicted values may be added to your graph as symbols with drop-lines to the X
and Y axes.

The Dynamic Curve Fitting algorithm may be used to help solve difficult curve fitting problems involving local
minima.These are typically encountered with the five parameter logistic functions.

Using the Standard Curve Macro

To use the Standard Curve Macro:

1. Enter either X and Y columns or X and multiple replicate Y columns into your worksheet. These columns must
be adjacent. If you plan to compute predicted Xs or Ys from the computed curve, you will also need to enter a
column of the source values.
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2. Select the equation from the Equation list to use to fit the curve. Your options are: straight line or quadratic
equation; four parameter logistic equation; five parameter logistic equation; five parameter logistic equation – 2
slopes.

3. Select whether or not to plot the X axis using a common log scale
4. If you find that your data is difficult to fit, select the Dynamic curve fit. In this case 200 curve fits will be

performed using initial starting values that span the parameter ranges. The best fit will be selected from the 200
results.

5. Set the columns to use for the X and Y data. If your X data us already in a log format, make sure you check the
Log format X data option.

6. If you have replicate Y measurements for each X data point then select the Y replicates and then select the Last Y
replicate column.

7. Select Predict unknowns to compute results using the solution to the fit. You can compute a column of new Y
values from given Xs, or Xs from given Y values. If you are using the four or five parameter logistic equations
you can compute ECpercent values for a specified range of percent values. You can also elect to plot the results of
these on your standard curve.

8. When finished, click OK. A standard curve appears, and if you elected to compute additional values, they are also
plotted using drop lines to indicate the X and Y values.

Figure 174: A Standard Curves Graph

Y Replicates

If you have multiple measurements for each X value, select Y replicates on the Standard Curve  dialog box, then
select the Last Y replicate column from the drop-down list. The Y replicate columns must begin to the right of the X
data.
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Figure 175: Y Replicate Data for the Standard Curves Macro

Log Data Format

If your X data uses simple integers, especially negative numbers, it is already in log format and you should select
the Log format X data option. The macro will automatically create a new column of equivalent numeric data, and
automatically plot X on a log axis scale.

Figure 176: Log Data Format for the Standard Curves Macro

Linear Equation

A straight line, characterized by the slope a and the y-intercept y0.

Quadratic Equation

The standard parabolic equation with quadratic coefficient b, slope a and intercept y0.

Four Parameter Logistic Equation
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Figure 177: A Dose-Response Curve with a Variable Slope Parameter

This is a typical dose-response curve with a variable slope parameter. Four parameters are produced:

• Min, or bottom of the curve.
• Max, or top of the curve.
• EC50: Median effective concentration. That is, the concentration that can be expected to cause a defined effect on

50% of a given population of organisms under defined conditions.
• Hillslope: Characterizes the slope of the curve at its midpoint.

Five Parameter Logistic Curve

where



 | The SigmaPlot Toolbox | 365

Figure 178: Richard's Formulation of the Five Parameter Logistic

This is the Richard’s formulation of the five parameter logistic. It adds an asymmetry parameter 's' to the four
parameter logistic. The asymmetry is shown above with large changes in curvature with changes in s in the lower
curve but relatively small changes in the upper curve.

The additional algebraic equation for xb maintains EC50 as the half-maximum y value. The equation has been written
so that a positive Hillslope results in a curve that increases with x.

Four of the five parameters are the same as those in the four parameter logistic.

s – controls the asymmetry. If s = 1 then this function is the same as the four parameter logistic.s less than 1 decreases
the overall slope of the curve whereas s greater than 1 increases the overall slope.

Five Parameter Logistic – Two Slopes

where
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Figure 179: Ricketts and Head Equation with Two "Slope” Parameters

This is the Ricketts and Head equation with two "slope" parameters (the parameters actually better describe the two
different curvatures). It has a different shape than Richard’s equation and will fit some data sets better. The equation
is written in terms of SlopeCon to force Slope1 and Slope2 to be the same sign.If this is not the case then in rare
situations, error in the data will result in a fit with slopes of opposite sign.In this case the function attempts to follow
the error which results in an irregularly shaped curve. The graph shows the increasing asymmetry with increasing
SlopeCon (and therefore increasing Slope2). If SlopeCon=1 then Slope1 = Slope2 and the curve is symmetric and
identical to the four parameter logistic curve.
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Survival Curve
This macro computes and graphs a Kaplan-Meier survival curve. Specify the column containing the survival data,
as well as the column indicating censoring of cases. A value of 0 in the censoring column indicates that the case is
censored, whereas a value of 1 indicates an uncensored case.

Use the Graph Titles section of the Survival Curve dialog box to customize the graph title, the X axis title and the
Y axis title. Further customize the plot by selecting between a built-in symbol and a half-line symbol for censored
observations.

The macro writes the data underlying the plot in seven worksheet columns, beginning in the specified location. The
first three result columns contain the time, cumulative probability, and standard error of the cumulative probability.
The next two columns hold the coordinates of the censored observations. The final two columns contain the
coordinates of the half-lines used to depict the censored observations.

Restriction:
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• To run the macro, a worksheet must be open and in focus.
• The worksheet must be sorted by survival times.
• If identical survival times occur for both censored and uncensored cases, place the censored cases after the

uncensored within the tied time value.

Vector Plot
This macro uses the vector transform to plot X,Y, angle and magnitude data as vectors with arrowheads. The
arrowheads have a user-specified length and angle. The vector starting point may be selected as the point of the vector
tail, midpoint or head. The vector plot consists of three line plots. The data underlying these plots appears in the six
columns of the worksheet immediately to the right of the data as three XY pairs.

Restriction:

• To run the macro, a worksheet must be open and in focus.
• The four columns to be plotted must be contiguous and in the following order: X, Y, Angle, and

Magnitude (Length). Due to this restriction, only the first data column (X) must be specified.
• Angle data must be in radians.





Chapter

14
SigmaPlot Automation Reference

Topics:

• About Objects and Collections
• About Properties
• About Methods
• Returning Objects

OLE Automation is a technology that lets other applications, development
tools, and macro languages use a program. Using SigmaPlot Automation,
you can integrate SigmaPlot with the applications you have developed.
Automation can also be an effective tool to customize or automate frequent
tasks you want to perform.

Automation uses objects to manipulate a program. Objects are the
fundamental building block of macros; nearly all macro programs involve
modifying objects. Every item in SigmaPlot - graphs, worksheets, axes, tick
marks, reports, notebooks, and so on - can be represented by an object.

SigmaPlot uses a VBA®-like macro language to access automation internally.
For more information, see Automating Routine Tasks on page 325.
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About Objects and Collections
An object represents any type of identifiable item in SigmaPlot. Graphs, axes, notebooks, worksheets, and worksheet
columns are all objects.

A collection is an object that contains several other objects, usually of the same type; for example, all the items in a
notebook are contained in a single collection object. Collections can have methods and properties that affect the all
objects in the collection.

Use properties and methods to modify objects and collections of objects. To specify the properties and methods for an
object that is part of a collection, you need to return that individual object from the collection first.

For more information, refer to SigmaPlot Automation Help located on the Help menu.

About Properties
A property is a setting or other attribute of an object. Think of a property as an "adjective." For example, properties of
a graph include the size, location, type and style of plot, and the data that is plotted.

To change the settings of an object, change the properties settings. Properties are also used to access the objects that
are below the current object in the hierarchy.

To change a property setting, type the object reference followed with a period, then type the property name, an
equal sign (=), and the property value.

For more information, refer to SigmaPlot Automation Help.

Example

Set Notebook.Title = "My Notebook"

Sets the name of the referenced SigmaPlot notebook to "My Notebook".

Note that some properties cannot be set, and only retrieved. The Help topic for each property indicates whether you
can both set and retrieve that property (read-write), only retrieve the property (read-only), or only set the property
(write-only).

You can get information about an object by returning the values of its properties.

Example

Set CurrentDoc = ActiveDocument.NotebookItems(3)

The fourth item in the current notebook (specified by ActiveDocument) is assigned to the variable CurrentDoc
(item counts start with 0).

About Methods
A Method is an action that can be performed on or by an object. Think of methods as verbs. For example, the
WorksheetEditItem object has Copy and Clear methods. Methods can have parameters that specify the action
(adverbs).

For more information, refer to SigmaPlot Automation Help which you can find on the Help menu.

Example

Notebooks(0).NotebookItems(2).Close(True)
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This example closes the second item in the NotebookItems collection object while saving it first. Note that the
NotebookItems collection is selected using the Notebooks object NotebookItems property.

Returning Objects
In order to work with an object, you must be able to define the specific object by returning it. In general, most objects
are returned using a property of the object above it in the object tree.

Returning Objects from Collections

Other objects are returned by specifying a single object from a collection. Once you define the collection, you can
return a specific object by using an index value (as you would with an array). You can use either the Item method
shared by all collections, or use the index directly. The index can be the item name or a number. For example:

Set Worksheet = Notebooks("My Notebook").NotebookItems.Item(2)

The collection index value returns the notebook "My Notebook" from the Notebooks collection, then the Item
property and index number returns the third item from the NotebookItems collection as the variable Worksheet.

The Notebooks collection contains a list of all the open notebooks in SigmaPlot, and the NotebookItems collection
contains all items in the specified notebook.

Defining Variables

You can also return and use objects by defining the object to be a variable, generally using the Dim (dimension)
statement.

Although you can implicitly declare variables just by using the variable for the first time, you can avoid bugs caused
by typos using Option Explicit. For example, the script:

Option Explicit 

Sub Main 
Dim ItemCount 
Dim SPWorksheets$() 
ItemCount = ActiveDocument.NotebookItems.Count 
ReDim SPWorksheets$(ItemCount) 
Dim SPItems 
Set SPItems = ActiveDocument.NotebookItems 
Dim Index 
Index = 0 
Dim Item 
For Each Item In SPItems 
If SPItems(Index).ItemType = 1 Then  
      SPWorksheets$(Index) = SPItems(Index).Name 
End If 
Index = Index + 1 
Next Item  

Begin Dialog UserDialog 320,119,"Worksheets in Active Notebook" '
 %GRID:10,7,1,1 
      OKButton 210,14,90,21  
      ListBox 20,14,170,91,SPWorksheets(),.ListBox1 
End Dialog 
Dim dlg As UserDialog 
Dialog dlg 
End Sub

Uses the Dim (Dimension) statement to define several variables, and uses the Set instruction to define a declared
variable as an object.
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Index

Special Characters
.ASC files

opening 107, 108
.CVS files

opening 107, 108
.DBF files

opening 107, 108
.DIF files

opening 107, 108
.ini files 5
.jfl files 5
.jgg files 5
.JNB files

exporting as non-notebook files 112
.jnt files 5
.JNT files

defined 13
.MOC files

opening 107, 108
.PRN files

opening 107, 108
.SMB files

importing 168
.SP5 files

opening 107, 108
.SPG files

opening 107, 108
.SPW files

opening 107, 108
.TXT files

opening 107, 108
.WK* files

opening 107, 108

Numerics
10th/90th percentiles

box plots 229
1st derivative

computing 341
21CFR 101, 104
2D graphs

adding plots 72
area plots 212, 231, 235
arranging data 53
asymmetric error bar plots 51
asymmetric error bars 219
bar charts 212
blobbogram 244
box plots 213, 229
column averaged error bar plots 51
creating 213
creating multiple axes for single plot 249
creating plots with asymmetric error bars 219
creating plots with error bars 216
error bars 216
examples 16, 19

forest plots 244
grouped bar charts 223, 224
grouped bar charts with error bars 223
modifying plots 95
multiple axes 249
multiple plots 72
plotting data 53, 212, 212, 212, 213, 227
plotting multiple curves 54
plotting mutiple curves, same X or Y 53
plotting X or Y using row numbers 53
polar axes 297
quartile plots 219
range plots 218
reference lines 229
stacked bar chart 51
vector plot 52

3D bar charts
data format 28
fills 88

3D graphs
adding plots 72
axes placement during rotation 262
bar chart data format 28
bar charts 252
changing view 259
creating 253, 253, 254, 255
creating mesh 257
data format 28
examples 20, 21
generating mesh data 14
gradient fills 258
light source 259
lighting 259
line data format 28
mesh 252
mesh data format 28
mesh lines/fills 258
mesh plots 257
modifying drop planes in waterfall plots 257
modifying mesh lines and fill color 258
origin axes 259
perspective 259
plotting data 57, 251
positioning axes 262
rotation 259
scatter and line 252
scatter data format 28
smoothing mesh data 14
trajectory 254
water fall lines/fills 257
waterfall plots 253, 255

3D line plot data formats
3D trajectory 49
3D waterfall 49

3D mesh plots
data format 28

3D scatter plots
adding drop lines 93, 94
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symbols 76, 80

A
Add Procedure dialog box 333
adding

axes 249
axis breaks 283
contour fills 265
contour labels 266, 266
exploding slices to pie charts 271, 271
frame lines 262
graphs to pages 117, 118
labels to page 144
macros to macros 332
multiple axes for single plot 249
plots to graphs 72
prefix/suffix to tick labels 290
procedures to macros 333
reference lines 229
styles to Graph Style Gallery 65
suffixes/prefixes 266
text to page 144

aligning
axis titles 284
objects/graphs/labels 13, 142
snap-to grids 143
text 144
using crosshairs 143
using snap-to 143
with grids 143
with rulers 143

alphanumeric symbols 79
angular axes

about 294
arc 294, 294
modifying 297
range 294, 294
rotation 294, 294
scale 294, 294

angular values 54
antialiasing

lines on a graph page 162
apex

dragging to modify ternary axis ranges 298
applying

data transforms 14
graph styles using the Graph Style Gallery 65

arc
angular axis 294

Area Below Curves 338
area plot data formats

multiple area plot 40
multiple vertical area plot 40
simple area plot 40
vertical area plot 40

area plots 231
changing area fill direction 235
changing fill color 235
climographs 236
converting multiple into complex 235
creating complex area plots 234

creating multiple and multiple vertical area plots 233
creating simple straight line area plots 231
creating vertical area plots 231
examples 212
identifying regions 235
shading between two curves 236

arithmetic mean 175
arranging

data for 2D graphs 53
data for 3D graphs 57
data for bubble plots 56
data for contour plots 57
data for mesh plots 57
data for polar plots 55
graphs 141
graphs on a page 138
radial and angular values for polar plots 54
XY data for polar plots 55

arranging data 49, 57
arranging data 52
asymmetric error bar plots 51
column averaged error bar plots 51
column means 51
polar plots 54
stacked bar chart 51
vector plot 52

Arrhenius plot 278
Arrhenius scale 281
arrow keys

moving graphs and objects using 137
arrowheads

filled 244
lines 244
modifying for vector plots 244

arrows
drawing 133
modifying arrow heads 135

ASCII files 173
aspect ratio

options 112
asymmetric error bar plots 51, 51
asymmetric error bars

creating 2D plots with 219
asymmetrical error bars

quartile plots 219
attributes 122

changing line 282
text formatting 146

audit trails 101, 104
automatic legend updating 153
automatic legends 12, 13, 147

column count 154
direct labeling 155
displaying 149, 152
dragging individual entries 149
editing 149
locking 153
locking into place 149
moving individual entries 149
moving individual items 155
restoring to default settings 149

automatic updating 4
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automation 330, 330
Add Procedure dialog box 333
adding macros to macros 332
automating routine tasks 325
creating buttons 336
creating custom dialog boxes 332
creating macros 325
creating user-defined functions 334
Debug Window 334
editing macro code 332
editing macros 328
macro window 331
Macro Window toolbar 329
Object Browser 333
parts of macro programming language 331
reference 369
running macros 338
user-defined functions 333

available statistics 175
averaging 175
axes

displaying 281, 281
engineering notation 289
hiding 281, 281
modifying 281, 281
polar plots 293
turning on/off 281, 281
viewing 281

axis
3D placement during rotation 262
about 248
adding 249
additional for multiple plots 248
angular 297
breaks 13, 283
category scale 277, 280
changing scale 276, 276, 276, 276, 277, 277, 277, 278, 278
changing scale types 280, 281
common log 276
contour range values 265
creating multiple for single plot 249
custom scale 281
date/time 278
dragging to modify ternary ranges 298
Extreme Value Distribution axis scale 281
labels 284
line attributes 282
linear scale 276
logit scale 277
modifying 262
modifying range by dragging 298
moving 2D 282
multiple 13
multiple pairs 249
natural log scale 276
origin axes 259
polar 297
positioning 3D 262
positioning using Graph Properties 282
probability scale 276
probit scale 277
radial 297

radial tick labels 297
range values 279
range, changing 279
reciprocal 278
scale types 276, 276, 276, 276, 277, 277, 277, 278, 278, 280,
281
scale values 290
tick labels 290
tick marks 287, 304
titles 284
types 276, 276, 276, 276, 277, 277, 277, 278, 278
using drawing tools, using formatting commands 14
x and y 13

axis breaks
creating 283

axis range
scale 279
values 279

axis scale
Arrhenius 281
Extreme Value Distribution 281
switching to category 280
switching to custom 281
types 276

axis titles
editing 284
hiding 284
moving 284
rotating 284
viewing 284

axis, range
contour plots 265

Axon files
importing 173

B
back planes

color 291
grid lines 293
transparent planes 291

backup files 12
bar chart data formats

grouped horizontal bar chart 46
grouped horizontal bar chart with error bars 46
grouped vertical bar chart 44
grouped vertical bar chart with error bars 44
horizontal bar chart with error bars 46
simple horizontal bar chart 46
simple vertical bar chart 44
stacked horizontal bar chart 46
stacked vertical bar chart 44
vertical bar chart with error bars 44

bar charts
automatic reference lines 95
creating 213
edges 134
error bars 223
examples 212
fills 88, 134
grouped bars with error bars 226
horizontal data format 28
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needle plot 91
spacing bars 91, 92, 225

bar charts, 3D
creating 253, 254
examples 252

bar widths
variable 92

bars
edges 134
fills 88, 134
spacing 91, 92, 225

base
using as tick labels 289

Base
using as tick labels 266

Batch Process Excel Files 338
bidirectional error bars

data format 29
Bland-Altman Analysis 339
blobbogram 244
blocks, data

deleting 195
inserting 194
sorting 192

border colors
tables 316

Border Plots 340
box plot data formats

box plots 48
box plots

10th/90th percentiles 229
box fills/color 229
box widths 229
Cleveland percentile method 230
computing percentile methods 230
computing percentile values 227
creating 213, 227
data format 28
edges 134
examples 213
fills 88, 134
macro for creating 340
mean lines 229
modifying 229, 229, 229
outliers 229
Standard percentile method 230
symbols 76, 80, 229
whisker cap widths 229

boxes
drawing 133
edges 134
fills 88, 134

breaks 283
bubble plots 76

2D 241
applications 241
arranging data 56
arranging data for size 56
converting area data to diameters 56
plotting data 56
transforms dialog box 56
X, Y values 56

buttons
creating using macros 336

By Group Data Split 340

C
calculating

error bar mean 223
error bars 223

category axis scale 277
category data 50

creating graphs using 214
using to create plots 220

category scale
creating 280
modifying 280

cells
engineering notation 188
formatting in worksheets 188
moving to 166
setting decimal places in worksheets 188
using as column or row titles 199
wrapping text 188

centering
axis titles 284

changing
3D graph view 259
area plot fill color 235
axis range 279
axis scale 276
axis scale types 280, 281
bar/box fills 134
color of fill pattern lines and edge lines 134
colors 86
column width 178, 181
contour labels 266, 266
contour plots 264, 266
contour range values 265
default layout template file 141
fill patterns 134
fills 86
gap color 135
grids 291
inserted object icons 129
line end attributes 135
line types 83, 135
object background fills 134
objects fills 134
page color 160
pasted object icons 128
pattern and edge line thickness 134
pattern density of plot fills 86
patterns 86
pie charts 271
polar plot axes 293
polar plots 55
radial axes 296, 297
radial axes tick labels 297
range direction 300
scale direction 300
slice fills 134
symbol fills 134
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ternary axis direction 300
ternary graphs 274
ternary range 300
ternary scale type 299
text formatting 146
tick label text 289
tick values 290
units of measurement 159

Changing
axis color 282
axis thickness 282

characters
non-keyboard 144
using as symbols 79

chart fills
color incrementing 88

charts
creating pie charts 49
creating radar charts 50

clearing 194
graph titles 133
graphs/objects 133
legends 133

Cleveland percentile method
using for box plots 230
using for quartile box plots 230

climographs 236
Clipboard

cutting and copying data 124, 125, 187, 193
using 124, 125, 193

clockwise angular units
setting for polar plots 272

color
axis lines 282
bars 88
box plots 88, 229
changing 86
contour fills 265
contour lines 264
custom 162
custom incrementing schemes 88
error bars 221
frame lines 262
gap color 135
graph back planes 291
grids 291
incrementing chart fills 88
line 135
lines 83
mesh lines/fills 258
page 160
radial axes 296
reference lines 95
schemes 162
tick marks 288, 304
waterfall plot fills 257

color incrementing
assigning to worksheet 88
customizing 88, 92
symbols 78

color schemes 162
incrementing 89

setting the first color 89
using the ellipse 89

Color Transition Values 341
colors

creating gradients 341
column averaged error bar plots 51

arranging data 51
column averaging

grouped bar chart 226
column count

for legends 154
column means 51
Column picker dialog box

Graph Wizard 69
column statistics

maximum value 175
mean 175
minimum positive value 175
minimum value 175
missing values 175
other values 175
printing 205, 206
setting Options 12
size of sample 175
standard deviation 175
standard error 175
sum of sample 175
viewing 14, 175

column titles
duplicate 164

column width
changing 178, 181

columns
asymmetric error bar plots 51
averaging 175
column and row titles dialog box 196
column averaged error bar plots 51
deleting 195
inserting empty 194
inserting graphic cells 88, 236
inserting symbol size values 80
key 192
line widths 85
merging 345
multiple Z 57
picking different data for current plot 69
plotting multiple curves, same X or Y 53
plotting X or Y using row numbers 53
plotting XYZ 57
selecting 193
setting for legends 154
sizing 178, 189
sorting data 192
stacked bar chart 51
statistics 175
switching from rows to columns 195
tick labels 266, 291
titles 195, 199
type labels 291
using as row titles 198
vector plot 52
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Comma Delimited (.CSV)
importing 168

command prompt
using to run SigmaPlot macros 336

common logarithmic axis scale 276
comparing groups 339
complex area plots 234, 235
Compute 1st Derivative 341
computing

1st derivative 341
computing percentile methods 230
cumulative percentages 349
power spectral density 349
quartiles 230
rank and percentile 349

confidence lines
95% and 99% confidence interval 175

configuring
printer settings 205, 208, 209

contour fills
color 265
modifying 265

contour labels
changing frequency 266
numeric 266
rotating 266
skipping 291
suffixes/prefixes 266
text attributes 267
turning on/off 266

contour lines
color 264
line types 264
modifying 264
showing/hiding 264
thickness 264

contour plot 19
contour plot data formats

contour plot 48
filled contour plot 48

contour plots
adding fills 265
adding labels 266, 266
creating 262
data format 28
editing contour labels 267
example 19
frequency of contour labels 266
line types 264
modifying 264, 266
modifying contour lines 264
modifying fills 265
modifying labels 266, 266
modifying Z data range/scale 265
plotting data 57, 262
setting line intervals 265
setting the direction of fills 265
X,Y,Z values 57

converting
area data to diameters for bubble plots 56
numeric and date and time data 189

copy and Paste 173

Copy shortcut 166
copying

data 169, 194
graphs 118
notebook items between notebooks 107, 108
objects/graphs 124, 125, 125, 193

creating
additional axes for multiple plots 248
additional plots 72
axis breaks 283
buttons using macros 336
category scale 280
complex area plots 234
contour plots 262
creating pie charts 49
creating radar charts 50
custom dialog boxes 332
custom graph page layout 140
custom scale 281
embedded graphs 74
files for figure submission to journals 322
filled contour plots 262
graphs 27, 59
graphs using Excel worksheets 204
graphs using the Graph Style Gallery 64, 65
graphs with Graph Wizard 61
labels 144, 146
legends 144, 146
macros 325, 327
multiple area plots 233
multiple axes for single plot 249
multiple curves 54
new graph for current page 118
new object to insert 129
page templates 122, 131
pie charts 49
plots using category data 220
plots with date and time scale 281
polar plots 55, 272
radar charts 50
simple straight line area plots 231
survival curves 366
ternary graphs 273
text labels, legends 144
user-defined functions 334
vector plots 367
vertical area plots 231

crosshairs 143
cumulative percentages

computing 349
curves

column averaged error bar plots 51
multiple for polar plots 55
multiple in graph 214
multiple, same X or Y 53
plotting multiple 54, 214
plotting X or Y using row numbers 53
using category data 214

custom color 162
custom dialog boxes 332
custom error bars 222
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custom graph styles
Graph Style Gallery 64, 65
saving 64, 65

custom layouts
creating 140

custom scale
creating 281

custom tick mark intervals 287
customer service 22, 22, 22
customizing

color increments 88, 92
error bar directions 222
fill increments 88, 92
graph styles 64, 65
line increments 88, 92
symbol increments 88, 92
tick labels 266, 291
tick mark intervals 287

Cut shortcut 166
cutting

data 194
notebook items between notebooks 107, 108
objects/graphs 124, 125, 125, 193

D
data

2D graphs 211, 227
3D graphs 251
applying transforms 14
arranging for 2D graphs 53
arranging for 3D graphs 57
arranging for bubble plots 56
arranging for contour plots 57
arranging for polar plots 54, 55
column statistics 175
contour plots 57, 262
converting bubble plot area 56
converting data to diameters for bubble plots 56
converting to mesh format 14
copying and pasting from other applications 169
cutting 194
deleting 194, 194
entering 163, 204
entering into a worksheet 167
exporting 174
highlighting outliers 201
importing 168, 169, 173, 199
indexing 202, 202
inserting 167
long form mesh format 57
mesh, converting to 14
moving 194
multiple-curve plots (ternary triplets) 55
one column for multiple curves in polar plot 55
pasting 194
plotting additional 72
plotting different data for current plot 69
plotting portion of 74
plotting X or Y using row numbers 53
polar plots 55, 55
previewing before printing 206

printing 205, 205, 206
protecting data on the Web 321
radial and angular values 54
rearranging 195
regression 14
removing outlying data 199
retrieving from graph pages 125
sampling 74
selecting 193
selecting for ternary graphs 273
single-curve plot (ternary triplets) 55
smoothing 14
sorting 192
storage in graph pages 125
ternary graphs 273
transposing 195
unindexing 202
viewing for embedded graphs 76, 76
X,Y, many Z for contour and mesh plots 57
XY values for polar plots 55

data brushing 180, 199, 201
data feedback

set colors on worksheet 180
data format

3D bar chart 28
3D graphs 28
3D line plot 28
3D mesh plot 28
3D scatter plot 28
3D trajectory 49
3D waterfall 49
arrow line radar plot 43
box plots 28, 48
contour plot 28, 48
error and radio band radar plot 43
filled contour plot 48
forest plots 28
graph styles 29
graph types 28
grouped horizontal bar chart 46
grouped horizontal bar chart with error bars 46
grouped vertical bar chart 44
grouped vertical bar chart with error bars 44
horizontal bar chart 28
horizontal bar chart with error bars 46
horizontal dot plot 29
line and scatter plot 28
line plot 28
line plus radar plot 43
long form mesh 57
multiple area plot 40
multiple horizontal step plot 35
multiple regressions 29
multiple scatter plot 29
multiple spline curves 35
multiple straight line 37
multiple vertical area plot 40
multiple vertical step plot 35
pie chart 28
polar line plot 42
polar plot 28
polar scatter line plot 42
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polar scatter plot 42
radar line plot 43
radar scatter line plot 43
radar scatter plot 43
scatter plot 28
simple area plot 40
simple horizontal bar chart 46
simple scatter plot 29
simple spline curve 37
simple straight line 37
simple vertical bar chart 44
simple vertical plot 35
stacked horizontal bar chart 46
stacked vertical bar chart 44
ternary 28
ternary line plot 43
ternary scatter line plot 43
ternary scatter plot 43
vector plot 28, 28
vertical area plot 40
vertical bar chart 28
vertical bar chart with error bars 44
vertical dot plot 29

data formats 49, 57
pie charts 49
polar plots 54
radar charts 50

data ranges 63
databases

importing 169
date and time

Options 12
tick intervals 286

date and time axis scale
tick labels for contour plots 267
tick marks 286

date and time data
converting to numeric 189
formatting in worksheets 188

date and time format
date delimiters 186
entering 167
regional settings 186
using with Excel 187
worksheet display 184, 187

date and time scales
creating plots with 281

date delimiters
date and time formats 186

date/time axis scale 278
Day Zero

leap years 186
setting in worksheets 186

dBase (.DBF)
importing 168

Debug Window 334
Intermediate tab 334
Stack tab 335
tabs 334
toolbar buttons 334
Watch tab 335

decimal places
setting in worksheets 181

defaults
setting graph 28

Delete Cells... command 166
Delete shortcut 166
deleting 194

columns and rows 195
data 194, 194
graph titles 133
legends 133
objects 133
tables 316

DemingWzd.ini 5
density

changing pattern of plot fills 86
derivatives

computing 341
dialog boxes

creating in SigmaPlot 332
digital pre-press

preparing graphs 322
direct labeling

legend items 155
direction

customized error bars 222
error bars 221
reference lines 95

display formats
date and time format 184, 187
numbers 182

displaying
automatic legends 149, 152
axes 281, 281
contour fills 265
contour labels 266, 266
contour lines 264
grid lines 293
outlying data 201
page margins 157
reference lines 95

dividing
data into multiple columns 340

DOS files
importing 168

Dot Density Plot 341
dot plot

horizontal data format 29
vertical data format 29

dpi 323
dragging

2D axes 282
Notebook Manager sections and items 107
objects 135
radial axes 296
ternary axes 298

drawing
arrows 133
ellipses 133
lines 133
objects 14, 133
Page toolbar 133
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drawing speed 74
drop lines

adding to plots 93, 94
attributes 93
for single point 94
modifying 93

drop planes
modifying 257

duplicate column titles 164

E
E notation 177
E Notation Always

display 182
E Notation When Needed

display 182
edge lines 86

setting the color 134
setting thickness 134

edges
bar/box 134, 134
plot line thickness 86
slice 134, 134

editing
automatic legends 149
axis tick labels 288
axis titles 284, 284
contour labels 266, 267
embedded graphs 74, 75, 76
Graph Style Gallery graphs 65
macros 328, 332
notebook items 106
notebook sections 106
page format 156
pasted graphs in other applications using OLE2 125
radial axes tick labels 297
text 144, 146
tick labels 289

EK.ini 5
ellipse

use for selecting a color scheme 89
ellipses

drawing 133
embedded graphs 75

editing 74, 76
opening inside SigmaPlot 76
viewing data 76, 76

Embedded graphs
resizing 76

embedding
objects 126, 131
Reports 126

embedding objects in graphs
viewing as an icon 127

engineering notation 182
as used in SigmaPlot 177
scientific notation 177
setting in worksheets 188
tick labels 289
using as axis values 289

entering
column titles 195, 199
data 163, 204
data into worksheets 167
Greek symbols 144
labels 144
row titles 195, 199
symbols in legends 144
text 144, 146

enzyme kinetics 338
activate module 14

Enzyme Kinetics Module 14
EPS files 323
equations

plotting 27
error bar direction 221, 222
error bar plots

arranging data 51
error bars

asymmetric 219
bidirectional data format 29
bidirectional error bars 29
calculating 223
cap width 221
color 221
creating 2D plots with 216
creating grouped bar charts with 223
custom directions 222
direction 221
generating 223
grouped bar charts 226
horizontal data format 29
line thickness 221
mean computation method 223
methods for generating 223
modifying 221
modifying appearance 221
multiple and regressions data format 29
multiple data format 29
plot types 216
quartile plots 219
range plots 218
relative direction 221
simple and regression data format 29
simple data format 29
vertical point plot 29

European address and phone number 22
examples 19

2D graphs 16, 19
3D graphs 20, 21
of macro uses 335
pie charts 16
polar plot 19

Excel
importing 172

Excel 2007 files
importing 168

Excel files
batch processing 338

Excel workbooks
options 12
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Excel worksheets 204
creating graphs 204
creating within Notebook Manager 106
limitations 204
opening 203
regression 204
statistics 204
system requirements 4
transforms 204
using 203, 204
using date and time format 187

exploding pie chart slices 271, 271
exploratory enzyme kinetics 15, 338
exponents

numeric tick labels 266, 289
exporting

data associated with graph 321
data only, not the graph 321
graphs and pages 112
graphs as webpages 321
into HTML 320
reports 309
to Systat 175
worksheet data 174, 205
worksheets 174
worksheets as text files 175

Extreme Value Distribution scale 281

F
factor

axis tick labels 289
fast page open 12
feedback

mouse-over 117
file formats 168
files

as objects to insert 129
embedding objects 126, 131
exporting as non-notebook files 112
importing data from 168, 173, 199
linking objects 126, 131
notebook templates 122, 131
opening non-notebook 107, 108
text 173

fill color
gradient fills 258
modifying 257, 258
transparency 258

filled contour plots
creating 262
modifying 265

fills
area plots 235, 235
bar chart 134
box plot 134
box plots 229
change color of pattern lines and edge lines 134
change object fill background color 134
change object fill pattern 134
changing 86
contour plots 265

custom incrementing schemes 88
increment customizing 88, 92
mesh plots 258
modifying 88
object 134
pie chart 134
symbol 134
transparency 258
waterfall plots 257

Fixed Decimal
display 182

fonts
Greek 144
PostScript 144
symbols 144
TrueType 144

forest plots 244
arranging data 245
creating 246
data format 28

formats
submitting graphs for publication 322

formatted worksheets 60
formatting

cells 188
date and time data 188
numeric data in worksheets 188
text 146
text in cells 188

frame lines
color 262
line type 262
modifying 262
relative to origin 262
relative to viewer 262

freezing panes 165
frequency

contour labels 266
frequency plots

creating 342

G
galleries

graph style 64
Gallery.jgg 5
gap color 135
gap colors in line 83
Gaussian Cumulative Distribution 344
generating

error bars 223
mesh data 14

global text changes 146
Go to...

worksheet cell 166
gradient colors

creating 341
gradient fills 258
graph defaults 12

options 28
setting 28
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graph page
setting options 112, 112

graph pages 111
creating within Notebook Manager 106
naming 106
printing 113
retrieving data 125
selecting objects 115
storing data 125

graph planes
color 291
modifying 257
transparent planes 291

Graph Properties 115
customizing tick labels 291
getting Help 10
how to use 9
modifying graphs 68, 68
modifying grids 68
modifying tick appearance 284, 287
modifying titles and legends 68
moving axes 282
positioning 2D axes 282
radial axes 296
transparency 10
viewing/hiding axis 281

graph style
custom 64
Graph Style Gallery 64
multiple straight lines 35
saving 64
simple straight line 35

graph style data format
3D trajectory 49
3D waterfall 49
arrow line radar plot 43
box plots 48
contour plot 48
error and radio band radar plot 43
filled contour plot 48
grouped horizontal bar chart 46
grouped horizontal bar chart with error bars 46
grouped vertical bar chart 44
grouped vertical bar chart with error bars 44
horizontal bar chart with error bars 46
Horizontal dot plot 29
horizontal point plot 29
hortizontal error bars 29
line plus radar plot 43
multiple area plot 40
multiple error bars 29
multiple error bars and regressions 29
multiple horizontal step plot 35
multiple regressions 29
multiple scatter plot 29
multiple spline curves 35
multiple straight line 37
multiple vertical area plot 40
multiple vertical step plot 35
polar line plot 42
polar scatter line plot 42
polar scatter plot 42

radar line plot 43
radar scatter line plot 43
radar scatter plot 43
simple area plot 40
simple bar chart 44
simple error bars 29
simple error bars and regression 29
simple horizontal bar chart 46
simple horizontal step plot 35
simple regression 29
simple scatter plot 29
simple spline curve 35, 37
simple straight line 37
simple vertical bar chart 44
simple vertical step plot 35
stacked horizontal bar chart 46
stacked vertical bar chart 44
ternary line plot 43
ternary scatter line plot 43
ternary scatter plot 43
vertical area plot 40
vertical bar chart with error bars 44
vertical dot plot 29

Graph Style Gallery
adding styles 65
applying graph styles 65
creating graphs 64, 64, 65
editing graphs 65
using 64

graph styles
custom graph styles 65
Graph Style Gallery 65
using the Graph Style Gallery 64, 65

graph titles
deleting 133

graph toolbars
2D, 3D 118

graph type data format
3D bar chart 28
3D line plot 28
3D mesh plot 28
3D scatter plot 28
box plots 28
contour plot 28
forest plot 28
horizontal bar chart 28
line and scatter plot 28
line plot 28
pie chart 28
polar plot 28
scatter plot 28
statistical graphs 28
ternary 28
vector plot 28
vertical bar chart 28

Graph Wizard 115
additional axes 248
area plots 231
bubble plots 241
changing graph type/style 70
creating 3D graphs 253, 254, 255
creating graphs 61
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creating mesh plots 257
data ranges 63
multiple plots 248
radar graphs 248
vector plots 242, 242

graphs
2D example 16
3D example 20, 21
adding drop lines 93, 94
adding plots 72
adding to page 117, 118
aligning 142
anatomy of 15
arranging on a page 138, 141
asymmetric error bar plots 51
automatic legends 147
axes 262
box plots 229
centering 142
column averaged error bar plots 51
contour plots 19, 269
copying 124, 125, 125, 193
creating 27, 59
cutting 124, 125, 125, 193
data format for graph styles 29
data format for graph types 28
defaults, setting 28
displaying automatic legends 149, 152
editing in Graph Style Gallery 65
editing in other applications using OLE2 125
grid lines 293
grouped bar charts 223, 224
grouping/ungrouping objects/text 137
hiding 131
hiding automatic legend 149, 152
hiding graph titles 133
hiding on page 131, 131
hiding using shortcut menu 131
legends 144
modifying 27
modifying 2D plots 95
modifying type/style 70
modifying using Graph Properties 68, 68
moving 135, 135
moving legend entries 149
multiple curves, same X or Y 53
picking different data for current plot 69
pie charts 16, 269
plotting data 53
plotting multiple curves 54
plotting X or Y using row numbers 53
polar plots 19, 269
resizing labels/legends automatically 112
scaling 135, 135
scatter, 3D 57
selecting 69
selecting style 29, 59
selecting type 28
sizing 135, 135
stacked bar chart 51
styles 29
symbols 76, 80

ternary 269
types 28
types and styles 12
using Paste Special 125
vector plot 52
viewing on page 131, 131
working on pages 131, 131, 134, 162
zooming in/out 118

graphs, 2D 213
GraphWzd.ini 5
Greek symbols

entering 144
Gregorian calender 186
grid

changing colors 179
grids

aligning graphs and objects 143
color 292
displaying in front/behind 292
graph back planes 293
hiding 293
line types 292
mesh graphs 14
modifying 262
snap-to 143
turning on/off 293

grouped bar charts
column averages 226
creating 223, 224
creating with error bars 223
error bars 226
examples 223
spacing bars 91, 92

grouped data 214
grouping

objects/text 137
guidelines

for submitting graphs for publication 322

H
halting 153
hardware

system requirements 4
Help

for Graph Properties 10
Help system

using 22
hiding

automatic legends 149, 152
axes 281, 281
axis titles 284
contour lines 264
graph titles 133
graphs on page 131, 131
graphs using shortcut menu 131
grid lines 293
legends 133
radial axis labels 297
statistics 176
tick marks 284
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highlighting
outliers 201

histograms 27
macro for creating 340

HistogramWzd.ini 5
horizontal bar chart

data format 28
horizontal dot plot

data format 29
horizontal error bars

data format 29
horizontal point plot

data format 29
HTML

exporting graphs into 320

I
icons

changing display for inserted objects 129
changing display for pasted objects 128
displaying inserted objects as 129
displaying pasted objects as 128
on graph pages 127

identifying
area plot intersections 235

ignoring
outliers 199

importing
Axon files 173
data by copying and pasting 169
data files 168, 173, 199
data from multiple Excel files 338
databases 169
Excel files 172
Lotus 1-2-3 files 172
MicroSoft Excel files 172
ODBC databases 169
Quattro files 172
SPSS files 173
text files 173

Importing
SigmaPlot files 172
SigmaScan files 172
SigmaStat files 172

inches
page units 159

incrementing
color schemes 89
lines 84
symbol color 78

incrementing colors
chart fills 88

incrementing line types 83
incrementing schemes

customized 88
independent graph pages 107
indexed data 50, 214
indexing data 202

creating 202
unindexing data 202

Insert Cells shortcut 166

Insert Date and Time command
for reports 312

inserting
columns and rows 194
data 167
displaying inserted objects as icons 129
graphs into Microsoft Word 345
linked objects 129
modifying inserted object icons 129
new object 129
objects from file 129

Insertion mode
turning on/off 167

installing SigmaPlot 4
serial numbers 4
types of folders 5

intersections
identifying in area plots 235

intervals
confidence/prediction 175
setting for contour plots 265
tick mark values assigned to a worksheet 287

introduction 3

J
jagged lines

removing them 162
JNT files 138
journals

preparing graphs for publication 323

K
Kaplan-Meier survival curve 366
key column 192
keyboard

moving around worksheet 166
moving graphs and objects using arrow keys 137

keyboard shortcuts 7
keystrokes

functions 166

L
label notation 289
labeling

with symbols, text from column 345
labels

adding to page 144
aligning 142
automatic scaling with graphs 112
axis titles 284
axis values 290
column titles 195, 199
column type 291
contour 266, 266
creating 144, 146
editing tick 289
entering non-keyboard characters 144
frequency of contour 266
grouping/ungrouping 137, 137
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numeric tick 266
radial axes 297
reference lines 95
rotating 144
rotating contour 266
row titles 195, 199
suffixes/prefixes 266
tick mark 290
using column and row title dialog box 196
using for column titles 197
using for row titles 198

landscape
page orientation 159

layering in front/behind
grid lines 292
reference lines 95

layout files 12
Layout.jnt 5
leap years 186
legend entries

dragging 149
locking into place 149
moving 149
moving with arrow keys 147
reordering 153

legend items
direct labeling 155

legends 133
adding symbols 144
adding to page 144
automatic 13, 147
automatic scaling with graphs 112
column count 154
creating 144, 146
deleting 133
direct labeling 155
dragging individual entries 149
editing 149
frame in box 149
hiding 149
locking 153
locking into place 149
moving individual entries 149
moving individual items 155
restoring to default settings 149
showing 149

ligand binding 338
light source

3D graphs 259
line and scatter plot

multiple straight line data format 37
simple straight line data format 37

line and scatter plots
adding drop lines 93, 94
creating 213
data format 28
examples 212

line plot data formats
multiple horizontal step plot 35
multiple spline curves 35
multiple vertical step plot 35
simple horizontal step plot 35

simple spline curve 35
vertical step plot 35

line plots
3D data format 28
adding drop lines 94
adding drop lines to 93, 94
color 83
creating 213
data format 28
examples 212
midpoint step 83
multiple straight lines 35
step 83
straight 83
symbols 76, 80

line type
frame lines 262
modifying 135
reference lines 95

line widths
setting from worksheet column 85

line/scatter graphs
asymmetric error bars 219
error bars 216
quartile plots 219
range plots 218
symbols 76, 80

linear axis scale 276, 289
linear interpolation

for computing percentile methods 230
linear regression 27
lines

adding arrow heads 135
alternating colors in lines 83
assigning to worksheet 88
attributes 282
axis 282
changing end attributes 135
changing thickness 83
changing type 83
color 83
contour 264
custom incrementing schemes 88
drawing 133
drop 93, 94
error bars 221
frame 262
grid 293
grid line types 292
increment customizing 88, 92
incrementing 83, 84
layering in front/behind symbols 83
mesh plots 258
midpoint step plots 83
modifying properties 135
radial axes 296, 297
reference 229
setting intervals for contour plots 265
smoothed 83
spline curves 83
step plots 83
type 83
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linking
objects 126, 131
Reports 126

links
viewing object links 131

locking
legends 153

locking legends 149
log axes 289
logarithmic axis scale 276, 289
logit axis scale 277
Lotus 1-2-3 (WK*)

importing 168
lournals

preparing graphs for publication 322

M
macro language

creating macros using 327
macro programming language 331
macro window

appearance 331
Macro Window 330, 330

opening 327
options 331

Macro Window toolbar 329
macros 330, 330, 338, 338, 339, 340, 340, 341, 341, 341, 342,

343, 344, 345, 345, 345, 345, 346, 348, 349, 349, 349,
349, 361, 366, 367

adding macros to macros 332
adding procedures 333
creating 325, 327
creating as buttons 336
creating custom dialog boxes 332
creating user-defined functions 334
editing 328, 332
examples 335
for Microsoft Word/Excel 335
list of 337
programming language 331
recording 325
running 338
running from a command line 336
setting options 331
user-defined functions 333
using Macro Window toolbar 329
using the Add Procedure dialog box 333
using the Debug Window 334
using the Object Browser 333
using to automate routine tasks 325
window options 331

magnitude data
plotting as vector 367

Main Button 10
major ticks

date and time axis scale 286
maximum value (max)

column statistics 175
mean

column statistics 175
error bar computation method 223

mean computation method 223
mean lines 229

box plots 229
median lines 229
merging

columns 345
mesh data

converting 14
generating 14
interpolating 14

mesh lines
modifying 258

mesh plots
3D data format 28
creating 257
examples 252
fills/color 258
gradient fills 258
light source 259
mesh data 14
mesh lines 258
modifying lines/fills 258
plotting data 57
smoothing data 14
transparency 258
transparent 257
X,Y,Z values 57

metafiles 126
Microsoft Excel

opening SigmaPlot within 335
Microsoft Excel (.XLS)

importing 168
Microsoft Word

inserting graphs 345
opening SigmaPlot within 335

millimeters
page units 159

Mini toolbar 14
minimum positive value (min pos)

column statistics 175
minimum value (min)

column statistics 175
Minitab

importing 168
minor ticks

date and time axes 286
modifying 286

missing values
column statistics 175

Mocha worksheets 172
Mocha Worksheets

importing 168
modifying

2D plots 95
3D graph view 259
adding plots 72
area plots 235, 235
attributes for new pages 122
automatic legends 147
axes 262, 281, 281
axis range by dragging 298
axis scale 276
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axis scale types 280, 281
background colors 88
box fills/color 229
box plots 229
box widths 229
category scales 280
contour labels 266, 266
contour lines 264
contour plots 264, 266
drawn objects 134
drop lines 93, 94
drop plane color 257
drop planes 257
edges 86
embedded graphs 75, 76
error bar appearance 221
error bar computation method 223
error bar direction 221
error bars 221
fill color 257, 258
fills 88
frame lines 262
gap color 135
gradient fills 258
graph lighting 259
graph perspective 259
graph plane color 257
graph planes 257
graph rotation 259
graph styles 70
graph types 70
graphs 27
graphs using Graph Properties 68, 68
grid lines 262
grids 68, 291
inserted object icons 129
line color 135
line end attributes 135
line thickness 135
line type 135
mesh lines 258
mesh plots 258
modifying 88
multiple text labels 146
object fills 134
object links 131
page color 160
page view 118
pasted object icon 128
patterns 88
pie charts 271
plot pattern line thickness 86
polar axes 297
polar plot axes 293
polar plots 55
radial axes 297
radial axes arc 296, 297
radial axes tick labels 297
symbol attributes 77
symbols 76, 80
ternary axis direction 300
ternary plots 274

ternary tick labels 304
ternary tick marks 304
text formatting 146
tick labels 290
tick marks 262
titles and legends 68
whisker cap widths 229

modifying for new pages 122
modules

Enzyme Kinetics 14
exploratory enzyme kinetics 15
shelf life 15
simple ligend binding 15
standard curves analysis 15

mouse
moving objects 135
sizing objects 136

mouse-over feedback 117
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2D axes 282
2D axes manually 282
2D axes with mouse 282
around the worksheet 166
axes to precise location 282
axes with Graph Properties 282
axis titles 284
data 194
graphs 135, 135
graphs and objects using arrow keys 137
notebook items between notebooks 107, 108
objects 135, 135
objects to back/front 137
radial axis 296, 297
to worksheet cell 166

moving objects 135
multiple area plots

creating 233
multiple axes

creating 249
multiple curves

creating 214
plotting data 214
using category data 214

multiple error bars
data format 29

multiple error bars and regressions
data format 29

multiple plots 72
additional axes 248

multiple regressions
data format 29

multiple scatter plot
data format 29

multiple spline curve
format 35

multiple straight line
data format 37

multiple users 5
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graph pages 106, 106
notebook files 106, 106
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worksheets 106, 106

natural log axis scale 276
needle plot

creating 91
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sections 106
worksheets 106
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non-notebook files

exporting to original file format 112
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notebook files
creating 106
naming 106, 106
opening 107, 108
template notebook files 122, 131
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exporting as non-notebook files 112
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Notebook Manager
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OLE
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SigmaPlot as a command line 336
SigmaPlot in other applications 335
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options

automatic 112
automatic legends 12
backup files 12
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Excel workbooks 12
fast page open 12
graph defaults 12, 28
graph pages 112
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layout files 12
macro window 331
novice prompting 12
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page 12
page undo 112
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retain window states 12
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templates 12
worksheet 12
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highlighting 201
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Overwrite mode 167
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creating graphs for current 118
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editing format 156
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moving objects/graphs 135, 135
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setting options 112
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setup 156
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showing rulers 112
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viewing graphs 131, 131
working with graphs 131, 131, 134, 162
working with objects 131, 131, 134, 162
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selecting on a page 115

Page toolbar 133
Page undo

options 112
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selecting graphs 115
selecting objects 115
selecting text 115
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plotting 348
password protecting data 321
passwords

password protecting 321
protecting notebooks 101
protecting worksheets 101

Paste shortcut 166
Paste Special

command 125
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embedding objects 126, 131
linking objects 126, 131
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data 169, 194
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graphs to PowerPoint 345
graphs/objects with the Paste Special command 125
objects 125
transpose 195
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assigning to worksheet 88
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changing color lines of fills and edges 134
changing density of plot fills 86
changing object fills 134
modifying 88
plot line thickness 86
set pattern and edge line thickness 134
setting thickness 134

PDF
saving 114

percentile methods
box plots 230

percentiles 230
perspective

3D graphs 259
pharmacology 15, 338
picking data

different columns to plot 69
different data for current plot 69

pie charts 88
adding exploding slices 271, 271
creating 49
data format 28
data formats 49
example 16
examples 270
fills 88, 134
modifying 271
plotting data 49
rotating 271
slice edges 134

Pie charts
sample graph 18

Piper plots 346
Plain Text (.TXT, .PRN,.DAT,.ASC)

importing 168
plot fills

pattern density 86
plot styles

multiple curves 214, 214
plot types

error bars 216
plots

about 248
adding new 72
contour 269
custom incrementing schemes 88
dummy 249
frequency 342
layering lines in front/behind symbols 83
multiple 72
multiple axes for single 249
needle plot 91
offsetting radial axes 296
pattern line thickness 86
picking different data 69
pie charts 269
Piper plots 346
polar 269
polar axes 297
selecting 69
survival curve 366
symbols 76, 80

ternary 269
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vector plots 367

plots, 2D
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creating with asymmetric error bars 219
creating with error bars 216
grouped bar charts 223, 224
line 212
line and scatter 212
modifying 2D 95
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scatter 212
types available 212, 212, 212, 213, 227
using category data 214

plots, 3D
bar charts 252
mesh 252
scatter and line plots 252
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waterfall plots 253

plotting
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portion of data 74

plotting data
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3D graphs 57
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multiple curves 54, 214
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portion of 74
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stacked bar chart 51
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plotting 348
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modifying 297
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data for multiple curves 55
data format 28
example 19
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plotting data 55
radial and angular values 54
radial axes 296, 297
radial axis tick marks 297
symbols 76, 80
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polar plots, multiple curves
data from one column 55

portrait
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positioning
2D axes using the Graph Properties 282
2D axis 282
3D axes 262
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computing 349

PowerPoint
creating slides with graphs 345

pre-formatted worksheets 60
precise location

moving axes to 282
precision options 289
prefixes
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tick labels 290

preparing
graphs for publication 322, 323

previewing
worksheets before printing 206

printer settings
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previewing 206
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setting options 205, 208
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adding to macros 333
producing

file for publication 322
producing files for publication
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properties

modifying text 146

protecting
notebooks with passwords 101
worksheets with passwords 101

publishing
graphs in journals 322, 323
journal submission requirements 322
on the World Wide Web 320

publishing graphs 320
.EPS 323
about dpi 323
using the Submission Assistant 323

Q
quality control lines 229
quartile plots 219
quartiles

computing for box plots 230
Quattro/DOS (.WK*)

importing 168
Quick Access Toolbar 11
quick re-plot 349
Quick Start 60

R
radar charts

creating 50
data formats 50
plotting data 50

radar graphs
2D 248
about 247

radar plot data formats
arrow line radar plot 43
error and radio band radar plot 43
line plus radar plot 43
radar line plot 43
radar scatter line plot 43
radar scatter plot 43

radial axes
about 295
attributes 296
lines 296, 297
modifying 296, 297
moving 296, 297
offset from graph center 296
tick labels 297
tick marks 297
turning on/off 296, 297

radial labels
turning on/off 297

radial values 54
range

angular axis 294
Z data for contour plots 265, 265

range plots 218
range, axis

axis values 265
modifying 279
modifying by dragging 298
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computing 349

rearranging data 195
reciprocal axis scale 278
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direction 95
displaying 95
displaying in front/behind 95
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line attributes 95
line thickness 95
line type 95
lower specification 95
statistics 95
turning on/off 95

regional settings
date and time format 186

Regression Wizard 14
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fitting data 14
using data in Excel worksheets 204
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outliers 199

Report Editor 14
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changing table border color 316
delecting tables 316
formatting paragraphs 313
formatting text 313
formatting toolbar 313
ruler 313
setting paragraph indents 315
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report rulers
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showing or hiding 314
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changing table border color 316
creating within Notebook Manager 106
deleting tables 316
embedding objects 126
exporting 309
inserting date and time 313
linking objects 126
printing 310
Report Editor 14
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setting page size and margins 308
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showing or hiding rulers 314
tables 316

reports creating Report Editor
creating 306
creating reports 306
reports 306

requirements
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resize
symbols 148

Resizing
embedded graphs 76

restoring
legends to default settings 149

retain window states 12
retrieving data 125
Ribbons

customizing 6
minimizing 7
minimizing for a short period of time 7
turning off sticky Ribbons 7
using 6

right-clicking
hiding graphs 131
selected graphs and objects 115

ROC Curve Analysis 349
rotating

3D graphs 259
3D graphs axes placement 262
angular axis 294
axis titles 284
contour labels 266
labels 144
pie charts 271, 271
text 144

rows
deleting 195
inserting empty 194
selecting 193
sizing 178, 189
titles 195, 199
transposing 195
using as column titles 197, 199

rulers
aligning graphs and objects 143

running
macros 338
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sampling

data 74
SAS Data Set

importing 168
SAS Export File

importing 168
saving

as PDF 114
time using the Graph Style Gallery 64

saving time
using the Graph Style Gallery 64

saving your work 10
Sax Basic

getting Help 329
scale

angular 294, 294
axis 13
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category 277, 280
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common log 276
custom 281
date/time 278
linear 276
logit 277
natural log 276
probability 276
probit 277
reciprocal 278
tick labels 290
tick marks 287, 304
types 13, 276, 280, 281

scale type
changing 280, 281

scale, axis
base/exponent labels 266
contour plots 265, 265

scales
Arrhenius 281
Extreme Value Distribution 281
using a date and time scale 281

scaling
graphs 135, 135
objects 135, 135
resizing labels/legends automatically with graphs 112
setting aspect ratio option 112
using mouse 136

scatter and line plots
examples 252

scatter plots
asymmetric error bars 219
creating 213
data format 28
drop lines 94
error bars 216
examples 212, 212, 212, 213
quartile plots 219
range plots 218
symbols 76, 80

scatter plots, 3D
creating 253, 254, 255

schemes 162
incrementing 89

scientific notation 177
tick labels 289
using as axis values 266, 289

section
creating within Notebook Manager 106
dragging within the Notebook Manager 107
editing 106
naming 106, 106

security
password protecting notebooks 101
password protecting worksheets 101

selecting
all data in worksheet 193
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data 193
entire worksheet 193
graph style 29, 59

graph type 28
graphs 69
graphs on page 115
objects on page 115
page objects 115
plots 69
right-clicking graphs 115
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text on page 115

Selection mode 115
serial numbers 4
set auto recovery

options 12
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axis breaks 283
decimal places 181
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macro window options 331
page options 112
passwords 321
passwords for the World Wide Web 321
printing options 113, 205, 208
report options 306

setting arrowhead length 244
setting the angle 244
setting up

graph page format 156
settings 112

3D graph view 259
angular axis 294, 294
aspect ratio 112
axis range 279
column statistics 12
error bars 221
frame lines 262
graph defaults 28
object location on page 135
radial axes 296, 297
reference lines 95
statistics 176
template files 122
worksheet 12

shading
3D graphs 259
between two curves on an area plot 236

shapes
lines 83

shelf life 15, 338
Shortcut menu

hide 131
shortcuts 7

worksheet 166
showing 131
SigmaPlot

folders 5
installing 4, 4
introduction 3
registration 4
system requirements 4
using in Windows 6
using OLE2 to edit graphs pasted to other applications 125
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SigmaPlot 1.0 and 2.0 (.SPW)
importing 168

SigmaPlot Macintosh 4 and 5 Worksheet
importing 168

SigmaPlot Macro Library.jnb 5
SigmaPlot macros

Area Below Curves 338
Batch Process Excel Files 338
Bland-Altman Analysis 339
Border Plots 340
By Group Data Split 340
Color Transition Values 341
Compute 1st Derivative 341
Dot Density Plot 341
F Test Comparison of Curves 343
Frequency Plot 342
Gaussian Cumulative Distribution 344
Insert Graphs into Word 345
Label Symbols 345
Merge Columns 345
Paste to PowerPoint Slide 345
Piper Plots 346
Plotting Polar and Parametric Equations 348
Power Spectral Density 349
Quick Re-Plot 349
Rank and Percentile 349
ROC Curve Analysis 349
Standard Curve 361
Survival Curve 366
Vector Plot 367

SigmaScan (.SPW)
importing 168

SigmaStat 3, 14
SigmaStat 1.0 (.SMB)

importing 168
simple bar chart data format 44
simple error bars

data format 29
simple error bars and regression

data format 29
simple ligand binding 338
simple ligend binding 15
simple regression

data format 29
simple scatter plot

data format 29
simple spline curve

data format 35, 37
simple straight line

data format 37
simple straight line plot

data format 35
size

column statistics 175
symbols 148
values from column for symbols 80

sizing
columns and rows 189
columns and Rows 178
graphs 135, 135
objects 135, 135
resizing labels/legends automatically with graphs 112

setting aspect ratio preference 112
using mouse 136

slices, pie chart
edges 134
exploding 271, 271
rotating 271, 271

smoothing data
mesh plots 14

snap-to 143
sorting

data 192
source

templates for new pages 122
spacing

bars 91, 92
bars from different plots 91, 92, 225

speed
increasing drawing speed 74

SPSS files
importing 173

SPW.ini 5
SPW32.opt 5
stacked bar chart 51
stacked bar charts

automatic reference lines 95
standard curve macro 361
standard curves analysis 15, 338
standard deviation

column statistics 175
standard error

column statistics 175
Standard percentile method

using for box plots 230
Standard.jfl 5
statistical graphs 28
statistics

changing ribbons for quick access 6
Options 12
overview 3
reference lines 95
setting Options 176
showing/hiding 176
using Excel worksheets 204
worksheet 14

storing data 125
style

Graph Style Gallery 65
styles

graph 29
using the Graph Style Gallery 64, 65

Submission Assistant 323
editing a profile 324

submission profiles 5
submitting

graphs to journals 322, 323
Subscript 144
suffixes/prefixes

contour labels 266
tick labels 290

sum
column statistics 175

Superscript 144
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survival curves
creating 366

switching
between date and time and numeric display 189

symbols
alphanumeric 79
assigning to worksheet 88
box plots 229
changing edge color 77
changing edge thickness 77
changing fills 77
changing size 77
changing type 77
characters used as 79
color incrementing 78
custom incrementing schemes 88
dot/crosshair color 77
fills 134
Greek 144
increment customizing 88, 92
inserting in legends 144
layering lines in front/behind 83
modifying attributes 77
modifying in plots 76, 80
resize 148
restoring to default settings 149
size values from a worksheet column 80
using characters as 79
using macro to label with 345

Systat
European office 22
exporting to 175

system requirements 4
Excel workbooks 4
hardware 4

T
tables

adding to reports 316
changing border color 316
deleting 316

template files
settings 122

Template.jnt 5
TEMPLATE.JNT 123
templates 12, 138, 139, 140, 141, 162

adding styles to gallery 65
creating 122, 131
Graph Style Gallery 64, 65, 65
JNT files 123
notebook files 122, 131
options 12
page 122, 131

ternary axes
about 297
dragging 298

ternary axis direction
modifying 300

ternary graphs
changing axis direction 300
changing scale direction 300

changing scale type 299
creating 273
data for multiple -curve plot 55
data for single plot curve 55
data format 28
defined 55
line plots 273
line/scatter plots 273
modifying plots 274
modifying tick labels 304
modifying tick marks 304
multiple-curve plots 55
plot data set 273
scatter plots 273
selecting data 273
third-column data 55

ternary plot data formats
ternary line plot 43
ternary scatter line plot 43
ternary scatter plot 43

ternary triplets
data for 55

text
adding to page 144, 144
alignment 144
editing 144
editing contour labels 267
editing tick labels 289
entering 144, 146
formatting 146
grouping/ungrouping 137
labels to page 144
rotating 144
subscript 144
superscript 144
using as plot symbols 79

text files
exporting worksheets 175
importing 173

text labels
creating 144

text mode
entering non-keyboard characters 144

Text Properties 115
Text Properties dialog box

changing text labels 288
thickness

axis lines 282
contour lines 264
grid lines 292
line 83, 135
radial axes 296
reference lines 95
tick marks 288, 304

thickness plot pattern lines 86
Three dimensional 20
tick intervals

Date and Time 286
tick labels

custom 266, 291
date and time 266
editing text 289
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factors 289
formatting numeric tick labels 289
modifying 290
modifying ternary 304
numeric notation 266
prefix/suffix 290
radial axes 297
rotating 288
scientific notation 289
text attributes 288
time and date 290
using from a worksheet column 266, 291

tick line options 288
tick mark direction 287
tick marks

customizing intervals 287
date and time axes 286
direction 297
displaying and hiding on radial axes 297
hiding 284
intervals assigned to a worksheet 287
labels 290
length 288, 304
modifying 287, 304
modifying ternary 304
radial axes 297
turning on/off 287
viewing 284

ticks
specifying direction 287

time and date 290
tips and tricks

avoid repeating the same steps 64
titles

axis 284
column 195, 199
column and row titles dialog box 196
hiding graph 133
row 195, 199
using cells as column or row titles 199
using worksheet columns as row titles 198
using worksheet rows as column titles 197

toolbars
drawing 133
using Macro Window toolbar 329

Tools menu
draw arrow 133
draw box 133
draw ellipse 133
draw line 133

trajectory plots
creating 253, 254
symbols 76, 80

transforms
applying to data 14
defined 14
duplicate column titles 164
using data in Excel worksheets 204

transparency 258
turning off in Graph Properties 10

transparent graph planes
creating 291

transparent mesh
creating plots 257
selecting shading 257

Transpose Paste shortcut 166
transposing

rows and columns 195
trapezoidal rule 338
Tukey plot 229
turning on/off

axes 281, 281
contour labels 266
contour lines 264
grids 293
insertion mode 167
radial axes 296, 297
radial labels 297
reference lines 95
tick marks 287

two dimensional 16, 19
types

graph 28
lines 83

types of graphs 12

U
undo

setting for worksheets 164
ungrouping

legend items 155
objects/text 137

unindexing data 202
units of measurement

page 159
updating SigmaPlot 4
user accounts 5
user folders 5
user-defined

command with bubble plots 56
user-defined functions

creating 334
in macros 333

UserDialog Editor 332

V
values

angular 54
axis range 265
axis scale 265
minimum 175
minimum and maximum 175
minimum positive 175
missing 175
radial 54
Z data for contour plots 265

values, axis
factors 289
labels 290
numeric labels 266
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range 265, 279
time and date 267, 290

variable bar widths 92
VBA

creating macros using 327
vector formats 323
vector plot line types

dashed 244
dotted 244

vector plots
2D 242, 242
arrowheads with lines 244
creating 367
filled arrowheads 244
modifying arrowheads 244

vertical bar chart
data format 28

vertical dot plot
data format 29

vertical point plot data format 29
view

3D graphs 259
viewing 281

axes 281, 281
axis titles 284
column statistics 14, 175
column statistics in Excel worksheets 204
contour lines 264
data for embedded graphs 76
graphs 118, 131
graphs on page 131, 131
inserted objects as icons 129
Macro Window 327
notebook files 107, 108
notebook items 107, 108
object links 131
objects as icons 127
pasted objects as icons 128
tick marks 284

W
water fall plots

creating 255
waterfall plots

examples 253
fills/color 257

WebViewer 320
publishing graphs on the World Wide Web 320

Weibull scale 281
whiskers

box plots 229
widths

box widths 229
setting from a column 85
whisker caps 229

Wizards
Regression 14

worksheet
changing grid color and thickness 179
column statistics 175, 204
column titles 195, 199

column type labels 291
deleting columns and rows 195
entering data 163, 204
Excel 203, 204
exporting as non-notebook file 112, 174
exporting data 205, 206
going to a cell 166
importing data 168, 173, 199
inserting columns and rows 194
inserting graphic cells 88
inserting symbol size values 80
insertion mode 167
moving around 166
moving between notebooks 107, 108
moving data 194
naming 106, 106
opening 108
overwrite mode 167
previewing before printing 206
printing 205, 205, 206
printing column statistics 206
right-click pop-up menu shortcuts 166
row titles 195, 199
selecting all data 193
selecting data 193
selecting entire 193
set data feedback colors 180
setting Options 12
setting printing options 208
size 14
sorting data 192
statistics 14
Statistics, showing/hiding 176
transposing rows and columns 195

worksheets
creating within Notebook Manager 106
entering data 167
exporting as text files 175
formatting date and time data 188
formatting numeric data 188
formatting text 188
macro to split data into multiple columns 340
opening 164
password protecting 101
setting Day Zero 186
setting decimal places 181
wrap text 188

World Wide Web
publishing graphs to 320
setting passwords to protect your data 321
using the WebViewer 320

wrapping text
in worksheet cells 188
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X,Y values

bubble plots 56
X,Y, many Z

contour plots 57
mesh plots 57
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contour plots 57

XY error bars 222

Z
zooming in/out

on graphs 118
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